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What's New in Version 2019.2
Exago v2019.2 brings many exciting changes for system administrators, report designers and report viewers.

Dashboard Upgrades
The hallmark of v2019.2 is a complete re-design of our Dashboard Designer and Dashboard Viewer tools. More specifically:

Designer Workflow
We've made the workflow for designing Dashboards much simpler. This means less time building and more time working with your data.
Building a Dashboard takes you through a left-to-right workflow on screen:
1. Add tiles from the New Tile menu on the top-left of the Designer.
2. Place the tiles on the canvas as you'd like
3. Interact with the tiles in a newly designed Tile Properties Pane on the right side of the screen

Visualization Overhaul
We've overhauled charts and visualizations built directly on the Dashboard canvas. Dashboard visualizations are now based on Advanced
Reports instead of ExpressView. This means that the flexible sorting, filtering, formulas and aggregation offered by the Advanced Report
Designer are now available to Dashboard Visualizations. But this doesn't mean that building visualizations on the Dashboard is difficult—on
the contrary. Meaningful, attractive and easy to interpret visualizations can be built in as few as four steps!

Click video above to see how easy it is to quickly create a visualization on a Dashboard

Filter and Parameter Menu
The Filters and Parameters menu in the Dashboard Designer has been made easier to use by grouping all content together. This Filters
menu shows two Interactive Filters on a Dashboard, as well as an Imported filter from one of the reports on the canvas:

Filters and Parameters contained on reports with the same data field or name will automatically consolidate into a "stack". This allows a
cleaner, more intuitive filtering and interaction experience in both the Dashboard Designer and Dashboard Viewer. When filters and
parameters automatically consolidate, they group together so that changing their Value will affect all of the tiles on the canvas
simultaneously. Of course, this consolidation can be broken to allow granular customization as well.
The documentation on Dashboard Filters and Dashboard Parameters includes information about how these new menus work in greater
detail.

Drilling Down to Dashboards
The Advanced Report Designer will now allow you to link (or drilldown) to a Dashboard instead of just another Advanced Report. The
filtering action of drilling down is automatically applied to the tiles on the Dashboard, allowing a one-stop view of important data from
another report.

Report Designer Upgrades
Changes to our Report Designer will mean enhancements for both users designing reports and for those viewing and interacting with
reports. The new toolbar is easier to work with and easier to see. Prompting parameters now include dropdown lists with values from the
data source that can be scrolled up or down. Prompting filters with a formula can also display a dropdown list of values—taking the
guesswork out of filtering! Conditional formatting with formulas allows more powerful conditional formatting. A new color picker and "sticky"
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headings round out enhancements to the Report Designer for an all-around better experience for all users.

New Toolbar Icons and Layout

Advanced Report Designer toolbar in v2019.2+
The Report Designer toolbar includes a new, bold icon set. Additionally, these new icons in the Advanced Report Designer are the same
icons used in other parts of the application. This means that custom themes are easier to apply, and a uniform look-and-feel is quick to
accomplish.
Read more about the Toolbar in our documentation.

Parameter Dropdowns Load All Values
When a report contains a prompting parameter, a user will now be able to select any available value from the data source. Previously, only
the first 100 values were available in the dropdown. Now, values load 100 at a time in the direction the user is scrolling. Scrolling works in
both directions.

All of the OrderIds are available in this prompting filter dropdown

Formula Filters Show Available Filter Values In Dropdown
Whenever a filter uses a formula, a user will now be able to select any available calculated value from the data source in a dropdown. For
example, a filter with the formula {OrderDetails.Quantity} * {OrderDetails.UnitPrice} will show the results of this
calculation in the dropdown when the report is run. Previously, only a text field was available where a value would need to be keyed in.

New Color Picker

New color picker dialog
A new color picker is in use throughout the application. The new color picker makes more colors available to report designers, as well as
directly entering hexadecimal or decimal color codes.
The bottom row of colors can show a default set of colors, can save preferred colors on a per-user basis or with extensibility, can be set by
a system administrator.

"Sticky" Section Headers
When scrolling a report whose height or width is larger than the available screen space, section headers on the left side and top of the
Advanced Report Designer will be frozen in place so you can still see them after scrolling.
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Section, Page Header, Detail, Footer: Categories and Report Footer stay in place when scrolling horizontally across this
report

Conditional Format with Functions
Those of you who work with our Advanced Report Designer may be familiar with Conditional Formatting. One application of
Conditional Formatting is to change the color of text or a cell's background. Previously, these colors changes were static choices made
during the report design process. In v2019.2, the color attribute can be set dynamically with an Exago formula. This means that data fields,
functions, calculations, parameters or cell values can be used to determine the color attribute. A new "Set by Formula" button appears in
the color picker.

Scheduling with the REST Web Service API
A number of REST Web Service API endpoints have been added to the application that allow developers to create, modify, view and delete
schedules programmatically. Several new enumerations and constants have been added as well to accommodate this new functionality.

Aggregate Functions
Custom Aggregate Functions
Just as Exago administrators can already create their own Custom Functions, administrators can now create their own Custom
Aggregate Functions for aggregating data. Custom Aggregate Functions can be implemented in either C# or VB.NET directly through the
Admin Console or programmatically through the .NET API. We have provided several examples of Custom Aggregate Functions in our
documentation.

Aggregates in Group Headers
Aggregate Functions will now work as expected when placed directly into a group or section header. Previously, a cell reference was
needed to make this work. Now, header aggregates are supported right out-of-the-box.

Technical Specifications
Operating Systems
Windows
Windows Server 2012+ / Windows 10
Internet Information Services (IIS) 7+
.NET Framework 4.6.1+, version 4.7.2 recommended

Linux
Supported/Recommended Distributions
Ubuntu 14+

Additional Distributions
Red Hat Enterprise Linux 7
SUSE Linux Enterprise Server 12
CentOS 7
Fedora 21-25
Debian 8-9
Warning
Exago is incompatible with SELinux.

Requirements
Exago is not compatible with mono versions installed from system repositories. It is highly recommended that only official mono-project
repositories are used or that the Exago installer install mono.

Mono
Warning
These are the only versions of Mono that are compatible with Exago. In addition, the Exago installer will install a patched version of
System.Web.dll. This patch can also be installed manually.
mono 5.10.1.20
Optional: mono-basic, which provides support for VB.NET

Apache 2.4+
mod-mono
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NGINX
mono-fastcgi-server4
The Exago installer can automatically download and install supported versions of mono, mod-mono or mono-fastcgi-server4.

Data Sources
Fully Supported
Microsoft SQL Server 2000+
PostgreSQL 7.1+
Oracle Version 9i+
MySQL 5.0+
Amazon Aurora
IBM DB2
IBM Informix
Redshift
Snowflake

Partially Supported
MariaDB
ElasticSearch*
MongoDB*
Microsoft OLAP†
* Limited support available, see CData Drivers: Known Limitations.
† Limited support available, see Data Sources: OLAP and MDX Queries.

Database APIs
ODBC
.NET Assembly Methods

Files
XML
Excel

Data Object Types
Database Tables
Database Views
Stored Procedures
Database Functions
Parameterized SQL Statements
.NET Assembly Methods

Browsers
Exago BI targets the most current stable versions of the following web browsers.

Desktop
Desktop browsers support the full user interface and Admin Console.
Mozilla Firefox
Internet Explorer 11
Microsoft Edge
Google Chrome
Apple Safari (MacOS)

Mobile
Mobile browsers support viewing report output in the embedded Report Viewer and Dashboard Viewer.
Google Chrome
Apple Safari

Storage
Reports
File System (pre-v2020.1)
Custom Folder Management (pre-v2020.1) — see the Report and Folder Storage/Management article for more information.
.NET
Azure File/Blob Storage (pre-v2020.1)

Schedules
File System
Scheduler Queue (custom)
.NET

Configuration
File System
Azure Blob Storage

Application Integration
AJAX enabled — .NET API and REST Web Service API for communication between Exago and host application
Server-side
.NET API
REST API
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Client-side
JavaScript
IFrame

Extensibility
Custom Functions
.NET
JavaScript (server-side)
Server Events
.NET
JavaScript (server-side)
Action Events
.NET (server-side) + JavaScript (client-side)
JavaScript (server- & client-side) [Windows only]
Tip
See An Overview of Exago Extensions for more information.

System Requirements
The content of this article has been moved to Technical Specifications and Considerations When Sizing an Exago System.

Configuring IIS for Exago
This guide covers the IIS configuration details necessary in order to install Exago. First-time users are highly encouraged to use this guide
during their installation process. Following these steps in order will reduce the amount of troubleshooting necessary to get Exago running.
1.
2.
3.
4.
5.
6.

Install Prerequisites
Install Exago
Set the Application Pool
Set Folder Paths and Permissions
Check that the Web Site is Running
Open the Admin Console

Install Prerequisites
Exago requires the following Windows Features to be installed:
Internet Information Services
Web Management Tools
IIS Management Console
World Wide Web Services
Application Development Features
.NET Extensibility
ASP.NET
ISAPI Extensions
ISAPI Filters
Common HTTP Features
Optional: WebDAV Publishing
Before installing Exago, please ensure that these features are present on your system. To verify, access the Windows Features panel via
Control Panel > Programs > Programs and Features, and click Turn Windows features on or off.

In the Windows Features dialog, expand Internet Information Services and ensure that the prerequisite features are selected. If any are
not installed, check the relevant boxes, press OK, then restart the server.
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These features are necessary in order for the proper Application Pools to be available.

Install Exago
At this point, Exago can be installed.
For a detailed walkthrough, see Installing Exago on Windows.

Set the Application Pool
Next, verify that Exago is using a valid application pool.
Open IIS via Control Panel > Administrative Tools > Internet Information Services (IIS) Manager.
In the left-most Connections pane, select the Exago application.

In the right-most Actions pane, click on Advanced Settings...

In this menu, click on the [...] button to the right of the Application Pool.

In the Select Application Pool menu, determine which of the app pools has the properties:
.Net Framework Version: 4.5
Pipeline mode: Integrated
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Select this app pool, then press OK to close the App Pool menu, and then OK to close the Settings menu.
Next, ensure that the app pool is running. In the left-most Connections pane, select Application Pools.

Check the Status column for your selected app pool.

If it does not say Started, select the app pool and in the right-most Actions pane, press Start.

Set Folder Paths and Permissions
Exago uses a Temp and Report (pre-v2020.1) folders to store working data and the reports file system, respectively. Create folders in
locations suitable for your environment.
The Reports folder should not be within the Exago application directory. This could cause timeout errors while using the application.
The Temp folder may contain sensitive report and database information. It should be in a secure location, inaccessible to web users.
Several Exago folders require you to set additional permissions for the application pool user. First, determine the user: Open IIS to
the Application Pools pane, and look at the app pool which is running Exago. The Identity property indicates the application user:

By default, this is set to ApplicationPoolIdentity. This corresponds with the built-in user IIS_IUSRS. If this is a different user, then set
permissions for that user account instead.
The following folders require the app pool user to have read/write permissions:
Config
Temp
MapCache
Reports (pre-v2020.1)
Note
This process may differ slightly depending on the version of Windows.
First, right-click on the folder and select Properties.
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Open the Security tab. Then click the Edit... button.

If the application pool user is not available to select, you need to add it. Press the Add... button.

Then enter the username in the dialog box, and press OK (the default app pool user is IIS_IUSRS).

With the user selected, check the box for Allow Full control. Then press OK.

Repeat this process for every folder listed above.

Check that the Web Site is Running
Before starting Exago, ensure that the Web Site is running. Open IIS, and in the left-most Connections pane, locate and select the web
server under which Exago was installed

Verify in the right-most Actions pane that the Start button is greyed out, and the Restart and Stop buttons are available. If the Start
button is not greyed out, press it to start the web server.
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Next, in the left-most Connections pane, locate and select the web site under which Exago was installed.

Verify in the right-most Actions pane that the Start button is greyed out, and the Restart and Stop buttons are available. If the Start
button is not greyed out, press it to start the web site.

Open the Admin Console
You're almost done! To verify that Exago was installed correctly, open a web browser and navigate to
http://[YourServerAddress]/[YourExagoVirtualPath]/Admin.aspx. If you see the Exago Administration Console, then
your installation was successful.
In the Admin Console > General Settings, set your Temp and Reports paths to the folders you previously created. Then click Okay.
Finally, navigate to http://[YourServerAddress]/[YourExagoVirtualPath]/ExagoHome.aspx. If you can see the Exago
Web Application user interface, depending on version the Report Tree should be:
empty for versions pre-v2020.1
Congratulations! You've completed your first Exago installation.

Additional Notes
We highly recommend Setting up a State Server to handle Exago sessions.
If you are experiencing problems that aren't detailed in this guide, please file a support ticket, and a representative will be happy to help
you get set up.

Installing Exago on Windows
Exago runs on the web server application Microsoft Internet Information Services (IIS). The following sections walk through the installation
process for Windows based systems.

Prerequisites
See Considerations When Sizing an Exago System to ensure that you have sufficient hardware to run Exago.
See Technical Specifications to ensure you have the minimum software requirements to run Exago.
See Configuring IIS for Exago to ensure that IIS is installed and configured correctly.

Installation
Important
If you are upgrading an existing Exago installation, please ensure that the file eWebReportsManifest.txt is present in the install directory.
Otherwise, the installer will overwrite any custom config or styling you've applied.
Download the Exago installer from our Downloads page.
Run the installer as an administrator. The installation menu will appear with three downloadable applications. Click the top icon to install
the Exago Web Application, as pictured below.
Note
If Windows Defender prevents this installation, it may be bypassed by clicking "More Info" and then selecting "Run Anyway."

Follow the steps in the wizard to install Exago. You may optionally choose to install the Scheduler and the Web Service from this wizard.
Even though the installer has finished, Exago will most likely not function at this point. You must continue with some additional
configuration.

Create the Directory Structure
After the installation is complete, configure Exago using the following steps. (See Configuring IIS for Exago for a more detailed
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walkthrough.)
1. Set permissions for the Config folder:
1. Right click on the folder named "Config" and click Properties.

2. In the Security tab click "Edit" then "Add." Enter the IIS application pool user (default IIS_IUSRS).

3. In the "Permissions for Config" window select the user that was just created and select "Full Control" permissions.

2. Repeat this process for the ApplicationThemes, MapCache and Drivers folders (the latter is only required if a CData Driver is
being utilized.)
3. For pre-v2020.1, create a folder for storing reports. This folder needs to be accessible from the web server, but is not required to be
on the web server. It can reside on any server accessible by Exago via direct UNC or virtual path created in IIS.
Important
Do not create this folder within the Exago application structure. Doing so will cause ASP.NET sessions to crash when report
folders are created or deleted within the Exago application.
Give the Report Folder full control privileges for the IIS application pool user. Below are three examples of report paths to the
folder \Reports:
C:\Reports – Folder is on a file system.
\\Server Name\Reports – Physical folder is on a separate server.
/Reports – Assumes an IIS virtual directory called 'Reports' has been created to point to the folder.
4. Create a folder for storing temporary data. By default this is a sub-folder of Exago called 'Temp'. However it is recommended to not
use the install path's temp folder in production environments. Give the Temp folder full control privileges for the IIS application pool
user.
5. Point your browser to the Administration Console. By default this is http://<YourServer>/Exago/Admin.aspx.
For pre-v2020.1, in the General > Main Settings section, specify the location of the Report Folder in the 'Report Path'
setting. Verify the connection is successful by clicking the icon.
For all versions, in the General > Main Settings section, specify the location of the Temp Folder in the
'Temp Path' setting.

What's Next
Point your browser to the Admin Console to verify that your installation was successful. By default this
is http://<YourServer>/Exago/admin.aspx
If you encounter problems at any point, please see Installation Troubleshooting for some potential solutions. If you cannot resolve your
problem, please file a Support Ticket.
At this point you will need to set up your data sources in order to use Exago. See Administration Console Setup to get started.
If you would like to set up Google Maps, GeoCharts, and/or any downloadable Application Themes, please see Installing Optional Features
for more information.

Resources
System Requirements — Baseline hardware requirements.
Configuring IIS for Exago — Necessary configuration details for IIS.
Installing the Scheduler Service — Scheduler config info.
Install and Configure the Web Service — Web service config info.
Installation Troubleshooting — Common install problems & their solutions.
Administration Console Setup — Initial data sources setup guide.
Installing Optional Features — How to set up Google Maps, GeoCharts, and Application Themes.

Installing Exago on Linux
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The following article walks through the installation process for Linux systems. Before beginning installation, refer to the Technical
Specifications article for a list of supported distributions and a list of minimum requirements.
The Linux Installer was updated in v2019.2.1 of the application. Select the applicable version of Exago from the Application Version
dropdown on the right-side of this article to show only the information pertaining to that version.
Important
Any previous headless install scripts will start prompting for missing formation and will require editing to account for the new parameters.
This article is divided into two sections: Apache and NGINX. Only follow the instructions in the section that corresponds with the web
server in your environment.
Apache • NGINX

Installation with Apache
Apache must be installed prior to installing Exago.
The Exago Linux Installer can be used to install the Exago Web Application, Web Service API, and Scheduler Service. It can also install
mono and mod-mono. Use the following steps to install Exago on Linux with Apache.
Note
Apache or NGINX must be installed prior to installing Exago. If changing from one or the other, verify the dependencies (mod-mono or
mono-fastcgi-server4) are installed.
1. Navigate to the Downloads page, select a build, and then use the Linux Download option.
2. Decompress the download:
tar zxvf ExagoInstaller_vX.X.X.X.tgz

3. Change to the newly created Installer directory.
cd Installer

4. Run installExago.sh as root:
sudo ./installExago.sh

5. The installer can be run in guided or silent mode. The Linux distribution and Apache version will be detected automatically.

Silent Installation with Parameters
Usage:
[-d <install path>] [-m <TRUE|FALSE>] [-i <WEBAPP|WEBAPI|SCHEDULER>] [-y] [-h]

Parameter

Description

-d <Install Path>

Directory to install Exago in
Default is /opt/Exago

-m <TRUE|FALSE>

Whether or not to install Mono framework with Exago
Which component(s) to install

-i <WEBAPP|WEBAPI|SCHEDULER>

WEBAPP — Web Application
WEBAPI — REST Web Service API
SCHEDULER — Scheduler Service

-a <Web App URL Alias>

Default is /Exago

-s <Web Service URL Alias>

Default is /ExagoWebApi

-r <Scheduler Service Name>

Name to use for the Scheduler Service's systemd service. Default is exagoscheduler.

-R

Configure systemd services
As of v2019.2.1, Exago will automatically install systemd services unless the -N
flag is passed to inhibit their installation. This option is not available in Exago
versions pre-v2019.2.1.

-N

As of v2019.2.1, do NOT configure systemd services
This option is not available in Exago versions pre-v2019.2.1.
As of v2019.2.1, user ID to create in the operating system that the Exago
systemd services and FastCGI listeners will run under.

-u <userId>

A group and home directory with the same name will be created.
This option is not available in Exago versions pre-v2019.2.1.

-w <APACHE|NGINX>

Available in v2019.1.15+
Select the web server to configure, if both are available.
As of v2019.2.1, select all default values for installation options. Individual options
can be overridden by including the parameter on the command line.

-D

This option is not available in Exago versions pre-v2019.2.1.
See Default Values below for further details

-y

Do not prompt for final verification before installing

-h

Show this help screen

Examples:
1. Install the Exago Web Application and Web Service API into /opt/Exago
./installExago.sh -d /opt/Exago -m TRUE -i WEBAPP -i WEBAPI

2. Full installation using all default values without prompting before starting the install
./installExago.sh -D -y
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3. Install the Scheduler Service only into /opt/ExagoRemote using defaults for everything else
./installExago.sh -d /opt/ExagoRemote -i SCHEDULER -D

Guided Installation v2019.2.1+
##############################################
___ __ __ __ _
__ _
___
/ _ \ \ \/ / / _` | / _` | / _ \
| __/ > < | (_| | | (_| | | (_) |
\___| /_/\_\ \__,_| \__, | \___/
__/ |
Linux Installer |___/
##############################################

The Linux Installer will ask a series of questions to setup the environment. Suggested default values for each question are enclosed in [
brackets ]. To choose the default value, simply press the Enter key on the keyboard. Default values are explained in their own section
below.
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.

Select base install path. Default value is /opt/Exago.
Would you like to install the Mono runtime if not already installed? Default is yes.
Would you like to install the Exago Web App? Default is yes.
Would you like to install the Exago Web Service API? Default is no.
Would you like to install the Exago Scheduling and Remote Execution Service? Default is no.
Multiple web servers appear to be present. Please choose which web server you would like to use. This question will only appear if
both Apache and NGINX are installed on the web server. You must choose 1 for Apache or 2 for NGINX.
Enter a name for the Exago Scheduling Service. Default is exago-scheduler.
Select WebServer Alias for Exago Web App. Default is /Exago
Select WebServer Alias for Exago WebService API. Default is /ExagoWebApi
Should systemd services be configured? Default is yes.
Please enter a userId to configure for use with Exago. This user account is used to run the Exago services under (Scheduler
Service and Monitoring Service). Default is exago.
A summary of installation parameters will appear and you will be asked if ready to install.

Continue to Start and Test Install below.

Start and Test Install
Restart Apache.
Point your browser to the Admin Console to verify that your installation was successful and to create a default configuration file. By
default this is http://<YourServer>/Exago/Admin.aspx
If you encounter problems at any point, please file a Support Ticket.
Continue to Folder Configuration below to continue with the installation.

Folder Configuration
Configure storage locations for the configuration, report storage (either Storage Management for v2020.1.0+ or a Report Path prev2020.1.0) and temporary file storage.

Config
The Config sub-folder of the Exago installation has read and write permissions set by default.

Report Storage
Create a folder for storing reports. This folder needs to be accessible from the web server, but is not required to be on the web server. The
report folder can reside on any server accessible by Exago, provided a mount point is accessible on the Exago server.
Important
Do not create the reports folder within the Exago application structure. This can cause sessions to crash when report folders are created
or deleted within Exago.
1. Set the Report folder's read and write permissions to 770.
sudo chmod 770 Reports

2. Set the default ownership to the specific <apache user>:<apache group>
3. In the Admin Console, specify the location of the report folder in General > Main Settings > Report Path
Note
The group ownership on the reports directory is not mandatory, and can be changed to have other group ownership as needed for access
outside of Exago.

Temporary File Storage
The recommended path for the Temp folder is /opt/Exago/Temp.
1. In the Admin Console, specify the location of the temp Folder in General > Main Settings > Temp Path
2. Set the MonitoringService folder's read and write permissions for the Apache user, (of if not using the default Apache user the
user ID specified with -u) to 775, and set the default ownership to <apache user>:root.
Note
If using a custom Application Theme, the ApplicationThemes folder will also need the same permsissions.
Installation is now completed. If the Scheduler Service or Monitoring Service is required, continue to the Scheduler and Monitoring Services
section at the end of this article.
If all components are installed, the Installer directory may be deleted.
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Installation with NGINX
NGINX must be installed prior to installing Exago. NGINX proxies incoming and outgoing requests to a running instance of Exago using a
fastcgi module that is installed during the installation process. mono-fastcgi-server4 is a prerequisite for Exago to run on NGINX.
The Exago Linux Installer can be used to install the Exago Web Application, Web Service API, and Scheduler Service. It can also install
mono and mono-fastcgi-server4. Use the following steps to install Exago on Linux with NGINX.
Note
Apache or NGINX must be installed prior to installing Exago. If changing from one or the other, verify the dependencies (mod-mono or
mono-fastcgi-server4) are installed.
1. Navigate to the Downloads page, select a build, and then use the Linux Download option.
2. Decompress the download:
tar zxvf ExagoInstaller_vX.X.X.X.tgz

3. Change to the newly created Installer directory.
cd Installer

4. Run installExago.sh as root:
sudo ./installExago.sh

5. The installer can be run in guided or silent mode. The Linux distribution will be detected automatically.

Silent Installation with Parameters
Usage:
[-d <install path>] [-m <TRUE|FALSE>] [-i <WEBAPP|WEBAPI|SCHEDULER>] [-y] [-h]

Parameter

Description

-d <Install Path>

Directory to install Exago in
Default is /opt/Exago

-m <TRUE|FALSE>

Whether or not to install Mono framework in Exago
Which component(s) to install

-i <WEBAPP|WEBAPI|SCHEDULER>

WEBAPP — Web Application
WEBAPI — REST Web Service API
SCHEDULER — Scheduler Service

-a <Web App URL Alias>

Default is /Exago

-s <Web Service URL Alias>

Default is /ExagoWebApi

-r <Scheduler Service Name>

Name to use for the Scheduler Service's systemd service. Default is exagoscheduler.

-f <Fastcgi Service Name>

As of v2019.2.1, name to use for the FastCGI services used by NGINX. This
option is not available in Exago versions pre-v2019.2.1.

-p WEBAPP:<port>|WEBAPI:<port>

As of v2019.2.1, port numbers to use for the FastCGI listeners for the Web
Application or Web Service API, respectively. This option is not available in Exago
versions pre-v2019.2.1.

-R

Configure systemd services
As of v2019.2.1, Exago will automatically install systemd services unless the -N
flag is passed to inhibit their installation. This option is not available in Exago
versions pre-v2019.2.1.

-N

As of v2019.2.1, do NOT configure systemd services
This option is not available in Exago versions pre-v2019.2.1.
As of v2019.2.21, User ID to create in the operating system that the Exago
systemd services and FastCGI listeners will run under.

-u <UserID>

A group and home directory with the same name will be created.
This option is not available in Exago versions pre-v2019.2.1.

-w <APACHE|NGINX>

Available in v2019.1.15+
Select the web server to configure, if both are available.
As of v2019.2.1, select all default values for installation options. Individual options
can be overridden by including the parameter on the command line.

-D

See Default Values below for further details
This option is not available in Exago versions pre-v2019.2.1.

-y

Do not prompt for final verification before installing

-h

Show this help screen

Examples:
1. Install the Exago Web Application and Web Service API into /opt/Exago
./installExago.sh -d /opt/Exago -m TRUE -i WEBAPP -i WEBAPI

2. Full installation using all default values without prompting before starting the install
./installExago.sh -D -y

3. Install the Scheduler Service only into /opt/ExagoRemote using defaults for everything else
./installExago.sh -d /opt/ExagoRemote -i SCHEDULER -D

Guided Installation v2019.2.1+
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##############################################
___ __ __ __ _
__ _
___
/ _ \ \ \/ / / _` | / _` | / _ \
| __/ > < | (_| | | (_| | | (_) |
\___| /_/\_\ \__,_| \__, | \___/
__/ |
Linux Installer |___/
##############################################

The Linux Installer will ask a series of questions to setup your environment. Suggested default values for each question are enclosed in [
brackets ]. To choose the default value, simply press the Enter key on the keyboard. Default values are explained in their own section
below.
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.
15.

Select base install path. Default value is /opt/Exago.
Would you like to install the Mono runtime if not already installed? Default is yes.
Would you like to install the Exago Web App? Default is yes.
Would you like to install the Exago Web Service API? Default is no.
Would you like to install the Exago Scheduling and Remote Execution Service? Default is no.
Multiple web servers appear to be present. Please choose which web server you would like to use. This question will only appear if
both Apache and NGINX are installed on the web server. You must choose 1 for Apache or 2 for NGINX.
Enter a name for the Exago Scheduling Service. Default is exago-scheduler.
Select WebServer Alias for Exago Web App. Default is /Exago
Select WebServer Alias for Exago WebService API. Default is /ExagoWebApi
Enter the base fastcgi service name. Default is exago-fcgi
Enter the port for the web app fastcgi listner. Default is 9000
Enter the port for the web service fastcgi listener. Default is 9001.
Should systemd services be configured? Default is yes.
Please enter a userId to configure for use with Exago. This user account is used to run the Exago services under (Scheduler
Service and Monitoring Service). Default is exago.
A summary of installation parameters will appear and you will be asked if ready to install.

Continue to Start and Test Install below.

Start and Test Install
Configure NGINX
The required configuration is created in a separate site file located in the NGINX configuration directory.
For Ubuntu systems this is typically /etc/nginx/sites-available/exago. For other systems this may be
/etc/nginx/conf.d/exago. The exact location of the file will depend on your system and NGINX installation. Consult with your
operating system and NGINX official product documentation for more information.
The site file is not enabled by default.

Example
#Exago conf file for fastcgi-mono-server4
server {
listen 80;
listen [::]:80;
server_name _;
root /var/www;
location /Exago/ {
include /etc/nginx/fastcgi_params;
root /opt/Exago;
access_log /var/log/nginx/exago.log;
fastcgi_param SERVER_NAME $host;
fastcgi_param SCRIPT_FILENAME $document_root$fastcgi_script_name;
fastcgi_param PATH_INFO "";
fastcgi_pass 127.0.0.1:9000;
}
location /ExagoWebApi/ {
include /etc/nginx/fastcgi_params;
root /opt/Exago/WebServiceApi;
access_log /var/log/nginx/exago_ws.log;
fastcgi_param SERVER_NAME $host;
fastcgi_param SCRIPT_FILENAME $document_root$fastcgi_script_name;
fastcgi_param PATH_INFO "";
fastcgi_pass 127.0.0.1:9001;
}
}

For example on Ubuntu, to enable the site file, link it to /etc/nginx/sites-enabled:
sudo ln /etc/nginx/sites-available/exago /etc/nginx/sites-enabled/exago

Or include the configuration in another running site configuration file. This step will depend on your specific environment. Consult your
operating system and NGINX official documentation.
Note
Make sure that the default port does not conflict with another running site. If it does, you will see a warning when reloading Nginx:
nginx: [warn] conflicting server name "Exago" on 0.0.0.0:80
Then reload NGINX to refresh the configuration:
sudo nginx -s reload

Note
This article references <WebApp>/, <WebSvc>/ as a placeholder for the application's install location and the Web Service API's install
location, respectively. The default install locations are /opt/Exago/ and /opt/Exago/WebServiceApi; however, these directories
may be changed during installation.
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Start Listeners
The installer will create two new scripts which can be used either standalone or along with a service manager such as systemd.
Note
The exago-fcgi portion of each service name can be configured from the defaults below with the -f parameter in silent installation or by
providing an answer to the Enter the base fastcgi service name question during guided installation.
<WebApp>/exago-fcgi-webapp.sh
<WebSvc>/exago-fcgi-webservice.sh
When not using a service manager, each of these scripts can be run with either the start, stop and restart directives. For example,
<WebApp>/bin/exago-fcgi-webapp.sh start will start the Web Application's FastCGI listener. <WebSvc>/bin/exago-fcgiwebservice.sh restart will restart the Web Service API's FastCGI listener.
When using systemd, the commands take the following form:
service exago-fcgi-webapp start
service exago-fcgi-webservice stop

Content Storage Configuration
The Config sub-folder of the Exago installation has read and write permissions set by default.
Create a folder for storing reports. This folder needs to be accessible from the web server, but is not required to be on the web server. The
report folder can reside on any server accessible by Exago, provided a mount point is accessible on the Exago server.
Important
Do not create the reports folder within the Exago application structure. This can cause sessions to crash when report folders are created
or deleted within Exago.
1. Set the Report folder's read and write permissions to 770.
sudo chmod 770 Reports

2. In the Admin Console, specify the location of the report folder in General > Main Settings > Report Path
Note
The group ownership on the reports directory is not mandatory, and can be changed to have other group ownership as needed for access
outside of Exago.
Default UMASK for files written by Exago is 027.
The recommended path for the Temp folder is /opt/Exago/Temp.
1. In the Admin Console, specify the location of the temp Folder in General > Main Settings > Temp Path
Note
If using a custom Application Theme, the ApplicationThemes folder will also need the same permsissions.
Installation of Exago is now completed. If the Scheduler Service or Monitoring Service is required, continue to the Scheduler and Monitoring
Services section at the end of this article.
If all components are installed, the Installer directory may be deleted.

Scheduler and Monitoring Services
Scheduler Service
A script named exago-scheduler.sh by default is used to manage the Scheduler Service. The name is customizable with the
installer's -r parameter.

Installed as a systemd Service
When utilizing a systemd service, the Scheduler Service should start automatically when the system boots, and can be managed with the
service command in the following ways:
service exago-scheduler start
service exago-scheduler stop
service exago-scheduler status
When a second scheduler is installed on the same server, the default service name will increment: exago-scheduler2, exagoscheduler3, and so on.

Not Installed as a systemd Service
When the Scheduler Service is not installed as a systemd service (without the -R parameter), it is not possible to know if another service
with the same name exists on the same server. When a service with the same name is installed, only one can be used at a time. This is
due to the fact that lock files used by the service are based on the service's name, and will prevent the second process from starting. In
this scenario, the -r flag should be used and additional schedulers be given different names.
To start the Scheduler Service, execute the exago-scheduler.sh script as the owner of the installation directory (either root prev2019.2.21 or the user name specified with the -u parameter, exago by default in v2019.2.21+). For example:
In v2019.2.21+, assuming the Scheduler Service is installed in /opt/Exago/Scheduler/:
su exago
/opt/Exago/Scheduler/exago-scheduler.sh start
exit
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See Scheduler Configuration and Setting Up Monitoring to configure the respective services correctly. If necessary, configure the
Scheduler and Monitoring services to run at startup.

Start Monitoring Service
Note
This article references <WebApp>/ as a placeholder for the application's install location. The default install location is /opt/Exago/;
however, this directory may be changed during installation.
If the Web Application was installed, the Monitoring Service is also installed, but is disabled by default. This script created during
installation needs to be started manually or configured to run at startup:
<WebApp>/MonitoringService/startService.sh

Default Values
The -D parameter was added to the Linux installer in v2019.2.1. This parameter will select the default values for each parameter unless
already specified on the command line. These values are:
defined in the exagoinstall.properties file in the Exago installation directory if Exago has already been installed, or
if Exago has never been installed or is being installed in a new directory for the first time, defined below:
Exago Installation Path: /opt/Exago
Components to install: Web Application, Monitoring Service, Web Service API, Scheduler Service
Install Mono runtime: Yes
User ID: exago
Scheduler information
Scheduler install path: /opt/Exago/Scheduler
Scheduler service name: exago-scheduler
Scheduler user ID: exago
Configure systemd service: Yes
Web Server information
Selected Web Server: Apache (will use Apache if both NGINX and Apache are available; will use NGINX if only
NGINX is available)
Web Application install path: /opt/Exago
Web App alias: /Exago
Web App user ID: exago for NGINX. For Apache, the default is system dependent and will be read from either
apache.conf or httpd.conf depending on which one is in use.
(NGINX only) NGINX conf file: /etc/nginx/conf.d/exago.conf
(Apache only) Apache conf file: /etc/httpd/conf.d/exago.conf
Web Service install path: /opt/Exago/WebServiceApi
Web Service alias: /ExagoWebApi
Web Service user ID: apache for Apache, exago for NGINX
(NGINX only) Use system for service(s): Yes
(NGINX only) Web App Service Name/Port: exago-fcgi-webapp / 9000
(NGINX only) Web API Service Name/Port: exago-fcgi-webservice / 9001
Tip
For a completely headless installation with all of the default values, pass the -D and -y parameters. -D will not start the installation on
it's own, only select the default values for each parameter.
Once Exago is installed, the settings chosen during installation become the defaults and are written in to the aforementioned
exagoinstall.properties file in the Exago installation directory.

Upgrading Mono v2019.2.29+ v2020.1.13+ v2021.1.1
The upgradeMono script included with the installer can be used to upgrade from one supported version of mono to another. The script will
remove the installed version and then install the new version in its place, along with the apache mod_mono module and fastcgi module as
applicable.
If the system does not meet the minimum requirements for any of the components, it will upgrade only the installed components but will
not install anything additional.
1. Download, uncompress the Linux installer and change to the Installer directory as described in steps 1–3 of Installation with
Apache or Installation with NGINX above.
2. Call the script as root. The command line parameters described below are optional. If no parameters are provided, the script will
prompt for answers to certain questions.
Usage:
sudo ./upgradeMono.sh [-f] [-s] [-y] [-a] [-h]

Parameter
Description
-f
Force a reinstall, even if the version currently installed is at the recommended version
-s

Skip the reinstall if the version currently installed is already the recommended
version

-y

Don't prompt before starting the upgrade, silently install

-a

Upgrade everything despite what is currently installed

-h

Show command line parameter help screen
***********************************
Upgrade summary:
Upgrade Mono:
TRUE
Upgrade Mod Mono:
TRUE
Upgrade Mono FastCGI: FALSE
***********************************
Would you like to continue with this upgrade? (Y or N) [Y]

An example summary for a system with Apache. Pressing Y or Enter on the keyboard will start the upgrade process

Dependencies
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The Exago installer handles the installation and configuration of all of its own dependencies. Installing and configuring dependencies ahead
of time is not required, and in some cases could lead to unexpected issues with the Exago deployment. This list is provided as a reference
only. In most cases, Exago utilizes the most up to date versions available through the operating system's package manager (i.e. apt, yum,
zypper).
The Exago installer will display error messages if certain dependencies are not, cannot be or are not correctly installed.
Note
Not all of the packages listed below are installed for every operating system and situation.
Installer requirements — for downloading files, adding repositories and installing GPG keys
curl
unzip
wget
yum-utils — only required on distributions that utilize the yum package manager
Base .NET runtime — requirements for all Exago components
mono-4.0-service
mono-complete
Datetime function support
mono-vbnc — used on Ubuntu and Debian only
mono-basic — used on Red Hat Enterprise Linux, CentOS, Fedora and SUSE Linux Enterprise Server
Export support
Any font package such as liberation fonts or croscore fonts (chromium installed fonts will also work)
Apache web server support
apache2-mod_mono (libapache2-mod-mono)
mono-apache-server
Puppeteer — support for headless chart rendering in exported files
alsa-lib
atk
chromium
cups-libs
gconf2
gtk3
libasound2
libatk-bridge2.0-0
libgtk-3-0
libnss3
libx11-xcb1
libxcomposite
libxcursor
libxdamage
libxi
libxscrnsaver
libxrandr
libxtst6
libxss1
nss
pango
xorg-x11-fonts-75dpi
xorg-x11-fonts-100dpi
xorg-x11-fonts-cyrillic
xorg-x11-fonts-Type1
xorg-x11-fonts-misc
xorg-x11-utils
NGINX web server support
mono-xsp4
xsp
mono-fastcgi-server4

Installing Exago on Azure
Microsoft Azure is a cloud infrastructure for hosting files, databases, virtual machines, and web applications. Exago supports various forms
of integration with Azure.
Virtual Machine — Exago can be installed on a Windows virtual machine on Azure.
App Service — The Exago Web Application, REST Web Service API and .NET API host apps can be installed as Azure app
services. An Azure Virtual Machine is also required for remote report execution when utilizing an Azure App Service.
File Storage — Exago data can be stored and accessed from Azure storage containers.
These methods can be implemented independent of each other. However, Web App integration and VM integration are usually redundant
with each other, and most Web App solutions should also implement Azure file storage. This guide will walk through how to set up each of
these solutions.

Which solution should I use?
Azure virtual machines are the preferred implementation method for production environments. App Services should only be used for testing
and demonstration—not in production.

App Service
Caution
Deploying the Exago Web Application in an Azure App Service also requires a separate Azure Virtual Machine and the Exago Scheduler
Service for handling chart and map rendering. Consider using an Azure Virtual Machine for the entire deployment instead. See
Configuring Remote Report Execution Host for Azure App Service Deployments for more information.
The following Azure resources are required:
App Service plan
App Service
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Note
You may require a Storage Account to run Exago as a scalable app. See File Storage for details.
This section is divided into three parts:
Hosting Exago BI in an App Service
Using Exago Web Service API in an App Service
Using the .NET API with Azure

Hosting Exago BI in an App Service
Note
This walk-through requires a local Exago installation. See the Exago Installation Guide for details.
1. In your Azure Dashboard, create a new App Service container or navigate to an existing one.

2. In the App Service, navigate to Deployment Credentials. Add a username and password. This will allow you to FTP into your app
service to transfer files.
3. Next, you'll need an FTP application. Open a connection using the deployment credentials created in step 2. Copy your local Exago
BI web app installation directory to the app service container.

4. In the App Service, navigate to Application Settings. Set the following:
.NET Framework version: v4.0 or Later
Managed Pipeline Version: Integrated
5. Under Virtual applications and directories create a virtual directory path to the installation directory and check
the Application check box.

6. Click Save to save your settings.
7. Configure the Remote Report Execution Host as a Virtual Machine.
8. Test your installation and by navigating to the WebAppUrl\virtual path to Exago App Service\Admin.aspx page (Admin Console).
If you will use Azure Blob Storage to store the config file, follow the File Storage instructions before setting the base config. We also
recommend setting up a state server either with SQL Server or another database when running Exago in an Azure App Service. Review the
Setting Up a State Server article or the Exago Support Team for assistance.

Using Exago Web Service API in an App Service
Note
This walkthrough requires either a local Exago Web Service API installation, or a downloadable ZIP file containing the WebServiceApi
directory. See the Installing and Configuring the Web Service article for details.
1. Copy the contents of the local Exago installation's WebServiceApi folder to the app service container.
2. Under Virtual applications and directories create a virtual directory path to the WebServiceApi directory and check
the Application check box.
3. Click Save to save your settings.
4. In Azure, edit the WebServiceApi\Config\WebReportsApi.xml file as follows:
<apppath>virtual path to Exago App Service</apppath>
<webreportsbaseurl>virtual path to Exago App Service</webreportsbaseurl>

Note
Include a trailing slash for both the apppath and webreportsbaseurl elements.
5. In the WebServiceApi\appSettings.config file, add a new key to enable the REST service.
<appSettings><add key="ExagoREST" value="TRUE" /></appSettings>

The result should be the following:
<?xml version="1.0"?>
<appSettings>
<add key="ExagoREST" value="True" />
</appSettings>

6. To prevent front end access without authentication outside of the API, in the Admin Console, navigate to General > Main
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Settings > set Allow direct access to Exago (bypassing API) to False. Click OK. Test your installation by navigating to the
WebAppUrl\Exago\Api.aspx page. An 'Unauthorized access. Please contact your administrator' error message should appear.
7. To test that the path was set correctly, navigate to WebAppUrl\virtual_path_to_Exago_App_Service\Api.aspx. A test file listing
avaiable supported operations in the API should appear.
8. To prevent unauthorizedAdmin Console access to prevent users from inadvertently reaching it, delete
WebAppUrl\Exago\Admin.aspx and WebAppUrl\Exago\Bin\admin.aspx.cdcab7d2.compiled.
Tip
Make a backup of the files before deletion in case Admin Console may be needed later.
9. Test that Admin Console is no longer accessible by navigating to WebAppUrl\Exago\Admin.aspx. A 404 error page should appear.
10. Test that REST is enabled by utilizing an advanced REST client such as Advanced REST Client. Make a POST request to
WebAppUrl\virtual_path_to_Exago_App_Service\rest\rest\sessions.
Header Name
Header Value
Accept
application/json
Content-Type application/json
Authorization The REST authorization key. Review the Introduction to REST article for more information.
Copy the AppUrl received in the response and append it to the end of the browser's URL WebAppUrl\virtual path to Exago App
Service\ The Exago front end should load, proving that the application can only be reached through the API.
11. Configure the Remote Report Execution Host as a Virtual Machine.

Using the .NET API with Azure
Exago .NET API based host applications must be compiled locally before being uploaded to the Azure app container. References to the
WebReports.dll library should be updated manually, and the program recompiled, when upgrading to a new Exago version.
Set your API constructor to use the previously set Exago virtual path:
Api api = new Api(@"/exago/virtual/path");

Important
.NET host apps can only access virtual paths (and not URL paths). Therefore they must be located in the same App Service container as
the Exago web app.
Exago utilizes the virtual directory passed in the first argument of this constructor to locate the required .dll libraries to load Exago. In
cases where the virtual directory is not specified within the API constructor (e.g., if Exago is installed on the root of the .NET host
application), then a reference to the Microsoft.WindowsAzure.Storage.dll library will need to be added manually to the host
application.

File Storage
Exago can be integrated with Azure cloud storage for storage and live access to reports, templates, config, and other data files.
The following Azure resources are required:
Storage account
Blob storage
The following Azure resource is optional:
Files storage
Important
The Web Application, Scheduler Service, Web Service API and any cloud storage mechanisms must share at least one security
protocol in common otherwise they will not be able to communicate with each other. For more information, refer to the Application
Settings article.
Blob storage is a "flat" file system, which stores every file at the root level. To make use of this system, Exago emulates a directory
structure using file names. Standard and premium blockblobstorage accounts are supported with Exago.
File storage is a directory-based system. Files are placed into directories, which can have sub-directories.
For pre-v2021.1, reports can be stored in File storage or Blob storage. Config files, templates, themes, and temp files must be stored in
blob storage. For v2020.1+, only config files and temp files are stored locally. Reports, templates and themes are stored in a Storage
Management database.
In your Azure Dashboard, begin by creating a new Storage account or navigating to an existing one.

This section is divided into three parts: Config file storage, Reports storage, and Temporary files storage (which includes themes and
templates). If you are implementing Exago as a scalable app, you must set all three to static locations.

Config File
An Exago installation contains a configuration file, usually called WebReports.xml, which tells the application where to store Reports and
Temp files.
First, in the Storage account, navigate to Access Keys. Record the two connection strings.

Azure Connection String
An Azure Connection String is a formatted string which contains your Azure account name and a unique alphanumeric key. It is used to
give applications access to your storage account. The string uses the following format:
DefaultEndpointsProtocol=https;AccountName=acctName;AccountKey=encryptedalphanumerickey;
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Next, there are two places which you need to specify the location of the configuration file:
1. The appSettings.config file in the web app install directory.
2. If you're using the .NET API, a parameter in the API constructor method.

appSettings.config
Exago BI contains a file called appSettings.config in the root folder of the install directory. This file is used for custom app settings which
are automatically imported into Web.config during runtime.
This file may also be used to specify other important environmental conditions, such as security protocols and input sanitation rules. More
information about all available settings can be found in the Application Settings article.
Note
Do not edit Web.config file. It is automatically generated by Exago, and any changes will be overridden.
To set the config file location, add the following key to the appSettings.config file:
Important
The connection strings used for report, configuration file and temporary file storage must be unique.

<add key="ExagoConfigPath" value="pathtype=azure;credentials='Azure Connection String';storagekey=config"/>

credentials: Your Azure Credentials Connection String.
storagekey: The prefix of a blob container used to store the config file.
Caution
When both the REST Web Service API and cloud config storage are being used, the ExagoConfigPath node must be included in both
the REST Web Service API and Web Application appSettings.config files.

API
.NET API host apps cannot access the appSettings.config file. Instead, use one of the following two methods to specify a config file
location:
1. Place the config key within the host application's web.config or app.config.
2. Or pass the connection string in the API constructor method:
Api api = new Api("/exago/virtual/path", "configFn.xml", "pathtype=azure;credentials='Azure Connection String';storagekey=config");

storagekey: The prefix of the blob container used to store the config file.
configFn: The name of the config file.
Caution
When both the REST Web Service API and cloud config storage are being used, the ExagoConfigPath node must be included in both
the REST Web Service API and Web Application appSettings.config files.

Reports Storage
To use an Azure storage resource for report and folder management, enter a formatted connection string in the Report Path field in your
config file.

Important
The connection strings used for report, configuration file and temporary file storage must be unique.
The connection string uses the following format:
pathtype=azure;credentials='Azure Connection String';storagekey='reports';usefilestorage=false

credentials: Your Azure Connection String.
storagekey: The prefix of the container used to store report files. Reports are stored in "storagekey-reports", templates in
"storagekey-templates", and themes in "storagekey-themes". This key is optional and defaults to "wrreports".
usefilestorage: If true, Reports are stored in File storage. If false, Blob storage is used. Templates and themes always use blob
storage. This key is optional and defaults to false.
Note
Templates are automatically stored in blobs when the template upload button is used in Exago. Themes need to be manually uploaded
to blob storage.

Migrating from local storage to Azure blob storage
Exago emulates a directory structure within a "flat" file system like Azure blob storage by placing a "placeholder.dir" block blob in each
directory. This directory file serves as a reference to a folder within the blob container and is automatically added to new folders when the
Report Path is set to an Azure blob storage container. If this file is not present, Exago will not be able to recognize that the virtual directory
exists within a blob.
When migrating from local storage to Azure blob storage, this file will need to be manually added to pre-existing report folders as it will not
exist in folders that were created when the report path was set to a local directory. In order to manually add this file to these folders,
please follow these steps after the Report Path is set to an Azure blob storage container:
1. In Exago, add a new folder to the Report Tree.
2. With the Azure Storage Explorer, navigate to this folder.
3. Copy the "placeholder.dir" blob within this folder and paste it into folders where it does not already exist.

Temporary Files Storage
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Azure allows an App Service to be scaled up to multiple instances on separate servers. When implementing this configuration, take the
following safeguards in order to prevent loss of user data.
Each instance of Exago BI has its own local temp directory, whose path can (optionally) be specified in the Temp Path setting in the
config file (defaults to %INSTALLDIR%\Temp).

In a scalable configuration, initial user calls will reach one instance, storing temp files on that server, but subsequent calls may reach a
separate instance, which will not have those temp files in its local directory. There are two solutions to resolve this issue:
Temp Cloud Service
Azure Affinity Cookie

Temp Cloud Service
This is Exago's built-in solution for handling multiple instances. Specifying a Temp Cloud Service causes each instance to push its
temporary files to a shared Blob container. Then if a subsequent user call reaches a separate instance, that instance will pull the relevant
files from the Blob to its local temp directory. Temp files may only be stored in blob storage.
To set up an Azure storage resource for temporary files:
1. Create a container for temporary files with the Azure Storage Explorer. The default container name is wrtemp but any container
name, except for those used for report or configuration storage may be used by providing a storagekey in the connection string in
step 2.
2. Set the Admin Console > General > Main Settings > Temp Cloud Service to a formatted connection string.
Important
The connection strings used for report, configuration file and temporary file storage must be unique.
The connection string uses the following format:
pathtype=azure;credentials='Azure Connection String';

to save temporary files to the default blob container named wrtemp or
pathtype=azure;credentials='Azure Connection String';storagekey=tempFileStorageKey

to save temporary files to a blob container named tempFileStorageKey.
Examples:
type=azure;credentials='DefaultEndpointsProtocol=https;AccountName=acctName;AccountKey=encryptedalphanumeric';

Store temporary files in the default wrtemp blob container
type=azure;credentials='DefaultEndpointsProtocol=https;AccountName=acctName;AccountKey=encryptedalphanumeric';storagekey=ourExagoTempFiles;

Store temporary files in a blob container named ourExagoTempFiles

Azure Affinity Cookie
Azure supports setting Affinity Cookies, which track which server instance each user is connected to and cause all calls within the
session to reach the same instance.
In your app service, navigate to Application Settings. Set ARR Affinity to On.

Virtual Machine
Exago can be hosted on a Windows-based Azure Virtual Machine. Installing Exago on a VM differs only marginally from installing it on a
local machine. Therefore, this guide will not go into depth on this method. For a full installation and setup guide, see the Exago
Installation Guide.
You can interact with a VM using either a remote desktop application or a command shell application.

Remote Desktop
1.
2.
3.
4.

Using Remote Desktop Connection or another remote desktop application, view your VM as a desktop environment.
Use a Web Browser to download the Exago Installer from our support site.
Run the installer as Administrator and install Exago.
Configure Exago (see Install and Configure).

Command Shell
1.
2.
3.
4.

On a local machine, use the above steps 2-4 to create a temporary Exago installation.
Remote into your VM using Windows PowerShell or another command shell application.
Copy the Exago directory to a directory on your VM.
Configure Windows and IIS (see Manual Application Installation).

After configuring IIS, open up the Exago port using a Windows Firewall inbound exception rule. You can then access Exago through the
VM's IP address. Set up DNS and data security as desired.

Configuring Remote Report Execution Host for Azure App Service
Deployments
When Exago is deployed as an Azure App Service, some additional configuration is necessary. At a high level, these configuration steps
are:
1. The Exago Scheduler Service must be installed and properly configured on an Azure Virtual Machine. Exago v2019.1.5+ must be
installed for both the Azure App Service and the Virtual Machine, and the version numbers must be the same.
2. On the Azure App Service installation, enable the Scheduler and Remote Execution.
3. Enable Exago's Puppeteer image rendering libraries on the Azure Virtual Machine (for versions pre-v2020.1).
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Detailed information about each of these requirements follows.

1. Azure Virtual Machine
Exago's Puppeteer image rendering libraries were introduced in v2019.1.5 of the application. At a minimum, v2019.1.5 must be installed
on the Azure Virtual Machine. The version number of the Scheduler Service must match the version number of the Web Application.
Refer to the articles in the Recommended References section below for complete details on the installation and configuration of the
Scheduler Service and how to install Exago on a Virtual Machine in Azure.

Recommended References
Installing Exago on Azure
Updating to the Latest Version
Installing the Scheduler Service
Configuring the Scheduler Service

2. Settings
The Scheduler Service should already be properly installed and configured on the Azure Virtual Machine.
On the Exago installation running as an Azure App Service, there are four parameters in the Admin Console which direct it to schedule
and execute reports on the Virtual Machine instead of in the App Service:
General > Scheduler Settings > Enable Report Scheduling must be set to True. By default, the value is False.
General > Scheduler Settings > Enable Remote Report Execution must be set to True. By default, the value is False.
General > Scheduler Settings > Schedule Remoting Host must be set to the virtual machine Scheduler Service's protocol, host
name/IP address and port. (e.g. http://a.b.c.d:2000)
General > Scheduler Settings > Remote Execution Remoting Host must be set the same as Schedule Remoting Host
above.

Recommended References
Admin Console Scheduler Settings

3. Enable Puppeteer pre-2020.1
By default, Exago will use the older WkHtmlToImage libraries for visualization rendering. Therefore, Puppeteer must be manually
enabled by adding or changing a key in the virtual machine Scheduler Service's eWebReportsScheduler.exe.config file, as shown below:
<appSettings>
<add key="useWkHtmlToImage" value="false" />
</appSettings>

This file is located in the Scheduler Service's installation directory. For example,
D:\Exago\ExagoScheduler\eWebReportsScheduler.exe.config. The closing / in the new key is required.

Recommended References
Scheduler Apps Application Settings

Installing Optional Features
Several features require additional configuration before they can be used.

Legacy Maps (GeoCharts)
The GeoCharts feature present since v2013.2 has an additional requirement for use if you are enabling it for the first time, or if you are
implementing your application under a new domain name.
Our mapping features use the Google Maps API. Historically, this was a free solution. However, in June 2016, Google began to require
paid licenses for commercial usage.
If you had GeoCharts enabled prior to June 2016, and you have not since changed the domain name of your application, this section does
not affect you because you have been grandfathered in.
If you are a new user in need of mapping, we strongly suggest implementing the new Google Maps feature instead of legacy GeoCharts.
If you intend to implement GeoCharts under a new domain name, then you must acquire a Google Maps API License in order to use this
feature. See Google's Pricing & Plans page for details. Your license must include the Google Maps Javascript API.
Note
For help with API keys, see Google's API Console Help.
To install a legacy GeoCharts license file, place the license key in the General > Feature/UI Settings > Advanced Report Designer
Settings > GeoChart Map Key (optional) setting of the Admin Console.

Google Maps
Important
Exago's Google Maps wizard uses the Google Maps API, which requires a paid license for commercial use. You must acquire a Google
Maps API license in order to enable this feature.
There are additional steps needed in order to enable the new Google Maps wizard introduced in v2016.3.
1. Download and install the Google Maps Polygon Database for free from our support site.
2. Create a new directory inside Exago's installation path named MapCache and extracted the polygon database into it.
3. If Remote Execution is in use, the polygon database must also be extracted into a mapCache folder inside of each Scheduler
Service's /bin directory.
4. Give the web server full permissions to read the mapCache directory.
For Windows:
1. Right click on the folder and click Properties.
2. In the security tab click Edit then Add.
3. Enter iis_iusrs then click OK.
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4. In the Permissions for Config window, select the IIS_IUSRS that was just created and check Allow Full Control. Click
OK.
For Linux:
1. chown $apacheUserID MapCache
2. chmod -R u+wr MapCache
Exago's Google Maps wizard uses the Google Maps API, which requires a paid license for commercial use. You must acquire a
Google Maps API license in order to enable this feature. Please see the the Maps and Places > Geocoding sections of the
Google Maps Pricing Table for details. You must obtain a Google Maps Javascript API key and a Google Maps Geocoding
API key, either as part of the same license, or separate.
Note
Licensing fees are subject to change by Google.
Note
For help with API keys, see Google API Console Help.
To install the license file:
1. Toggle General > Feature/UI Settings > Advanced Report Designer Settings > Show Google Maps Wizard in the
Admin Console to True.
2. Place your unlimited license key or Google Maps JavaScript API key in the Admin Console: General > Feature/UI
Settings > Advanced Report Designer Settings > Google Map Key (unlimited or JS API restricted).
3. If you used a Google Maps JavaScript API limited key in the previous setting, place your Google Maps Geocoding API key in
General > Feature/UI Settings > Advanced Report Designer Settings > Google Map Key (optional Geocode API
restricted).

Installing and Configuring the REST Web Service API
This content has been moved to REST — Getting Started.

Installing the Scheduler Service
Important
The version and build number of the Scheduler Service must match that of the Web Application. Due to this requirements, Scheduler
Service's must run on the same operating system as their corresponding Web Application servers.
You may have different installations of Exago with different versions/builds on separate servers. The Scheduler Service installation wizard
allows you to install multiple Schedulers to maintain corresponding version/builds with the Web Application.
Use the following steps to install the Scheduler Service:
1. Download the latest Windows or Linux installers.
2. Make sure your antivirus is software disabled and run the installation wizard as an Administrator.

For Windows
1.
2.
3.
4.
5.
6.
7.

Click the Scheduler button.
Click Next to bring up the ‘Select Installation Location’ menu.
Specify if you want to create a new service or if you want to update an existing one.
To create a new service set a name and location.
Select to who the Exago Scheduler Windows Service will be installed. By default, “Everyone” is selected. Click Next.
Confirm your location selections by clicking Next
Monitor the installation and click Finish when it is complete.

Note
As of v2016.2.12, schedulers take system resources into account when assigning remote execution jobs. This requires that the services
have read access to the system registry. This can be done by adding the services to the Performance Monitor Users group. See How
to Read Performance Counters Without Administrator Privileges (MSDN) for details.

For Linux
If you elect to install the Scheduler Service, the installer will create the sub directory "Scheduler" in your previously specified install path.
Follow the instructions in the Installing Exago on Linux article to install the Service. To configure the Service, continue to the Scheduler
Configuration article.

Saving Scheduled Reports to a Repository
The contents of this article have been moved to Scheduler Service Configuration.

Installation Troubleshooting
This content has been moved to Error Message Glossary.

Administration Console Setup
Configuring the database metadata can be done within the Exago Admin Console. These bullets detail the terms used in Exago that are
consistently referred to in both the guides and the application.
Data Source refers to a database or similar programmable file which provides data to the application.
Tables, views, functions, and procedures are stored as Data Objects (also called Entities) within Exago which can then be
connected using Joins.
Exago can automatically discover metadata from most traditional data sources

Data Sources
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Add a data source by entering the Admin Console
http://<YourServer>/Exago/Admin.aspx

See the Data Sources article for instructions on how to add a data source to your installation.

Building Metadata
Multiple Data Objects and joins can be created at once via Exago’s Automatic Database Discovery tool.
See the Data Objects article for instructions on how to create Data Objects from a Data Source and how to use the Automatic Database
Discovery tool.

Verifying the Report Path pre-v2020.1
1. In the Main Menu open the General drop-down and double click Main Settings. The first parameter in Main Settings is the Report
Path.
2. Make sure that the Report Path is pointing to the folder where read/write permissions were set earlier.
3. Check this connection by clicking the Test Connection icon.

Admin Console Password Encryption
Beginning with v2017.3, the Admin Console password is now encrypted by default when entered into the Admin Console or when set
through an API call. This is done to increase the security of credential storage by preventing plain text passwords from being saved to disk
in the unencrypted version of the configuration file.
Caution
If updating from an older version, existing passwords will not be encrypted automatically.
There are two ways to set an encrypted Admin Console password: Using the Admin Console or the API.

Using the Admin Console
1. Browse to the Admin Console
2. Navigate to General > Other Settings.
3. Enter the desired password into the Password and Confirm Password fields

4. Click Apply or Okay
To verify that the configuration contains the encrypted password, open the XML config file in a text or XML editor and locate the
<password> node.

The value should be an encrypted string surrounded by brackets [ ].

Using the API
To add an encrypted password to a programmatically generated config file:
api.General.Password = api.General.EncryptPassword("mypassword");
api.SaveConfigToFile(); // Save the configuration file to disk

To verify whether two passwords match:
bool IsMatch = api.General.CheckPassword("mypassword", api.General.Password);

To verify if an existing password is encrypted:
bool IsEncrypted = api.General.IsHashedPassword(api.General.Password);

Additional information
Password encryption is one-way. An encrypted password cannot be decrypted into plain text.
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The encryption algorithm used is SHA-256. Passwords are salted.
Important
We still recommend that the plain text config file (e.g. WebReports.xml) is removed in favor of the encrypted config file (e.g.
WebReports.xml.enc) in a production environment. See Security Checklist for more information.

Scheduler Service Configuration
To configure the Scheduler Service, edit the file eWebReportsScheduler.xml. This file can be found in the Scheduler Service's
installation directory. By default, this is C:\Program Files\Exago\ExagoScheduler on Windows and /opt/Exago/Scheduler
on Linux.
The following settings are available:
Important
Settings that can be true or false are case sensitive and must use lower case.
<smtp_server> — The SMTP server used by the Scheduler Service to email reports.
<smtp_enable_ssl> — Set to true to enable SSL.
<smtp_user_id> — The user id that is used to login into the SMTP server.
Note
If the user id is set to a null or empty value or DefaultCredentials, the value automatically defaults to the user's current credentials. For
anonymous emailing see the Credential-less SMTP section below.
<smtp_password> — The password that is used to login into the SMTP server. This value is only considered when using the user id as
an SSL credential.
Note
If the password is set to a null or empty value, the value automatically defaults to the user's current credentials.
<smtp_from> — The 'From' email address used in the report emails.
<smtp_from_name> — The 'From' name used in the report emails.
<error_report_to> — The email address to send error reports to.
<channel_type> — tcp or http — must match the setting of the Remote Host in the Admin Console Scheduler Settings.
<port> — The port number of the .NET remoting object used to communicate with Exago; this should also be entered in the Admin
Console Scheduler Settings.
<working_directory> — The directory where scheduled documents and temporary files are written. The default setting
[INSTALLDIR]working creates a working folder in the Scheduler Service's installation location.
<default_job_timeout> pre-v2019.2.31 pre-v2020.1.14 pre-v2021.1.2 — The maximum number of seconds any report execution is
allowed. If an execution reaches a maximum number of seconds, the job is marked Abended and an email will be sent to the address
specified under <error_report_to>. Email jobs use default_job_timeout exclusively for timing out the connection to the SMTP server.
For v2019.2.31+, v2020.1.14+ and v2020.1.2+, this value is ignored. Use smtp_timeout to limit SMTP connection time and
max_job_execution_minutes exclusively.
Important
<default_job_timeout> and <max_job_execution_minutes> work in conjunction. They should both be set to the same time
period. Note that <default_job_timeout> is set in seconds and <max_job_execution_minutes> is set in minutes.
<smtp_timeout> v2019.2.31+ v2020.1.14+ v2021.1.2+ — limit connection time to the SMTP server in seconds. The default is 30.
<report_path> — A path to specify where to save reports when 'Email Scheduled Reports' is set to false in the Admin Console. For
more details see Saving Scheduled Reports to External Repository below.
<sleep_time> — The time interval (in seconds) used for polling for scheduled reports to execute.
<simultaneous_job_max> — The maximum number of report executions that can occur simultaneously. This setting is based on the
resources available of the server where the Scheduler Service is installed.
<logging> — Logging is on by default. To turn logging off, set to OFF (in all-caps). To configure logging, edit the Logging Settings in
the eWebReportsScheduler.exe.config file.
<flush_time> — The number of hours that a completed, deleted, aborted or abended (v2021.1.6+) job will be saved for viewing in the
Schedule Manager. Set to 0 to flush jobs immediately upon completion. Set to -1 to disable automatic flushing only at the direction
of an Exago Support Analyst. Flushing should be done automatically at all other times. The default value is 24 in v2021.1.9+.
<sync_flush_time> — The number of hours that a completed, deleted, or aborted Remote Execution job will be saved in the Scheduler
Service's job list. Set to 0 to flush jobs immediately upon completion (default). Set to -1 to disable automatic flushing only at the direction
of an Exago Support Analyst. Flushing should be done automatically at all other times.
Note
Synchronous jobs are never displayed in the

Schedule Manager, even if this value is greater than 0.

<email_addendum> — Text that will be added at the end of email body. Use \n to insert lines.
<external_interface> — Overrides the Admin Console's setting for the External Interface, a deprecated extensibility feature that
should not be used for new installations.
<abend_upon_report_error> — This controls how the scheduling service should proceed if an error occurs while loading or executing
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a report. The default true will stop the running the schedule and set the status to Abended. Set to false to continue running the
schedule and maintain the status as 'Ready'.
<ip_address> — Binding IP address for the Scheduler Service. Most commonly used when the server has multiple Network Interface
Cards (NICs).
<encrypt_schedule_files> — Set to true to encrypt the files created by the Scheduler Service. All existing schedules will be
encrypted the next time the service is started.
<max_temp_file_age> — The number of minutes between each flush of the temp files created by the scheduling service. The default is
1440 minutes (24 hours).
Note
Setting <max_temp_file_age> too low may result in errors as temp files are used during report execution and for interactive HTML
capabilities when using remote execution. It is not recommended setting this value any lower than 60 minutes. Execution cache files will
not be flushed.
<email_retry_time> — In the case an email fails to send, the number of minutes to wait before retrying to send the email. After five
failed attempts the schedule will set itself to 'Aborted'. The default is 10 minutes.
<max_job_execution_minutes> (v2016.2.12+) — Maximum amount of time (in minutes) to run an execution job before timing out. If
the job times out, the schedule will be marked as Aborted.
Note pre-v2019.2.31 pre-v2020.1.14 pre-v2021.1.2
<default_job_timeout> and <max_job_execution_minutes> work in conjunction. They should both be set to the same time
period. Note that <default_job_timeout> is set in seconds and <max_job_execution_minutes>is set in minutes.
For v2019.2.31+, v2020.1.14+ and v2020.1.2+, <default_job_timeout> is no longer applicable.
<secure_channel> (v2016.3+) — Set to true to allow receipt of encrypted data from hosts. The setting Use Secure Scheduler
Remoting Channel must be true in the Admin Console/XML configuration file.
<security_protocol> (v2016.3.4+) — Specify which security protocol(s) the scheduler should use. Possible values: Ssl3, Tls,
Tls11, Tls12, Tls13 (.NET v4.6+). Separate multiple values with commas (,).
<service_name_tag>— For manual installation of Scheduler Services using Visual Studio installutil.exe, this field is appended to the
end of the service name. Useful for installing multiple services on the same server. installutil.exe must be in the same folder as the
scheduler configuration file.
<webappbaseurl> — Set to the virtual directory URL where the Exago BI Web Application is installed. In Cross-Origin Resource
Sharing (CORS) environments, setting this flag ensures that images are correctly loaded.
<load_assembly_in_external_domain> (v2018.1+) — Set to True to load Assembly Data Sources in an external domain, as
opposed to the application domain. When True, this feature also should be enabled in the Web Application's appSettings.config and
and the Scheduler Service's eWebReportsScheduler.exe.config files.

Example XML File
<?xml version="1.0" encoding="utf-8" ?>
<eWebReportScheduler>
<smtp_server>smtp.office365.com:587</smtp_server>
<smtp_enable_ssl>true</smtp_enable_ssl>
<smtp_user_id>me@mycompany.com</smtp_user_id>
<smtp_password>notmypassword#1234</smtp_password>
<smtp_from>me@mycompany.com</smtp_from>
<smtp_from_name>Exago Scheduler</smtp_from_name>
<error_report_to>admin@mycompany.com</error_report_to>
<channel_type>tcp</channel_type>
<port>2011</port>
<working_directory>[INSTALLDIR]working</working_directory>
<default_job_timeout>3600</default_job_timeout>
<sleep_time>15</sleep_time>
<simultaneous_job_max>10</simultaneous_job_max>
<logging>on</logging>
<flush_time>-1</flush_time>
<sync_flush_time>0</sync_flush_time>
<email_addendum></email_addendum>
<external_interface></external_interface>
<report_path>[INSTALLDIR]</report_path>
<abend_upon_report_error>true</abend_upon_report_error>
<ip_address></ip_address>
<security_protocol></security_protocol>
<encrypt_schedule_files></encrypt_schedule_files>
<max_temp_file_age>1440</max_temp_file_age>
<email_retry_time>10</email_retry_time>
<queue_service></queue_service>
<load_assembly_in_external_domain>false</load_assembly_in_external_domain>
</eWebReportScheduler>

Starting and Changing Scheduler Services
The Windows Service will have to be manually started for new installations of the Scheduler. Starting the service will create the working
directory as set in <working_directory> described above.
To start the scheduler open Windows Services. Double click on 'ExagoScheduler' and the Properties menu will appear. Click Start.
If any changes are made to the configuration (detailed above) the service must be stopped and restarted for the changes to take effect.
For starting and stopping Scheduler Services on Linux servers, refer to the Scheduler and Monitoring Services section of the Installing
Exago on Linux article.

Credential-less SMTP v2018.1+
The values for <smtp_user_id>, <smtp_password>, <smtp_from>, and <smtp_from_name> cannot be removed or left blank.
Otherwise, these values will be reset to their default or throw an error when attempting to send an email.
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To set up anonymous report emailing:
Set <smtp_user_id> to NoSmtpCredentials
Set <smtp_password> to any non-null value

Saving Scheduled Reports to a Repository
Instead of sending report output as an e-mail, the output file can be saved to a file repository instead. To enable this:
1. Provide a Report Path in the Scheduler Service's configuration file. This is the location where the Scheduler Service will save the
report output files. Add the <report_path> element if it does not yet exist and set the location of the repository.
Note for pre-v2020.1:
This report path is the location of the scheduled report output archive, and should be different than Exago's Report Path
configuration setting.
2. In the Admin Console set

General >

Scheduler Settings > Email Scheduled Reports to False.

After applying these settings, generic scheduled reports (i.e. the schedule does not run as a batch) will be saved directly to the specified
repository rather than being sent via email.
If the General > Scheduler Settings > Show Schedule Delivery Type Options setting is True, users can select whether to save
a scheduled report to the specified repository or to send it via email.
Output files will be saved to the <report_path> directory with the filename based on the Scheduler Service's working file GUID with
_Download appended. For example, 855b5857-38ee-473f-8f2c-f3ce36393ef2_Download.pdf.

Server Events for Handling Scheduled Reports
The OnScheduledReportExecuteSuccess Server Event, if defined, is called after a scheduler executes a file, but before emailing it or
saving it to disk. This event can override Exago's default email or archival operations. For example, the file names could be changed to
better reflect their user and content, or files could be uploaded to an FTP server or other location.
For assistance with this Server Event, contact the Exago Services Team.

Scheduler Reply To Address
As of v2018.2, users can specify a "Reply To" address in the Schedule Wizard when scheduling a report.
The new setting, "Show 'Reply To' Field in the Scheduler 'Recipients' Tab", has been added to the Admin Console under Scheduler
Settings. This setting enables or disables the 'Reply To' field in the Recipients tab when creating or editing a scheduled report.

The "Reply To" Field shown in the Scheduler Wizard.

userEmail parameter
Along with this setting, there is a new parameter named userEmail. Currently, this parameter is used exclusively for the Scheduler Reply
To field. If there is a value placed in this parameter, that value will appear as the default value for the Reply To field when creating a new
scheduled report. If the field is desired to be blank for any new scheduled reports, this parameter must be left blank.
Note
The userEmail parameter cannot be deleted.
The "Reply To" field can be modified when creating a new schedule if the user does not want to use the default value of userEmail.
Changing the "Reply To" address here does not affect the value of userEmail.
When using the parameters userId and companyId to identify the user, it is recommended to modify the userEmail parameter based on
the userId and companyId. See User Identification for additional information.

Time Zone Calculation Enhancements in v2019.1
Geopolitical time zones present an inherent problem for scheduling and date calculations. Their UTC offset values may vary throughout the
year based on if and when a user's or server's location observes daylight saving time (DST). For example, a user in California and server in
England would enter and exit DST on different dates, necessitating different UTC offset values throughout the year. This displacement of
the UTC offset may cause schedules to run ahead or behind their intended times or even be ignored entirely.
With the release of v2019.1, Exago BI now offers an easy way to accurately handle different users and server spread across different
geopolitical time zones.

What Changed
In previous versions of Exago BI, the client and server time offset would be compensated for based on the a static setting called Server
Time Zone Offset, a specified number of +/- hours to calculate the difference in time between client and server. This setting, however, is
incapable of considering the fluctuation in server time offset caused by the non-uniform observations of DST in different geopolitical regions.
To better handle this is issue Exago now has a new setting called Client Time Zone Name which works in conjunction with Noda Time,
an advanced .NET library, to accurately consider geopolitical time zones through the year as schedules and calculations are done.

Client Time Zone Name
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To accurately handle time zones there is a new Culture Settings field called Client Time Zone Name where the user's geopolitical time
zone may be specified.
Note
Using Client Time Zone Name is highly recommended as a best practice. However, if Client Time Zone Name is not given a value
then Exago BI will fall back on its pre-v2019.1 behavior and use the Server Time Zone Offset setting. In general the Server Time Zone
Offset setting should only be provided if a Client Time Zone Name cannot be determined.

Adjusting the Client Time Zone Name
The Client Time Zone Name setting may be set in the following ways:
Within the Admin Console
Modifying the configuration file XML
Via the .NET and REST APIs

Admin Console
Within Culture Settings in the Admin Console, the default Client Time Zone Name can be specified. Setting a default value is
recommended if all or a majority of clients and users are located within the same geopolitical region. If clients and users are located in
many different regions, then a default is not required as this information should be set dynamically through the use of Roles or via the API.

The dropdown contains a complete list of official IANA time zones. Expressed as locations rather than as deltas from UTC, each time
zone in this list correlates to a specific geopolitical region and contains information on that region's observations of DST.

Configuration XML
The Client Time Zone Name can be manually edited within the configuration file XML using the following tag:
<clienttimezonename>America/New_York</clienttimezonename>

.NET and REST APIs
To modify this setting via the .NET API, the following property may be used:
PageInfo.SetupData.General.ClientTimeZoneName

This setting may also be modified via the REST API:
curl http://{webservice}/rest/settings?sid={sid} -X PATCH ^
-d "{
'General':
{
'ClientTimeZoneName': 'America/New_York'
}
}"

Noda Time Library
The standard .NET date and time library lacks important date/time concepts (e.g., "a date and time in a specific geopolitical time zone").
Due to the inherent issues that arise for scheduling processes because of DST and other non-linear time zone conflicts, Exago has
replaced this library with a more powerful date and time library: Noda Time, a .NET library specifically designed to resolve date and time
issues associated with geopolitical time zones and DST.
The Schedule module now utilizes the Instant and LocalDateTime classes of the Noda Time library. The Instant class represents a
global, linear time in seconds. It does not map onto any calendar system and does not consider DST. The LocalDateTime class
represents a point in time of a particular IANA time zone. These values can be mapped onto a calendar system and can take DST into
consideration. The system operates using Instants while users operate in the LocalDateTime of their legislative time zone of residence.
The Noda Time library is also available for use by developers via the .NET API. For in-depth information on the Noda Time library, please
see the Noda Time documentation.

Updates to the Scheduler Queue
Note
If you have not implemented the Scheduler Queue, then the following information will not affect your v2019.1 upgrading process.
Certain DateTime values may have been assigned different meanings in the Scheduler Job XML following the implementation of Noda Time.
Depending on the modifications made to your implementation of the Scheduler Queue, changes may have to be made to its code:
If your implementation of the Scheduler Queue utilizes the QueueAPI object from WebReports.Api.Scheduler, then there should
be no required for the Scheduler Queue to function properly after upgrading to v2019.1.
If your implementation of the Scheduler Queue has been modified to directly parse the Job XML, then some DateTime values may
have been assigned a different meaning and will need to be adjusted for. It is recommended that you contact our Services team
at services@exagoinc.com for help in determining which values will need to be adjusted.
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Remote Execution
Report execution can be balanced across servers to improve performance. As one execution is being processed subsequent report
execution calls will be sent to different servers. For each new job, Exago will prioritize the server with the lowest load (according to CPU
and memory load) and ratio of running jobs to max jobs allowed. The number of jobs on a server will not exceed the value specified by the
Scheduler Service's <simultaneous_jobs_max> setting.
The following instructions provide an overview for setting up report execution on remote servers:
On each remote execution server:
1. Install the Scheduler Service. For detailed instructions see: Scheduler Service Installation.
2. The following conditions must be met:
The Scheduler Service version must match the Web Application version.
The Scheduler’s language files and the Exago Application’s language files must match.
Any custom assemblies must be present in the Scheduler Service's /bin directory.
3. Configure the Scheduler Service. For detailed instructions see: Configuring Scheduler Services. By default the execution host
will pass the reports back to the Exago Application. In order to save reports to an external repository, see: Saving Scheduled
Reports to External Repository.
Tip
Multiple Scheduler Services can point to the same repository.
In the Admin Console:
1. Set General > Scheduler Settings > Enable Report Scheduling to True.
2. Set General > Scheduler Settings > Enable Remote Report Execution to True.
3. Set General > Scheduler Settings > Remote Execution Remoting Host to a comma or semicolon-separated list of the
Scheduler Services. e.g. http://MyHttpServer1:2001, tcp://MyTcpServer:2121. The servers will be prioritized based on the listed
order.
Note
When a Scheduler Service is used for both scheduling and remote execution, Exago will place immediate priority on Remote Execution
tasks.

Execution Caching
Execution Caching allows the data from a report execution to be saved so that reports can be viewed more quickly and with less stress
to the data source. The frequency and schedule of data source updates is customizable for each report. Updates can be scheduled for offhours in order to better balance system load. Caching can significantly reduce data source calls for reports that are accessed frequently.
Large or data-intensive reports, which can take a long time to run, especially benefit from caching.
Note
Execution caching is currently incompatible with the Scheduler Queue.

Enabling Execution Caching
Important
This feature requires the installation and proper configuration of the Scheduler Service.
Execution Caching uses the Scheduler Service to cache the data at set refresh intervals. When caching is enabled for a report, a
caching schedule is created that determines how often the data is refreshed. Scheduler Services need to be enabled for the user or users
who will be setting the caches; however, users who only need to view the cached reports do not need to have scheduling enabled.
To enable execution caching, set General > Scheduler Settings > Enable Execution Cache in the Admin Console to True.

Cache Visibility Settings
The userId and companyId parameters must exist and have default values assigned to them in order to be able to enable execution
caching. These parameters are used to assign visibility permissions to cached data.
The following Admin Console settings that affect access to some schedule recurrence options will also affect the recurrence options
available in the execution caching window:
General > Scheduler Settings > Show Schedule No End Date Option
General > Scheduler Settings > Show Schedule Intraday Recurrence Option
The following Admin Console setting will affect the view level options that a user has when assigning permissions for an execution cache:
General > Scheduler Settings > User Cache Visibility Level (v2017.3+)
The cache data is stored in the scheduler temporary directory, however cache files will not be deleted by the scheduler's routine cleanup.

Setting Cached Reports and Refresh Intervals
To set up caching for an advanced report:
Caution
Role-based filters and column-based tenancy apply based on the user who creates the cache. Users who can view the cache will see
data filtered by the creator's role and tenancy, not the viewer.
1. From the

Advanced menu, click

Execution Caching.

2. Check the Enable execution caching check box.
3. Choose which users will be able to see the cached data:
Note
Not every option may be available.
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User: Users will only see cached data that they have created. When another user runs the report, it will execute against the
database instead of the cache.
Company: Users will see cached data that has been created by anyone with the same companyId parameter. When a
user from outside the company runs the report, it will execute against the database instead of the cache.
Global: The report has one data cache which is visible for all users.
4. Choose how often the cache is updated:
a. Enter a time of day in the Schedule Time field, or use the picker to select a time.
b. Optional: To update the cache multiple times per day, select the Repeat Every check box and enter a time for how often it
should repeat.
Optional: To repeat until a certain time of day, enter that time in the Until field, or use the picker to select a time.
5. Choose which days of the week the cache is updated. Select either:
To repeat every day or every number of days, click Every __ day(s) and enter a number of days for how often it should
repeat.
To repeat every Mon, Tues, Wed, Thurs, and Fri, click Every weekday.
6. Click OK.
When execution caching is enabled for a report, the cache is not created immediately. To run the report, you can manually create the
cache by clicking the Cache Status
icon, or you can wait until the first scheduled update completes. The cache can always be
updated manually by clicking this icon.
Cache schedules are visible in the schedule manager, with the label (cache). Caches can be edited or deleted using the schedule manager
or the advanced report designer.

Viewing a report cache in the schedule manager

Editing cached reports
Editing a cached report invalidates its cache. It cannot be run until the cache is updated. A missing or invalid cache is indicated by the
message Cache is invalid, both in the report description and in the report tree menu.

Valid and invalid report cache indicators
It is recommended that you fully design a report first, so that you can manually verify the output, before enabling the cache.

Scheduler Queue
The Scheduler Queue is a custom-built application library that sits between the Exago core application and any number of Scheduler
Service instances and handles how schedule traffic is managed. The Scheduler Queue is completely optional, but configurations with
multiple scheduler instances for which load balancing is a priority are ideally suited to making use of this feature.

Background
The way in which Exago has historically handled report scheduling and the default behavior without using a queue, is the following.
For this discussion, it's important to define some terms:
A Schedule represents all of the information that a Scheduler Service needs to execute a report. A Schedule contains information
such as report name, time and frequency of execution, and how to handle the result. This information is usually stored as an XML
file in a repository. Schedules can be accessed from the .NET API using the ReportScheduler class.
Each Schedule contains some interpreted data that tells a Scheduler Service when to run it. This information is called a Job. Jobs
can also be stored separately from Schedules. Jobs can be accessed from the .NET API using the QueueApiJob class.
The process whereby a Scheduler Service runs a report at a specified time and emails or saves the information is called an
Execution.
Within the host application, all Scheduler Service instances are listed in the configuration XML file:

When a Schedule is created in the Web Application, the host application sends the job to Scheduler Services starting with the first and
moving through the list ("round-robin" style). The queried Scheduler Service stores the Schedule XML in a local working directory. This acts
as a repository for the Scheduler Service's unique set of jobs.
From this point, each Scheduler Service works independently. The host application has no idea what happens to schedules after they are
sent out successfully. Likewise, the Scheduler Services have no more communication with the host application with regard to report
execution.
Note
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Schedules can be viewed and edited from the Web Application using the
Schedule Manager, but this is essentially a combined
front-end for the Scheduler Service's existing files. If a Scheduler Service is offline, its schedules do not appear in the list (there will be a
warning message). The Schedule Manager has no impact on the host application.
Scheduler Services periodically scan their repository for job execute times. If a job is ready and the current time is equal to or past the
execute time, the Scheduler Service knows to run the job. The Scheduler Service will perform its duty and then alter the schedule XML file
to indicate success or failure and the next execute time.
This default behavior may be adequate for most cases, but there can be issues. In particular, the Scheduler Queue sets out to solve the
following two issues that can arise in default configurations: Load Balancing and Unexpected Outages.

Load Balancing
Ideally, unoccupied Scheduler Services would receive new jobs. This way, stacks of unexecuted data do not build up on individual
Scheduler Services, leading to unbalanced load and potential time loss. But the host application has no idea which schedulers will be busy
when, and no idea how long jobs will take to run. The randomness of round-robin job assignment could cause jobs to build up inordinately
on one Scheduler Service.

Outages
Once the host application sends out a schedule, as far as it's concerned, it's finished. If a Scheduler Service goes offline unexpectedly the
host has no recovery function. The job will simply be delayed until the Scheduler Service is restarted. There is also no function to move
schedules from one Scheduler Service to another.

How the Queue Works
The Scheduler Queue is a custom .NET or Web Service library which aims to handle scheduling in a more robust manner. It's important
to note that the queue is entirely customizable. You are only required to implement the applicable methods; how you do so is up to you.
The following section will describe a typical setup which can improve load balancing and help resolve some common issues with multiple
Scheduler Services.
The queue sits in between the Exago host application and any number of Scheduler Services and handles logic for all scheduler requests
and maintenance.

Architecture Diagram pre-v2020.1
The host applications and Scheduler Services all make calls to the queue at certain points during their runtime. In particular, Scheduler
Services will call the queue on three occasions: upon service startup, periodically while running, and when a job's status is changed.
The host application calls the queue for various maintenance tasks related to schedule creation and populating the
Schedule
Manager. For now, we'll focus on the relationship of Scheduler Services to the Scheduler Queue and how it can aid a typical multischeduler configuration.
When Scheduler Services are configured to use the queue, their behavior changes somewhat.
Note
In the default configuration, Scheduler Services store their unique schedules in a local working directory, from which jobs are queried for
execution.
Scheduler Services now periodically query the queue, which has instructions (GetNextExecuteJob) for assigning jobs. (The query time
defaults to 15 seconds, but is configurable). In a typical setup, the queue pulls from a central repository of stored schedules. In order to
prevent duplication, Scheduler Services lock the queue so that only one may access it at a time. Additionally the Scheduler Queue sets a
job's status to "running" while it's active, so that other Scheduler Services know to ignore it.
Note
Scheduler Services still use a local working directory for temporary files.
This has several advantages. First, Scheduler Services are no longer responsible for a unique set of schedules. This prevents outages from
causing excessive missed executes. Only one job will ever be hung per Scheduler Service as it will be responsible for only one job at a
time. If a Scheduler Service goes offline in the middle of a job, the Scheduler Queue can be used to gracefully handle incomplete jobs.
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Next, jobs are now distributed much more evenly between the Scheduler Services. Jobs will only be assigned to available Scheduler
Services. Finally, since this allows us to control what data is being sent and received to the Scheduler Services and the file system, any
custom load balancing solution can be implemented.

Set Up
Setting up the Scheduler Queue is a multi-part process which depends on the desired configuration. We'll discuss some constants and
some potential variations.

Write the Scheduler Queue
First we need to write the Scheduler Queue. This can be a .NET Assembly or a Web Service, and it can be part of another library.
All the following methods must be implemented in the Scheduler Queue interface:
public static string[] GetJobList(string viewLevel, string companyId, string userId)

Called from the Exago Web Application to populate the jobs in the

Schedule Manager.

public static string GetJobData(string jobId)

Called from the Exago Web Application

Schedule Manager to get the full job XML data.

public static void DeleteReport(string reportId)

Called from the Exago Web Application when a report is deleted.
public static void RenameReport(string reportId, string reportName)

Called from the Exago Web Application when a report is renamed.
public static void UpdateReport(string reportId, string reportXml)

Called from the Exago Web Application when a report is updated.
public static void Flush(string viewLevel, string companyId, string userId)

Called from the Exago Web Application

Schedule Manager in response to a click on the

Flush icon.

public static void Start(string serviceName)

Called from Scheduler Services to indicate when a specific service starts.
public static string GetNextExecuteJob(string serviceName)

Called from the Scheduler Services to return the next job to execute.
public static void SaveJob(string jobXml)

Called from both the Scheduler Service and the Exago Web Application to save the job. This method is called when a schedule is added,
updated, completed, killed, etc.
The QueueApi and QueueApiJob helper classes have been added to the API to facilitate writing the Scheduler Queue. You'll need to
reference the WebReports.Api.Scheduler namespace. QueueApiJob wraps a Job object and a variety of useful methods for managing
jobs. The QueueApiJob class will be used extensively in the following example.

Configuration
The host application config and each Scheduler Service config must contain the path to the Scheduler Queue assembly or Web Service
class in the following format:
Assembly=Path\To\Assembly.dll;class=Namespace.Class

The path may be set by one of these methods:
Using the Admin Console by setting the General > Scheduler Settings > Custom Queue Service field.
Setting the Custom Queue Service field in the Admin Console
By setting the field <schedulerqueueservice> in the config file,
By setting the field Api.SetupData.General.SchedulerQueueService via the .NET API at runtime.
In each Scheduler Service, set the field <queue_service> in the config file.
Next, determine how schedules are accessed. A common solution uses a database to optimize lookup speed. The queue only needs to
know the Job ID (filename), Next Execute Time, and the Running status to determine which schedules to run.
Job ID Next Execute Time Running?
String DateTime

Boolean

User Identification
Exago does not have native user authentication. User logins must be handled by a security layer in the embedding host application. After a
user logs in, the host application should pass identification parameters to the Exago API, which can be used to set permissions on
content and data objects within Exago.

System Parameters
Exago has two built-in parameters which are used to store identifying information: userId and companyId. These parameters are used in
conjunction with the Scheduler Service and User Preferences, and they are automatically passed to any extensions which may need to
access authentication. Folder Management, External Interface, Scheduler Queue, and any extension which can access sessionInfo
(such as Assembly Data Sources or Server Events) can retrieve these parameters in relevant methods.
Note
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These are required parameters. They cannot be deleted through the Admin Console, and if they are not present in the Config, then they
are automatically added at load time.
Often userId corresponds with a unique user or log-in, and companyId represents a group of users with shared characteristics. Either
parameter can be used without the other.

userEmail v2018.2+
The userEmail parameter is a third built-in parameter that can specify an email to be set as the "Reply To" email for any scheduled
reports. If using the userId or companyId parameters to identify the user, it is possible to change the default value of userEmail to be
specific to the users identified by userId or companyId. See below for an example of this in the .NET API and REST API. For more
information about this parameter see Scheduler Reply To Address.

Setting the current user
(v2017.2+)
The Id parameters are added by default in the base config file with blank values.

Admin Console
As created in the Admin Console:

Config File
As created in the config file:
<parameter>
<id>userId</id>
<data_type>string</data_type>
<value />
<hidden>True</hidden>
<prompt_text />
</parameter>
<parameter>
<id>companyId</id>
<data_type>string</data_type>
<value />
<hidden>True</hidden>
<prompt_text />
</parameter>

The userEmail parameter (v2018.2+):
<parameter>
<id>userEmail</id>
<data_type>string</data_type>
<value />
<hidden>True</hidden>
<prompt_text />
</parameter>

.NET API
As created in the .NET API:
Note
"DataType" defaults to DataType.String, so the call is omitted.

api.Parameters.GetItem("userId").Value = "ApiUser";
api.Parameters.GetItem("companyId").Value = "ApiCompany";

For setting the userEmail parameter (v2018.2+):
Parameter userId = api.Parameters.GetParameterById("userEmail");
userId.Value = "user_224@company_17.com";

REST API
As created in the REST API:
Note
"DataType" defaults to "String", so the call is omitted.
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POST /parameters
{
"Id": "userId",
"Value": "user_224"
...
}

POST /parameters
{
"Id": "companyId",
"Value": "company_17"
...
}

For setting the userEmail parameter (v2018.2+):
POST /parameters
{
"Id": "userEmail",
"Value": "user_224@company_17.com"
...
}

Basic sandboxing
Setting the userId and companyId parameters has several effects in the Exago interface.

Schedule Manager
By default, the
Schedule Manager will show only schedules belonging to the current userId. This can be changed by modifying the
following Admin Console setting:
Scheduler Manager User View Level (Scheduler Settings)
Current User ('User'): Filters schedules by current userId parameter.
All Users in Current Company ('Company'): Filters schedules by current companyId parameter.
All Users in All Companies ('All'): No filtering.
This setting can also be overridden by a Role.

Execution Cache
The userId and companyId parameters are used to set permissions for which users can view cached report data. Users can choose
whether a report cache is visible just for their userId, for everyone with the same companyId, or for all users. The options that are
available to a user depends on the following setting:
User Cache Visibility Level (Scheduler Settings)

User Preferences
User preferences, including which reports should run on startup and User Reports (live report customization), are set by userId, and will
only apply to that user.

Advanced permissions
userId and companyId can be used in many other application areas in order to handle security permissions.

Roles
Additional permissions are typically handled by Roles. A check can be made in the API which maps the current userId and/or
companyId to the role which it belongs. This must be handled manually via a lookup table or a similar data structure. Then activate the
role for the session.
.NET: api.Roles.GetRole("admin").Activate();
REST: PATCH /REST/Roles/admin?sid={sid} { "IsActive": true }
For more information, see Roles.

Tenanting
userId and companyId can be used as tenant parameters in your data objects.
If your data is set up such that each table, view and stored procedure has columns that indicate which user has access to each row, then
you can use userId and/or companyId to match these columns and act as data row filters. (For this purpose, the parameters cannot be
set to 'hidden').
For more information, see Multi-Tenant Environment Integration.

Accessing Ids in extensions
userId and companyId are passed to any custom extensions where relevant. For example, in an external interface assembly, you may
wish to access the userId in order to log user executions. You could do so by implementing the ReportExecuteStart method, which
passes the userId parameter.
public static void ReportExecuteStart(string companyId, string userId, string reportName)
{
string logText = string.Format("{0}: Report '{1}' executed by user '{2}'.", DateTime.Now, reportName, userId);
File.AppendAllText(logFile, logText + Environment.NewLine);
}

This would return the following text upon a report execution by userId "Alex":
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2017-03-07 14:50:49: Report 'Test\Product Sales Report' executed by user 'Alex'.
Most extensions have methods which can access userId and companyId. In addition, the parameters are accessible through
sessionInfo. So any extensions which can access sessionInfo can also access userId and companyId, even if methods do not explicitly
implement them.
The following server event automatically adds the userId to the description text whenever a report is saved.
Global Event Type: OnReportSaveStart, References: WebReports.Api.Reports
Report report = sessionInfo.Report;
string userId = sessionInfo.UserId;
if (!report.Description.EndsWith(userId)) { report.Description += ("\n" + userId); }
return null;

Setting up a State Server
We highly recommend using a state server to manage Exago sessions. Often, the cause of timeout problems is related to not properly
managing session state. In a high availability implementation, a state server is required.
You can create a state service on the same server as the Exago application, or on a different one.
ASP.NET State Service on Windows
ASP.NET State Service on Linux
Elasticache for Redis on AWS EC2

ASP.NET State Service on Windows
Enable the Service
1. On your state server, click Start and then Run.... Type services.msc, and click OK.
2. Locate the ASP.NET State Service and check the Startup Type property. If it is not set to Automatic or Automatic (Delayed
Start) then you have to enable the service.
3. Right-click on it, and select Properties.
4. Change the Startup Type to Automatic, then click Apply. Then click Start.
If your state server is on a network, make sure you have allowed inbound connections to the state service on a port.

Configure the Web Server
1. To configure the web server to use the state service, open IIS Manager, then in the left-most Connections pane, locate and select
your Exago application.

2. Double-click on Session State.

3. Select the State Server setting, and input the server port and a desired timeout value.
Note
Windows' built-in State Server runs on port 42424 by default. It is suggested that this port is used for the configuration of the State
Server. However, if preferred, this may be changed.

4. Finally, in the right-most Actions pane, click Apply.
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After applying these settings, the web server should be fully configured.

Additional Info
For more information about out-of-process session state, see the following external links:
Configure a State Server to Maintain Session State (IIS 7.0)
Configuring Step 2: Configure ASP.NET Settings

ASP.NET State Service on Linux
Note
This section references <WebApp>/ as a placeholder for the application's install location. The default install location is /opt/Exago/;
however, this directory may be changed during installation.
A state service is installed as part of the mono runtime. Exago provides a script that can enable the state service to run headless, that can
be downloaded from the Downloads page on the Support Site.

Prerequisites
Using an ASP.NET State Service on Linux requires:
mono be installed on the state server
the expect package be installed on the state server
a firewall rule allowing access to port 42424 on the state server for all servers in the web farm. This port may be changed, see
Choosing a Different State Service Port below for more information.

Setup
Perform these steps on the state server:
1. Download the startStateServer script with the link above. This script should be saved outside of the root or bin directory of the
Exago installation (e.g. <WebApp>/StateService) in order to isolate it from the rest of the application.
2. Run the script as root. For example:
sudo /opt/Exago/StateService/startStateServer.sh

Perform these steps on each Exago application server in the web farm:
1. Open the <WebApp>/web.config file for editing.
2. Locate the <sessionState mode="InProc" cookieless="false" timeout="20" /> line and comment it out using
XML comment tags <!-- and -->.
3. Uncomment (or add if missing) the <sessionState mode="StateServer" cookieless="false" timeout="15"
stateConnectionString="tcpip=localhost:42424" /> line just below the line in step 2.
4. Replace localhost in the stateConnectionString attribute with the IP address of the server running the state service.
When finished, the web.config file should look like this:
<!--<sessionState mode="InProc" cookieless="false" timeout="20" /> -->
<sessionState mode="StateServer" cookieless="false" timeout="15" stateConnectionString="tcpip=0.0.0.0:42424" />

5. Restart the web server.

Choosing a Different State Service Port
To use a port other than 42424 for the state service:
1. Open the <WebApp>/web.config file for editing.
2. Modify the <sessionState mode="StateServer" cookieless="false" timeout="15"
stateConnectionString="tcpip=localhost:42424" /> line with the correct port in the stateConnectionString attribute
3. Save and close <WebApp>/web.config.
4. Restart the web server.
5. Repeat steps 1–4 on each server in the web farm.
6. On the state sever, open /usr/lib/xsp/4.0/asp-state4.exe.config for editing.
7. Locate the <channel ref="tcp" port="42424" /> line inside of the <channels> node. Modify the port attribute to the
same port specified in step 2 above.
8. Save and close /usr/lib/xsp/4.0/asp-state4.exe.config.
9. Restart the web server and state service.

Elasticache for Redis on AWS EC2
1. Create an Elasticache for Redis instance on AWS. The Elasticache for Redis instance must be in a security group that has port
number 6379 open in order to communicate with Exago. Consult with the AWS and Redis documentation on how to do this.
2. On the Exago EC2 instance, install the Redis command line interface by issuing the following commands. The commands below
are for Ubuntu and Debian type Linux distributions, modify them for other operating system variants.
1. sudo apt-get install gcc
2. wget http://download.redis.io/redis-stable.tar.gz
3. tar xvzf redis-stable.tar.gz
4. cd redis-stable
5. make
6. make test
Note
Note that the make and make test steps will take several minutes to complete each.
make test requires that Tcl be installed on the system. If not installed already, it can be installed with sudo apt-get
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install tcl.
3. Confirm that you can connect to Redis from the Exago EC2 instance by issuing the following command:
1. src/redis-cli -c -h <redis-host-name> -p 6379
Substitute <redis-host-name> for the actual host name of the Elasticache for Redis instance created for step 1. The
Redis CLI prompt should appear. If the session store is not correctly setup, this operation will time out instead.
2. Run a few test commands to insure that Redis is working. Exit the CLI with Ctrl + C on the keyboard.
4. On the Exago EC2 instance, modify the Web Application's web.config file. Locate the sessionState node and modify it as
follows:
<sessionState mode="Custom" customProvider="MySessionStateStore">
<providers>
<add name="MySessionStateStore" type="Microsoft.Web.Redis.RedisSessionStateProvider" host="<redis-host-name>:6379" accessKey="" ssl="false" />
</providers>
</sessionState>

Substitute <redis-host-name> for the actual host name of the Elasticache for Redis instance created for step 1.
5. On the Exago EC2 instance, download the NuGet Package Manager and the required packages by issuing the following
commands:
Note
This article references <WebApp>/, as a placeholder for the application's install location. The default install location is
/opt/Exago/ however, this directory may have been changed during installation.

6.

7.

8.
9.

1. cd <WebApp>/bin
2. sudo wget https://dist.nuget.org/win-x86-commandline/latest/nuget.exe
3. sudo mono nuget.exe install StackExchange.Redis.Mono.StrongName
4. sudo mono nuget.exe install Microsoft.Web.RedisSessionStateProvider -Version 3.0.2
Verify that the following directories now exist in <WebApp>/bin:
Microsoft.AspNet.SessionState.SessionStateModule.1.1.0
Microsoft.Web.RedisSessionStateProvider.3.0.2
StackExchange.Redis.Mono.StrongName.1.2.0
Move the libraries from their directories to <WebApp>/bin by issuing the following commands:
1. cd <WebApp>/bin/Microsoft.Web.RedisSessionStateProvider.3.0.2/lib/net452
2. sudo mv Microsoft.Web.RedisSessionStateProvider.dll <WebApp>/bin
3. cd <WebApp>/bin/StackExchange.Redis.Mono.StrongName.1.2.0/lib/net45
4. sudo mv StackExchange.Redis.StrongName.dll <WebApp>/bin
5. cd <WebApp>/bin/Microsoft.AspNet.SessionState.SessionStateModule.1.1.0/lib/Net462
6. sudo mv Microsoft.AspNet.SessionState.SessionStateModule.dll <WebApp>/bin
Load the Admin Console to verify Exago loads without errors and to create at least one session in the cache.
Check to make sure the cache is working by issuing the following Redis CLI command from the Exago EC2 instance.
1. Re-establish a connection to the Redis CLI with the commands in step 3.1 above.
2. KEYS '*'
Keys for Exago should appear in the listing if the Admin Console loaded in step 8, similar to the figure below.

Redis Resources
Redis Quick Start
Redis Command Refernce

Deploying to Production
This guide describes the considerations you should take when deploying an Exago BI installation to a production environment. Suggested
steps are listed in the order they should be taken. Best practices are recommended for each step. However, every environment is different,
so recommendations should be considered in the context of your desired setup.
For personalized support, please file a support ticket.

Contents
1.
2.
3.
4.
5.
6.
7.
8.
9.

Installation: Decide where the Exago BI application and schedulers live
Data: Determine how to expose your data to your users
API: Use the API to control user permissions
Content Management: Implement a content management solution
Integration: Visually integrate Exago BI into your host app
Reports: Make "canned" reports as examples for your users
User Preferences: Implement a user preference storage solution
Deployment: Important steps to follow before deploying your application
Security: Follow our Security Checklist of best practices

Installation
Since Exago BI is an embedded application, it is up to you to decide which of your servers Exago is installed on. Exago BI supports nearly
any type of deployment, including cloud, private servers or onsite at your clients.
Exago does not need to be installed on the same server as the host application. One or more scheduling services can be further installed
separate servers to handle Remote Execution of reports. Additional scaling can be accomplished with a Web Farm. To use the .NET
API, Exago BI must be accessible from the host application via a file system path. See API for more information.
The scheduling services are capable of acting as standalone report execution applications. The best way to scale Exago BI for
performance is to deploy additional scheduling servers, and offload report executions to them. This method, called Remote Execution,
also implements an automatic load balancing solution. The servers with the most available resources are given execution priority in order to
keep an even load distribution.
A QA/Staging environment is highly recommended as well. This allows developers to test API changes, config changes, and Exago BI
version updates, before moving to production.
Also consider the following:
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Where do you want temp files and report definitions to reside for each server?
Where does the data source reside, relative to where Exago BI will be deployed?
Should Exago BI reside in the same domain as your host application?

Data
It is critical to make the right choices in how to present your data to your users. Consider the technical level and reporting experience of
your users. You may need to service different classes of users, from technical users like developers and database administrators, to nontechnical business analysts and project managers.
Exago BI can manage data object permissions to many levels of precision. Permissions can be set per-user and per-group, for data
objects, fields, rows, and even within field values. Data objects are easily restricted for classes of users using Roles. Within a data object,
fields can be hidden, and row access can be limited by matching a linked user ID with the logged-in user. Roles can also provide filters for
data values, in case some fields should be partially, but not fully hidden from view.
It is also recommended to use aliasing, descriptions, categories, and metadata to control how your data objects appear in the
application. Categories are a way to separate data objects into folders, so you can group together associated data. Aliasing allows you to
show more user-friendly names for data objects, instead of how they are named in the database. Descriptions provide additional
information, and metadata can improve report performance.
Also consider the following:
How normalized or de-normalized should the visible data be?
Should any data objects be available for some users and not for others?
Within a data object are there row-level permissions or multi-tenant permissions per user?
Will the underlying data objects change in the future? If so, add IDs to objects to prevent naming conflicts.

API
It is critical that Exago BI is only exposed to users through the API. The API allows you to set security and permissions settings, and
tailor the reporting experience by user.
.NET environments can use the .NET API, which is the most flexible and extensible API. Non-.NET environments can access a subset of
API calls through the REST Web Service API.
The most basic API implementation begins by initializing a session, then sets the "userId" and "companyId" parameters to identify the
logged-in user, sets a user-specific Role to control permissions, and then launches Exago BI using the getUrlParamString() method.
Developers should write the API code robustly with checks for null return values and exception handling.
Consider where you want Exago BI to appear within your application, and how users should use it to access reporting. For example,
should it be placed in an iFrame container, a redirected page, or a popup window?
Also consider the following:
Do you want to provide a list of reports and dashboards to users and directly run them via the API?
Are there other settings in Exago BI you want to enable or disable based on the user?

Content Management
In versions pre-2020.1, Exago can handle the storage and retrieval of reports on a local or cloud-based file system. However, it is strongly
recommend to use the Folder Management extensibility feature to customize where report definitions reside. Using folder management
can allow you to store reports in a database instead of on a file server. This can make it easier to control user access permissions, helps
to scale your deployment, and provides additional benefits such as soft deletes and report usage tracking.
Your custom folder management definitions are accessed from a custom assembly, so this does require some additional development.
This sample code can be downloaded and used as a guide or a starting point.
Also consider the following:
How do you want the folder tree to appear for new users?
Will you create common reports that are available for all users?
Are there multiple levels of report permissions beyond individual users and published reports?

Integration
Exago BI gives you full control over the CSS, icons, and language strings in the UI. You can have several different application themes if
necessary, and select different ones for different classes of users. You can also build custom themes for reports and visualizations. And
you can make a custom start page that users will see when they first enter the UI.
For integration, we recommend the following best practices:

Home page
Copy the ExagoHome.aspx home page to a new page, and use that as the entry point for users going into the full UI. This copy can be
styled at will.

Application Theme
Make a new application theme by extracting a copy of our theme template into a new folder in the ApplicationThemes directory.
Enable the theme in the Admin Console, and add any custom styling if desired.

Getting Started
Remove the content from the default Getting Started page, since this is only intended to be a styling example. It is recommended to add
custom content, since users with access to the full UI will see this page often. Clients have used the Getting Started page to provide
announcements, quick tips, helpful formulas, and links to other parts of the application.
Also consider the following:
Does your application support multiple languages?
Are there any text strings or tooltips you want to customize?
Do you want to customize the CSS or swap out any of the icons in Exago BI?
Do you want to customize the context-sensitive help to match your documentation?

Reports
By providing a folder of "canned" reports, you can show users Exago BI's capabilities, and some useful examples of the data that is
available to them. This folder should be at the top level so it is easy to locate, and read-only so that users cannot edit the reports. If they
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want to make changes or see how the reports are made, they can duplicate a report and edit the copy.
Making these reports can be a good opportunity for your support, sales, and services staff to become familiar with Exago BI. The Exago BI
services team can also assist your staff, either by basing your training on these reports, or by building them for you.
Also consider the following:
What questions can be answered by reporting?
What data objects do you want to highlight?
Are there any specific Exago BI features that you want to showcase?

User Preferences
The User Preferences store user-level customizations of the application environment in the user's browser local storage by default, but it
is recommended to store these in a database via extensibility.
For more information:
Admin Console: User Settings
Admin Support Lab — Customizing Color Picker (video)
Admin Support Lab — v2018.2 User Preferences (video)

Deployment
Once the other steps are in place, lay out a plan for moving to production. We recommend keeping detailed notes of the process so it can
be replicated for future updates.
After installing in production, move the following files from your staging environment to production:
1. The encrypted configuration file: /Config/config.xml.enc
2. Any custom application themes folders: /ApplicationThemes/themeFolder
3. Any custom language files: /Config/Languages/language.xml. These also need to be added to the /Languages
directories for each scheduler installation.
4. Your custom Getting Started page: /Config/Languages/getting-started.xml
5. Any other configuration files: /Config/Other/file.json, and /appSettings.config
6. Your custom context-sensitive help, if you have one: /NetHelp
7. Your custom home page: /home.aspx
8. If you are not using folder management, any custom theme files: /Themes/theme
9. If you are using Google Maps, make sure the MapPolygonDataBase.sqlite file is present in the /MapCache folder.
We also recommend adding the non-encrypted config file (/Config/config.xml) to your version control after removing any sensitive
passwords or connection strings.
Disable the Admin Console. It should not be accessible in a production environment.
Also consider the following:
Make sure all Exago BI instances and Scheduler Services are on the same version and build number.
If you are using the .NET API make sure the version of WebReportsApi.dll matches the version and build number of Exago BI.
Do the same with any custom assemblies, such as Folder Management, Scheduler Queue, or Server and Action Events.

Security
IMPORTANT: Follow our Security Checklist before turning on access to your application. It is highly recommended to follow these steps
to reduce the possibility of unauthorized access.

Security Checklist
There are a number of precautions that should be taken before running Exago in a production environment.
Set an external temp path
Disable direct access
Set configuration and API credentials
Remove the XML configuration file
Remove the Admin Console
Encrypt Scheduler Service working data
Disable SOAP Web Service API
This article mentions several Admin Console settings. There are matching configuration file nodes and API properties that can be used for
modifying these settings as well. For more information, review the Config File XML Reference and Config File and API Setting Reference
articles.
Note
This article references <WebApp>/, <WebSvc>/ and <Sched>/as a placeholder for the Web Application, Web Service API and
Scheduler Service's install location respectively. The default install location is C:\Program Files\Exago\ExagoWeb\
(/opt/Exago/ on Linux), C:\Program Files\Exago\ExagoWebApi\ ( /opt/Exago/WebServiceApi/ on Linux) or
C:\Program Files\Exago\ExagoScheduler\ (/opt/Exago/Scheduler/ on Linux); however, these directories can be
changed during installation.

Set an External Temp Path
The Temp directory contains working data that may contain sensitive information. If the Temp Path configuration setting is left blank,
Exago will default to a Temp folder at the root of the installation directory. This is not recommended because it could expose temporary
data to web access.
The Temp Path should be set to a location outside of the Exago installation (and behind the server's firewall). Set the Temp Path in Admin
Console > General > Main Settings > Temp Path.

Disable Direct Access
Access to Exago should be curated through the API so that user permissions can be set via Roles or the Storage Management identity
system. Users should not be able to access the home page directly, which would bypass role restrictions. To disable direct access to
Exago, set the Admin Console > General > Main Settings > Allow direct access to Exago (bypassing API) to False.

Set Configuration and API Credentials
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A User ID, Password, and REST Key should be set in the configuration. This safeguards access to the Admin Console and REST API.
See REST API for information on accessing a password-protected web service. To do so, set values for the following settings:
Admin Console > General > Other Settings > User Id
Admin Console > General > Other Settings > Password
Admin Console > General > Other Settings > Confirm Password
Admin Console > General > Other Settings > REST Key

Remove the XML Configuration File
The Admin Console generates two copies of the configuration: a plain-text XML file, typically WebReports.xml and an encrypted version
WebReports.xml.enc. Plain-text config files may contain sensitive information, such as database connection strings, schemas,
usernames, and passwords.
When your config settings have been finalized, the plain-text config file should be removed from the Config folder and saved in a secure
location.

Remove the Admin Console
The Admin Console should not be accessible in a production environment. To permanently remove the Admin Console, in each installation:
1. Delete <WebApp>\Bin\admin.aspx.cdcab7d2.compiled
Tip
Admin.aspx can be deleted as well, or edit it to show a static error message.

Encrypt Scheduler Service Working Data
Note
This section applies only in environments where at least one Scheduler Service is in use.
Each Scheduler Service stores working data in a local temporary folder. For security, this data should be encrypted. In each Scheduler
Service's configuration file:
1. Set the <encrypt_schedule_files> setting to True. For example:
<encrypt_schedule_files>True</encrypt_schedule_files>

2. Restart the Scheduler Service

Disable SOAP Web Service API
Note
This section applies only in environments where the REST Web Service API is in use. If the .NET API is being used instead, the REST
Web Service may not be installed. It may be uninstalled if it will not be used.
If you are using the REST Web Service API, disable the SOAP API to prevent any unauthorized requests. To do so, in each instance of
the Web Service API:
1. Delete <WebSvc>\Bin\api.asmx.cdcab7d2.compiled
Tip
Api.aspx can be deleted as well, or edit it to show a static error message.

About the Administration Console
The Exago Administration Console serves as a user interface to set up and save administrative preferences. Use the Administration
Console to create and modify:
Config File Options — Implement a static/dynamic configuration
Storage Management — Configure report, theme, folder and template file storage
Data — Establish how to connect to data sources and determine what data should be exposed to users. Configure system-wide
variables called Parameters.
General — Modify global settings of Exago to enable/disable features.
Roles — Create and modify security Roles for individuals or groups of users.
Extensions
Functions — Create and modify custom functions to make calculations on reports.
Aggregate Functions — Create and modify custom aggregate functions.
Filter Functions: Create and modify custom filter functions
Server Events — Create and modify custom code that is run when reports execute.
Action Events — Create and modify custom code that activates when a certain condition in the application is met.
Custom Options — Create and modify custom options that can be set on reports.
The Administration Console creates two configuration files: an XML file named WebReports.xml and an encrypted XML file named
WebReports.xml.enc. These files are created and saved in the /Config sub-directory of Exago's installation location. The encrypted
file cannot be edited with the Admin Console. It is recommended to use this as the live version of the config in a production environment.
Copy WebReports.xml to a secure backup, and then delete WebReports.xml from the Config directory.

Accessing the Administration Console
Once Exago is installed, navigate with a web browser to http://<Your Server>/Exago/Admin.aspx.
It is recommended to protect access to the Admin Console by setting values for the General > Other Settings > User ID, Password
and Confirm Password settings.
Once Exago is configured and working, access to the Admin Console should be completely disabled. The Admin Console should never be
accessible in a production environment. For more information, review the Security Checklist.
Warning
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Aside from the obvious security concerns by exposing the Admin Console in production, any changes made to the system configuration
will invalidate all current user sessions causing an unsatisfactory user experience. For more information, review Modifying Configs in a
Production Environment.

Navigation
The Administration Console consists of two sections. On the left is the Main Menu and on the right are Tabs that can contain menus to
create and modify Data Sources, Data Objects, Parameters, Roles, and other settings.

Main Menu
Through the main menu you can:
Create Data Sources, Data Objects, Joins, Parameters, Roles, and Custom Functions.
Edit settings for: Data, Roles, Functions, and General features.
Delete Data Sources, Data Objects, Joins, Parameters, Roles, and Functions.
Automatically discover data source objects and metadata.
Click the Collapse

icon to hide (or restore) the main menu.

Tabs
The right section of the Admin Console is made up of tabs containing menus to create and modify administrative settings.
To save the changes made in a tab click Apply or Okay.
Tabs can be closed with or without saving by clicking the Close

icon to the right of the tab name.

Tabs may be arranged by clicking and dragging them as desired.

Creating Additional Configuration Files
As part of the integration of Exago you may want to create alternative configuration files in addition to WebReports.xml. Additional
configuration files can be utilized in two ways:
If entering Exago directly, the configuration file to be used is specified in the Custom Styling.
When entering through the API the configuration file to be used is specified in the API Constructor Methods.
To create additional configuration files:
1. Navigate to the Administration Console in a web browser.
2. Append "?configFn=NewConfigFile.xml" to the URL replacing NewConfigFile with the desired configuration file name.
3. Click in the URL bar and press enter.

About This Section
This section of the documentation describes in detail each of the Admin Console settings and their effect on the application.. The system
configuration can also be changed by editing the configuration XML files directly, or through one of the APIs.
The settings work the same way regardless of modification method. Use this section of the documentation as a reference when locating a
particular function or setting in the application, then refer back to the appropriate articles for the method you are using.

Main Settings
This article applies to the Admin Console >

General >

Main Settings.

Select your version of Exago from the Application Version dropdown on the right-side of this article to show only the settings available in
your version.
The main settings are the basic options for Exago. The following settings are available:
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Report Path pre-v2020.1
The parent folder for all reports. The Report Path may be:
Virtual Path
Absolute Path — used to provide increased security (ex. C:\Reports)
Web Service URL or .NET Assembly — using a Web Service or .NET Assembly allows reports and folders to be managed in a
database. For more information see Report Folder Storage & Management

Temp Path
The location where temp files are stored. The Temp Path may be:
(no value) — All temp files and images will be saved to ./Temp.
Virtual Path
Absolute Path — Temp files will be saved to the absolute path and image files will be saved to ./Temp
Important
Before deploying into a production environment be sure to set a Temp Path that resides behind your server’s firewall/security system.

Temp Cloud Service
Web Service, .NET Assembly, or Azure Authentication string used to integrate into a cloud environment. For more information see Cloud
Environment Integration.

Language File
List of the XML files that specify language strings. See Modifying Select Language Elements for more details.

Temp URL
Overrides the portion of the temporary URL used to store images from HTML exports. Temp URL can override just the scheme (i.e. https)
or the full URL.

Allow Direct Access to Exago
A boolean setting:
True: allows users direct access to Exago with no security.
False: users must be authenticated by the host application to enter Exago. Users that try to directly access Exago will receive a
message saying ‘Access Denied.’
Important
We highly recommend setting this to False before deploying Exago in a production environment.

Allow Execution in Viewer
Enables or disables running reports in the Report Viewer.
Note
Setting Allow Execution in Viewer to False will also prevent creating new Dashboards regardless of the setting of Admin Console >
General > Feature/UI Settings > Allow Creation/Editing of Dashboards.

Allowed Export Types
The available formats for exporting all reports. Check the box of the formats that should be available. Unchecking PDF restricts
Dashboards from being exported in both PDF (Chained Report) and PDF (Snapshot) modes (v2021.2+).

Default Output Type
The export format that appears when a new report is selected unless a specific export format is set in the Options Menu of the Report
Designer.
Note
The Default Output Type must be one of the available Allowed Output Types.

Report Tree Shortcut
Whether the report execute button in the report tree defaults to Run the report in the Report Viewer, or Export the report to the default
format.
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Active Role
Retains the Id of the Role to be made active upon session start. The active Role may be changed manually using the dropdown. For more
information please see the Roles article.

Culture Settings
This article applies to the Admin Console >

General >

Culture Settings.

Introduction
The Culture Settings give administrators control over formats and symbols that vary amongst geographic location. These settings can be
overwritten for a specific user or group of users by modifying the Role. For more information see Roles.

Settings
The following settings are available:

Date Format
The format of date values. May be any .NET standard (e.g., MM/dd/yyyy).

Time Format
The format of time values. May be any .NET standard (e.g., h:mm:ss tt).

DateTime Format
The format of date-time values. May be any .NET standard (e.g. M/d/yy h:mm tt).
Note
For more information on .NET Date, Time, and DateTime format strings please visit this MSDN article.

Date Time Values Treated As
Choose to format DateTime as Date or DateTime values. To change this setting for specific columns see Column Metadata.
Note
Column metadata will override culture settings.

Numeric Separator Symbol
Symbol used to separate 3 digit groups (ex. thousandths) in numeric values. The default is a comma (,).

Numeric Currency Symbol
Symbol prepended to numeric values to represent currency. The default is the US currency symbol ($).

Numeric Decimal Symbol
Symbol used for numeric decimal values. The default is a period (.).

Numeric Decimal Places
The default number of decimal places to show when a cell format is set to display a Number or when column metadata or the data source
identifies the value is a number data type. This value is also the default value presented to users in the Report Designer Cell Formatting
dialog. Default is -1 which will show two decimal places. Values between -1 and 8 are accepted.

Currency Decimal Places
The default number of decimal places to show when a when column metadata or the data source identifies the value is a currency data
type. Default is -1 which will show two decimal places. Values between -1 and 8 are accepted.

Apply Numeric Decimal Places to General Cell Formatting
Set to true to apply the Numeric Decimal Places to any cell that has Cell Formatting set to General but contains a number. Default value
is false.

Apply General Currency Right Alignment
Set to true to cause currency values to appear right-aligned by default in report cells.

Server Time Zone Offset
A nullable decimal value that is used to convert server to client time (the negation is used to convert client to server time). This offset is not
applied to data coming from Data Sources. It is utilized by Exago features like the Scheduler Service. Set to 0 to use server time or null to
use the External Interface (a deprecated extensibility feature) to calculate the time zone change.
Note
A Server Time Zone Offset is only required if a Client Time Zone Name cannot be provided. Otherwise, all scheduling calculations
will be performed using the provided time zone information.

Time Zone Name
Default geopolitical location of the client as determined by the IANA time zone database (e.g., America/New_York). Utilized by Exago to
properly resolve scheduling issues centering around DST and other non-linear time zone conflicts. The setting is also used for other time
and date related features in the application such as Date/Time functions like Now().
Note
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For information regarding the time zone enhancements made in v2019.1+, please see this article. For a full list of official IANA time
zones and their relative UTC offsets, please reference this Wikipedia article.

Feature/UI Settings
This article applies to the Admin Console >

General >

Feature/UI Settings.

Introduction
The Feature/UI settings allow administrators to hide various features in the user interface. As each heading indicates, settings may apply
to specific report types or the entire application.

Settings
The parameters are broken up into several sub-sections:
Available Report Types
ExpressView Settings
Advanced Report Designer Settings
Dashboard Report Designer Settings
Common Settings

Available Report Types
These settings enable/disable report types.

Allow Creation/Editing of Advanced Reports
Enables/Disables the Advanced Report Wizard and Report Designer

Allow Creation/Editing of CrossTabs
Enables/disables the creation of new CrossTab reports from the main menu.
When False, the Show CrossTab Wizard setting will appear under Advanced Report Designer Settings, permitting CrossTabs to be
enabled/disabled separately in the Advanced Report Designer.

Allow Creation/Editing of Dashboards
Enables/Disables the Dashboard Designer.
Note
Both Allow Creation/Editing of Dashboards and General > Main Settings > Allow Execution in Viewer must be True to enable
the Dashboard Designer.

Allow Creation/Editing of Chained Reports
Enables/Disables the Chained Report wizard.

Allow Creation/Editing of ExpressViews
Enables/Disables the ExpressView designer.

ExpressView Settings
These settings only apply to the ExpressView designer.

Allow Editing ExpressView with Live Data
When True, users are allowed to make changes to an ExpressView when the in Live Data (Run) mode. When False, users must click the
Stop button on the toolbar before changes may be made.
The default value is false for pre-v2021.1.1 or true for v2021.1.1+
Note
Prior to v2021.1.1 we recommend setting this to False. Editing live ExpressViews will cause an increase in Data Source requests, and
may reduce performance.

Fields Enabled in Data Fields Tree v2017.1.2+
This setting controls whether users are allowed to add fields to an ExpressView that are not directly joinable to another field on the report.
All joinable fields (default): Users can add any fields with a join path to existing report fields.
Direct joins only: Users can only add fields with a direct join to an existing report field.
Note
As of v2018.1.23+, the join algorithm has been modified for ExpressViews with Direct joins only enabled. The Disable Non-Joined
Data Objects database setting is now taken into consideration when generating a join path, allowing these ExpressViews to properly
analyze join weight and encompass constructed SQL.

Join Path Algorithm
Select the join path algorithm to use when running ExpressViews with multiple data objects.
Standard (default): More performant in most cases.
Legacy: Select if you are experiencing issues with ExpressViews created in an older version.

ExpressView Tutorial v2018.2–v2020.1
Enables an instructive tutorial guide using ExpressViews to guide new users through the process of building an ExpressView report. The
user can opt out during the course of the tutorial.
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ExpressView Hints v2018.2–v2020.1
Enable context-sensitive hints when using different features in ExpressViews.

Advanced Report Designer Settings
These settings only apply to the Advanced Report designer.

Show CrossTab Wizard
If Allow Creation/Editing of CrossTabs in Available Report Types is False, this option becomes available. When Allow Creation/Editing of
CrossTabs is True, this option is hidden from view in the Admin Console.
Set to True to allow CrossTab widgets to be added to Advanced Reports in the Designer, or False to completely disable the creation of
CrossTabs in the application.

Show Chart Wizard
Enables/disables the Chart Wizard

icon in the toolbar (pre-v2021.1). Set to False to disable users from creating or editing charts.

Chart Colors
Lists the values used for default chart colors, except for heatmap charts. Hexadecimal values should be separated by commas or
semicolons.

Maximum Number of Chart Data Points
Upper limit on the number of data points visible on a chart. If the limit is exceeded, a warning will be displayed to the user. Charts with
large numbers of data points could cause browser performance issues.

Default Chart Font
Specifies a default font for charts created in the Advanced Report Designer. This setting can be overridden on a per-Report basis. Does not
apply to ExpressView charts or Dashboard visualization tiles.

Show Geochart Map Wizard
Enables/Disables the GeoCharts

icon in the toolbar (pre-v2021.1). Set to False to disable users from creating or editing GeoCharts.

Note
The first time Show Geochart Map Wizard is set to true a dialog appears prompting you to accept the terms of using the Google Charts
Api. Type "I accept" in the first box and your full name in the second to accept the terms and enable mapping.

GeoChart Map Key
Optional Google Maps license key for GeoCharts permissions. License must contain the Google Maps Javascript API service. See
Legacy Maps (Geocharts) for more information.
Note
Due to a change in Google's Maps API Terms of Service, if geocharting was enabled after June 2016, or if you had geocharting enabled
before, but changed your host domain name after June 2016, you need a license key to use this feature.

Geochart Map Colors
List the values used for default Geochart map colors. Hexadecimal values or CSS color names should be separated by commas (or
semicolons).

Show Google Map Wizard
Enables/Disables the Google Maps
Maps.

icon in the toolbar (pre-v2021.1). Set to False to disable users from creating or editing Google

Note
In order to use Google Maps, a license key must be obtained from Google, a polygon file must be downloaded from our support site and
the Exago server must have an Internet connection. See Installing Optional Features for more information.

Google Map Key (unlimited or JS API restricted)
License key for Google Maps permissions. Must contain either:
Google Maps JavaScript API and Geocoding API services, unlimited key.
Google Maps JavaScript API service, limited key with referrer URLs. If this is the case, supply a limited Geocoding API service
key in the following field.
Note
When upgrading from a version prior to v2018.1, the value previously supplied for the Google Map Key will appear here.

Google Map Key (optional Geocode API restricted)
License key for Google Maps permissions. If the previous field contains a key limited to the JavaScript API service, supply a limited
Geocoding API service key in this field, given server IP addresses. Otherwise leave this blank.

Google Map Colors
List the values used for default Google map colors. Hexadecimal values or CSS color names should be separated by commas or
semicolons.

Show Gauge Wizard
Enables/Disables the Gauge Wizard

icon in the toolbar (pre-v2021.1). Set to False to disable users from creating or editing gauges.
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Gauge Colors
List the values used for default gauge colors. Hexadecimal values or CSS color names should be separated by commas (or semicolons).

Show Document Template
Enables/Disables working with document templates. Set to False to disable users from using the Document Template menu.

Show Document Template Upload Button
Set to True to allow users to upload document template files from their local computer. Set to False to prevent users from uploading
Document Templates.

Show Linked Report
Enables/Disables the Linked Report

icon in the toolbar. Set to False to disable users from linking reports.

Show Linked Report Fields
Enables/Disables the Fields tab in the Linked Report dialog.

Show Linked Report Formula
Enables/Disables the Formula tab in the Linked Report dialog.

Show Linked Action
Enables/Disables the Linked Action Event

icon. When True, users will be able to add Action Events to reports.

Show Insert Image
Enables/Disables the Image

icon in the toolbar (pre-v2021.1). Set to False to disable users from inserting images.

Show Joins Window
Enables/Disables the Joins menu under Advanced Options. Set to False to disable users from modifying joins.

Show Advanced Joins
Enables/Disables additional options in the Joins menu. Set to True to enable advanced users to create, delete, and modify joins.

Advanced Joins Display v2017.3.1+
Select whether to show complex join options in the report Joins menu.
Complex — allow users to modify join operators and expressions, and allow conjoining clauses.
Standard — only permit joining data columns on equality.

Allow Category Aliasing v2017.3.1—2020.1
Category aliasing allows users to add categories multiple times on the same report. This may be necessary for some advanced join
operations.

Show Events Window
Enables/Disables the Events item under Advanced Options. Set to True to allow users to apply Server Event Handlers in the report. See
Server Events for more information.

Show Report-Level Parameters Window v2019.1.3+
Enables/Disables the Parameters item under Advanced Options. Set to True to allow users to view system-parameters and define their
own report-level parameters for use within reports. See Advanced Options for more information.

Show SQL Window
Enables/Disables the Show Generated SQL menu under Advanced Options. Set to True to allow users to view the SQL that will be sent
to the data sources upon execution. See Advanced Options for more information.

Linked Report Display v2017.3+
Specify where to display drilldowns for linked reports.
Cursor — a popup window appears at the mouse cursor
New Tab — the linked report opens in a new user interface tab
Center of screen — a popup window appears at the center of the screen

Allow Grouping on Non-Sorts
Enables/disables users to create groups on non-sort formulas.
Note
Grouping on non-sort formulas is deprecated and unsupported.

Allow Creation of Custom SQL Objects v2018.1+
Allow end-users to write custom SQL objects at the report level.
Warning
Carefully review the Report Level SQL article before enabling.

Data Sources to Exclude from Custom SQL Creation v2018.1+
When Allow Creation of Custom SQL Objects is enabled, enter the data sources to exclude from Report-Level SQL. Write each data
source in double quotation marks ("), and separate sources by a comma (,). Example: "Northwind","AdventureWorks".

Dashboard Report Designer Settings
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These settings only apply to the Dashboard designer. If Allow Creation/Editing of Dashboards is false these settings will be ignored.

Prompt user for Parameters/Filters on Execution
Default setting indicating whether to prompt the user for filter and/or parameter values when executing a dashboard. The option can be
overridden on an individual dashboard in the Options menu.

Show URL Item Button
Display/Hide the URL item in the New Tile Menu of the Dashboard Designer. When False, users will not be able to add URL tiles to the
Dasboard canvas.

Allow Creation/Editing of Dashboard Visualizations
Display/Hide the Visualization item in the New Tile Menu and Tile Properties Pane of the Dashboard Designer.

Refresh Reports/Visualizations on Dashboards Silently
Set to True to disable the refresh hourglass animation for timed automatic dashboard reloads.

Minimum Tile Width for Dashboard Reflow v2019.1+
Specifies the minimum width a tile will be drawn when Dashboard Reflow is enabled. Please see the Canvas section of the Dashboard
Designer article for more information.

Minimum Window Width for Dashboard Reflow v2019.1+
Specifies the minimum window size where Dashboard Reflow will begin to take effect. Please see the Canvas section of the Dashboard
Designer article for more information.

Common Settings
Default Designer Font
Specifies a default font for reports created in the Advanced Report Wizard, Express Report Wizard, Advanced Report Designer and
Dashboard Designer. This setting can be overridden on a per-report basis.
End-users must have the selected font installed locally in order to display. Otherwise, Exago will default to Sans Serif.

Default Designer Font Size
Specifies a default font size for reports created in the Advanced Report Wizard, Express Report Wizard, Advanced Report Designer, and
Dashboard Designer. This setting can be overridden on a per-report basis. Does not apply to CrossTabs.

Show Help Button
Enables/Disables the Help
sensitive help system.

icon in the top right corner of the user interface. Set to False to disable users from accessing the context-

Custom Help Source
Specifies the URL that contains custom context-sensitive help content. See Custom Context Sensitive Help for more details.

Show Exports in Tab
Set to True to open PDF reports in an Exago tab. Set to False to prompt the user to download the PDF.

Show IE Download Button
Set to True if Internet Explorer is not automatically prompting users to download PDF, XLS, RTF or CSV export files.

Show Join Fields
Enables/Disables any Data Fields that are used as Unique Keys or Joins. Set to False to hide all unique key and join Data Fields from
users. To hide specific Data Fields see Column Metadata.

Show Grid Lines in Report Viewer
Sets the default output to show grid lines or not. This can be overriden on a per-report basis.

Show Enhanced Tooltips
Sets the style of tooltips to display. If True, enhanced tooltips which support HTML will be displayed. If False, standard browser tooltips
will be shown.

Show Enhanced Tooltips set to True

Show Enhanced Tooltips set to False

Save on Report Execution
Set to False to disable automatic saving of reports when executing from the Report Designer.

Save on Finish Press
Set to False to disable automatic saving of reports when finish button is pressed in a wizard.

Enable Right-Click Menus
Set to False to disable right click menus.

Enable Reports Tree Drag and Drop
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Set to False to disable the dragging of reports and folders in the Report Tree.

Show Report Upload/Download Options
Set to True to enable users to upload and download report files by right clicking on folders and reports. Default value is False.

Allow interactivity in Report Viewer
Set to False to disable Interactive Report Viewer capabilities, including: changing column width, styling output, and interactive filters.

Show Toolbar in Report Viewer
Specify if Report Viewer should display paging, search, and export options.
Auto — Exago will detect if the report only displays a single page of content from the Report Footer Section. If so the HTML Toolbar
will be hidden, otherwise it will show.
Show —the toolbar will always show.
Hide — the toolbar will never show.

Default interactive report viewer dock is open
Set to True to have the Interactive Dock opened by default when a report is executed in the Report Viewer.

Interactive report viewer default dock placement
Specify if the Interactive Dock should appear on the left or right of the Report Viewer. The default value is is Left pre-v2021.1.5 or Right
v2021.1.5+

Allow save to report design for report viewer
Set to False to prevent users from saving changes to a report made in the Report Viewer back to the original report design. This effectively
removes the Save Changes To This Report and Save Changes to New Report options in the Report Viewer.

Maximum number of fields in a CrossTab header or tabulation source
Specify the maximum allowed fields in a CrossTab header or tabulation source. Note that adding a large number of data fields to a
CrossTab will significantly increase the execution time of the report.

Use SVG for Application Icons v2016.3+
Set to True to se SVG icons instead of the default PNG icons in user interface elements. SVG icons look nicer on high-pixel density
screens, but they may not be compatible with some web browsers.
When using a custom application theme, this setting should be set to True.

Application Theme Selection v2016.3+
Choose from a selection of available user interface themes. See Application Themes for more information.
After choosing a theme, users should clear their browser cache and refresh the user interface in order for the theme change to take effect.

Show Data Fields Search Box v2017.2+
Data Fields Search Mode
Enables/Disables the data field search tools in the Data Fields Pane of the ExpressView, Advanced Report and Dashboard Designers.
Disabled — there is no search box
As You Type — search results display as the user types
On Submit — search results display after hitting the Enter key
Note
We highly recommend setting Column Metadata, and setting Schema Access Type to Metadata for all available objects, before
enabling this feature.

Programmable Object Settings
This article applies to the Admin Console >

General >

Programmable Object Settings.

The Programmable Object Settings enable you to specify names for parameters that will be passed from Exago to stored procedures,
web services, or .NET Assemblies. Using these parameters will allow filtering to be done before the data is sent to Exago. This can
increase performance and reduce server resources when using Programmable Objects. For more information on these types of Data
Objects see Web Services & .NET Assemblies.
Note
If performance is a concern, especially for large data sets, database-joinable objects, such as tables, views, and table-valued
functions, are preferable to programmable objects.
Names for the following Parameters can be set:

Call Type Parameter Name
Integer that specifies what Exago needs at time of the call. There are three possible values.
0 : Schema — return a data set with no rows (only the schema information).
1 : Data — return a full data set.
2 : Filter Dropdown Values — return data for the filter dropdown list. The Data Field requested is passed in the Column
parameter and the filter value is passed in the Filter parameter (see below). The direction the user is scrolling the dropdown is
passed in the Sort parameter as either ASC (scrolling down) or DESC (scrolling up).

Column Parameter Name
Call Type = 1: List of columns required to execute the report, separated by commas.
When Call Type = 2: Column being requested by the filter dropdown.

Filter Parameter Name
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When Call Type = 1: The filter string specific to the Data Object being called passed as standard SQL.
When Call Type = 2: The current value of the filter whose dropdown is being requested.

Full Filter Parameter Name
When Call Type = 1: The filter string for the entire report passed as standard SQL.
When Call Type = 2: The Tenant and Row Level filters passed as standard SQL.

Sort Parameter Name
The sort string for the report.
If using call type 2, it can indicate which direction the user is scrolling a filter dropdown. ASC indicates scrolling down or DESC indicates
scrolling up.

Data Category Parameter Name pre-v2021.1
The Data Object’s name. Can be used in conjunction with the Data Object ID Parameter.

Data Object ID Parameter Name
Id of Data Object being called. For more information see Calling a Single Web Service/.Net Assembly/Stored Procedure.

Filter Settings
This article applies to the Admin Console >

General >

Filter Settings.

Introduction
The Filter Settings provide control over what filter options are exposed to users and how the dropdowns within filters behave.

Settings
Select your version of Exago from the Application Version dropdown on the right-side of this article to show only the settings available in
your version.

Show Group (Min/Max) Filters
Enables/Disables the Min/Max Filter menu. Set to False to disable users from using Min/Max filters.

Show Top N Filters v2017.1+
Enables/Disables the Top/Bottom Filters menu in the ExpressView and Advanced Report designer. Top N filters allow users to see the
highest or lowest values for a data set. Set to False to disable users from using Top N filters.

Allow New Filters at Execution
Controls the creation of new filters when a user is prompted for a filter value at the time of report execution. Set to False to disable new
filters from being created at execution.

Read Database for Filter Values
Enables/Disables filter dropdowns to contain values from the filter field's data object.
Set to False only if retrieving the values for the dropdown will take more than a few seconds.

The Filters tab of the ExpressView Properties Pane with Read Database for Filter Values set to True (top) and False
(bottom). Note the lack of the filter dropdown arrow in the bottom figure.

Allow Filter Dependencies
Causes filter drop downs to retrieve values dependent on the filters above them in the menu. Set to True to enable. Default value is False.
For a full description of how this feature works, review the Filter Dependency section of the Filters article.
Note
This setting only works for Data Objects from databases and will not change drop downs from Web Services, .NET Assemblies and
stored procedures.

Show Filter Description
Enables/Disables reports to have description text for the filters menu. The filter description is set in the Description tab of the New Report
Wizard or from the Description item on the Report Designer's Settings menu.
A Help

icon will appear in the Filters dialog and display the filter description when clicked.
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Default Filter Execution Window
Determines the default type of window that appears when prompting users for filter execution input:
Standard — New reports display the standard filter execution window, allowing filters to be modified and new filters to be created.
Simple with Operator — New reports display a simplified filter execution window that only allows the operator and value to be
changed.
Simple without Operator — New reports display a simplified filter window that only allows the value to be changed.
Custom — New reports use a custom built filter execution window. When this option is chosen, Allow User to Change Filter
Window should be set to False and a value be provided for Custom Filter Execution Window. This is a deprecated feature and
should not be used in new installations.

Allow User to Change Filter Window
Enables/Disables reports to change the type of filter execution window that is displayed.

Include Null Values for 'NOT' Filters
Indicates to include NULL values for filters with using the operators ‘not equal’ or ‘not one of’.

Custom Filter Execution Window
Specifies a control or URL that contains Custom Filter Execution Window. This is a deprecated feature and should not be used in new
installations.

Restore All Default Date Filter Functions v2016.3+
Restores the default Filter Functions to the Extensions menu.

Restore All Default Formula Functions v2017.2+
Restores the default Custom Functions to the Extensions menu.

Database Settings
This article applies to the Admin Console >

General >

Database Settings.

The Database Settings allow administrators to adjust how Exago interfaces with the data sources. Additional type-specific settings allow
you to specify which driver to utilize when connecting to each data source.

Settings
Select your version of Exago from the Application Version dropdown on the right-side of this article to show only the settings available in
your version.
The following Database Settings are available:

Database Settings
Database Timeout
A value that is passed to the data provider's CommandTimeout property as Exago queries the business intelligence data source. It is up
to the data provider what to do with this value. This timeout has no effect on connections to Folder Management or databases, if
applicable.
Caution
This value is passed on to the data source provider when the report is executed. Each data source driver, data source or individual
database may interpret this setting slightly differently. Consult the official product documentation associated with your data source
implementation for complete details how this setting will impact your environment.
Note
This setting will also control the maximum number of seconds that a Web Service API method can run. If set to 0 the Web Service API
time out will be infinite.

Database Row Limit
Maximum number of rows returned on an execution. This only applies to Tables, Views and Functions. Set to 0 to return all rows.

Row Limit Step Size
Maximum number of rows returned on a query. Set to 0 to return all rows. Set greater than 0 to enable Incremental Loading for
Advanced Reports and ExpressView. The value determines how many rows are returned for each user-initiated data query.

Disable Non-Joined Data Objects
If True users are not able to add Data Objects to a report that do not have a join path with at least one other Data Object on the report. Set
to False to disable this restriction.
This setting does not have an affect for ExpressView unless Feature/UI Settings > ExpressView Settings > Fields Enabled in Data
Fields Tree is set to Direct Joins Only.

Enable Special Cartesian Processing
If True any one-to-many Joins will cause special processing to avoid data repeating on the report. Set to False to disable this behavior.

Aggregate and Group in Database
If True, aggregate and grouping calculations will be done in the database when possible. This will provide a performance boost for reports
with group sections.
Important
Before enabling this, you must ensure that all One-To-Many Joins in your environment are correctly identified and set as One-To-Many in
the Join options menu. If these joins are not properly identified, reports which utilize them will return incorrect aggregate data. See

53 of 201

Database Settings

Technical Guide

Database Aggregation for more information.

Convert Formula Filters and Sorts to SQL v2018.2–v2020.1
If True, formula filters and sorts will be converted to SQL when possible. The converted SQL statements will be placed in the WHERE (for
formula filters) and ORDER BY (for formula sorts) clauses when querying data for the report. If set to False, all formula filtering and sorting
will occur in-memory.
For more information, please see the Converting Formula Sorts to SQL section below.
Important
Due to innate difference between Exago's formula engine and SQL database engines, there may be discrepancies in data returned
between two methods. Additionally, because the converted SQL formulas may contain arbitrary input, the connection string must be
read-only access. For more information please see the Database Formulas article.

Type-Specific Database Settings
Each type of Data Source has the following settings available.
Click the AutoFill icon to automatically fill the Data Provider, Table Schema Properties, View Schema Properties, Function
Schema Properties and Procedure Schema Properties fields for each database type. Fields will be filled with data from the drivers
provided with the application.

Data Provider
Specify the name that can be used programmatically to refer to the data provider.
This matches the InvariantName found as a property of DbProviderFactories in the server's machine.config file.
Note
The machine.config file is located in the %SystemRoot%\Microsoft.NET\Framework\%VersionNumber%\CONFIG\
directory.

Table Schema Properties
Specifies how to retrieve the schema of tables.

View Schema Properties
Specifies how to retrieve the schema of views.

Function Schema Properties
Specifies how to retrieve the schema of functions.

Procedure Schema Properties
Specifies how to retrieve the schema of procedures.
Note
For any of the Schema Property settings you can dynamically refer to properties from the Data Source’s connection string by
surrounding the property name in @ symbols. For example, "@database@" will be replaced with the database name from the connection
string of the Data Source being queried.

Converting Formula Sorts to SQL
When Convert Formula Filters and Sorts to SQL is True, Exago will attempt to push all formula sorts to the database instead of running
them in memory. This feature converts formula sorts on a report to SQL syntax so that they can be appended to the ORDER BY clause of
the query. When applicable, formula sorting will then be pushed to the database level of report execution, improving execution
performance.
For example, a report may be sorted by the following formula, which organizes the data based upon whether or not an Order has a
Revenue of greater than or equal to $1000.
=(OrderDetails.Revenue)>=1000

This formula sort would be converted to the following SQL statement and appended to the ORDER BY clause of the query during report
execution.
ORDER BY
(CASE WHEN dbo.[OrderDetails].[Quantity] * dbo.[OrderDetails].[UnitPrice] >=
1000 THEN '1' ELSE '0' END) asc

Formula Dictionary
All defined Exago formula to SQL statement translations can be found in the dbconfigs.json file. The translations are located under the
Formula Dictionary property of each database type listed in this file. See Managing the dbconfigs.json File for more information.
For example, the following contains part of the Formula Dictionary for the MySQL database:
"FormulaDictionary":
{
"and": ["({0} AND {1})"],
"false":["(1=0)"],
"if": ["(CASE WHEN {0} THEN {1} ELSE {2} END)"],
"or": ["({0} OR {1})"],
"len": ["CHAR_LENGTH({0})"],
"true":["(1=1)"],
"date": ["STR_TO_DATE('{0}/{1}/{2}', '%Y/%m/%d')"],
...
},

SQL syntax translations may be added in this file for any custom functions that are defined. Functions may also be overloaded, meaning
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that a client can define multiple versions of a function that can take a variable amount of arguments and Exago will choose the correct
function based on the number of arguments that are passed to it. Functions with an unbounded number of arguments, however, cannot be
defined.

Notes on Behavior
Please take the following information into consideration when utilizing this feature:
Non-SQL databases (e.g., Mongo, ElasticSearch, Excel) do not support this feature. All sorting for reports using non-SQL
databases will occur in-memory.
DB2 is supported by this feature; however, there are limitations regarding what formulas can be translated to SQL when using this
database type.
If a sort contains reference to an object from a different data source than the one that is being queried for report execution, then all
sorting will occur in-memory.
If a sort contains reference to an object from an Excel data source, then all sorting will occur in-memory.
If no sorts exist on a report then no SQL will be appended to the query.
Boolean expressions will prioritize False values when set to ascending and True values when set to descending.
If sorts that cannot be properly translated to SQL exist on a report, then SQL statements will be generated and appended to the
database query up to the sort that cannot be translated. For example, if the third sort on a report is untranslatable, then only the
first two sorts will be translated and appended.
Calculations that are pushed to the database may differ in comparison to those run in-memory by Exago. For example, pi (π) is
rounded to the 15th digit in Exago but is only rounded to the 6th digit in MySQL by default. These differences in calculations vary
depending on the database type and should be taken into consideration when enabling this feature.

Scheduler Settings
This article applies to the Admin Console >

General >

Scheduler Settings.

Reports can be emailed or scheduled for recurring automated delivery to an email address. The Scheduler Settings are used to configure
these services. Before adjusting the settings, ensure that the Scheduler Service ExagoScheduler is installed, running, and set to
automatically start. For more information see Installing Exago Scheduler.
The Remote Execution service can be used to move processing to a different server or to provide load balancing across multiple servers.
For more information see Remote Execution.

Settings
Enable Report Scheduling
Enables/Disables scheduling and remote execution functionality in the application.
If False, will override Show Report Scheduling Option, Show Email Report Options, & Show Schedule Manager also to False.
If False, Enable Remote Report Execution is ignored.

Show Report Scheduling Option
Enables/Disables the
scheduling reports.

Schedule Report option when right-clicking on a report in the Report Tree. Set to False to disable users from

Show Email Report Options
Enables/Disables the

Email Report option when right-clicking on a report in the Report Tree.

Show Schedule Reports Manager
Enables/Disables the Schedule Manager

icon on the Main Menu.

Show Schedule No End Date Option
Enables/Disables users ability to create a schedule that never ends. Set to False to force users to set an end date limit to the schedule.

Show Schedule Intraday Recurrence Option
Enables/Disables options in the Recurrence tab of the Schedule Wizard to allow a schedule to repeat throughout the day.

Scheduler Manager User View Level
Controls what information each user can see in the Schedule Manager. These levels utilize the Parameters companyId and userId. There
are three possible values:
Current User: Can only view and delete report jobs that have been created by that user. This setting will hide the Host and
Company Id columns of the Schedule Manager.
All Users in Current Company: User can only view and delete report schedules for their company. This setting will hide the Host
column of the Schedule Manager.
All Users in All Companies: User can view and delete report schedules for all companies (administrator).
For more information, see User Identification.

Email Scheduled Reports
Set to False to have the Scheduling Service save reports to a file repository instead of attaching them to emails. For more details see
Saving Scheduled Reports to a Repository.

Enable Batch Reports
Set to True to allow users to schedule reports which are filtered separately for each recipient user. Batch reporting requires a table or other
data structure containing email addresses for the intended recipients associated with a key used to filter the reports. For more information
see Scheduling Reports.

Show Schedule Delivery Type Options
Enables/disables user option to choose the output type (i.e. email or save report to repository) with each schedule. When True, the default
value will reflect whatever is set in the Email Scheduled Reports setting.
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Use Secure Scheduler Remoting Channel
Enables/disables encrypting of data Set to true to cause data sent to remote schedulers to be encrypted. Each scheduler config file must
also have <secure_channel> set to true.

Schedule Remoting Host
Sets the protocol, server and port to the Scheduler Service. Separate multiple remoting hosts with a comma or semicolon. Click the
Test Connection icon to test the connection between the Web Application and the Scheduler Services.
The protocol and port must match the Scheduler Service's channel_type and port configuration settings, respectively.

Examples
http://localhost:2001
http://SchedulerOne:2001,tcp://SchedulerTwo:2001

Enable Remote Report Execution
Set to True to enable Remote Execution of reports by one or more Scheduler Services. Enable Report Scheduling must also be True
and a value must be provided for the Remote Execution Remoting Host.
Set to False to disable this behavior.
For more information, review the Remote Execution article.

Enable Execution Cache
Enables/disables users to use an execution cache for their reports. An execution cache refreshes report data on a schedule, and report
execution calls use the cached data instead of querying the data source each time the report is executed.
This dropdown will only display False until all conditions in the Enabling Execution Caching section of the Execution Caching article are
met. Then, this setting can be changed to True to enable the feature.

User Cache Visibility Level
Controls what visibility permissions users can assign to Execution Caches. Available levels utilize the parameters companyId and
userId. There are three possible values:
User: Users can only view cached report data for caches that they have created.
Company: Users can permit cached data to be visible to all other users in the user's company. Users can also select the User
option.
Global: Users can permit cached data to be visible to all other users for all other companies. Users can also select the Company
or User options.

Enable Access to Data Sources Remotely
When True, all calls, including populating Filter Value dropdowns and retrieving Data Object/Data Object schemas made to the Data
Sources are handled by the Remote Execution Remoting Host, or the Schedule Remoting Host if no Remote Execution Remoting
Host is defined.
When False, the Scheduler Services will only make calls to the Data Sources during report execution. All other calls are handled by the
Web Application.
Enabling this feature is helpful when whitelisting connections to the Data Sources, and connections should only originate from the the
designated Remote Execution Remoting or Schedule Remoting Hosts as opposed to the Web Application servers; or when the Scheduler
Services and the databases are on the same firewall level but the Web Application is not.

Remote Execution Remoting Host
Specifies the Scheduler Services to use for remote execution. Separate multiple servers with commas or semicolons. Click the Test
Connection icon to test the connection between the Web Application and the Scheduler Services.
The protocol and port must match the Scheduler Service's channel_type and port configuration settings, respectively.

Example
http://MyHttpServer1:2001,tcp://MyTcpServer:2001

Custom Queue Service
Specifies the web or assembly queue service for custom scheduler management and load balancing. See Scheduler Queue for details.
Click the Test Connection icon to test the connection between the Web Application and the Queue Service.

Delete Schedules upon Report Deletion
When a report is deleted corresponding schedules can be deleted automatically by Exago. Set to True to enable this behavior.

Default Email Subject
Set a default subject that will be displayed in the schedule report wizard.
Internal Parameters such as @reportName@ may be utilized in this area.

Default Email Body
Sets a default body that will be displayed in the schedule report wizard.
Internal Parameters such as @reportName@ may be utilized in this area.

Password Requirement (for pdf and excel documents)
Requires a password for PDF or Excel file export. This parameter can be made up of the following values:
A: requires an upper case letter for each ‘A’
a: requires a lower case letter for each ‘a’.
n: requires a numeric character for each ‘n’
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4: password must have at least 4 characters
For example, ‘AAnna6’ would require a password of at least six characters with 2 capitals, 1 lower case and 2 numeric characters.

Custom Scheduler Recipient Window
Provides URL, height and width for custom Scheduler Recipient window. This is a deprecated extensibility feature and should not be used
in new installations.

Show "Reply To" Field in the Scheduler "Recipients" Tab
Displays the email specified in the userEmail parameter in the Recipients tab when scheduling a report. Any replies to the scheduled
report will be sent to this email address instead.

Other Settings
This article applies to the Admin Console >

General >

Other Settings.

Select your version of Exago from the Application Version dropdown on the right-side of this article to show only the settings available in
your version.

Excel Export Target
Choose the type of Excel export you would like. Choosing 2003 will automatically split the workbook into multiple worksheets when
Excel’s row limit is reached.
Note
Linux does not support setting the Excel export target to 2003.

External Interface
Provide a Web Service URL or .NET Assembly to interface with the external module. This is a deprecated extensibility feature that should
not be used in new installations.

Enable Paging In the Report Viewer
Controls when data for Report Viewer output is sent to the client. Set to True to send data as each page is requested. If this is set to
False, it restricts the interactive HTML hide/show column option in the Report Viewer.
Note
When enabled, it will cause multiple requests from the server.
Set to False to send all the data to the client browser at once.

Renew Session Automatically
This setting is used to bypass the session timeout property set in web.config. Set to True to send a server side AJAX callback every
two minutes to keep the session from expiring.
Note
This will only work if the timeout period set in web.config is greater than two minutes.

Write Log File
Important
Setting the log level to DEBUG in a production environment can have unintended performance consequences. Only use DEBUG level
logging in production temporarily and under advisement from the Exago Support, Services or Development teams.
Set the level of detail logged in the Exago log file. See Application Logging for information about the different log levels. This setting will
be overridden by a log4net.config file.

Enable Debugging
Set to True to enable debugging. For more information see Submitting a Debug Package.

Max Report Execution Time (minutes)
Specify how long, in minutes, reports should run before timing out. Default is 240 minutes (4 hours).

Maximum Age for Temp Files
Determines the maximum number of minutes a temp file can exist before Exago’s automatic cleanup removes it.
Important
Understand that setting the maximum age too low may cause an error, as users might spend some time viewing a report executed in
HTML, which uses AJAX to read temp paging files.
The default value is 1440 minutes (1 day). The minimum this value can be set to is 30 minutes.

Enable Web Service/Assembly Data Mapping
Allows Web Service and .NET Assembly methods to replace Data Field names.

Limit Reports and Visualizations to One Category
Limits reports and visualizations to Data Objects within a single category. Set to true to restrict reports and visualizations to one category,
or false to allow Data Objects from multiple categories.
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Run Aggregate Functions at Record Level by Default v2019.1.8+
The recordLevel argument of all aggregate functions will default to this value if no value for recordLevel is passed when the
aggregate function is called. If True, aggregate functions run at the record level (including duplicates). If False, aggregate functions run at
the entity level which is the default behavior.
By default, set to True

Cache External Services
Caches external Web Services and .NET Assemblies. Setting to False may reduce performance due to loading/unloading of services.

Global Schema Access Type
Specifies whether to query the Data Source for an object’s schema or to read it from Column Metadata. See Retrieving Data Object
Schemas for more information.

Allow Multiple Sessions
Allows multiple sessions of Exago per user. Set to True to enable this behavior.

Allow MD5 Hashing on FIPS Server
Allows a FIPS-compliant server to encrypt PDF files by using an alternate MD5 library to the built-in System.Cryptography.

Write BOM to CSV Files v2019.1.1+
Attaches a Byte Order Mark (BOM), an optional abstract character used to declare and recognize Unicode encoding of a text file, to the
beginning of CSV file exports. Set to True to enable.

Enable Report List Caching pre-v2020.1
Note
This setting has moved to the Storage Management section as of v2020.1

If True, the

Report Tree list will be cached rather than being read fresh each time it is needed. Default value is True.

Enable Report XML Caching pre-v2020.1
Note
This setting has moved to the Storage Management section as of v2020.1
If True, the XML report definition files will be cached rather than being read fresh each time they are needed. Enabling this setting will
reduce the number of calls to the report storage mechanism and may help with performance. Default value is True.

Report XML Caching Timeout pre-v2020.1
Note
This setting has moved to the Storage Management section as of v2020.1
If Enable Report XML Caching is True, set the timeout in seconds that the Report XML cache should expire. Report definition files in the
cache that are this number of seconds old or older will be refreshed from report storage.

'LoadImage' Cell Function Parameter Prefix
A string that is prepended to the LoadImage function when the report is run. This setting allows an administrator to hide the report path of
images on your server. This field is ignored for images loaded from a database.

Ignore Inaccessible Report Folders
If False, Exago throws an error message if a folder has an accessibility issue. Set to True to ignore the error and hide the inaccessible
folder.

User ID
Sets the User ID necessary to gain access to the Administration Console and REST API. Leave blank to permit unverified access to the
Administration Console.

Password
Used in conjunction with User ID to gain access to the Administration Console and REST API.

Confirm Password
Used to confirm the value of Password.

Debug Password
A password that enables clients to send a debug package directly to Exago Inc. Leave blank to disable Debug Extraction. When set to
True, correct permissions must be set on the ./Debug Folder. For details see the Submitting a Debug Package article.

REST Key
Set a key to authenticate REST requests. Review the Authorization section of the Introduction to REST article for more information.

Exago Expiration Date
A date when users will no longer be able to access Exago.

Custom Code Supplied by Exago
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Used for custom functionality.

License Key
Used to activate purchased add-on Exago features.

Data Sources
This article applies to the Admin Console >

Data >

Sources settings.

Data Sources establish the connection between Exago and a database or a web service. Although typically only one database is used,
Exago can join data from different sources into a single report.
Note
To utilize some types of data sources, the appropriate driver may need to be downloaded and installed separately from the Exago install
process. Refer to Data Source Drivers below.

Creating, Editing or Deleting Data Sources
To add a new data source click

Sources in the Main Menu and either:

click the Add
icon at the top of the main menu
right-click and select Add from the context menu
To edit a source either:
double click it
select it and click the Edit
icon at the top of the main menu
right-click it and select Edit from the context menu
To delete a source either:
select it and click the Delete
icon at the top of the main menu
right-click it and select Delete from the context menu
To save changes and new objects click the Apply or Okay buttons.

Data Source Properties

Each data source must have the following:

Name
A friendly name for the Data Source that will be referenced in the application.

Type
The type of source being used. Valid types include:
Relational databases
SQL Server — Microsoft SQL Server
MySQL
Oracle
Postgres — PostgreSQL
DB2 — IBM db2
Informix — IBM Informix
ODBC — ODBC Driver
Non-relational databases
MongoDB v2018.2+
ElasticSearch v2018.2+ — ElasticSearch/ELK database (For more information see CData Drivers.)
Data warehouses
Redshift v2019.1.11+
Snowflake v2019.1.9+
Other
File — XML or Excel file (For more information see Excel and XML Files.)
.NET Assembly — .NET Assembly DLL (For more information see .NET Assemblies.)
MS OLAP — OLAP (For more information OLAP and MDX Queries.)

Schema/Owner Name (blank for default)
If using schema to provide multi-tenant security, provide a database schema. Otherwise, leave this field blank. For more information, review
the Multi-Tenant Environment Integration article.

Connection String
The method that is used to connect to the data source. Connection strings vary by type:
Type

Connection Strings
Refer to connectionstrings.com for database connection strings.
If using Integrated Authentication from an IIS Application Pool to connect to a remote MSSQL or
Microsoft SQL Server Analysis Services (SSAS) server, review these MSDN and Stack Overflow
articles to ensure the correct credentials are sent to the SQL server.

mssql, oracle, postgres, mysql
and olap

The database driver specified in Database Settings determines the character set used in the
application. If the data in the data source uses a different character set, it should be explicitly set in
the connection string.
For PostgreSQL data sources using the Npgsql driver and all lowercase schema names, set the
UseDelimitersOnSchema directive in dbconfigs.override.json to true for best results. See
the Overriding dbconfigs Information section of the Managing the dbconfigs.json File article for more
information.
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Required parameters:

assembly

assembly – The full path of the assembly name.
class – The class name in the assembly where the static methods will be obtained.

file

Requires the physical path to the Excel or XML file and the file type.
Example: File=C:\example.xls;Type=excel;

mongodb

For more information see CData Drivers

elasticsearch

For more information see CData Drivers

snowflake

For more information see CData Drivers

redshift

For more information see CData Drivers

Click the Test Connection icon to verify the connection succeeds.
Click the Make Connection String Visible or Connection String Hide
Data Source tab.

icons to show/hide the connection string in the

Data Source Drivers
Below is a list and the associated links for recommended ADO.NET drivers for each type of data source.
SQL Server
No external ADO.NET driver needed
Oracle
Oracle ODAC Connector
Oracle.ManagedDataAccess.Client
MySQL/MariaDB
Devart Connector
MySql.Data.MySqlClient
PostgreSQL
Devart Connector
Npgsql
DB2/Informix
IBM Data Server Driver Package — 5.exe or newer
Elasticsearch, Redshift, Snowflake, MongoDB
CData ADO.NET drivers

MySQL on Linux v2019.2+
As of v2019.2 the Exago Linux Installer does not install a MySQL ADO.NET driver at the time of installation. Instead, clients wishing to
use a MySQL data source for either reporting or for Storage Management will need to provide their own.
Exago has provided wrappers around two popular MySQL data drivers that clients may choose to install on their own.
Devart dotconnect free edition
MySQL ADO.NET
Contact your Customer Success Manager or the Exago Support Team for assistance. Install the driver by extracting the contents of the
download and then running either installMySql.sh or installDevartMySql.sh as root. Provide the Exago installation path to the
installer script. For example:
sudo ./installDevartMySql.sh /opt/Exago

Once installed, update the Admin Console > General > Database Settings to reflect the new data provider.

.NET Assemblies
.NET Assemblies can be used as data sources. This is possible when the .NET Assemblies underlying methods are setup as data
objects.
An advantage of doing this is being able to use high-level language to manipulate the data being reported on at run-time. The main
disadvantage is not being able to take advantage of the database to perform joins with other data objects; data from methods can still be
joined, but the work to do this is done within Exago. For more information see Note about Cross Source Joins.

Parameters
Parameters are passed from Exago to .NET Assemblies. Three types of parameters can be passed but only Call Type is required.

Call Type (required)
Integer that specifies what Exago needs at the time of the call. There are three possible values. You may specify the name of this
parameter in the Programmable Object Settings of the General section.
0 : Schema - returns a DataSet with no rows.
1 : Data - returns a full DataSet.
2 : Filter Dropdown Values – returns data for the filter dropdown list. The Data Field being requested is passed in the column
parameter. The filter type is passed in the filter parameter (see below).

Column, Filter and Sort Strings
To optimize performance Exago can pass user-specified sorts and filters to the .NET Assembly. This process reduces the amount of data
sent to Exago. If these parameters are not used, all of the data will be sent to Exago to sort and filter. Column, filter and sort strings are
sent as standard SQL. You may specify the name of these parameters in the General > Programmable Object Settings section.

Custom Parameter Values (optional)
Additional parameters can be specified to be sent to individual methods in the Data Object Menu.
Important
To increase performance, when a .NET Assembly is first accessed it is compiled and cached within Exago. Therefore, Exago will not be
aware of any changes within .NET Assembly. If the assembly is subsequently changed, reset the internal cache by clicking the Test
Connection icon restarting the web server.
Note
If an Exago .NET API application needs to access reports with an assembly data source, it must include a reference to the assembly
WebReportsAsmi.dll.
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SessionInfo (optional) v2016.2+
Session state variables. See SessionInfo for more information.

.NET Assemblies
It is important to note that when a connection string for .NET Assembly is set the class name must match the name of the class where
the static methods will be searched. UNC or absolute paths may be used. Make sure that the assembly has read privileges for the IIS user
running Exago. Below is an example of a .NET Assembly connection string:
assembly=\\MyServerName\MyShareName\MyAssembly.dll;class=Main

.NET Assembly methods must be static. Below is an example of a .NET Assembly method.
public class Main
{
public static DataSet dotnet_optionees(int callType, string columnStr, string filterStr, int myCustomParameter)
{
switch (callType)
{
case 0:
// return schema
case 1:
// return data
case 2:
// return filter values for dropdown
}
}
}

Method signature using SessionInfo (v2016.2+):
public class Main
{
public static DataSet dotnet_optionees(WebReports.Api.Common.SessionInfo sessionInfo, int callType, string columnStr, string filterStr, int myCustomParameter)
{
switch (callType)
...
}
}

Excel and XML Files
Exago can read Microsoft Excel workbooks and XML files as Data Sources.
Caution
Excel workbooks and XML files will have less speed, performance, and security of a database. Using Excel and XML files is
recommended only if the dataset is small or if the information is only available in this format.

Excel
Each worksheet in the Excel file will be read as a separate table with the sheet name as the table's name. The top row will be read as the
column headers, and the remaining cells will be read as the data. Do not leave any blank rows or columns.

Connection String Example
File=C:\example.xls;Type=excel;

XML
The XML document must begin with the schema. After defining the schema the data must be placed into the appropriate tags. For
reference see the working example below:
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<?xml version="1.0" encoding="UTF-8"?>
<ExagoData>
<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema" xmlns:msdata="urn:schemas-microsoft-com:xml-msdata" id="ExagoData">
<xs:element name="ExagoData" msdata:IsDataSet="true" msdata:UseCurrentLocale="true">
<xs:complexType>
<xs:choice minOccurs="0" maxOccurs="unbounded">
<xs:element name="Call">
<xs:complexType>
<xs:sequence>
<xs:element name="CallID" type="xs:unsignedInt" minOccurs="0" />
<xs:element name="StaffID" type="xs:string" minOccurs="0" />
<xs:element name="VehicleUsed" type="xs:unsignedInt" minOccurs="0" />
</xs:sequence>
</xs:complexType>
</xs:element>
<xs:element name="Staff">
<xs:complexType>
<xs:sequence>
<xs:element name="StaffID" type="xs:unsignedInt" minOccurs="0" />
<xs:element name="Rank" type="xs:string" minOccurs="0" />
<xs:element name="LastName" type="xs:string" minOccurs="0" />
<xs:element name="FirstName" type="xs:string" minOccurs="0" />
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:choice>
</xs:complexType>
</xs:element>
</xs:schema>
<Call>
<CallID>890</CallID>
<StaffID>134</StaffID>
<VehicleUsed>12</VehicleUsed>
</Call>
<Call>
<CallID>965</CallID>
<StaffID>228</StaffID>
<VehicleUsed>4</VehicleUsed>
</Call>
<Call>
<CallID>740</CallID>
<StaffID>1849</StaffID>
<VehicleUsed>2</VehicleUsed>
</Call>
<Staff>
<StaffID>134</StaffID>
<Rank>Captain</Rank>
<LastName>Renolyds</LastName>
<FirstName>Malcom</FirstName>
</Staff>
<Staff>
<StaffID>228</StaffID>
<Rank>Lieutenant</Rank>
<LastName>Brown</LastName>
<FirstName>Bill</FirstName>
</Staff>
<Staff>
<StaffID>1849</StaffID>
<Rank>Sergeant</Rank>
<LastName>John</LastName>
<FirstName>Pepper</FirstName>
</Staff>
</ExagoData>

Connection String Example
File=C:\example.xml;Type=xml;

OLAP and MDX Queries
Exago can query OLAP Data Sources using MDX Queries. OLAP Data Sources and Objects are identical to a regular data base type
object, with the following exceptions:
Data Objects belonging to OLAP type Data Sources must have their Schema Access Type set to Metadata and must have
Column Metadata set for all fields.
OLAP Data Objects will always be MDX Queries written in the Custom SQL Object dialog. These queries are passed directly
through to the data source. Exago simply passes through the MDX query to the data source and does not modify it in any way.
Therefore, all filtering and sorting are done in memory, tenanting at the data object level and database aggregation do not work with
OLAP data sources.
Connecting to a Microsoft SQL Server Analysis Services (SSAS) data source will use Integrated Authentication. See the notes in the
Connection String section above how to handle this situation. In a general sense, the IIS Application Pool will need to login with a
credential assigned in an appropriately provisioned SSAS role on the data source.

Sample Connection String
Data Source=SERVER1\MSSQLSERVER2014;Catalog=AdventureWorksDWAnalysis;

Tip
The Catalog parameter should match the Database name in Microsoft SQL Server Manageent Studio.

62 of 201

Assembly Data Sources

Technical Guide

Using Azure based SSAS
In order to use an Azure based Microsoft SQL Server Analysis Services Database (SSAS) you need the most up to date ADOMD.NET
driver, which is available from Microsoft. Then, in order to properly configure Data Object entities through joins, the following information
must be provided:
The entity containing the primary key should be specified in the "From" section.
The entity containing the foreign key should be specified in the "To" section.
The IDs used in the join configuration must be included in the metadata fields and should be available in the design model.

ODBC Drivers
Exago can use ODBC drivers to connect to data sources. When connecting to an ODBC data source, an extra option will appear to set
the Column Delimiters. The delimiter character depends on which type of data base you are connecting to.

Examples
MySql
' (grave accent)

MsSql, OLAP
[] (brackets)

DB2, Informix, Oracle, Postgres, Sqlite
" (quotation marks)

If you don't know which delimiter character to use, contact your database administrator.
Warning
If your data objects have spaces in their names, you must set the correct delimiter in order to access the data. Otherwise, improper SQL
will be generated and you will see errors or erroneous data.

CData Drivers
As of v2018.2+, Exago allows for additional data source types through CData ADO.NET drivers. For more information, see the article on
CData Drivers.

Assembly Data Sources
Exago supports the ability to retrieve data from .NET assemblies. Assembly Data Sources are custom programmatic .NET Framework
binaries for transforming and exposing arbitrary data in a format that can be read by Exago BI.
Assembly Data Sources can be used as data connectors and drivers for unconventional data sources. They can also be used as Extract,
Transform, Load (ETL) layers for processing, combining, and caching data before it reaches the reporting engine. This article describes
how to write custom .NET Assembly Data Sources for Exago BI.
Assembly Data Sources must be written for and compiled with supported versions of the .NET Framework, and must be compiled as a
class library (.dll).

Interface
Assembly Data Sources must implement the following interface.
The entry point or points for Exago BI are public static methods, which accept at minimum an integer Call Type parameter and return an
ADO.NET System.Data.DataSet object. The Call Type parameter name must be defined in Admin Console > General >
Programmable Object Settings > Call Type Parameter Name.
Note
Although the return type is a DataSet, each Assembly Data Souce method is expected to return only a single data table. This is usually
done by merging in a System.Data.DataTable object which has a schema and has been populated with data.
If a DataSet with multiple tables is returned, only the first one will be recognized.
Entry methods can optionally accept some or all other parameters described in the Programmable Object Settings, in order to have
additional context for the method call. All the parameters in use must have defined names in the Admin Console.
Entry methods may also access a WebReports.Api.Common SessionInfo object. This contains the active session's configuration
settings and references to the active API objects. It can be used to identify properties as well as mutate session state. An assembly
reference to bin\WebReportsApi.dll is required for the SessionInfo class definition.

Method Examples
Considering the following parameter names defined in Admin Console > General > Programmable Object Settings:
Call Type Parameter Name: CallType
Column Parameter Name: Columns
Filter Parameter Name: Filter
The following are a few examples of valid entry method signatures:
public static DataSet Method(int CallType)
public static DataSet Method(int CallType, string Columns, string Filter)
public static DataSet Method(int CallType, string Columns = "")
public static DataSet Method(SessionInfo Session, int CallType)
public static object Method(SessionInfo Session, object CallType)
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There can be more than one entry method. Each public static method in the class will appear as a virtual table when adding the Assembly
Data Source in the Admin Console.
Alternatively, one method can support multiple tables by incorporating the Object ID parameter, which passes the object ID as defined in
the configuration. See Handling Multiple Data Tables for details.

Additional Notes
1. Methods cannot be overloaded, as it will be ambiguous which one Exago BI should use.
2. For security reasons, only the entry methods in the class should be public, so that any other utility or methods are not erroneously
visible in the Admin Console.

Class Definition
The entry methods must reside within a public class (non-static) within a defined namespace. The class must be at the top level of the
namespace, not within another class. Its default constructor must be public (defining the constructor is optional).

Example
namespace AssemblyDataSource {
public class Tables {
public Tables() { ... } /* optional */
public static DataSet EntryMethod(...) {...}
}
}

Implementation
Each Assembly Data Source query is a discrete atomic operation. While Exago BI can optionally cache the assembly in memory, the
application will not maintain a connection between queries. Unless you store application state on disk, queries will have no knowledge of
each other.
Assembly Data Source method calls are synchronous, meaning that the main application thread will wait until the method returns before
continuing.
Exago BI queries Assembly Data Sources for three distinct reasons:
Schema: The column/field names and data types. This is called whenever the schema needs to be retrieved (such as expanding a
Data Object's fields in the ExpressView data objects pane) and the Schema Access Type is set to Datasource. The frequency of
schema calls can be significantly reduced by specifying a static schema for the Assembly Data Source in the Column Metadata.
Data: The data values for the table. This is called whenever a report is executed.
Filter values: Data values for a single column, possibly filtered by an input string. This is called when values need to be populated
for a filter dropdown list.
Each type of query requires a different amount of information to be returned. The Programmable Data Object parameters are passed
alongside each query to indicate the information that Exago BI is expecting. With this in mind, you can write ADS with certain
optimizations to improve performance. It is highly recommended to use the Programmable Data Object parameters for this reason.
Note
If performance is a strict concern, consider that databases will almost always be more performant for large data sets than Assembly
Data Sources.
See Optimizing for Query Types for more details.

Data Format
Exago BI expects an ADO.NET DataSet object to be returned from the Assembly Data Source method. A DataSet is an in-memory
representation of a relational data model.
Important
To return no data, for any reason, construct and return a DataSet with the schema and no rows. Sending null or an empty schema will
cause an exception to be thrown.
Exago BI reads only the first DataTable in a set, at index DataSet.Tables[0], regardless of the number of tables comprising the set.
To return multiple tables from an ADS, return a different DataSet depending on an input parameter or method name. See Handling
Multiple Data Tables for more information.
See DataSets, DataTables, and DataViews for the ADO.NET DataSet documentation.

Optimizing for Query Types
Avoid retrieving the full data set whenever possible. This is usually the most computationally intensive query task. A number of
Programmable Object Parameters are passed to the Assembly Data Source in order to determine the amount of processing required for
each query.

The ADS query types, what data they expect, and how the data is processed by Exago

Using the Call Type Parameter
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Call Type is an integer parameter, with value 0 for a schema query, 1 for a data set query, and 2 for a filter values query.
Schema queries are expected to be quick, and do not require the actual data table. Returning a static schema is the most performant way
to handle this. Do not make the application wait to populate the full table.
Warning
It is highly recommended to set the Schema Access Type for the Assembly Data Source to Metadata in order to eliminate schema
queries to the data source. This will significantly improve the responsiveness of the user interface.
Filter values query a single data column, with a text filter applied to limit the number of values returned. Therefore this call type works best
with the Column and Filter parameters.

Column, Filter, and Full Filter Parameters
For data queries (Call Type 1), it is not strictly necessary to implement these parameters to filter the data in the Assembly Data Source,
because Exago BI will filter the data regardless once it is returned to the application.

Suppressing Application Filtering & Sorting v2018.1
You have the option to suppress the default application filtering and sorting of data returned for data queries. You can choose to filter and
sort in the Assembly Data Source code instead, which allows for more control over the manner in which these processes are done.
To suppress application filtering and sorting for selected objects, set the Suppress Sort and Filter setting for each Data Object in the
Admin Console to True for each object.
Note
Suppression will only occur for reports where the object is joined exclusively to zero or more programmable objects which also have
suppression enabled. In-memory processing such as advanced joins, Special Cartesian processing, and sort and filter formulas will
override this setting and force application processing to occur.
Caution
Exago will not filter the dropdown values for filter values queries (Call Type 2) by default. It is highly recommended to apply filtering for
these queries in the Assembly Data Source to avoid inaccurate and potentially insecure behavior for the filter dropdown lists. Therefore,
these parameters should not be seen as optional for all but the most trivial applications.
The following table shows the parameter values for either data or filter values queries.
Call Type
Column
Filter
Full Filter

Sort

1
Data
List of requested column database names
"col1,col2,col3"

2
Filter values
Requested column database name
"col2"

Data object filter SQL
"(col1 = 'value') AND (tenantId = 'id')"

Filter dropdown value
"value"

Report filter SQL
"([obj].[col1] = 'value') AND ([obj].[tenantId] = 'id')"

Tenant and row-level filter SQL
"([obj].[tenantId] = 'id')"

Sort SQL
"col3 asc, col1 desc"

Sort SQL
"col3 asc, col1 desc"

Expected DataSet with requested columns, optionally filtered
Return

DataSet with single column, filtered

The Column parameter will give the list of fields necessary for a report execution (data query) or the field requested by a filter dropdown
(filter values query). It may be more performant to build the DataSet with only the requested columns.
Filtering for data queries is only required if the Suppress Sort and Filter setting (v2018.1+) is True. Otherwise Exago BI automatically
filters the data set in memory for data queries.
You must apply filtering for filter value queries.
What is a filter values query?
Several activities in the application involve querying a table for a list of values from a single field, possibly filtered by a user input string. This
occurs when users interact with filter dropdowns, so that they can view and select valid field data when creating report filters.

Example of interaction with a filter dropdown
Note
Report Viewer and Dashboard interactive filters are populated by the data query for the report execution, not by a separate filter values
query.
You can prevent this type of query entirely by setting the Admin Console >
Values setting to False.

General >

Filter Settings > Read Database for Filter
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Note
It is not possible to implement Filter Dependencies in an Assembly Data Source.
Typing into a filter dropdown field causes it to return values filtered by the input text. This filtering must be done manually in the Assembly
Data Source for two reasons:
1. Accuracy — Dropdown lists are not filtered by Exago BI, so typing to filter will be ineffective if not implemented manually.
2. Security — Row and column tenancy filters must be applied to the dropdown list so that users cannot view data values without
access rights.
The Column, Filter, Sort and Full Filter parameters must be combined together to generate the proper filtering. With Call Type 2, the
Column parameter contains the name of the requested data field, and the Filter parameter contains the input text. These can be
combined to generate the necessary SQL WHERE clause.
Example:
string SQL = string.Format("(CONVERT({0}, System.String) LIKE '%{1}%')", Columns, Filter);
// Note: DateTime columns should use a different comparison

The Full Filter parameter already contains the necessary tenancy SQL specified in the data object and active role settings, so this can be
easily added to the input filter SQL to create the full clause. Then apply it to the data set and return only the resulting rows.
As of v2019.1.11+ the Sort Parameter can be used to indicate in which direction the user is scrolling a filter dropdown. ASC indicates
scrolling down or DESC indicates scrolling up.
SQL += " AND " + FullFilter + Sort;
DataRow[] DropdownRows = FullTable.Select(SQL);
// Note: In a proper implementation be sure to sanitize the SQL before passing it to the db

Additional Considerations
DateTime comparisons should be handled in a different manner than with a LIKE operator.
Only distinct values are shown in the dropdown, so there is no need to use a DISTINCT clause in the SQL statement.
A maximum of 100 values are shown in the list. You can choose to implement a TOP 100 clause, if it would improve performance.
As of Exago BI v2017.3+, for database sources, end-users have the option of selecting whether their filter dropdown input should
apply a Starts With or Contains rule to the data field filter. This behavior cannot currently be implemented in an Assembly Data
Souce, because the value of this setting is not passed in a parameter.
As of v2017.3+, values are queried incrementally as the user scrolls the dropdown list, for supported sources. This is also not
currently supported by Assembly Data Sources.

Sort Parameter
It is only required to sort in an Assembly Data Source if the Suppress Sort and Filter setting (v2018.1+) is set to True for the Data
Object associated with it. Otherwise Exago BI automatically sorts the data set in memory for data queries.
Note
Formula sorts use the application's internal formula engine. It is impossible to handle formula sorts in an Assembly Data Source code.
Note
The Sort parameter is irrelevant for filter values queries. Filter values are always sorted in ascending order.

Handling Multiple Data Tables
There are two ways which an Assembly Data Source can allow for multiple data tables to be returned as separate objects in the Exago BI
data model. The first involves using multiple entry methods. The second involves specifying table names in the metadata.

Multiple Methods
Separate tables can be implemented as separate entry methods within the ADS. This has several advantages:
Each public method from a source will appear as a "table" in the Admin Console when adding objects to the data model.
Method names can describe the tables in a self-documenting manner.
Example:
/* Public methods seen by Exago BI */
public static DataSet EmployeeTable(int call) { return GetTableData("Employee", call); }
public static DataSet ProductsTable(int call) { return GetTableData("Products", call); }
/* Common data retrieval method */
private static DataSet GetTableData(string tableName, int call) { ... }

However, this does not allow retrieval of previously undefined tables without editing the Assembly Data Source and adding additional
methods in support. So for a database where objects are likely to be added, programmatic maintenance of the Assembly Data Souce will
be required.

Single Method with Parameters
The Data Object and Data Object ID parameters correspond to the user-input metadata fields Category and ID (respectively) in each data
object's properties in the Admin Console. The ID field, in particular, can accept arbitrary input without affecting the user interface. So
table names or identifiers can be defined in the ID field. Thus, one entry method can support multiple tables based on a conditional string
from the metadata. This allows an Assembly Data Source to support a more dynamic data structure, since any subsequent tables can be
added simply by editing the metadata.
Example:
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public static DataSet GetTableData(string objectId, int call)
{
switch (objectId)
{
case "Employee": { ... }
case "Products": { ... }
default: { throw ... }
}
}

However, adding metadata elements to the config can be error-prone, so ensure that admins always have the up-to-date mapping of IDs to
tables.

Configuration
Once written, the following steps are taken for Exago BI to access the Assembly Data Source.
1. Ensure that the assembly is in a location accessible by the IIS application pool user (and the Exago Scheduler Service, if in use)
with read and execute permissions.
2. Add the Assembly Data Source to the Admin Console Data Sources (with Type=Assembly) using the following connection string
format:
assembly=\path\to\assembly.dll;class=Namespace.Class

3. Click the Test
icon to verify that the assembly and class are accessible.
4. Define the method parameter names in the Programmable Object Settings.
5. Add the entry methods to the Admin Console Data Objects, then add any relevant joins and metadata aliasing.

Maintenance
There are several notes to keep in mind when updating an ADS and/or updating Exago BI.

System Locks
The web server maintains a lock on the assembly as long as it is running. Additionally, if using any classes in the
WebReports.Api.Scheduler namespace, or if there are any scheduled or cached reports that use the Assembly Data Source, the
Scheduler Services lock it as well.
Therefore, when updating the Assembly Data Source, the web server and Scheduler Services will need to be disabled while the file is
replaced.

WebReportsApi.dll Version
If you are using SessionInfo or any other Exago .NET API classes, the Assembly Data Source must be recompiled with the new
version of the WebReportsApi.dll assembly whenever Exago BI is updated.
Note
Utility libraries, such as SQLUtils.dll are updated less frequently than the main web application binaries. Even if only referencing utilities,
verify nevertheless that the Assembly Data Source works without needing recompilation.

Example
The following example is provided for reference. While trivial, the example is fully working and demonstrates a typical Assembly Data
Source framework. It can be freely used, extended, and redistributed for any custom implementation.
Download the example.

Data Objects
This article applies to the Admin Console >

Data >

Objects settings.

Data Objects are the tables, views, methods, stored procedures, functions and custom SQL made accessible from the Data Sources for
reports.

Create, Edit, Delete Data Objects
To add a new data object click

Objects in the Main Menu and either:

click the Add
icon at the top of the main menu
right-click and select Add from the context menu
or to quickly add data objects, use the Automatic Database Discovery tool
To clone an object, right-click and select Clone from the context menu
To edit an object either:
double click it
select it and click the Edit
icon at the top of the main menu
right-click it and select Edit from the context menu
To delete an object either:
select it and click the Delete
icon at the top of the main menu
right-click it and select Delete from the context menu
To save changes and new objects click the Apply or Okay buttons.

Data Object Properties
A data object has the following properties:

Name
Select the data source from the first dropdown. In the second drop-down select a data object. This field is required.
Note
This will display all the of the source’s tables, views, methods, stored procedures, and functions.
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icon next to the Data Sources dropdown. For more details see Custom SQL

Important
The name of data objects may not contain the following characters:
{ } [ ] , . %

To create a data object for a database table (or other backing model) with one of these characters in its name, create a Custom SQL
Object with a simple SELECT clause. For example for a table named sales.figures.2020:
SELECT * FROM [sales.figures.2020]

Note that the identifier delimiters (the [ ]) around the table name will vary with the database type.

Alias
The user friendly name for the data object. The alias will be displayed to end-users. This field is required.
Important
An alias may not contain the following characters:
@ { } [ ] , . %

Unique Key Fields
The columns which uniquely identify a record in this data object. This field is required.

Category pre-2020.1
The folder used to group related data objects. A hierarchy can be created by using backslashes between names.
Northwind

Data objects in a single folder
Northwind\Employees

A hierarchy of data objects
When configuring Multiple Data Models, separate the different folder names with a comma.

ID
An application-wide unique identifier for the data object. IDs are required when creating multiple data objects with that have the same name
but come from distinct data sources. IDs can also be used to optimize Web Service and .NET Assembly calls. For more information see
Data Object IDs at the end of this article.
Note
By default all objects have an implicit object ID that is set behind-the-scenes. This field allows you to set the IDs explicitly. It is generally
recommended to set explicit IDs for all data objects. As of v2019.1.12, this field will display the implicit ID by default.

Parameters
Parameters that are passed to stored procedures, table functions, Web Services or .NET Assembly methods. Clicking in the drop-down
will bring up a menu. Click the Add button and select the parameter from the drop-down list. For more information see Stored
Procedures and Web Services & .NET Assemblies.
Parameter values are passed in the order in which they are listed in the data object. It is critical to ensure that the order is correct.

Tenant Columns
Specify which columns contain tenant information and link the parameters accordingly.
This setting is used to filter data when multiple users’ information is held within the same table or view, and a column holds information
identifying each user. Exago will only retrieve the rows where the column value matches the corresponding parameter.

Description
Provide an optional user-friendly description of this data object. When this object is hovered over in the
description text will pop up in a tooltip.

Data Fields Pane, the
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Both plain-text can be added verbatim or a language file ID can be supplied. See Column Description v2016.3+ below for more information.

Column Metadata
Specify any columns that should not be filterable, visible, or that should be read as a specific data type. See Column Metadata for more
information.

Schema Access Type
Specify how Exago should retrieve the schema for the data object. There are three possibilities:
Default — Follow the global Schema Access Type setting in Other Settings.
Datasource — Queries the data source for the schema.
Metadata — Reads the schema from the stored metadata.
Note
For more information see Retrieving Data Object Schemas.
As of v2019.1+, the Schema Access Type defaults to Metadata. The optimizations made to the configuration architecture in this version
alleviate the performance issues previously associated with loading large configuration files—metadata playing a primary role in increasing
configuration file size. Exago now strongly encourages the full use of metadata in combination with the new configuration optimizations as
this will reduce the frequency in which the application queries databases.
Note
For more information regarding the performance enhancements of v2019.1+, please see this article.

Filter Dropdown Object
Specify an alternative data object or custom SQL to be queried when a user clicks a filter value dropdown (for example in the Report
Designer's Filters dialog, the Filters pane of the Dashboard or ExpressView Designer)

Filter value dropdown in the Report Designer's Filters dialog
Important
The Filter Dropdown Object must have a column with the same name as each column in the main data objects or an error message
will be displayed to the user when clicking the dropdown.
To set a Filter Dropdown Object, choose a Data Source and then:
select a table or view from the dropdown on the right, or
click the Custom SQL icon to write custom SQL statements to retrieve filter values. Writing custom SQL for Filter Dropdown
Objects is the same as writing Custom SQL Data Objects.
Note
The filter dropdown object data source should return values faster than it's corresponding "parent" data object. Therefore, .NET Assembly
data sources are not recommended as Filter Dropdown Object data sources.
To remove a Filter Dropdown object, click the Delete

icon.

For more information, review the Filter Dropdown Objects section at the bottom of this article.

Suppress Sort and Filter v2018.1+
If this object is a programmable object (Stored Procedure or .NET Assembly Method), select whether to suppress the application sorting
and filtering for report execution queries. Enable this if the programmable object uses Programmable Object parameters to do sorting
and filtering in code, as application processing would be redundant and unnecessary. This can allow for better performance for
programmable objects.
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Note
If the application requires sorting/filtering in memory, it will not be suppressed. For instance, a report with this object has a cross-source
join, an advanced join, a Cartesian join, or a formula sort or filter. Multiple tables from the same programmable data object can be joined
with suppressed filtering & sorting if this setting is enabled for all of them.

Cloning Data Objects v2019.1+
As of v2019.1+, data objects may be cloned via the Admin Console. A cloned data object inherits all its base attributes from its parent
except its Alias and ID, which must be entered manually in order to create the clone.
As of v2019.2.18+, a cloned data object may have its own folder and description.
To clone a data object, right-click it and select Clone.

Enter a new Alias and ID for the cloned object.

In v2019.2.18+, select how to handle the folder and description that will be associated with this cloned object:

Inherit Folder — check this checkbox to copy the folder location of the object that this clone was created from. Uncheck to
provide a different folder location in the text field below. When checked, the value copied is shown in the field below. The default
value is checked.
Inherit Description — check this checkbox to copy the description text of the object that this clone was created from. Uncheck to
provide a unique description in the text field below. When checked, the value copied is shown in the field below. The default value is
checked.
The cloned object will then appear in the Objects menu:

Functionality of Cloned Data Objects
A cloned data object is linked to its parent object. Any changes made to a parent data object will be reflected in its clone.
Deleting the parent data object will also delete its linked clone.
Clones do not inherit joins from their parent objects. Joins need to be manually created between clones and other data objects.
Clones cannot be distinguished from other data objects within the report designers. There is no visual or functional difference
between a cloned data object and a normal object outside of the Admin Console.
A cloned data object cannot itself be cloned or duplicated.

Stored Procedures
Stored Procedures offer the ability to use high level code to modify the data set before it is sent to Exago.
For best performance, stored procedures should know what sorts and filters the user has set and whether to return the schema, a single
column, or the entire data set. To accomplish this:
Use the Call Type, Filter, Column and Sort Parameters in the Programmable Object Settings. These parameters will be passed
from Exago to identically named parameters in the Stored Procedure. It is highly recommended to use these parameters as they
can improve performance.
Additional parameters may be passed by setting them in the Data > Object > Parameters tab for the Data Object.
Important
As noted above in the Parameters section, parameter values are passed in the order in which they are listed. It is critical to ensure that
the order listed is correct.

Important Note for Microsoft SQL Server
SQL Server has an attribute called FMTONLY that must be handled by all stored procedures.
FMTONLY has two possible values:
ON: The stored procedure will only return the column schema. However all IF conditional statements are ignored and all of the code
will be executed. This setting will fail if the stored procedure contains any temp tables.
OFF: The stored procedure returns all of the data and the column schema. The stored procedure will correctly execute IF
conditions.
The ON setting will cause problems if there are IF conditions in the procedure; however, only using the OFF setting will hurt performance if
the Call Type Parameter in the Programmable Object Settings is not used.
The following example demonstrates how to use the Call Type, Column, Filter and SortStr Parameters to improve efficiency.
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As of v2019.1.11+ the Sort Parameter can be used to indicate in which direction the user is scrolling a filter dropdown. ASC indicates
scrolling down or DESC indicates scrolling up.
Note
For SQL Servers, FMTONLY is set to OFF.

CREATE PROCEDURE [dbo].[sp_webrpt_person]
@callType INT,
@columnStr varchar(1000),
@filterStr varchar(1000),
@fullFilterStr varchar(1000),
@sortStr varchar(1000)
AS
SET NOCOUNT ON /*for performance reasons */
SET FMTONLY OFF /*force procedure to return data and process IF conditions */
declare @sql varchar(2000)
declare @columnInfo varchar(1000)
declare @orderbyClause varchar(1000)
declare @operator varchar(max)
if @callType = 0 /*return schema; no need to return any rows */
begin
set @sql = 'select * from vw_webrpt_person where 0 = 1'
end
else
if @callType = 1 /*return all data for execution */
begin
set @orderbyClause = ''
if @sortStr is not NULL AND @sortStr <> 'null' set @orderbyClause = ' ORDER BY ' + @sortStr
set @sql = 'select ' + @columnStr + ' from vw_webrpt_person where ' + @filterStr + @orderbyClause
end
else
if @callType = 2 /*return filter dropdown values; limit # rows to some value; sortStr will indicate which direction user is scrolling the dropdown*/
begin
set @orderByClause = ''
set @operator = ' >= '
if @sortStr is not NULL AND @sortStr <> 'null' AND @sortStr <> '' Begin SET @orderByClause = ' ORDER BY ' + @sortStr END
if (RIGHT(@sortStr, 4) = 'DESC')Begin SET @operator = ' <= 'END
set @columnInfo = '[' + @columnStr + ']'
SET @sql = 'select top 100 ' + @columnInfo + ' from Northwind.dbo.OrderDetails where ' + @columnInfo + @operator + @filterStr + ' AND ' + @fullFilterStr + @orderByClause
end
exec(@sql)

Table Value Functions
Table Value Functions can be used as data objects. Any available table value functions of a data source will be displayed in the
Extensions tab under Functions. Exago handles table value functions similar to views and tables except it will pass any parameters
set in the Data > Object tab or in the Programmable Object Settings.
For more information, see Table-Valued Functions.

Custom SQL Objects

Exago can use custom SQL as a data object.
1. Provide a unique Object Name for the new data object. It cannot match any existing data object in the system configuration nor
contain any of the following characters, including spaces: [ ] { } . , @
2. Choose the Data Source that this Custom SQL Object will retrieve data from. Not all data sources in the system may support
Custom SQL objects.
3. In the large code window enter the full SQL statement. This statement will be inserted as a subquery when it is sent to the Data
Source for processing.
Caution
ORDER BY clauses and Common Table Expressions are not supported in subqueries.
4. System variables called parameters, that change based on certain environmental situations (e.g. who is running the report) may
optionally be added to the SQL statement by selecting the name from the dropdown and clicking the Add button.
5. Click the Test icon to check the SQL statement for validity.
6. Click Okay to close the Custom SQL Object dialog and continue editing the data object.

Data Object Macros
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Macros can be embedded in Custom SQL Objects to make them even more dynamic. Each macro allows for different SQL to be used
according to the circumstances in which the data object is being called. Below are the details and examples of available macros.

IfExecuteMode
(string trueCondition, string falseCondition)
Description

Includes the trueCondition if a user is executing a report. Includes the falseCondition if
otherwise.

Example

SELECT * FROM vw_webrpt_optionee IfExecuteMode("WHERE [State] = 'CT'","")

IfExistReportDataObject
(string dataObjectName, string trueCondition, string falseCondition)
Description

Includes the trueCondition if dataObjectName exists inside the full Exago SQL statement
to the data source. Includes the falseCondition if otherwise.

Example

SELECT * FROM vw_webrpt_optionee IfExistReportDataObject("fn_webrpt_grant", "JOIN
ON fn_webrpt_grant...", "")

Column Metadata
Column metadata refers to the properties of each column in the data object.
Note
Column metadata overrides culture settings.
There are several ways to add column metadata to a data object:
for all data objects in a data source in bulk utilizing the Bulk Metadata feature
manually for each data object, as described below
To modify the metadata of a column, either:
double-click it
select it then click the
Click the

Add button.

Read Schema button to quickly create column metadata for each column in the data object.

To remove metadata for a column, select it in the right panel and click the Delete

icon.

To save changes to Column Metadata, click the Okay button. To discard the changes, click the Cancel button.

The following properties of each column can be modified:

Column Alias
The name of the data field that the end-users see.
Important
Column aliases may not contain the following characters:
{ } "

Column Description v2016.3+
Data fields can have description text added. If the data field is hovered over in a selection screen in the Report Designer, the description
text will pop up in a tooltip.

Plain Text
Tooltip text can be added verbatim in the Column Description field. In-line HTML tags like <b> can also be used if desired. Press Okay
when done, then Apply the change.

Language File
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You can also add description elements to the language file, and reference them in the Column Description field.
In the language file, add new elements to the <AdminObjects> section using the following format:
<element id="uniqueIdentifier" tooltip="Description Text"></element>

HTML tags must be encoded like so:
Encode < as &lt;
Encode > as &gt;
Encode " as &quot;
For example, the following tooltip string encodes "<b>Description</b> Text", which displays as "Description Text."
<element id="uniqueIdentifier" tooltip="&lt;b&gt;Description&lt;/b&gt; Text"></element>

After adding the element to the language file, add the ID string to the Column Description field. Press Okay when done, then Apply the
change.

Data Type
The type of data Exago should treat the data field as any of the following valid types:
String
Date
Datetime
Time
Int
Decimal
Image
Float
Boolean
Guid
Currency

Filterable
Whether this field can be used to filter reports. The available options are:
Important
To prevent users from attempting to build a filter in the Report Designer on an unsupported data type, Filterable should be set to None
if the column's data type is not one of the supported types in the Data Type section above.
Field

Used as a Report Filter
Yes, for the:
Advanced Report Designer
Express Report Designer
ExpressView Designer
Dashboard Designer
Scheduler

All (True)

Used as an Interactive Filter
Yes, for the:
Report Viewer

Yes, for the:
Dynamic (False)

No

Report Viewer

Yes, for the:
Static (v2017.1.2+)

Advanced Report Designer
Express Report Designer
ExpressView Designer
Dashboard Designer
Scheduler

None (v2017.1.2+) No

No

No

Note
This setting affects the availability of the column in the user interface. Filters may still be programmatically added to reports with the API
regardless of the setting here.

Sortable v2016.3+
If set to False, the data field will not be listed in the Sorts menu.
Admins can now indicate whether data fields should appear in the Sorts menu using the Sortable dropdown.
Note
This toggle does not prevent data fields from being sorted by. Users can still enter the data fields manually as a formula, or use the data
fields within a sort formula.

Date Format String v2019.1+
The format string for datetime data fields. Allows datetime data fields to be accurately translated from generic string columns, in order to
support datetime metadata for vertical tables.
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The exact form of this string is dependent on the underlying data source. Refer to the data source provider's official documentation for more
information. This transformation is supported for any data source that supports converting formulas to SQL, the most popular sources are
listed here. For example:
Microsoft SQL Server CAST and CONVERT Date and Time styles
MySQL STR_TO_DATE() Format Specifiers
PostgreSQL Template Patterns for Date/Time Formatting
ORACLE Database Datetime Format Models
Consider this example vertical table:
Key Value
1
LastName

Field Name
Davolio

Value

Data Type
0

1

HireDate

1/31/1975

8

2

LastName

Callahan

0

2

HireDate

12/7/2000

8

To properly translate the HireDate column, the Date Format String would look like the following:
Data Source Type Date Format String
Microsoft SQL Server 101
MySQL

%c/%e/%Y

PostgreSQL

FMMM/FMDD/YYYY

ORACLE

FMMM/DD/YYYY

Visible
If set to False, the data field will not be listed for users.

Sort and Group-By Value v2016.3+
Specify a custom formula by which columns should be sorted and grouped by the application.
This field allows admins to specify how columns should be sorted and grouped by the application. By default, Exago will sort (and group)
columns based on the data in the column. You can use this metadata field to specify different data by which the column should be sorted.
Note
As of v2019.1.1+, Sort and Group-By Values are not honored when the data field is being used within a formula sort. This change was
made to prevent unexpected behavior from occurring in these instances.
For example, you may have a custom column Employees.FullName like the following:
{Employees.FirstName} & ' ' & {Employees.LastName}
By default, Exago would sort this field on the full string. You may want to sort on just the LastName, instead. In Sort and Group-By
Value, enter {Employees.LastName}, and the column will sort on LastName.
Another common example is sorting a Month field by the numeric representation of the month instead of the name. Since this value
accepts any valid Exago formula (except aggregates), custom functions can also be used.
Note
The Sort and Group-By Value field must have a one-to-one relationship with the data field. Otherwise, unexpected behavior could
occur.

Custom Columns v2016.3+
Custom Columns are a way to add columns to Exago that don't exist in the Data Source. This is completely transparent for the users;
they can then use them like any other column except as noted below. New data columns can be created from composite or interpreted
data fields. A formula can be used to create data from scratch. Admins often use custom columns to make popular formula sorts available
on an application-wide level.
Caution
Custom columns cannot be used as filters, within aggregate formulas or as the collating field on a Chained Report.

Admin Console
To add a custom column using the Admin Console:
1. Expand the Data > Objects group and double-click on the desired data object, or select it and click the Edit icon.
2. In the Object panel that opens, in the Column Metadata field, click on the Edit Metadata icon at the end of the line to open
the Column Metadata dialog box.
3. Click the Add New button at the bottom left of the Column Metadata dialog box. Enter a name for the new column in the dialog
box.
4. Data Type, Column Alias, and Column Value are required fields, the others are optional.
5. In the Column Value field, click the Formula Editor
icon to open the Formula Editor and define the data for the new column.
For example, to create a new Revenue column, you might enter the formula {OrderDetails.Quantity} *
{OrderDetails.UnitPrice}.
Note
The Custom Value field may only reference other fields that exist in the Data Source, and not other Custom Columns including
references to itself.
6. Click Okay when done, then click Apply to save the new column to the configuration.

Config File
To add a Custom Column by editing the config file, open the config file in a text or xml editor. Data Objects are <entity> elements.
Locate the desired entity and add a new <column_metadata> element:
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<entity>
...
<column_metadata>
<col_source>ExagoFormula</col_source>
<col_name>FullName</col_name>
<col_type>string</col_type>
<col_alias>FullName</col_alias>
<col_description>First and Last Name</col_description>
<filterable>false</filterable>
<col_value>{Employees_0.FirstName} &amp; ' ' &amp; {Employees_0.LastName}</col_value>
<col_sortandgroupbyvalue>{Employees_0.LastName}</col_sortandgroupbyvalue>
</column_metadata>
</entity>

Note
Fields in bold are required.
<col_source>ExagoFormula</col_source> is static. This is the same for every <column_metadata>.
In <col_value> and <col_sortandgroupbyvalue>, data fields are identified by their ID, not their alias.
Note
The <col_value> field may only reference other fields that exist in the Data Source, and not other Custom Columns including
references to itself.
Acceptable values for <col_type>: string, date, datetime, time, int, decimal, image, float, boolean, guid, currency.
Save the config file when done, and restart the web server.

Examples:
There are a lot of options for what kinds of data fields you can create:
Transform or interpret an existing data field:
Right({Employees.SocialSecurityNumber},4)
Month({Orders.OrderDate})
Combine multiple data fields together:
{Employees.FirstName} & ' ' & {Employees.LastName}
Create new data from scratch:
Random(0,65536)
Uses a custom function
And much more!

Retrieving Data Object Schema
Many of the dialogs throughout Exago require schema information such as column name, data type, filterable, sortable and visible status,
sort-and-group-by value etc.... To enhance performance, schema information can be stored in the application as column metadata.
Exago can then read this metadata instead of querying the data source.
Note
While storing the schema as column metadata improves performance, updates to the column metadata will be required whenever
columns are added, removed, or re-titled.

Building Metadata in Bulk
The use of column metadata reduces the frequency in which the databases are queried for schema information. To make the process of
adding metadata simple, this information can now be built in bulk through the Admin Console.
Metadata can be built in bulk:
with the Bulk Metadata feature described below
Right-click a data object, then click Bulk Metadata.

Building metadata in bulk on the Northwind data source
Exago will then process the information for each data object under that data source and add metadata information for each field within
these objects. The Schema Access Type of each object will automatically be set to Metadata for each object.
A new Bulk Metadata tab will open in the Admin Console displaying the processing information.

75 of 201

Data Objects

Technical Guide

The metadata information that has been processed and added to each data object may then be edited or removed in the Column
Metadata menu.
Please note, however, that if metadata has not been added to or is not enabled for a data object, the following warning will appear next to
the data object in the Admin Console. This warning serves to further encourage the use of metadata and notify the system administrator
that this data object will query the database each time it requires schema information.

Building Metadata Manually
In versions prior to v2019.1, data sources are queried for schema information by default. This process, however, may cause performance
issues if the data sources take a considerable amount of time to return the schema. To avoid these performance issues, metadata may be
added manually via the Column Metadata menu.
For Exago to retrieve schema information from the metadata:
1. In Other Settings, set Schema Access Type to Metadata. This will force Exago to get all schema information from the metadata
for all data objects.
Note
Alternatively this setting can be overwritten for individual data objects by setting the Schema Access Type property.
2. For each data object open the Column Metadata menu.
1. Click the Read Schema button. A message will appear asking you to confirm you want to continue. Click Okay.
2. Click Okay to close the Column Metadata menu.
3. Press Okay or Apply to save the data objects.
Note
Other metadata options such as aliasing can still be utilized.

Data Object IDs
There are three ways in which you can utilize data object IDs.

Adding Multiple Data Objects with the Same Name
IDs distinguish Data Objects that have the same name but come from different Data Sources. When adding multiple Data Objects with the
same name, make sure each data object has a unique ID.

Avoiding Issues from Changes to Object Names
Providing IDs for all the Data Objects prevents issues if the name of the underlying table, view or stored procedure is changed.

Calling a Single Web Service/.NET Assembly/Stored Procedure
Web Services, .NET Assemblies and Stored Procedures comprise a group called Programmable Objects. These objects can retrieve
parameters from Exago and the host application in order to control what data is exposed to the user.
Generally for Web Services and .NET Assemblies each data object calls a distinct method. Similarly each Stored Procedure is its own
data object. By using data object IDs a single method/stored procedure can be called. This method can then return data or schema based
on the data object ID.
To call a single Web Service/.NET Assembly/Stored Procedure:
1. Provide a name for Data Object ID Parameter Name in Programmable Object Settings
2. Create a method/procedure in your Service/Assembly/Procedure that utilizes the object ID parameter to return the appropriate
data/schema.
3. For each data object:
1. Select
Object in the Main Menu and click the Add button
2. Select the single Service/Assembly/Procedure
3. Provide an Alias and an ID for the object
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4. Select the key columns
5. Click Okay or Apply to save the object.
Example: This stored procedure uses the object ID parameter (@objectID@) to return different data/schema information for different
object IDs.
ALTER PROCEDURE "dbo"." Exago_Example" @callType INT, @objectID nvarchar(max) AS
SET
NOCOUNT
ON
SET
FMTONLY OFF
if @objectID = 'Produce' begin
if @callType = 0
begin
ProductID,
ProductName,
SupplierID,
UnitPrice,
UnitsInStock
FROM
Products
WHERE
CategoryID = 1001
end
else if @callType = 1
begin
SELECT
ProductID,
ProductName,
SupplierID,
UnitPrice,
UnitsInStock
FROM
Products
ORDER BY
ProductID
end
else if @callType = 2
begin
SELECT
ProductID,
ProductName,
SupplierID,
UnitPrice,
UnitsInStock
FROM
Products
ORDER BY
ProductID
end
end if @objectID = 'Orders0' begin
if @callType = 0
begin
SELECT
OrderID,
OrderDate,
RequiredDate,
ShippedDate,
CustomerID
FROM
Orders
WHERE
CustomerID = 0
end
else if @callType = 1
begin
SELECT
OrderID,
OrderDate,
RequiredDate,
ShippedDate,
CustomerID
FROM
Orders
ORDER BY
OrderID
end
else if @callType = 2
begin
SELECT
OrderID,
OrderDate,
RequiredDate,
ShippedDate,
CustomerID
FROM
Orders
ORDER BY
OrderID
end
end

SELECT

Reading Images from a Database
Exago can read images from a database and load them directly into a cell of a report. When images are stored in a database as a binary
string there are two ways that Exago can load them into a report.
1. Change Column Metadata
1. Open the Column Metadata menu and for the image column set Data Type to Image.
2. Place the data field containing the images into the desired cell of a report. Upon execution the images will be loaded into the
cell.
2. Without changing Column Metadata
1. Place the data field that contains the images into the LoadImage function. Upon execution Exago will interpret the binary and
load the images into the cell.

Filter Dropdown Objects
The Filter Dropdown Object overrides the source of values that populate a filter value dropdown in the user interface (e.g. in a
prompting filter dialog; in the Filters dialog in the Report, Dashboard or ExpressView Designer; in the Dashboard or Report Viewer).

77 of 201

Data Objects

Technical Guide

A variety of filter value dropdowns as displayed in the Dashboard Viewer; ExpressView Filters pane and the Simple Filter
Window of the Report Viewer
By default, filter value dropdowns populate with data from their corresponding data object. Explicitly defining a Filter Dropdown Object in
the configuration allows those default values to be replaced by another table, view or by custom SQL statements. This substitution
happens transparently to the end user.
Specifying a Filter Dropdown Object may be most useful when the corresponding data object is a Stored Procedure, Web Service, or
.NET Assembly that takes more than a few seconds to return data, as this can adversely affect user experience. Filter Dropdown Objects
may also be useful when explicitly controlling filter values available to end users is desired (see Caution below).
Note
Using a Filter Dropdown Object requires General > Filter Settings > Read Database for Filter Values to be True.
Filter Dropdown Objects may reference Data Sources other than their corresponding data object but there must be an identical column
in the source data object and the Filter Dropdown Object.
For example, consider the Orders and OrderDetails tables of the Northwind sample data set. If the Orders table is used as the Filter
Dropdown Object for the OrderDetails table, and a filter is created on the OrderId field, the Filter Dropdown Object will work since
both tables contain an integer typeOrderId field.

Setting
Filter Dropdown Object for Northwind.OrderDetails table
Although not obvious in the figure, the order ID numbers (e.g. 10248, 10249, 10250) in the ExpressView filter dropdown below are read from
the Orders table since it is the Filter Dropdown Object for OrderDetails.
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On the contrary, there is no Quantity column in the Orders table. When attempting to filter on OrderDetails.Quantity, an error
message will be displayed to the end user.

To prevent users from filtering on fields that are not available in the Filter Dropdown Object, set the Filterable property in the Filter
Dropdown Object's Column Metadata to False. Note that this will prevent all filtering on that field through the user interface. Filters on the
column may still be added via one of the APIs.
Caution
Filter Dropdown Objects will completely replace the available filter dropdown values for their corresponding data object. If the Filter
Dropdown Object has less or more values than its corresponding data object, users may not be able to filter on all possible values or be
able to select values that do not correlate with records in the corresponding object.

The figure below demonstrates a less than ideal Filter Dropdown Object—the object only contains three Order IDs despite there being
many more in the OrderDetails table, as well as an Order ID that does not exist in the OrderDetails table (i.e. 9999999). A user
would only be able to filter by order ID 10248 or 10249.

Additional Resources
Admin Support Lab — Filters, segment on Filter Dropdown objects runs from 14:05–20:15.

Automatic Database Discovery
This article applies to the Admin Console >

Data >

Sources settings.

To discover and add data objects, joins and metadata to the configuration automatically use:
Discover Database Metadata tool
Automatic Database Discovery is available for all Exago supported Data Sources except files (Excel & XML), .NET Assemblies and
Microsoft OLAP.

Discover Database Metadata
The Discover Database Metadata option is available for granular control over the automatic discovery and import of Data Source schema
information.
To start using Automatic Database Discovery, select a Data Source from the list and then either:
click the Discover Database Metadata
icon at the top of the main menu
right-click the Data Source then click Discover Object/Join Metadata from the context menu
This will open a discovery tab for the Data Source.
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Automatic Database Discovery tab
In the discovery tab you can:
1. Select the Tables, Views, Functions, and Stored Procedures you would like to add by either:
checking individual item checkboxes
clicking Select All Complete Objects to select only those objects with unique key values already defined
clicking Select All Objects to select all data objects regardless of whether or not unique key values are defined
Table A — Icons
Icon
Description
This object has identified unique key values
This object has associated joins
This object is incomplete
2. Add Unique Key fields by right-clicking on an object and selecting Add/Edit Primary Key Info.
3. Check Preview Only and then Add Objects to preview the selected objects and joins.
4. Uncheck Preview Only and then add the selected Data Objects to the system by clicking Add Objects or Add Objects and
Joins to add the selected objects and any associated joins.
Note
If any selected Objects are missing unique key values they can be completed individually in a new tab which will open entitled
Incomplete Objects.

Schema Discovery
Exago can retrieve primary and foreign key contraint information from the Data Sources by:
Executing a SQL queries to discover the schema

SQL Queries
Customizing Data Discovery SQL v2016.3.6+
The SQL statements used for Automatic Database Discovery can be customized if necessary, in order to accommodate non-standard key
names.
To customize the discovery SQL:
1. Refer to Managing the dbconfigs.json File for the location of the file to edit. Follow the instructions in the Overriding dbconfigs
Information section to correctly override the default behavior depending on your version of Exago.
2. Locate the property for your data source type and edit the SQL for either or both primary and foreign keys.
3. Save the file, then run Database Discovery to see your changes.

"mysql": {
"PrimaryKeySql": "SELECT CONSTRAINT_NAME AS indexname, TABLE_SCHEMA as schemaname, TABLE_NAME as tablename, COLUMN_NAME as columnname FROM information_schema.key_column_us
"ForeignKeySql": "SELECT TABLE_SCHEMA As schemaname, TABLE_NAME as tablename, COLUMN_NAME as columnname, REFERENCED_TABLE_SCHEMA as referencedschemaname, REFERENCED_TABLE_
}

Excerpt from dbconfigs.json showing the database discovery SQL statements for Primary and Foreign Key discovery on
a MySQL Data Source

Join Configuration
This article applies to the Admin Console >

Data >

Joins settings.

Joins specify to Exago the relationship between Data Objects.
All existing Joins are listed in the Main Menu under Data. All the joins you are adding or editing will be displayed in a tab entitled Joins.

Create, Edit, Delete Joins
To add a new join click

Joins in the Main Menu and either:

click the Add
icon at the top of the main menu
right-click and select Add from the context menu
or to quickly add data joins, use the Automatic Database Discovery
To edit a join either:
double click it

tool

select it and click the Edit
icon at the top of the main menu
right-click it and select Edit from the context menu
Important

80 of 201

Parameters

Technical Guide

Review the Modifying Joins section below when making changes to joins in the Admin Console.
To delete a join either:
select it and click the Delete
icon at the top of the main menu
right-click it and select Delete from the context menu
To save changes and new joins click the Apply or Okay buttons.

Join Properties
Every join has the following properties:

From Object
The first Data Object you would like to join.

To Object
The other Data Object you would like to join.
The order of the Data Objects is important if you have a one-to-many relation type or a Left/Right Outer Join type. See below for
details.

Join Column(s)
Specify the field(s) of each Data Object that must match to join an entity in the From Object to an entity(s) in the To Object.

Join Type
Specify whether rows from either Data Object that do not have a match should or should not be included.
Inner — include only rows of the From Object that have a match in the To Object and vice versa.
Left Outer — include rows of the From Object that do not have a match in the To Object but not vice versa.
Right Outer — include rows of the To Object that do not have a match in the From Object but not vice versa.
Note
SQLite Data Sources do not support right outer joins.
Full Outer — include rows in either Data Object that do not have a match.
Note
MySQL Data Sources and SQLite Data Sources do not support full outer joins.

Relationship Type
Specify if the join type is one-to-one or one-to-many.
One-to-One — each row in the From Object can join to at most one row from the To Object.
One-to-Many — each row in the From Object can join to any number of rows from the To Object.

Weight
Give a join weight in order to set its precedence when multiple join paths exist between Data Objects. The path with the higher weight will
be utilized.
A report contains three Data Objects ‘Students’, ‘Professors’ and ‘Comp Sci 101.’ Students is joined to ‘Professors’ and ‘Comp Sci
101.’ Additionally ‘Professors’ is joined to ‘Comp Sci 101.’ There are two available join paths between ‘Students’ and ‘Comp Sci
101.’ Adding weight to a join will clarify which of the two paths Exago should use.

Modifying Joins
Although joins are created in the Admin Console, they are also saved within each individual report. If changes are made in the Admin
Console, the affected reports need to refresh their joins. To do so:
1. Open the report for editing in the Report Designer.
2. From the Advanced Options > Joins menu, click the
3. Click Okay on the confirmation dialog.

Recreate button.

For more information, review Advanced Report Designer: Advanced Options.

Cross Source Joins
Data Objects from different Data Sources can be joined together.

Caveats
Filter Dependency only works when all data objects originate from the same Data Source.
The data types and size of the joined columns must match exactly. For example, an Unsigned Int column may only be joined
with another Unsigned Int column.
Important
Cross Source Joins are done in-memory, so this process may be memory intensive for very large data sets.

Parameters
This article applies to the Admin Console >

Data >

Parameters settings.

Parameters are used throughout the Exago application to store values. Although parameters can be created and given a default value in
the Administration Console, parameters are designed to be set at runtime through the API.
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Parameters can be used to:
Pass values to Web Services, .NET Assemblies, or custom SQL Data Objects.
Important
Parameter values are passed in the order in which they are listed in a data object. It is critical to ensure that the order is correct. For
more information please see the Data Objects article.
Set tenant values to assure security in a multi-tenant environment. For more information see Data Objects.
Pass values into cells and formulas of a report. To display a non-hidden parameter in a cell type "=@ParameterName@".
Pass values into custom functions. For more information see Custom Functions.
Create a custom dropdown list of values for user selection on a report prompt.

Create, Edit, Delete Parameters
All existing parameters are listed in the Admin Console Main Menu under Data. All the parameters that are added or edited will be
displayed in a tab entitled Parameters.
To add a new parameter click

Parameters in the Main Menu and either:

click the Add
icon at the top of the main menu
right-click and select Add from the context menu
To edit a parameter either:
double click it
select it and click the Edit
icon at the top of the main menu
right-click it and select Edit from the context menu
To delete a parameter either:
select it and click the Delete
icon at the top of the main menu
right-click it and select Delete from the context menu
To save changes and new parameters click the Apply or Okay buttons.
Note
Currently, the prompt window will not appear when drilling down into a child report that contains prompting parameters. However, this can
be partially bypassed by adding the prompting parameter in a hidden cell on the parent report so that the user will be prompted at
execution for the parameter value.

Parameter Properties
Each Parameter has the following properties:

Name
A name for the parameter. Prompting parameters are sorted alphabetically by name unless otherwise specified or unless there are
dropdown parameters with dependencies.
The following characters are not allowed: @ , . { } [ ]
The following names are reserved by the application: filter, email, userId, companyId, reportName, reportFullName,
pageNumber, data_label, data_value, series_label, bubble_size, bubble_value, batch_x (where x can be any
string of characters).
Important
Parameter names are case sensitive.

Type
The parameter data type. The following types are available:
string
date
integer
decimal
boolean (v2019.1+)
Note
Select date for DateTimes and string for functions.

Value
The default value of a parameter. This is intended to be overwritten at runtime through the API.
Date values should be entered in yyyy-MM-dd format.
Null values may also be passed to parameters. In order to do so, the default value of the parameter needs to be set to {null}. This will
allow parameters to process any null values that are passed through the API or application at runtime.
Formulas as Default Parameter Values
Formulas that return strings, integers, dates or decimals may also be passed as parameter default values. Just as entering a function into
a cell in the Report Designer, include an equals sign as a prefix (e.g. =QuarterNumber(Today())).
Formulas may include multiple functions. As with other functions, these may also include other parameters.
Caution
The Admin Console will only allow String, Decimal or Integer Type parameters to have a formula as their default Value. If you need the
Date type, select String in the Admin Console, enter the formula into the Value field and then manually edit the XML configuration file to
choose the desired data type.
Examples
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1. This parameter as defined in the XML configuration file is date type and by default will return the value of the Today() function, which is
today's date.
<parameter>
<id>DateChoose</id>
<data_type>date</data_type>
<value>=Today()</value>
<hidden>False</hidden>
<prompt_text>Choose a date</prompt_text>
</parameter>

2. This parameter defined in the Admin Console returns a string with an employee's name. The employee's name is decided based on the
year of the current date.

3. This parameter defined in the Admin Console returns a decimal with the future value of an asset multiplied by 2.

Hidden
Set hidden to True to disable this parameter from being used by users in cells and formulas.

Prompt Text
Give non-hidden parameters a prompt text to query the user for a value at the time of report execution. Leave blank to use the default value.

Parameter Dropdown Object
Optional data object for populating the parameter as a drop-down selection list. Only applicable with prompting parameters. Commonly
used in conjunction with programmable data objects (such as stored procedures).

Stored Procedure Parameters
A list of preexisting Exago parameters to be used as variables for a selected stored procedure.

Value Field
A column from the data object or custom SQL that sets that actual value of the parameter at runtime. This represents a set of values that
are not displayed to the end user but are instead used when parameter values are required in custom SQL or stored procedures, or other
server side processing.

Display Value Field
A column from the data object or custom SQL that sets the display value of the parameter for the dropdown selector. This represents the
set of values that should be presented to the end user when they are executing or scheduling a report.
The Display Value is also displayed in reports and used in formulas (except in formula filters).
Note
These distinct values can be accessed in formulas with @ParameterName.Value@ and @ParameterName.DisplayValue@
respectively.

Display Type
The display value data type.

Report-Level Parameters v2019.1.3+
Report builders can define their own parameters on the report-level. These parameters function identically to parameters existing on the
system-level and may be used within filters, functions, and so on within the report. Parameters defined in this way are only accessible
within the report that they are created on. For more information, please see the Report-Level Parameters section of the Advanced
Options article.
Important
Report-level parameters cannot be used in report-level Custom SQL Objects in versions pre-v2021.1.1.
This feature is enabled by default and can be disabled by setting Show Report-Level Parameters Window to False. This setting is
located in the Feature/UI Settings section of the Admin Console.

Modifying Report-Level Parameters via the .NET API
To modify existing report-level parameters:
1.
2.
3.
4.

Load the report that the parameter is defined on.
Iterate through the parameters collection to find the parameter.
Finally, adjust the required values of the parameter
Save it back to the API.
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Note
Currently, report-level parameters cannot be loaded or modified via the JavaScript API.

Example
ReportObject report = (ReportObject)api.ReportObjectFactory.LoadFromRepository(@"Reports\Sales Reports");
report.Parameters.Find(x => x.Id == "SalesQuota").Value = "1500";
api.ReportObjectFactory.SaveToApi(report);

Parameter Support for Dashboard URL Tiles
A new feature of Exago BI v2017.3 is the ability to use parameters in dashboard URL tiles. Dashboard reports intended for use by
multiple classes of users can implement URL tiles that change based on user variables.

URL tile with parameter values
Parameters are key-value pairs that are reachable from the Exago API, application extensibility, and, optionally, the user interface.
They are intended to be instantiated via the API at session initialization, the value of which are set depending on the user accessing the
session. They can either be created in the API or created in the config file or Admin Console and modified in the API.
Note. Parameters must have the Hidden property set to False in order to be usable in the application user interface. Date type
parameters cannot be used in URL tiles.

Setting a parameter's Hidden property to False in the Admin Console
If the Prompt Text property is set on a URL tile parameter, users will be prompted to set its value when they run the dashboard.
Note. Dashboard URL tiles cannot be modified after the dashboard is run. Prompting URL parameters cannot be made accessible in the
Interactive Parameters pane.

URL formatting
Parameters may be utilized anywhere within a URL string.

Example
http://@address@.com
http://example.@domain@
http://@subdomain@.example.com
http://example.com/@path@
@protocol@://example.com
http://example.com:@port@
http://example.com?@key@=value
http://example.com?key=@value@
http://example.com#@fragment@

It is recommended that spaces and other special characters are URL-encoded where appropriate. For example, to pass "Hello World" as
part of a URL query string, encode the space between the two words as "%20%". This will not be done automatically.
http://example.com?key=Hello%20World

For more information, see Percent-encoding (Wikipedia)

Roles
This article applies to the Admin Console >

Roles settings.

This article explains how to use the Roles to control access to data and override the General Settings.

Create, Edit, Delete Roles
To add a new role click

Roles in the Main Menu and either:

click the Add
icon at the top of the main menu
right-click and select Add from the context menu
To edit a role either:
double click it
select it, expand the sections (Main, General, Folders, Objects or Filters) and click the Edit
menu
To delete a role either:

icon at the top of the main

select it and click the Delete
icon at the top of the main menu
right-click it and select Delete from the context menu
To save changes and new joins click the Apply or Okay buttons.
The Role that is currently active will be highlighted under the Roles menu of the Admin Console.
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User is the currently active role

About Roles
Roles are created to specify how a user or group of users interfaces with Exago. Roles can restrict access to folders or data objects.
Roles can also override the General Settings.
Note
Exago was designed to be an integrated reporting solution for other applications using the application’s own security and authentication
methods. Although you can create Roles through the Admin Console, Roles are typically created through the API to dynamically set a
user's access. For more information see the sections regarding the various APIs.
Roles have five sections to control access: Main, General, Folders, Objects, and Filters.

Main Settings
The Main settings control the broad properties of the Role.

Id
A name for the role.

Include All Folders
If checked, all folders that are not listed in Folder Access will be available. If unchecked, only those listed in Folder Access will be
available.

All Folders Read Only
If checked, all folders that are not specified in Folder Access will be execute-only. If unchecked, only those specified in Folder Access
will be execute-only.

Allow Folder Management
If True, users will be able to create root and sub folders, rename folders and delete folders in the user interface. If False, users cannot take
action on folders and the Add Folder buttons are hidden from the user interface.

Include All Data Objects
If checked, all Data Objects that are not listed in Objects Access will be available. If unchecked, only those listed in Objects Access will
be available.

General Settings
The General settings of a Role override the global General Settings. Utilize the API in order to overwrite additional settings for a user or
group of users.
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The following settings can be overwritten:

Report Path pre-v2020.1
The parent folder for all reports. The Report Path can be:
Virtual Path
Absolute Path: Used to provide increased security (ex. C:\Reports)
Web Service URL or .NET Assembly: Using a Web Service or .NET Assembly allows reports and folders to be managed in a
database. For more information see Report Folder Storage & Management.
A Web Service should be formatted as ‘url=http://WebServiceUrl.asmx’. A .NET Assembly should be formatted as ‘assembly
= AssemblyFullPath.dll;class-Namespace.ClassName’.

Date Format
The format of date values. Can be any .NET standard (ex. MM/dd/yyyy). If left blank, this setting will inherit the environmental settings.

Time Format
The format of time values. Can be any .NET standard (ex. h:mm:ss tt). If left blank, this setting will inherit the environmental settings.

Date Time Format
The format of date-time values. May be any .NET standard (ex. M/d/yy h:mm tt). If left blank, this setting will inherit the environmental
settings.
Note
For more details on .NET Date, Time and DateTime Format Strings please reference the Microsoft document here.

Numeric Separator Symbol
Symbol used to separate 3 digit groups (ex. thousandths) in numeric values. The default is ‘,’.

Numeric Currency Symbol
Symbol prepended to numeric values to represent currency. The default is ‘$’.

Numeric Decimal Symbol
Symbol used for numeric decimal values. The default is a period (.).

Server Time Zone Offset
Value that is used to convert server to client time (the negation is used to convert client to server time). If left blank, this setting will use
server time to calculate value.

Time Zone Name v2019.1+
Default geopolitical location of the client as determined by the IANA time zone database (e.g., America/New_York). Utilized by Exago to
properly combat scheduling issues centering around DST and other non-linear time zone conflicts.

Show HTML Export Grid Lines
Sets the default value for the HTML output option Show Grid. This can be modified in the Options Menu of the Report Designer.

Show Crosstab Reports
Displays/Hides the CrossTab Report Wizard and Insert CrossTab button in the Report Designer.

Show Advanced Reports
Displays/Hides the Advanced Report Wizard and Report Designer.
Note
If Show Advanced Reports is False then attempts to edit Advanced or CrossTab reports will cause an ‘access denied’ message.
Additionally, if False, users will not be able to create CrossTab reports.

Database Timeout
Maximum number of seconds for a single query to run.
Caution
This value is passed on to the data source driver when the report is executed. Each data source driver, data source or individual database
may interpret this setting slightly differently. Consult the official product documentation associated with your data source implementation
for complete details how this setting will impact your environment.
Note
This setting will also control the maximum number of seconds that a Web Service API method can run. If set to 0 the Web Service API
time out will be infinite.

Read Database for Filter Values
Enable/Disables filter drop-downs to contain values from the database. Set to False only if retrieving values for the drop-down will take more
than a couple of seconds.

Show Report Scheduling Option
Displays/Hides the scheduler icon on the Main Menu. Set to False to disable users from creating scheduled reports.

Show Email Report Options
Displays/Hides the email report icon on the Main Menu. Set to False to disable users from emailing reports.

Show Schedule Manager
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Displays/Hides the scheduler manager icon on the Main Menu. Set to False to disable users from editing existing schedules.

Scheduler Manager User View Level
Controls what information each user can see in the Schedule Manager. These levels utilize the Parameters companyId and userId. There
are three possible values:
Current User: Can only view and delete report jobs that have been created by that user.
All Users in Current Company: User can only view and delete report schedules for their company.
All Users in All Companies: User can view and delete report schedules for all companies (administrator).

Allow Creation of Custom SQL Objects in Advanced Reports v2018.1+)
Allow this role to create and execute reports with report-level custom SQL objects.

Folder Access
The Folder Access controls which report folders are visible and executable for the Role.
Caution
The Report Tree should contain no more than 1,000 items in it for best user experience.

Note
If Include All Folders is checked this list will deny access to the folders added. If unchecked, the list will allow access to the folders
added. If All Folders Read Only is checked this list will overwrite the setting when a folder is added without the 'Read Only' option
checked.
To add a folder to the list:
1. Click the Add button.
2. Click in the Folder Name column and select the folder you want to add.
3. To make the folder execute only check the box in the Read Only column.
To delete a folder click the Delete

icon at the end of the row.

Objects Access
The Objects Access controls which data objects are accessible to the Role. A report can only be executed if the Role has access to all
the data Objects on the report.

Note
If Include All Data Objects is checked this list will deny access to the data objects added. If unchecked the list will allow access to the
data objects added.
To add a data object click the

Add button.

Click in the Data Object Name column and select the object you want to add.
To delete an object click the Delete

icon at the end of the row.

Allow User to View Report-Level Custom SQL Objects v2018.1+
If Allow Creation of Custom SQL Objects in Advanced Reports is False, enable this setting to allow this role to run reports with reportlevel custom SQL objects. (Otherwise users will receive an "Access Denied" message when running such reports).

Filters Access
Filter Access provides a means to filter a Data Object by Role. Filters can be added to data objects so that users can only view specific
rows in the data object. To set row-based tenancy in Exago:

1. To add a filter click the Add button.
2. Select the Data Object Name from the dropdown.
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Important
A Data Object may only appear in the list once. Adding the same Data Object multiple times is not allowed and will return an error
message, "Please address the following errors before saving: Filters table contains the same object in multiple rows."
3. Enter the Filter String. The filter string should be valid, standard SQL to be added to the 'WHERE' clause sent to the Data Source.
This filter string can include Exago system parameters (e.g. @userId@) or custom SQL including subqueries (e.g. IN (SELECT
EmployeeID FROM Employees WHERE EmployeeID <4)). The Filter String must contain the actual name of objects in the
Data Source (e.g. tables, views, columns, etc...) rather than their Exago aliases.
To delete a filter click the Delete

icon at the end of the row.

Custom Functions
This article applies to the Admin Console >

Extensions >

Functions settings.

Exago comes with a number of functions that can be used to make formulas in the Formula Editor. Administrators may create additional
custom functions using high level coding languages which will be accessible to end-users of the Report Designer. Functions can be
added to a preexisting folder or a function can be put into a new custom folder.
Custom Functions can be written in C#, VB.NET, or JavaScript (Windows only). Functions can take as many input arguments as needed.
Functions can get and set elements of the current session state of Exago such as Parameter values. See SessionInfo for more
information.

Create, Edit, Delete, Restore Custom Functions
To add a new custom function click

Extensions >

Functions in the Main Menu and either:

click the Add
icon at the top of the main menu
right-click and select Add from the context menu
To edit a function either:
double click it
select it and click the Edit
icon at the top of the main menu
right-click it and select Edit from the context menu
To delete an object either:
select it and click the Delete
icon at the top of the main menu
right-click it and select Delete from the context menu
To restore the default custom functions that come with the application either:
right-click Extensions > Functions in the Main Menu and select Restore All Formula Functions from the context
menu
General > Filter Settings > Restore All Default Formula Functions and click on the Restore button.
To save changes and new functions click the Apply or Okay buttons

Custom Function Properties
Each Custom Function has the following properties.

Name
A name for the function that will be displayed to the end users. Required.

Description
A description of the function that will be displayed to the end users.
Note
To support multi-language functionality, you can supply an Id from a language file instead of a static string. For more information, see
Multi-Language Support.
Note
Arguments are passed to the code as an array of generic objects, accessed as args[ ].

Category
A way of grouping similar functions. You can assign custom functions to an existing Exago category or create a new category. To create a
new category, select Other. An input field entitled Specific Category Name will appear. Leaving this field blank will assign your function
to the Other category in the Exago Formula Editor. A non-empty value in this field will be new category with the specified name.
Note
To support multi-language functionality, you can supply an Id from a language file instead of a static string. For more information, see
Multi-Language Support.

Return Type v2018.2.6+
A return type must be specified for each Custom Function. This field can be defined as a String, Integer, Decimal, or Date, and determines
the expected return type of each function.

Prevent In-Database Grouping When Included in Detail Section v2019.1.5+
You may use this flag to specify whether this function has side-effects and should disqualify including reports from aggregating in the
database (thus skipping the function when in a suppressed Detail section). For example, most functions that build or manipulate memory
storage with Get/SetStoredValue should have this flag set to true.

Language
The high-level language of the code for the function. Can be C# or VB.NET, or JavaScript (Windows only).

References
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A semicolon-separated list of any DLLs that need to be referenced by the Custom Function. The DLLs must be present in the \bin folder
of the Exago Web Application, Scheduler Services, and the Web Service API if applicable. This folder can be found in the installation
directory of the respective component.
Tip
System.dll does not need to be listed as a reference as it is already available.

Namespaces
A semicolon-separate list of any namespaces that need to be referenced by the Custom Function.

Program Code
The program code for your Custom Function. Press the green check mark to verify the code executes properly. Required.
Note
To use a .NET Assembly for custom functions, first add it to the applicable \bin folders. Then add the assembly as a reference in the
Custom Code window, and invoke the method, e.g., return Extensions.Functions.DayBefore(args);.

Arguments
Starting with version v2017.2 there are several enhancements to the way function arguments are implemented and used. See Formula
Editor for details on how argument and function information will appear for end-users.
Click Edit Argument Info to show a dialog for managing arguments. Then click Add Argument for each argument the function will have.
Arguments have the following properties:

Name
The name of the argument, which will appear as a placeholder in the function parentheses and in the function's description tooltip.

Description
A description for what the argument is used for. You should mention the expected data type, if it is not obvious. This will appear in a tooltip
when the placeholder name is selected.
Can also be a language file ID.

Optional
Whether this argument is required or optional. Optional arguments are surrounded by brackets [ ] in the function's description tooltip.

Variable Argument Count
If selected, the last argument in the list accepts more than one value. Variable arguments are followed by an ellipsis (...) in the function's
description tooltip.

Exago Session Info
Custom Functions can access the Exago session state through a "sessionInfo" object. Access to sessionInfo allows powerful new
capabilities such as the ability to persist values across function invocations, allowing each invocation to be aware of previous calls and
behave accordingly.
Note
sessionInfo can also be accessed in Server Events, Action Events, and Assembly Data Sources.

Properties
PageInfo
This is the parent of all information in the current session. Included is the active Report and SetupData objects.
Note
Since the Report and SetupData objects are accessed frequently, direct pointers are included for these objects.

Report
An object that contains all of the report’s Data Object, sort, filter, and layout information.

SetupData
An object that contains all of the session’s configuration setting including Filters, Parameters, Data Objects, Joins, Roles, etc.

CompanyId
A direct pointer to the companyId Parameter value.

UserId
A direct poitner to the userId Parameter value.

Methods
GetReportExecuteHtml(string reportName)
A method that executes the specified report and returns its html output. This could be used to embed a report within a cell of another
report.
Note
The reportName is relative to the session’s report path.
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GetParameter(string parameterName)
A method that returns the specified Parameter Object. 'GetParameter' first looks in the Report Parameter collection, parameters being
utilized by the report, and then in the Config Parameter collection, as well as other parameters such as hidden parameters or multi-tenant
values.

GetReportParameter(string parameterName)
A method that returns the specified Parameter object that is utilized by the report being executed.
E.g. If a parameter is prompting a user for a value it will be available with the prompted value.

GetConfigParameter(string parameterName)
A method that returns the parameter object stored in the default configuration.
E.g. Any parameter that is not being utilized by the report being executed.

WriteLog(string text)
A method that writes the specified text to the Exago log file.
Note
The following methods utilize Stored Values which are objects that can be created and set by custom functions during report execution
to pass data between custom function calls. Stored Values only exist for the duration of report execution.

GetStoredValue(string valueName, [object initialValue = null])
A method that retrieves a Stored Value. If a there is no Stored Value with the specified valueName, then one will be created with the
specified initialValue.

SetStoredValue(string valueName, object newValue)
A method that sets the value of a Stored Value. Passing 'null' to newValue will delete the Stored Value.

Calling Exago Functions
Cases may arise where you want to call an existing function within your Custom Function. Using the class CellFormula and returning the
method CellFormula.Evaluate().

Default Custom Functions v2017.2+
Starting with v2017.2, Exago BI ships with several built-in custom functions. These are functions that are common in many reporting
environments, but the manner in which they work may be different depending on locality, time zone, or other factors. For this reason, these
functions have been exposed in the Admin Console so that administrators may change how they work.
Note
If these functions are unavailable, such after an upgrade, in the Admin Console navigate to General > Filter Settings > Restore All
Default Formula Functions and click on the Restore button.
The following custom functions ship with Exago BI:

MonthName
Description

Given a date value, returns the name of the month of that date. The month name is retrieved from the
active language dictionary. For example, given the date "01/01/2017", MonthName() will return
"January" in an English-speaking environment, and "Enero" in a Spanish-speaking environment.

Arguments

inputDateOrNumber: A formatted date string, a Date or DateTime value, or an integer value.
Required.

References

mscorlib.dll
These examples are in an English-speaking environment:
MonthName("02/29/2020")
February

Example

MonthName(3)
March
MonthName(1989-07-06 22:19:21)
July

QuarterName
Description

Arguments

Given a date value, returns the fiscal quarter of the date, as "Q1", "Q2", "Q3", or "Q4". By default, Q1
encompasses January 01 - March 31, Q2 encompasses April 01 - June 30, Q3 encompasses July 01 Sept 30, and Q4 encompasses Oct 01 - Dec 31. But since different countries or financial landscapes
may use different systems of quarters, the behavior of the function is exposed and customizable.
inputDate: A formatted date string, Date value, or DateTime value. Required.
QuarterName("02/29/2020")
Q1

Example
QuarterName(1989-07-06 22:19:21)
Q3

QuarterNumber
Description

Arguments

Given a date value, returns the fiscal quarter of the date, as "1", "2", "3", or "4". By default, Q1
encompasses January 01 - March 31, Q2 encompasses April 01 - June 30, Q3 encompasses July 01 Sept 30, and Q4 encompasses Oct 01 - Dec 31. But since different countries or financial landscapes
may use different systems of quarters, the behavior of the function is exposed and customizable.
inputDate: A formatted date string, Date value, or DateTime value. Required.
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QuarterNumber("02/29/2020")
1
QuarterNumber(1989-07-06 22:19:21)
3

Custom Filter Functions
This article applies to the Admin Console >

Extensions > Filter Functions settings.

Custom Filter Functions provide the ability to make functions that will dynamically calculate a value for a filter using high level code.
Filter Functions can be written in C#, JavaScript, or VB.NET. Filter Functions written in C# and VB.NET can get and set elements from the
current session of Exago, such as Parameter values. See Exago Session Info for more information.

Create, Edit, Delete, Restore Custom Filter Functions
To add a new custom filter function click

Extensions >

Filter Functions in the Main Menu and either:

click the Add
icon at the top of the main menu
right-click and select Add from the context menu
To edit a function either:
double click it
select it and click the Edit
icon at the top of the main menu
right-click it and select Edit from the context menu
To delete an object either:
select it and click the Delete
icon at the top of the main menu
right-click it and select Delete from the context menu
To restore the default custom filter functions that come with the application either:
right-click Extensions > Filter Functions in the Main Menu and select Restore All Default Date Filter Functions
from the context menu
navigate to General > Filter Settings > Restore All Default Date Filter Functions and click on the Restore
button.
To save changes and new functions click the Apply or Okay buttons

Custom Filter Function Properties
Each Custom Filter Function has the following properties:

Name
A name for the filter function that will be displayed to the end users. Required.

Description
A description of the function.
Note
To support multi-language functionality, if the filter function’s name or description can be prepended with _wrFunctionId. If this ID
matches the ID of any element in the language files, then the string of that language element will be displayed to the user instead of the
function name/description in the Admin Console. For more information see Multi-Language Support.

Filter Type
Determines the data type that the filter function should be available for. Either Date, String, Integer or Decimal.

List Order
The order the filter function will appear among other filter functions of the same type. Functions with a lower number will appear higher on
the list. If two functions have the same list value they will display in alphabetic order.
Note
All of the built in filter functions start with list value 100 or greater.

Language
The high-level language of the code for the date function. May be C#, JavaScript, or VB.NET.

References
A semicolon-separated list of any DLLs that need to be referenced by the Custom Filter Function. The DLLs must be present in the \bin
folder of the Exago Web Application, Scheduler Services, and the Web Service API if applicable. This folder can be found in the installation
directory of the respective component.
Note
System.dll does not need to be listed as a reference as it is already available.

Namespaces
A semicolon-separated list of any namespaces that need to be referenced by the Custom Filter Function.

Program Code
The program code for your Custom Filter Function. The code must return the data type that was set in the Filter Type setting.
Note
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Parameters may be referenced within custom functions by placing their name between @’s. For example, @userId@.

A Custom Filter Function that returns the date value of the last day of the current quarter
Click the Test custom code execution

icon to verify that the code properly compiles.

Default Custom Filter Functions v2016.3+
Exago comes with a number of built-in custom filter functions. They are exposed in the Admin Console so they may be modified as
needed.
Note
If these functions are unavailable, such as after an upgrade, follow the restore instructions in the Create, Edit, Delete, Restore Custom
Filter Functions section above to add them back to the configuration automatically.
In all of the examples below, today's date is assumed to be Friday, February 26, 2021.

FirstDayOfCurrentMonth
Description
Example

Returns a DateTime representing the first day of the current month
2/1/2021

FirstDayOfCurrentQuarter
Description
Example

Returns a DateTime representing the first day of the current
quarter
1/1/2021

FirstDayOfCurrentYear
Description
Example

Returns a DateTime representing the first day of the current
year
1/1/2021

FirstDayOfLastMonth
Description
Example

Returns a DateTime representing the first day of last
month
1/1/2021

FirstDayOfLastQuarter
Description
Example

Returns a DateTime representing the first day of last
quarter
10/1/2020

FirstDayOfLastYear
Description
Example

Returns a DateTime representing the first day of last
year
1/1/2020

FirstDayOfNextMonth
Description
Example

Returns a DateTime representing the first day of next
month
3/1/2021

FirstDayOfNextQuarter
Description
Example

Returns a DateTime representing the first day of next quarter
4/1/2021

FirstDayOfNextYear
Description
Example

Returns a DateTime representing the first day of next year
1/1/2022

FridayOfCurrentWeek
Description
Example

Returns a DateTime representing the Friday of the current
week
2/26/2021

FridayOfLastWeek
Description
Example

Returns a DateTime representing the Friday of the previous week
2/19/2021
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FridayOfNextWeek
Description
Example

Returns a DateTime representing the Friday of the next
week
3/5/2021

LastDayOfCurrentMonth
Description
Example

Returns a DateTime representing the last day of the current month
2/28/2021

LastDayOfCurrentQuarter
Description
Example

Returns a DateTime representing the last day of the current
quarter
3/31/2021

LastDayOfCurrentYear
Description
Example

Returns a DateTime representing the last day of the current
year
12/31/2021

LastDayOfLastMonth
Description
Example

Returns a DateTime representing the last day of the previous
month
1/31/2021

LastDayOfLastQuarter
Description
Example

Returns a DateTime representing the last day of the previous
quarter
12/31/2020

LastDayOfLastYear
Description
Example

Returns a DateTime representing the last day of the previous
year
12/31/2020

LastDayOfNextMonth
Description
Example

Returns a DateTime representing the last day of the next month
3/31/2021

LastDayOfNextQuarter
Description
Example

Returns a DateTime representing the last day of the next
quarter
6/30/2021

LastDayOfNextYear
Description

Returns a DateTime representing the last day of next year

Example

12/31/2022

MondayOfCurrentWeek
Description
Example

Returns a DateTime representing Monday of the current
week
2/22/2021

MondayOfLastWeek
Description
Example

Returns a DateTime representing Monday of the previous week
2/15/2021

MondayOfNextWeek
Returns a DateTime representing Monday of the next
week

Description
Example

3/1/2021

Today
Description Returns a DateTime representing today's
date
Example

2/26/2021

TodayMinus30Days
Description
Example

Returns a DateTime representing the date 30 days prior to
today
1/27/2021
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TodayMinus60Days
Returns a DateTime representing the date 60 days prior to
today

Description
Example

12/28/2020

TodayMinus7Days
Description

Returns a DateTime representing the date 7 days prior to today

Example

2/19/2021

TodayMinus90Days
Returns a DateTime representing the date 90 days prior to
today

Description
Example

11/28/2020

TodayPlus30Days
Returns a DateTime representing the date 30 days in the future from
today

Description
Example

3/28/2021

TodayPlus60Days
Returns a DateTime representing the date 60 days in the future from
today

Description
Example

4/27/2021

TodayPlus7Days
Description
Example

Returns a DateTime representing the date 7 days in the future from today
3/5/2021

TodayPlus90Days
Description
Example

Returns a DateTime representing the date 90 days in the future from
today
5/27/2021

Tomorrow
Description
Example

Returns a DateTime representing tomorrow's
date
2/27/2021

Yesterday
Description
Example

Returns a DateTime representing yesterday's date
2/25/2021

Custom Aggregate Functions
Exago comes with a number of functions that can be used to make formulas in the Formula Editor. Administrators may create additional
custom functions, using high level coding languages, which will be accessible to end-users of the Report Designer. In Exago v2019.2+
administrators may also create custom aggregate functions. Custom Aggregate Functions will be available in any formula editor in which
the existing built-in aggregate functions are also available.
Custom Aggregate Functions can be written in C# or VB.NET and can take as many input arguments as needed. They can get and set
elements of the current session state of Exago such as Parameter values. See the article on SessionInfo for more information.

Creating Custom Aggregate Functions
Custom Aggregate Functions may be created programmatically through the .NET API or manually through the Web Application. This
section details how to create Custom Aggregate Functions through the Web Application but contains important details about
programming the aggregate function which will apply to the .NET API as well.
1. In the Admin Console, navigate to Extensions > Aggregate Functions then click the Add
will open a new Custom Aggregate Function tab.

icon at the top of main menu. This

Each Custom Aggregate Function has the following properties:
Note
The Description and Category properties below support multi-language functionality, where an Id from a language file instead of a static
string may be supplied. For more information, see the article on Multi-Language Support.

Name
A name for the function that will be displayed to the end user and will be used to call the function. This name may only
contain letters, numbers and underscores, and must be different from any of the built-in aggregate functions.

Description
A description of the function that will be displayed to the end user when building a formula in the Formula Editor.

Category
A way of categorizing/grouping similar functions together. Custom Aggregate Functions may be assigned to any existing
category or to a new category. By default, custom aggregate functions are added to the Aggregate category unless a
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different one is chosen.
To create a new category, select Other from the dropdown. An input field named Specific Category Name (Optional) will
appear. Leaving this field blank will assign the new function to the Other category in the Formula Editor. A non-empty value in
this field will be added as a new category with the specified name.

Return Type
A return type must be specified for each Custom Aggregate Function. This field can be defined as a String, Integer,
Decimal, or Date, and determines the expected return type of the function.

Prevent In-Database Grouping When Included in Detail Section
If the Custom Aggregate Function is called from a Detail section of a report and that Detail section is suppressed
(hidden), setting this flag to True will prevent Exago from requesting the aggregation be done in the database. Instead
aggregation will be done in memory insuring that the Custom Aggregate Function is called for each Detail row.
If False, Exago's normal behavior determined by the Database Aggregation setting is utilized. If applicable, aggregation will
be done in the database and then the Custom Aggregate Function will be called afterwards. This might cause trouble if the
function is intended to work on unaggregated or ungrouped data.
For example, most functions that build or manipulate memory storage with GetStoredValue/SetStoredValue should have
this flag set to True.
This flag will have no affect if the Custom Aggregate Function is called from any other section besides a Detail section.
Note
If Exago's Database Aggregation setting is False, then aggregations will never be done in the database regardless of the
setting of the Prevent In-Database Grouping When Included in Detail Section flag.

Arguments
Click Edit Argument Info to show a dialog for managing arguments.

Edit Argument Dialog
Arguments are passed to the code as an array of generic objects, accessed as args[]. Custom Aggregate Functions
have two required arguments, dataToAggregate and recordLevel.
dataToAggregate: the data field or formula to aggregate. Can be renamed, but must always be the first argument.
recordLevel: indicates whether aggregation should occur at the record level or entity level. If true, aggregation occurs
on the record level. Can be renamed, but must always be the last argument. Refer to the articles on Aggregate
Functions and the Admin Console's Other Settings for more information on how this argument works.
Important
recordLevel will evaluate to true if it is set to any true value (as returned by functions like True(), a nonzero number, or a
non-empty string).
To add additional arguments to the function, click the Add Argument button.
To remove arguments from the function, click the Delete Row

icon at the end of the respective row.

Arguments have the following properties:
Note
Both Name and Description properties below support multi-language, where an Id from a language file instead
of a static string may be supplied. For more information, see the article on Multi-Language Support.

Name
The name of the argument, which will appear as a placeholder in the function parentheses and in the function's
description tooltip.

Description
A description for what the argument is used for which will appear as a tooltip when the placeholder name is
selected.

Optional
Check the box if a value for the argument does not need to be supplied when the function is called. Leave the
box unchecked if a value must be supplied.
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If a user does not supply a required argument, the formula editor will highlight the error.
Optional arguments are surrounded by brackets [ ] in the function's description tooltip.

Program Code
Language
The programming language of the code for the function. Either C# or VB.NET.

References
A semicolon-separated list of any libraries that need to be referenced by the Custom Aggregate Function. The DLLs must
be present in the \bin folder of the Exago Web Application, as well as any Scheduler \bin folders, and the Web Service
API, if applicable.
Note
System.dll does not need to be listed as a reference as it is already available.

Namespaces
A semicolon-separated list of any namespaces that need to be referenced by the Custom Aggregate Function.
WebReports.Api.Custom; WebReports.Api.Common; will be added automatically as they are required.

Code Editor
The code editor contains the program code for the Custom Aggregate Function. Unlike Custom Functions, the program
code for Custom Aggregate Functions accommodates a full class definition.
A Custom Aggregate Function must contain at most one class that implements the ICustomAggregator interface. The
code may include more than one class definition, but no more than one class should implement ICustomAggregator.
Depending on which language chosen, the code editor will pre-fill with a code stub as a general starting suggestion. This
stub is an empty class which implements the ICustomAggregator interface. Examples of both C# and VB stubs are
shown below.
C# Code Stub
public class MyCustomAggregator : ICustomAggregator
{
public void AddValue(SessionInfo sessionInfo, object value, params object[] args)
{
}
public object Result(SessionInfo sessionInfo)
{
}
}

VB Code Stub
Public Class MyCustomAggregator
Inherits ICustomAggregator
Public Overrides Sub AddValue(ByVal sessionInfo As SessionInfo, ByVal value As Object, ParamArray args As Object())
End Sub
Public Overrides Function Result(ByVal sessionInfo As SessionInfo) As Object
End Function
End Class

Note
To use a .NET Assembly for custom aggregate functions, first add it to the applicable \bin folders. Then add the assembly
as a reference in the Code Editor.
During report execution, the conditions under which Exago will call AddValue change depending on what is passed to the
Custom Aggregate Function’s dataToAggregate argument. This mirrors the behavior of the built-in aggregate functions:
If a data field is passed, and the function's recordLevel argument is false, AddValue is called when the key of the
data field’s data object in the current record is different from that of the previous record. If recordLevel is true,
AddValue is called for every record.
If a parameter is passed, AddValue is called for every record.
If a formula or cell reference is passed, AddValue is called for every record.
Result is called when the current break section has terminated. The aggregation result should be returned here. An
explanation of when section processing ends is below in the following paragraphs.
When this Custom Aggregate Function is used on a report, Exago will instantiate a new instance of the class
implementing ICustomAggregator once at the beginning of report execution, and again every time the section that the
Custom Aggregate Function appears in breaks. This means that ICustomAggregator implementations will only
aggregate within whichever section iteration is currently being processed, and aggregation starts over at the beginning of
each new section.
A section breaks when its corresponding sorting entity's unique key changes. For example, consider a report with Products
organized into Category groups. To know when a new product Category starts and the previous Category ends (and thus
when to display the appropriate section headers/footers and to perform aggregation), Exago looks for the unique key of the
Category entity to switch to a new value, this is a section break.
If the custom aggregate function is in a:
Detail section, a new ICustomAggregator is instantiated once before the first record is processed, then again
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before every other record is processed.
Group Header, a new ICustomAggregator is instantiated once before the first record is processed, then again
after every other Group Header with the same group break is processed.
Report Footer, a new ICustomAggregator is instantiated only once, before the first record is processed.
Click the Test Execution

icon to test the code for errors.

ICustomAggregator Interface
public interface ICustomAggregator
{
void AddValue(SessionInfo sessionInfo, object value, params object[] args);
object Result(SessionInfo sessionInfo);
}

The ICustomAggregator interface defines two functions, AddValue and Result. There must be one and only one class
defined in the Custom Aggregate Function's program code that implements both of these functions.
void AddValue(SessionInfo sessionInfo, object value, params object[] args)

value: The value to aggregate. The cell data derived from the dataToAggregate argument passed to the custom
aggregate function is passed here.
args: subsequent arguments passed to the custom aggregate function are made available here. args[0] here will
be the argument following dataToAggregate in the custom aggregate function call.
object Result(SessionInfo sessionInfo);

Called when the current break group has terminated. The aggregation result should be returned.
To complete the creation of the Custom Aggregate Function:
2. Click Apply or Okay. Exago will check the code for compilation errors and display a warning if any are found.
3. If there are no warnings, the Custom Aggregate Function is now available for use.

Editing Custom Aggregate Functions
1. In the Admin Console, navigate to Extensions > Aggregate Functions.
2. Click on the name of the Aggregate Function to be edited, then click on the Edit
icon at the top of the main menu.
3. Review the section on creating Custom Aggregate Functions to understand all of the available fields.

Deleting Custom Aggregate Functions
1. In the Admin Console, navigate to Extensions > Aggregate Functions.
2. Click on the name of the Aggregate Function to be deleted, then click on the Delete

icon at the top of the main menu.

Examples
Several examples of Custom Aggregate Functions can be found in the How-To Guides > Custom Functions section of our
documentation.

Custom Options
This article applies to the Admin Console >

Extensions > ;

Custom Options settings.

Custom Options allow for the definition of settings that users can modify on a per-report basis in the Report Designer. Options can be
accessed during report execution by Server Events or Custom Functions.
The name of each option can be controlled on a per-user basis using the multi-language feature. Custom Options can be Integers,
Decimals, Booleans, Strings or Lists. Each data type provides an appropriate UI element for the user to select a value.

Create, Edit, Delete Custom Options
To add a new custom filter function click

Extensions >

Custom Options in the Main Menu and either:

click the Add
icon at the top of the main menu
right-click and select Add from the context menu
To edit an option either:
double click it
select it and click the Edit
icon at the top of the main menu
right-click it and select Edit from the context menu
To delete an option either:
select it and click the Delete
icon at the top of the main menu
right-click it and select Delete from the context menu
To save changes and new options click the Apply or Okay buttons

Custom Option Properties
Each Custom Option has the following properties:

Id
The unique Id or name of the custom option. The Id is used in accessing the option and may be displayed in the Custom Options Menu as
the user sets its value on a report. Required.
The Id may not contain the following characters:
[ ] { } . , @ and whitespace.

Note
To support multi-language functionality, create an element in the language file(s) with an Id that matches the Option’s Id. The string of
that language element will be displayed to the user in the Custom Options Menu. For more information see Multi-Language Support.
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Type
The data type the Custom Option should display. Each data type will display an appropriate input element in the Custom Options Menu.
The following types are available.
Int: Represents a whole number.
Decimal: Represents a decimal number.
Bool: Represents a Boolean value. A checkbox is displayed.
Text: Represents a text string and displays a text box.
List: Represents a single choice from among multiple values. Click the Add

icon to define list choices.

User Interaction with Custom Options
After Custom Options are created, the Custom Options Menu will be available in the Report Designer of Advanced and CrossTab Reports.

Custom Options in Report Designer Settings menu
Note
The Custom Options Menu will only display if Custom Options exist.
In the Custom Options dialog, values can be set using the user interface elements displayed above.

Custom Options dialog with one list and one decimal option

Accessing Custom Option Values
The .NET API, Server Events, and Custom Functions can access Custom Option values through the SessionInfo.Report object by
using the following function:

string GetCustomOptionValue(string id)
Description

Returns the value of the specified Custom Option as a string.
For Bool options the value returned will be true or false.
For List Options, the chosen Id is returned.

Remarks

Note
List options will return the Id of the selected value and not the displayed language
string.
A Custom Function could use the following C# code to return the value of a Custom
Option. The Id of the Option is entered as an argument of the Custom Function.

Example
return
sessionInfo.Report.GetCustomOptionValue(args[0].ToString());

Hidden Flags
The following options are inaccessible from the Admin Console, but may be toggled on or off or otherwise modified by editing the field in
the XML configuration file.
<allowhtmlinscheduledemails> — Set to True to allow users to insert html tags within the body of scheduled emails.
<filterdropdownobjecttenancy> — Set to False to disable tenanting on filter and parameter dropdown objects. If this is
disabled and a tenant column limits the dataset for a data object, then a filter or parameter dropdown list within a report will show
the full dataset for the data object rather than its intended limited subset.
Example
A tenant column limits the dataset of an Employees data object so that only data for an employee with the last name "King"
appears. A report that uses this data object will only output data associated with King. If <filterdropdownobjecttenancy> is
True (default), then a filter on Employees.LastName added to this report will only allow King to be selected. However, if it is set to
False, the filter on Employees.LastName will allow all employee last names to be selected even though only data for King will
appear.
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<showbrowseroutofdatewarning> (v2016.3.4+) — Set to False to prevent a popup error message from appearing if a user
accesses Exago with an unsupported browser.
<webfarmsupport> — If not using sticky sessions in a web farm environment, should be True. More temp information will be
written to disk when True allowing other nodes in the farm to read it. Should be False if sticky sessions is configured or when
Exago runs in a single node to stop unnecessary costly disk writes and keep information in memory instead.
<expressviewdefaultformattheme> — (v2017.1+) Select a default ExpressView theme. Provide the name of the file in the
\Themes directory or the name of the theme as it appears in the content table of the Storage Management database.
<aliasallentities> — (v2017.2+) Set to True to always use the Exago data object ID as table aliases in application
generated SQL, rather than auto-generated aliases.
<allowearlypagebreak> — (v2017.3+) Set to True to allow users to insert a page break at the beginning of a report, which
would cause the first page to be empty.
<canjointransformobjectsindb> — (v2018.1+) Set to False to cause vertical table transformations to be processed in the
application instead of in the database. This will prevent the use of advanced joins with vertical tables.
<performancetesting> — (v2018.2+) Set to True to set Ctrl+Alt+A to allow for running a report a specified number of times
simultaneously for performance testing. Must be run from the report designer for the desired report.
<reportlistcache> — (v2018.2–v2020.1.0) Set to False to opt out of caching in the GetReportList method when using a Folder
Management assembly.
<webrequestkeepalive> — (v2018.2+) Set to True to allow the use of a single TCP connection to send and receive multiple
HTTP requests. If set to False, a new TCP connection will be opened for every HTTP request. This flag only applies to Google Maps
widgets.
<webrequestprotocolversion> — (v2018.2+) Defaults to "1.1", allowing the definition of 24 status codes as well as other
advancements made present in HTTP protocol version 1.1. This flag only applies to Google Maps widgets.
<showexpressreports> — (v2019.2+) Set to True to enable the Express Report Wizard.
<role><showexpressreportsstylingtoolbar></role> — (v2019.2+) Set to True to display styling tools in the Layout
tab of the Express Report Wizard for a role, or False to hide them.
<role><showexpressreportsthemes></role> — (v2019.2+) Set to True to display the Theme drop-down in the Layout tab
of the Express Report Wizard for a role or False to hide it.
<role><showexpressreportsgrouping></role> — (v2019.2+) Set to True to show grouping tools in the Layout tab of the
Express Report Wizard for a role or False to hide it.
<role><showexpressreportsformulabutton></role> — (v2019.2+) Set to True to show the Formula Editor button in the
Layout tab of the Express Report Wizard for a role or False to hide it.
Any fields which are not mentioned here are either not intended for external use or not fully implemented and should be ignored.

Monitoring: Setup
Monitoring that allows report management, execution, and performance statistics for the web application and schedulers to be tracked in
v2017.1+. Monitoring data is stored in local SQLite database files and can be reported on using Exago.
Many actions in the application can be monitored:
Report Management
Edit
Execute (begin & end)
Save
Delete
Rename
Duplicate
Report Designer usage
Gauge Wizard
Google Map Wizard
GeoChart Wizard
Map Wizard
Scheduling
Scheduled report
Schedule Manager
Monitoring for these components can be toggled on or off depending on your needs.
Additionally, you can track track CPU and memory load for each scheduler application so you can fine-tune your load balancing setup.
When the Exago Web Application is installed, the monitoring system is automatically installed, but it is disabled by default. It must be
configured and enabled manually. To set up monitoring, you need to configure the monitoring application, set your options for which data to
collect, and then set the monitoring service to run automatically.

Configuring Monitoring
Note
This article references <WebApp>as a placeholder for the application's install location. The default install locations are /opt/Exago/ on
Linux and C:\Program Files\Exago\ExagoWeb\ on Windows; however, these directories may be changed during installation.
The monitoring system is located in a folder MonitoringService, in the same folder as where the Web application is installed. The web
application stores its monitoring data in a Monitoring subfolder of the installation. So you should have the following folders:
<WebApp>
Monitoring
MonitoringService
Windows: Ensure that the IIS user has Full Control permissions for the ExagoWeb\Monitoring and MonitoringService folders.
See Configuring IIS for instructions.
To configure monitoring:
1. In MonitoringService, open the file Monitoring.exe.config in a text or xml editor. For each of the following keys in the
<appSettings> element, set the values as follows:
exagoAppPath, value="path" where path is the file path to the web app
Format: "C:\file\path\" (Windows), "/file/path/" (Linux)
A trailing slash (\) or (/) is required
userConfig, value="config" where config is the application config file
Format: "filename.xml"
Use extension .xml for either the encrypted or unencrypted version
webAppUri, value="uri" where uri is the url virtual path to the web app
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Format: "http://local/path/"
A trailing backslash (/) is required
Optional: ExtractionIntervalMinutes, value="i" where i is the number of minutes between updates to the core
database. The default is 3.
Optional: StatisticsIntervalMinutes, value="j" where j is the number of minutes between when each scheduler
is polled for performance statistics. The default is 1.

Example
<appSettings>
<add key="ExtractionIntervalMinutes" value="3" />
<add key="StatisticsIntervalMinutes" value="1" />
<add key="exagoAppPath" value="C:\ExagoWeb\" />
<add key="userConfig" value="WebReports.xml" />
<add key="webAppUri" value="http://localhost/monitoring/" />
</appSettings>

2. In <WebApp>, open the file appSettings.config in a text or xml editor. In the <appSettings> element, set
the Monitoring.DbPath key to the folder where your web application's monitoring data file is. The default location
is <WebApp>\Monitoring.

Example
<appSettings>
<add key="Monitoring.DbPath" value="C:\Exago\ExagoWeb\Monitoring\" />
...
</appSettings>

3. In the same file, set the options for which types of usage data you want to collect. To turn on monitoring for a specific action, set
the value for the key to "true". Available options are as follows:
Monitoring.CollectDeleteReportUsage
Monitoring.CollectRenameReportUsage
Monitoring.CollectDuplicateReportUsage
Monitoring.CollectExecuteReportUsage
Monitoring.CollectSaveReportUsage
Monitoring.CollectSaveReportXmlUsage
Monitoring.CollectDesignReportUsage
Monitoring.CollectGaugeControlUsage
Monitoring.CollectGoogleMapControlUsage
Monitoring.CollectMapControlUsage
Monitoring.CollectChartControlUsage
Monitoring.CollectScheduleReportControlUsage
Monitoring.CollectScheduleReportManagerControlUsage

Example
<appSettings>
...
<add key="Monitoring.CollectDeleteReportUsage" value="true" />
<add key="Monitoring.CollectRenameReportUsage" value="false" />
<add key="Monitoring.CollectDuplicateReportUsage" value="true" />
<add key="Monitoring.CollectExecuteReportUsage" value="true" />
...
</appSettings>

4. Restart your web server for the changes to be applied.

Configuring Scheduler Monitoring
If you want to track scheduled report execution, do the following for each Scheduler Service installation:
Open the eWebReportsScheduler.exe.config file in a text or XML editor. Add the following key to the <appSettings> element:
<add key="Monitoring.CollectExecuteReportUsage" value="true" />

Enabling the Monitoring Service
The monitoring system uses a Windows or Linux service that updates the core database with data from the Web Application and
Schduler Services at specified intervals. This way you have the data from every component in a single location.
The service is installed automatically, but it is not enabled by default. To enable the service:

Windows
1. As an administrator, open the Windows Services manager:
1. Click Start>Run.
2. Type services.msc.
3. Press Enter.
2. Locate the service Exago Monitoring Service vX.X.X.X, where vX.X.X.X is your Exago version. Right-click the service
and select Properties.
3. In the Properties window:
1. From the Startup Type list, select Automatic.
2. Click Start to start the service.
3. Click OK.

Accessing the Monitoring Data With Exago
To use monitoring data in reports, you need to add the Monitoring Service's core database
file MonitoringService/Monitoring.sqlite as an Exago Data Source.

Recommended Resources
Using SQLite Data Sources
Data Sources
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Monitoring: System Overview
The Monitoring system is structured in the following manner:

Structure of the monitoring system

Web Application Database
The Web Application database stores data for report and user interface events. The type of data tracked depends on your configuration. At
the Extract interval, the monitoring service moves this data from the local db to the collected db.

Scheduler Application Databases
Each Scheduler Service has a local database which stores report execution data, if enabled in the configuration. At the Extract interval, the
monitoring service moves this data from the local dbs to the collected db.
Scheduler performance data is "persistent," that is, always available, and is therefore not stored in the local scheduler dbs. At the
Statistics interval, the monitoring service polls the schedulers for their performance statistics, and logs this data in the collected db.

File Paths for Config Files & Databases
ExagoWeb\Monitoring\Monitoring.sqlite - WebApp db
ExagoWeb\appSettings.config - Select which web app data to track
MonitoringService\Monitoring.sqlite - Main collected db
MonitoringService\Monitoring.exe.config - Set Extraction & Statistics intervals

ExagoScheduler\Monitoring.sqlite - Scheduler local db
ExagoScheduler\eWebReportsScheduler.exe.config - Select which scheduled report data to track

Monitoring Database Schema
The monitoring database has three tables that can be used to build reports. This article describes what data is stored, and how to interpret
what you see.

Entity-relationship diagram (ERD) for the monitoring database

SystemStatistics
The SystemStatistics table logs the available CPU load and memory for the system on which each scheduler service is installed.
Data is polled at occasional intervals. You can specify the time between polls using the StatisticsIntervalMinutes setting in the
Monitoring.exe.config file. For instructions, see "Configuring monitoring".
The table contains the following data columns:
id
An integer used to uniquely identify each row. This is the primary key for the table.
transactionId
(v2017.2+) An integer used to associate rows with type: cpu available and type: free memory to common transactions, in order
to facilitate a vertical table transformation and report off both CPU and Memory usage in the same report and chart.
hostId
The scheduler which was polled for system data. Every scheduler is polled at the same time. Schedulers are identified by their host
address, as specified in the Administration Console.
Example. tcp://localhost:2010
type
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One of:
cpu available, which indicates that the value field in this row shows the CPU load percentage available at this time.
free memory, which indicates that the value field in this row shows the amount of free memory at this time.
value
One of:
A value indicating the CPU load available at this time, as a percentage of 100%. This field indicates CPU available if the type field
for this row shows cpu available. This value is "-1" if the scheduler could not be reached at this time.
A value indicating the amount of free memory at this time, in megabytes (MB). This field indicates free memory if the type field for
this row shows free memory. This value is "-1" if the scheduler could not be reached at this time.
Note. This field should be formatted as a decimal, either in the metadata for this column, or in the report cell formatting.
timestamp
A datetime value indicating when this scheduler was polled.

Transform
The following vertical transformation is recommended for the SystemStatistics table:
<entity>
<!--<entity_name></entity_name>-->
<db_name>SystemStatistics</db_name>
<!--<datasource_id></datasource_id>-->
<object_type>table</object_type>
<key>
<col_name>transactionId</col_name>
</key>
<transform>
<col_name>type</col_name>
<val_name>value</val_name>
<non_transform_col>
<col_name>timestamp</col_name>
<data_type>8</data_type>
</non_transform_col>
<non_transform_col>
<col_name>hostId</col_name>
<data_type>0</data_type>
</non_transform_col>
<non_transform_col>
<col_name>transactionId</col_name>
<data_type>0</data_type>
</non_transform_col>
</transform>
</entity>

Audit
The Audit table records when certain events, which you specify, happen to reports. This table records data for the web application and the
schedulers.
Data is logged at the time of each event, but the data is only collected in the core database at occasional intervals. You can specify
the time between data collections using the ExtractionIntervalMinutes setting in the Monitoring.exe.config file. For instructions,
see "Configuring monitoring".
The table contains the following data columns:
id
An integer used to uniquely identify each row. This is the primary key for the table.
hostId
The application for which this action took place. The web application and schedulers are identified by their host address.
Example. tcp://localhost:2010
Example. http://localhost
transactionType
A string indicating which type of event has triggered this row to be created. One of:
Execute Report
Rename Report
Duplicate Report
Delete Report
Design Report
Save Report XML
Chart Control
Gauge Control
Map Control
Google Map Control
userId
The userId parameter for this event.
companyId
The companyId parameter for this event.
timestamp
A datetime value indicating when this event happened.
auditId
For rows where the transactionType is Execute Report, this field joins up to two rows in the ExecutionDetail table that indicate
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when this execution started and, if successful, when it ended.
This field also joins rows in the ReportDetail table which give some information about the report in which the logged event happened.

ExecutionDetail
This table records data for report execution events.
Up to two rows for each event are created:
The first has transactionType Report Execution Begins, which logs when the report execution started.
The second has transactionType Report Execution Ends, which logs when the report execution ends. If the report execution
was not successful, this row will not be created.
The table contains the following data columns:
auditId
An integer used to join up to two rows in this table with a row in the Audit table.
transactionId
A globally unique identifier (GUID) for this execution. This GUID is used in several places throughout Exago. Notably, it is used as
the file name for scheduled reports which have been saved to disk.
transactionType
One of:
Report Execution Begins, which indicates that the timestamp value for this row shows when this execution started.
Report Execution Ends, which indicates that the timestamp value for this row shows when this execution ended.
timestamp
A datetime value indicating when this execution started or finished, depending on the value of transactionType.
Note. This table uses columns (transactionId and transactionType) as a primary key.

Transform
The following vertical transformation is recommended for the ExecutionDetail table:
<entity>
<!--<entity_name></entity_name>-->
<db_name>ExecutionDetail</db_name>
<!--<datasource_id></datasource_id>-->
<object_type>table</object_type>
<key>
<col_name>transactionId</col_name>
</key>
<transform>
<col_name>transactionType</col_name>
<val_name>timestamp</val_name>
<non_transform_col>
<col_name>auditId</col_name>
<data_type>2</data_type>
</non_transform_col>
</transform>
</entity>

ReportDetail
This table records information about the reports which relate to events in the Audit table.
auditId
An integer used to join a row in this table with a row in the Audit table.
reportId
The file path and name of the report which the event affected.
reportType
The type of report: advanced, express, expressview, chained, dashboard

Styling the Home Page
Visually modifying and branding the user interface is a simple but effective step toward integrating Exago into a host application. For
styling purposes Exago can be thought of as a control that sits within a div on an .aspx (html) page.
Aesthetic changes can be made for single users or groups of users by directing each user/group to different custom .aspx pages.
However, we suggest using Application Themes instead to encapsulate groups of changes, which can be selected dynamically in the
API.
To visually integrate Exago, make a copy of the ExagoHome.aspx file and modify the elements surrounding the Exago control or override
the CSS of the user interface itself.
Note
Do not make changes directly to ExagoHome.aspx as they will be overwritten during upgrades. Instead use the example below to create
a custom .aspx page.

Exago Control
The example below is the minimum code necessary to embed the Exago control.
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<%@ Page Language="C#" EnableViewState="false" EnableEventValidation="false" %>
<%@ Register src="WebReportsCtrl.ascx" tagname="WebReportsCtrl" tagprefix="wr" %>
<!DOCTYPE html>
<html>
<head runat="server">
<title>Exago</title>
</head>
<body>
<form runat="server">
<wr:WebReportsCtrl ID="WebReportsCtrl" runat="server" />
</form>
</body>
</html>

Exago Control Properties
Several properties can be set on the Exago Control to modify various settings and behaviors of Exago. The following properties can be set.
ConfigFile — Loads a configuration file other than that created by the Administration Console (e.g.
ConfigFile="NorthwindConfig.xml").
Note
If entering Exago through the Api this parameter is ignored.
LanguageFile — Specify which language files to use in place of the 'Language File' parameter of Main Settings in the
configuration file. (e.g. LanguageFile="es-mx, getting-started-custom").
ForceIECompatMode — Setting to True will force certain JavaScript functions to working in 'compatibility' mode. This may be
necessary if dragging a Data Field into a cell of the Report Designer does not work properly. (e.g.
ForceIECompatMode="true").
XUaCompat — Controls whether to remove the meta u-ax-compatible tag when running reports to PDF in IE8. The default is false
which removes the tag. If you are experiencing issues downloading PDF reports in IE8 setting this flag to True may resolve the
issue. (e.g. XUaCompat="true").
Note
IE8 is no longer supported by Exago, as of v2016.1.

Changing CSS and Images
All of the CSS and images used by Exago can be modified within the aspx page if desired. However we recommend using an Application
Theme instead.
Any icon in Exago can be changed on a per-company or per-user basis:
1. Create the custom images you would like to display.
2. Identify the Id of the image you want to change. See Finding Image Ids for more details.
3. Create a language file that maps the Ids to the location of the custom images. See Multi-Language Support for more information.

Example
<element id="ExportTypeMenuHtml" image= "Config\Images\Custom\HTMLExecutIconLarge.png"></element>

Hovering Images
For icons that have hover effects there is a special naming convention.
To change custom icons with hover effects:
1. Follow the steps above to create the non-hover icon.
2. Create the custom icon with the hover effect. Save it to have the same name as the non-hover icon and append "_h" to its name.

Finding Image Ids
To find the Ids of icons in Exago:
1. Open Exago in a browser.
2. Use the browser’s developer tools to inspect the icon you want to change. For most browsers this can be done by pressing F12.
3. Look at the id property of the icon. There will be several words separated by underscores. Use the last element as the image Id (see
example below).

Customizing Getting Started Content
The Getting Started tab is displayed as a user enters the Exago Web Application user interface. This tab can be customized by
customizing HTML in a language definition file. This is done by modifying the language element <GettingStartedContent> in the
<WebApp>\Config\Languages\en-us-getting-started.xml
Note
This article references <WebApp> as a placeholder for the Web Application's install location.
To assist in customizing the Getting Started tab, Exago provides several JavaScript functions and HTML5 attributes to open the New
Report Wizard, execute reports, open other custom tabs and display reports as Dashboards.
The figure below demonstrates a custom Getting Started tab. The two charts are loaded with the data-onloadreportname HTML5
attribute. The links to the New Report Wizard and Dashboard Designer use the void wrStartNewReportWizard([string
reportType]) function.
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Note
It is recommended to make custom tabs in a separate language file to make it easy to change tabs by user or groups of users. See
Modifying Select Language Elements.

Creating Additional Custom Tabs
Additional custom tabs can be created by creating a language elements with a unique name containing the HTML content. Custom tabs
can be opened with the JavaScript function wrAddTabbedContent.
This example demonstrates a custom tab that has buttons to launch a report in different formats.
<element id="QuickReportsTab">
<button value="HTML" onclick="wrExecuteReport('My Reports\\Revenue', 'html');" />
<button value="EXCEL" onclick="wrExecuteReport('My Reports\\Revenue', 'excel');" />
<button value="PDF" onclick="wrExecuteReport('My Reports\\Revenue', 'pdf');" />
<button value="RTF" onclick="wrExecuteReport('My Reports\\Revenue', 'rtf');" />
<button value="CSV" onclick="wrExecuteReport('My Reports\\Revenue', 'csv');" />
</element>

JavaScript Functions
To assist with the creation of custom tab content, Exago provides a number of JavaScript functions to allow custom HTML to call features
of Exago.

void wrStartNewReportWizard([string reportType])
Opens the Report Wizard in a new tab. Optionally, specify which wizard to open with the reportType argument.
Available values for reportType:
Description

Example

advanced
express
expressview
dashboard
chained
<p>Click <span style="text-decoration:underline; cursor:pointer;" onclick="wrStartNewReportWizard();">here</span> to create a new report.</p>

void wrStartDuplicateReportDialog(string reportFolder\\reportName)
Description Opens the Duplicate Report dialog.
Remark
Example

If the report name is null or blank Exago will use the report selected in the Main Menu.
<p>Click <span style="text-decoration:underline; cursor:pointer;" onclick=" wrStartDuplicateReportDialog();">here</span> to create a duplicate this report.</p>

void wrExecuteReport(string reportFolder\\reportName, string
format)
Description Executes the specified report in the specified format.
Example

<input type="button" class="Button" value="HTML" onclick="wrExecuteReport('Sales Reports\\Revenue by Category','html')

string wrGetSelectedReportName()
Description

Returns the name of the report that is selected in the Report Tree.

Remark

The returned string will include the folder structure of the report separated by slashes.

void wrAddTabbedContent(string ContentID, string TabName)
Description

Opens a new tab and loads the HTML stored in the element of the Language file that
corresponds to the ContentID string.
The ContentID should match the element ID of the HTML you want to load.

Remark

The TabName can match the element ID of the name you want the tab to display, or a
custom string with the name of the tab.

JavaScript HTML5 data- Attributes
To assist with the creation of custom tab content, Exago provides a number of HTML5 data- attributes to allow custom HTML to call
features of Exago.

data-onloadreportname="ReportFolder\ReportName"
Description

Executes a report as HTML and loads it into a div or iframe. Dashboards are not compatible with data-
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Executes a report as HTML and loads it into a div or iframe. Dashboards are not compatible with dataonloadreportname.
The report string should be formatted as "Report Folder\\Report Name."
Note

Remark

When using this function make sure the setting Enable Debugging in Other settings is False.
Example

<div class="Report" data-onloadreportname="Employee Reports\Number of Sales by Employee"></div>

data-useviewer="True/False"
Description Specifies to load a report as raw HTML or utilize Exago dynamic report viewer.
Remark
Example

Default value is true. In cases where the dynamic capabilities of the Report Viewer is not needed set to false to load raw HTML. This has a similar
behavior to using either ApiAction vs. GetExecute methods via the APIs.
<div class="Report" data-onloadreportname="Employee Reports\Number of Sales by Employee" data-useviewer= “False”></div>

data-enablescrolling="value"
Description Specifies whether or not to show scroll bars. This can helpful for certain reports that may not fit exactly within the startup content.
Available values for value:
Remark

Example

true — show scrollbars (default)
false — do not show scrollbars
<div class="Report" data-onloadreportname="Employee Reports\Number of Sales by Employee" data-enablescrolling= “False”></div>

data-reloadinterval="value"
Description Reloads a report every value seconds.
Remark
Example

This function is used in conjunction with data-onloadreportname.
<div class="Report" data-onloadreportname="Employee Reports\Number of Sales by Employee" data-reloadinterval="2"></div>

data-allowexport="value"
Description Specifies whether or not to show the export menu for the report.
Available values for value:
Remark

Example

0 — do not show the menu (default)
1 — show the menu
<div class="Report" data-onloadreportname="Employee Reports\Number of Sales by Employee" data-reloadinterval="1"></div>

Custom Context Sensitive Help
Exago is installed with context sensitive help. When a user clicks the Help
icon a tab opens to display the appropriate section of the
Exago User Guide. The content of this tab can be replaced with custom content managed by the host application.
To implement Custom Context Sensitive Help:
1. Create a minimum of one webpage for the custom help content.
2. Set the Admin Console > General Settings > Feature/UI Settings > Custom Help Source setting to the URL of the webpage
from step 1. Prefix the URL with url=.
Example
url=http://www.Customhelp.com/Exago;

Important
Supplying a value for the Custom Help Source will replace the Exago provided help system throughout the entire application.

Now, when a user clicks the Help

icon a tab opens to display the content from the supplied Custom Help Source URL.

The user’s language and a context parameter will be appended as a query string to the URL.
The language is determined by the value of the Admin Console > General Settings > Main Settings > Language File setting.
The context parameter is determined by where in the application the user clicked the Help
below.

icon, selected from Table A

Example
http://www.customhelp.com/Exago?helpKey=tabChartType&language=en-us

Table A — Custom Context Help Context Parameters
Context Parameter aka "helpKey"
Details
tabexecute
The user is in the Report Viewer.

ExpressView
tabExpressView

The user has the ExpressView Designer active.

tabExpressViewFilter v2019.2.37+v2020.1.20+v2021.1.8+ The user is interacting with the Filters tab of the
ExpressView Designer's Properties Pane
tabExpressViewSort v2019.2.37+v2020.1.20+v2021.1.8+

The user is interacting with the Sorts tab of the
ExpressView Designer's Properties Pane

tabExpressViewViz v2019.2.37+v2020.1.20+v2021.1.8+

The user is interacting with the Visualizations tab of the
ExpressView Designer's Properties Pane

dialogExpressViewFormulaEditor
v2019.2.37+v2020.1.20+v2021.1.8+

The user has the Formula Builder in the ExpressView
Designer open.
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Express Report Wizard
tabExpressName

The user has the Name tab of the Express Report Wizard
active.

tabExpressCategories

The user has the Categories tab of the Express Report
Wizard active.

tabExpressSorts

The user has the Sorts tab of the Express Report Wizard
active.

tabExpressFilters

The user has the Filters tab of the Express Report Wizard
active.

tabExpressLayout

The user has the Layout tab of the Express Report Wizard
active.

tabExpressOptions

The user has the Options tab of the Express Report Wizard
active.

Chained Report Wizard
tabChainedName

The user has the Names tab of the New Chained Report
Wizard active.

tabChainedReports

The user has the Reports tab of the New Chained Report
Wizard active.

tabChainedOptions

The user has the Options tab of the New Chained Report
Wizard active.

CrossTab Wizard
tabCrosstabName

The user has the Names tab of the New CrossTab Report
Wizard active.

tabCrosstabCategories

The user has the Categories tab of the New CrossTab
Report Wizard active.

tabCrosstabFilters

The user has the Filters tab of the New CrossTab Report
Wizard active.

tabCrosstabLayout

The user has the Layout tab of the New CrossTab Report
Wizard active.

dialogCrosstabOptions

The user has the CrossTab Data Designer dialog open.

New Report Wizard pre-v2021.1
tabAdvancedName pre-v2021.1

The user has the Names tab of the New Advanced Report
Wizard active.

tabAdvancedCategories pre-v2021.1

The user has the Categories tab of the New Advanced
Report Wizard active.

tabAdvancedSorts pre-v2021.1

The user has the Sorts tab of the New Advanced Report
Wizard active.

tabStandardFilters pre-v2021.1

The user has the Filters tab of the New Advanced Report
Wizard active.

tabAdvancedLayout pre-v2021.1

The user has the Layout tab of the New Advanced Report
Wizard active.

Report Designer
tabDesign

The user is editing an Advanced or CrossTab report in the
Advanced Report Designer.

dialogName

The user has the Rename Menu active.
This key is never called in v2021.1+

dialogDescription

The user has the Description Menu active.
This key is never called in v2021.1+

dialogCategories

The user has the Categories dialog open.

dialogSorts

The user has the Sorts dialog open.

dialogFilters

The user has the Filters dialog open.

dialogGeneralOptions

The user has the General Options dialog open.

dialogHtmlOptions

The user has the Report Viewer Options dialog open.

listItemReportHtmlOptionsGeneral

The user has the General section of the Report Viewer
Options dialog open.

listItemReportHtmlOptionsFilters

The user has the Filter section of the Report Viewer Options
dialog open.

listItemReportHtmlOptionsSorts

The user has the Sorts section of the Report Viewer
Options dialog open.

dialogTemplates

The user has the Template dialog open.

dialogJoins

The user has the Joins dialog open.

dialogJoinEdit

The user has the Joins dialog open.

dialogFormulaEditor

The user has the Formula Editor open.

dialogLinkedReport

The user has the Linked Report dialog open.

tabCellFormatNumber

The user has the Number tab of the Cell Format dialog
active.

tabCellFormatBorder

The user has the Border tab of the Cell Format dialog
active.

tabCellFormatConditional

The user has the Conditional tab of the Cell Format dialog
active.
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dialogCrosstabDesign
dialogGroup

The user has the CrossTab Data Designer dialog open.
The user has the Group Section dialog open.

dialogSectionShading

The user has the Section Shading dialog open.

dialogShowSQL

The user has the Show Generated SQL open.

dialofReportLevelParameters

The user has the Report Level Parameters open.

tabChartType

The user has the Type tab of the Chart Wizard open.

dialogChartBenchmarkLine

The user has the Benchmark Lines dialog open.

dialogChartDataFormat

The user has the Data Layout... dialog of the Chart Wizard
open.

tabChartLabels

The user has the Labels tab of the Chart menu open.

tabChartData

The user has the Data tab of the Chart Wizard open.

tabChartAppeance

The user has the Appearance tab of the Chart menu active.

tabChartSizeAndPreview

The user has the Size and Preview tab of the Chart Wizard
open.

tabMapType

The user has the Type tab of the GeoChart Wizard open.

tabMapLocations

The user has the Locations tab of the GeoChart Wizard
open.

tabMapData

The user has the Data tab of the GeoChart Wizard open.

tabGaugeType

The user has the Appearance tab of the Gauge Wizard
open.

tabGaugeData

The user has the Data tab of the Gauge Wizard open.

tabGoogleMapAppearance

The user has the Appearance tab of the Google Maps
Wizard open.

tabGoogleMapLocations

The user has the Locations tab of the Google Maps Wizard
open.

tabGoogleMapData

The user has the Data tab of the Google Maps Wizard
open.

tabGoogleMapSizeAndPreview

The user has the Size and Preview tab of the Google Maps
Wizard open.

listItemReportCacheOptionsGeneral

The user has the Execution Caching dialog open.

Dashboards
tabDashboard

The user has the Dashboard Viewer active

tabDashboardDesigner

The user has the Dashboard Designer active.

dialogDashboardUrlOptions

The user is adding or editing a URL tile on the canvas.

dialogDasboardImageOptions
v2019.2.37+v2020.1.20+v2021.1.8+

The user is adding or editing an Image tile on the canvas.

dialogDashboardTextOptions
v2019.2.37+v2020.1.20+v2021.1.8+

The user is adding or editing a Text tile on the canvas.

dialogDashboardName

The user has the Dashboard Rename menu active.

dialogDashboardDescription

The user has the Dashboard Description menu active.

dialogDashboardOptions

The user has the Dashboard Options menu active.

tabDashboardReportOptions

The user is adding or editing an Existing Report tile.

tabDashboardReportOptionsFilterPrompts

The user is interacting with the Filters menu.

tabDashboardReportOptionsParameterPrompts

The user is interacting with the Parameters menu.

tabDashboardReportOptionsOptions

The user has the Options tab of the Insert Report menu
active.

tabDashboardFilterOptionsReports

The user has the Reports tab of the Insert Filter menu
active.

tabDashboardFilterOptionsFilter

The user has the Filter tab of the Insert Filter menu active.

dialogDashboardVisualizationOptions

The user is adding or editing a visualization tile.

Scheduler
tabScheduleReportManager

The user has the Schedule Report Manager active.

tabScheduleRecurrence

The user has the Recurrence tab of the New Schedule
Wizard active.

tabScheduleParameters

The user has the Parameter tab of the New Schedule
Wizard active.

tabScheduleFilters

The user has the Filter tab of the New Schedule Wizard
active.

tabScheduleRecipients

The user has the Recipients tab of the New Schedule
Wizard active.
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The user has the Batch tab of of the New Schedule Wizard
active.

Tip
Create a default page to handle any cases where an undocumented or null context parameter is passed. This guarantees that a valid
help page will always be displayed.

Themes
Themes allow a user to quickly stylize reports or elements of reports such as maps and charts. This article covers Chart, ExpressView,
CrossTab, GeoChart and Express Report Themes. For styling the entire user interface, refer to the Application Themes article. Any further
references to Themes throughout this article refers specifically to the aforementioned visualization and report types.
Note
This article references <WebApp>/, as a placeholder for the Web Application install location. The default install location is C:\Program
Files\Exago\ExagoWeb on Windows or /opt/Exago/ on Linux. These directories can be changed during installation.
Exago comes with several themes pre-installed. Pre-installed themes are saved in the <WebApp>\Themes folder of Exago.
By default custom themes are saved in the Admin Console > General > Main Settings > Report Path.
Alternatively the host application can manage theme storage by implementing the GetTemplate, GetTemplateList, and SaveTemplate
functions. See Report and Folder Management for more information.

Chart Themes
A user can quickly select colors for Charts by applying a chart theme.
There are two way to create a chart theme:
Manually
1. In folder specified in the Admin Console > General > Main Settings > Report Path create a text file containing a comma
separated list of the hexadecimal values of the desired colors.
2. Save the file with the theme name.
3. Change the extension to .wrth.
With the Exago Theme Maker
1. Launch the Exago Theme Maker, and follow the instructions in the Exago Theme Maker article.
2. Download the theme created with the Theme Maker.
3. In folder specified in the Admin Console > General > Main Settings > Report Path, save the .wrth file.
Note
The file name will be displayed to the end user. To translate the name of a custom theme, see Multi-Language Support for Theme Names
below.

Example
The theme file below implements the built-in theme Autumnal Sunset.
#FFAA5C,#DA727E,#AC6C82,#685C79,#455C7B

ExpressView Themes
A user can quickly style ExpressViews by applying a theme. Custom theme creation is covered below:
Create a Custom ExpressView Theme (v2017.1–v2021.1)

CrossTab Themes
A user can quickly style CrossTabs by applying a theme. CrossTab themes can specify background color, foreground color, section
shading, borders, fonts and text size.
To create custom CrossTab themes:
1. Create a CrossTab with several Tabulation Data cells, Row Headers, Column Headers as well as sub-totals and grand totals. We
recommend CrossTab Themes have at least five Row Headers, Column Headers, Tabulation Data, sub-total rows, and sub-total
columns as well as a grand total row and a grand total column.
Note
If a user adds more Tabulation Data, Row Headers or Column Headers than existed on the theme they will appear without styling.
2. In the Report Designer stylize each cell as desired.
3. Hover the mouse over the CrossTab. Notice the CrossTab Design Menu
4. Hold Ctrl + Alt + Shift and click on the CrossTab Design Menu
icon

icon appears in the bottom left corner.

5. Click
Save as Theme.
6. Enter a name for the theme. This name will be displayed to the end-users.
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GeoChart Themes
A user can quickly select colors for GeoCharts by applying a theme.
There are two ways to create GeoChart themes:
Manually
1. In folder specified in the Admin Console > General > Main Settings > Report Path create a text file containing a comma
separated list of the hexadecimal values of the desired colors.
2. Save the file with the theme name.
3. Change the extension to .wrtm.
With the Exago Theme Maker
1. Launch the Exago Theme Maker, and follow the instructions in the Exago Theme Maker article.
2. Download the theme created with the Theme Maker.
3. In folder specified in the Admin Console > General > Main Settings > Report Path, save the .wrtm file.
Note
The file name will be displayed to the end user. To translate the name of a custom theme, see Multi-Language Support for Theme Names
below.

Express Report Themes
A user can quickly style Express Reports by applying a theme. Express report themes can specify background color, foreground color,
section shading, borders, fonts and text size.
To create a custom Express Report theme:
1. Create an Express Report with Headers, Footers and a Page Header/Footer and a Grand Total. We recommend Express Report
Themes utilize many Columns, Headers and Footers.
Note
If a user adds more Columns, Headers, or Footers than existed on the theme they will appear without styling.
2. In the Layout tab stylize the report as desired.
3. Hold Ctrl + Alt + Shift and click on the Save
icon.
4. Enter a name for the theme. This name will be displayed to the end-users.

Multi-Language Support for Theme Names
To support multi-language functionality, if the theme name concatenated with ‘_wrThemeId’ matches the id of any element in the language
files then the string of that language element will be displayed to the user instead of the theme name.
For example, in the Basic theme that is installed with Exago, there exists a language id ‘Basic_wrThemeId’. The string associated with
this id is displayed. For more information see Multi-Language Support.

Multi-Language Support
Note
The language elements discussed in this article do not include those created by users or administrators such as reports, folders,
express report/crosstab themes or Data Field names. To modify Data Field names please see Column Metadata. To modify theme
names please see Express Report and CrossTab Themes.
Any text in the application can be translated or modified. This can be accomplished by creating XML files in the Config\Language
directory under Exago's Web Application installation directory. These files map IDs to strings. Any place within Exago that displays text
has an associated ID. When a text element is required in the application, Exago will read the file(s) specified in the ‘Language File’
parameter of Main Settings and use the string that is mapped to the ID.
Exago comes with both a standard English file en-us.xml and a Spanish translation es-mx.xml. Below is an example of the multilanguage functionality. Notice that the prompt text in the New Report Wizard can be set by changing the string associated with the ID
NewReportLb1.
En-us.xml:
<NewReport>
<element id="NewReportLbl">Complete the steps in the wizard below to create a new report</element>
</NewReport>
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Es-mx.xml:
<NewReport>
<element id="NewReportLbl">Complete los pasos en el asistente para crear un nuevo informe</element>
</NewReport>

Caution
Some language strings contain special place holders between curly brackets (ex. {0}). These hold the place of elements that must be
filled in dynamically by Exago. Do not translate anything inside curly brackets. The place holders may be moved within the string but
do not delete them.
The example below demonstrates three place holders that will be replaced by dropdown menus in the Scheduling Wizard.
<element id="ScheduleRecurrenceRelativeMonthlyTxt">The {DayPosition} {DayOfWeek} of every {MonthNumber} month(s)</element>

Translating Exago
To translate the entire interface, make a copy of the file en-us.xml and give it a different name. Make sure this copy is in the folder
<webapp_dir>/Config/Languages, where <webapp_dir> represents the Exago Web Application installation directory. Without
changing the IDs translate the strings as desired (see example above). Then set the Language File setting in Main Settings to point at
your translated copy.
Note
If you are using the Exago Scheduler Service be sure to copy all custom language XML files to the ‘<scheduler_dir>/Languages’ folder of
each Scheduler Service instance.

Modifying Select Language Elements
To change specific language elements without copying the entire mapping you can use a base file and specify changes in separate
language files. When you set the Language File setting, list the all of the files you want to load separated by commas or semicolons.
Exago will load the files from left to right, meaning the first file listed will be used as a base and can be changed by the files loaded after it.
As an example you can create the file en-custom.xml which only contains the lines:
<?xml version="1.0" encoding="utf-8" ?>
<element id="GettingStartedTab">Home</element>

Set the Language File setting to en-us, en-custom and the Getting Started tab will reflect the change made in the custom file.

Note
Begin all language XML files with the line <?xml version="1.0" encoding="utf-8" ?>

Text of Prompting Filters and Parameters on Dashboards
When adding a Report to a Dashboard a user can specify text for any prompting Filters or Parameters. By default this text will match the
strings associated with the ids CompositeReportOptionsFilterDefaultPromptText and
CompositeReportOptionsParameterDefaultPromptText respectively.
If a user changes the default and enters a different language Id then the associated text for that new Id will display when the dashboard is
executed.
If a user enters text that does not match any language Id the text will be displayed when the dashboard is executed.
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Theme Names
Names of custom chart, GeoChart, CrossTab, ExpressView and Express Report themes can also be translated. Review the MultiLanguage Support for Theme Names section of the Themes article for more information.

An Overview of Exago Extensions
Exago extensions allow developers to access, extend and modify the platform's capabilities to suit particular needs that can't be handled
"out-of-the-box".
The interface for most capabilities is via coded elements, done either via Code Editor in the Administration Console or external code
modules provided via .NET Assemblies or Web Services. Other situation-specific options are also available, such as providing custom
parameterized SQL.
The following extension types are supported. More information on each type is provided in the remainder of this document:
Custom SQL
Custom Functions and Filter Functions
Server Events
Action Events
Custom Data Sources
Custom Options

Custom SQL
Exago supports a Custom SQL type Data Object. Objects of this type are very similar to pre-defined database views. They consist of a
SQL statement, have an implied field schema and return a relational value.
There are a few differences from traditional database views however.
Exago Custom SQL statements can be parameterized. In other words Exago parameters can be embedded within the SQL
statement. Parameters serve as placeholders for runtime values. Upon execution of a report any parameter values will be replaced
with the value of the parameter at runtime. Any part of the SQL statement can be parameterized in this way.
Exago Custom SQL statements behave like any other entity type. Administrators can attach column metadata. Report designers
can filter, sort and layout fields from the entity, etc.
Since the SQL is stored in the Exago configuration no intervention by database administrators is required.

Adding Custom SQL
Add a new Data Object and select the Data Source from the dropdown. Instead of selecting a table or view from the name field, click the
SQL button on the right of the name field.
You will be presented with the SQL code editor. Specify a name for your Data Object (no whitespace or special characters) then enter
your SQL as shown.
Notice the @StartDate@ and @EndDate@ parameters. They can be manually typed or inserted by selecting from the list of Parameters
and selecting the Add button.
When finished select Ok to save your object's information. You can then specify and Alias and select Unique Key Fields like any other
object.

The SessionInfo Object
The global SessionInfo object is available to Custom Functions, Server Events, and Action Events. It is similar to the API object in that
it contains the full running state of the Exago system during execution.
Collections of metadata and settings normally set in the Administration Console and/or via the API are accessible through the
sessionInfo.SetupData property. Note that for the most part the accessible properties are settable via SessionInfo.
SessionInfo also contains a key object store accessible via two methods:
void sessionInfo.SetStoredValue(Object key, Object value)
Object sessionInfo.GetStoredValue(Object key)

Custom Functions and Custom Filter Functions
Custom Functions and Custom Filter Functions allow developers to create abstracted high level language routines that are used by
report designers. Standard Custom Functions appear in the Exago Formula Editor as if they were part of the product. Custom Filter
Functions are available to use as values in user formulas.
Both types of functions have access to the SessionInfo object, creating powerful opportunities for context-sensitive processing as well as
storage. In the case of Custom Functions, global storage can be used to maintain counts as the report is processing.

Server Events
Server Events are handlers invoked on the server side during the normal execution lifecycle. They allow developers to inspect and/or
modify running state to achieve situation-specific objectives. Server Event handlers also have access to the global SessionInfo object,
providing the same global storage and state variables as mentioned above.
A commonly used event is the OnReportExecuteStart event, which allows the handler to make modifications to a report just prior to
execution. Another commonly-used event is OnExecuteSqlStatementConstructed which is invoked after Exago generates SQL
but before it is shipped to the data source. This event can be used to simply log the SQL for audit or diagnostics or to modify it to e.g.
substitute actual fields for placeholders.

Action Events
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Action Events are handlers invoked on the client side during the normal execution lifecycle and include an abstracted interface for serverside callbacks to gather data as needed and perform similar tasks. They offer a rich interface for modify charts and dashboard reports in
response to user actions. There are also specific interfaces to allow trapping and instrumentation of things like user saves.

Custom Data Sources
In additional to traditional relational data sources Exago can consume data from programmable data sources such as .NET assemblies.
Connection to and marshalling of the data sources is handled at the metadata layer, just like standard sources. This capability provides
two key benefits to end users:
Data from multiple disparate sources can be combined into a single report, visualization or dashboard
The end user view is the same regardless of the type of data source. Users will see no difference between relational and
programmable data sources when building reports and dashboards.
Custom data sources are often used when it is desirable to make use of an existing business logic layer such as a means to pull data
from non-traditional or distributed sources.

Custom Options
Custom Options allow administrators to alter the Exago UI to capture custom input from report designers. The values chosen by the
designer are available via the sessionInfo object and are thus accessible to Server Event and Action Event handlers.

Introduction to Action Events
This article applies to the Admin Console >

Extensions >

Actions Events settings.

Action Events can be grouped into two general categories: Local and Global events.
Local events have two sub-categories:
Handlers attached to items in reports and set to fire automatically, or when the item is interacted with in the Report Viewer.
Handlers attached to items in the Web Application User Interface and set to fire when that item is clicked.
Global events are active throughout the application, and fire when specific events occur.
This article explains how to create Local and Global Action Events, describes the ways in which Action Events can interact with the
Exago application, and lays out examples for common usage.

Create, Edit, Delete Action Events
To add a new action event click

Extensions >

Action Events in the Main Menu and either:

click the Add
icon at the top of the main menu
right-click and select Add from the context menu
To edit an action event either:
double click it
select it and click the Edit
icon at the top of the main menu
right-click it and select Edit from the context menu
To delete an action event either:
select it and click the Delete
icon at the top of the main menu
right-click it and select Delete from the context menu
To save changes and new functions click the Apply or Okay buttons
They can also be added or modified on a per-session basis via the .NET API using the Api.SetupData.ActionEvents server call.
This section details how to create Action Events through the Web Application but contains important details about programming them
which will apply to the .NET API as well.

Action Event Properties
Each Action Event has the following properties:

Name
A unique identifier for each Action Event.

Function
Can either be custom code or a .NET Assembly method.

Custom Code
To save code directly in Exago, select Custom Code from the first Function dropdown. Clicking on the second dropdown opens the
Custom Code dialog. See the Writing Action Events section below for information on how to access the arguments for each Event.

Custom Code has four additional properties:
Language: Code can be written in C#, JavaScript (in Windows only) or VB.NET.
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References: A semicolon-separated list of any libraries that need to be referenced by the Action Event. The DLLs must be present
in the \bin folder of the Exago Web Application, as well as any Scheduler \bin folders, and the Web Service API, if applicable.
Note
System.dll does not need to be listed as a reference as it is already available.
Namespaces: A semicolon-separated list of namespaces in the referenced DLLs or the Exago API library.
Code: The code that will be executed.
When done writing code, click the Test Execution icon to test the code for errors.

.NET Assembly Method
There are two ways to reference a .NET Assembly method.
Create a .NET Assembly Data Source. Select the desired assembly from the first Function dropdown. Clicking on the second
dropdown will open a list of available methods.
Add the .NET Assembly to the \Bin folder (for the Web Application, Web Service API, and all Scheduler Services, if applicable).
Then in the Custom Code, add the assembly as a reference, then invoke the method, e.g.
return Extensions.Events.CensorEmployeeBirthYear(sessionInfo, args);
Note
The Assembly’s DLL will be locked by Exago when it is first accessed. To replace the DLL, unlock it by restarting the IIS App pool.
Note
If you want to utilize the sessionInfo object that is passed to all Action Events the Assembly must include a reference to
WebReportsApi.dll. For more information see the article on SessionInfo.
Note
All methods used as Action Events must be static.

Event Type
Select an option in this dropdown to create an local event that will be executed when certain client-side actions are taken.
None: This Action Event is a Global Event. A value must be set for Global Event Type.
Load: The Action Event will execute when a report item is loaded in the Report Designer, Report Viewer, or upon Export. This
type of handler is typically used to interpret and then apply alterations to report data, e.g. conditionally changing the colors on
charts or maps.
As of v2016.2.5+ Load events can affect Export formats (PDF, Excel, RTF, CSV).
Click: The Action Event will execute when a user clicks on an item in a report or in the Exago UI. This type of handler is typically
used to add additional interactive elements to reports or to the Report Designer. Click events will not function on Export formats.
For information on adding action events to specific reports, see Adding Action Events to a Report.

Global Event Type
Select an option in this dropdown to create an event that will be triggered when a condition is met in the Exago application. The Global
Events article contains descriptions of all of the available event handlers.
Note
Selecting a Global Event Type will cause Exago to ignore any selected Local Event Type.

Assigned UI Item(s)
This field designates a semicolon-separated list of UI item IDs for items in the Exago interface. These elements can be intercepted and
modified by entering them in this field.
Important
This selection field only applies when the Event Type is Click. This field will be ignored when any other options are selected.

Writing Action Events
When an Action Event is fired, two primary parameter objects are passed: sessionInfo and clientInfo. These are the main points of
interaction with the Exago application.
sessionInfo: Provides access to all the elements of the current Exago session. This is the server-side information. For more
information see the article on sessionInfo.
Note: To access sessionInfo from a .NET Assembly, a reference to WebReportsApi.dll must be included.
clientInfo: A JavaScript object that is accessed from within the client-side script. Provides access to any specified client-side
parameters and information about the item attached to the Action Event. For a breakdown of the elements in clientInfo, see
ClientInfo.
arguments array – The server-side portion of action events can also access an array of input values called args. These parameters are
passed manually from client code to server code using the function clientInfo.ServerCallback(eventName, args...).

Adding Action Events to a Report
To enable an end-user to add Action Events to items in a report, the user must have access to the Report Viewer and the Action Events
toolbar option in the Report Designer. The options to enable these features are located in the following sections of the Admin Console:
Main Settings

Feature/UI Settings > Advanced Report Designer Settings

After a Local Action Event has been created, the event will be available to add to a report. In the Report Designer, select the cell to which
to add an event and click on the Linked Action Event button. The Linked Action Events Menu will open:

114 of 201

Global Action Events

Technical Guide

Press Add and select the event from the dropdown list. Press Delete to remove the selected event. Press OK when finished.
If the event is a Load event, you will have to save and re-open the report to see the changes applied in the Report Designer.

Global Action Events
Global Actions Events are actions that can be attached to one of a specific list of events that will occur within the Exago application.
These events usually trigger in response to user input, but they are not necessarily directly related to the input action, and thus will not
transfer information about the user input. However, global events are more reliable than capturing user clicks, especially in response to
actions that can be taken in a variety of ways, such as saving a report.
A subset of global events, namely the ones which are used to handle report tree interaction, require a boolean return value or a Promise of
a boolean in the client script. True indicates to Exago to stop the normal course of action, which we have replaced with our custom code.
False indicates that we should continue with the normal action. If any action event returns a Promise Exago will await the Promise before
taking action based on the boolean result.
For example, when double-clicking on a third party (non-Exago) report, we may want to launch an external editor instead of the Exago
report designer. We would check the report type, and if it is a third party report, we would insert our callout and then return True. If it is a
regular Exago report, we would continue with the normal course of action by returning False.
For these events to be able to have a return value, they must be enclosed within a JavaScript function. This means that if you want to write
the full client scripts in the admin console (rather than calling out to a separate function) each event will need to be wrapped in an autoexecuting anonymous function, like so:
string jsCode = @"(function()
{
/* javascript stuff; */
return true;
}())";
sessionInfo.JavascriptAction.SetJsCode(jsCode);
return sessionInfo.JavascriptAction;

List of Global Events
Events which require a boolean or Promise of a boolean return value are labeled.

OnSaveReport
Fires when a user attempts to save an open report.
Warning
Description

Remarks

This action event replaces the default save handling. If this action event is implemented, reports will
not be saved by the normal means.
Passes the report object.

OnDuplicateReport
Description

Fires when an open report is duplicated.
Note
This action event can return a Promise.

Remarks

Passes the report object.
If the return value resolves to true, then Exago will not launch the report name dialog to allow the user
to select the duplicate report name. If the return value resolves to false, then Exago will launch the
name dialog as usual.

OnEditReport v2016.3+
Description

Fires when a report is opened for editing.
Note
This action event can return a Promise.

Remarks
Passes the webReportsCtrl object, i.e. the application DOM, including the main UI window, folders
tree, main menu, etc. If the return value resolves to true, then Exago will not launch the corresponding
Designer. If the return value resolves to false, then Exago will launch the Report Designer as usual.

OnSelectReport v2016.3+
Description

Fires when a report item in the folders tree is selected.
Note
This action event can return a Promise.

Remarks

Passes the webReportsCtrl object, i.e. the application DOM, including the main UI window, folders
tree, main menu, etc. If the return value resolves to true, then Exago will not fetch report information
and update the report description box. If the return value resolves to false, then Exago will fetch
information about the report and update the report description box as usual.

OnDeleteReport v2016.3+
Description

Fires when a report is deleted from within the folders tree.

115 of 201

Global Action Events

Technical Guide

Note
This action event can return a Promise.
Remarks

Passes the webReportsCtrl object, i.e. the application DOM, including the main UI window, folders
tree, main menu, etc. If the return value resolves to true, then Exago will not prompt the user to delete
the report. If the return value resolves to false, then Exago will prompt the user to delete the report as
usual.

OnRenameReport v2016.3+
Description

Fires when a report is renamed from within the folders tree.
Note
This action event can return a Promise.

Remarks

Passes the webReportsCtrl object, i.e. the application DOM, including the main UI window, folders
tree, main menu, etc. If the return value resolves to true, then Exago will prevent the rename text box
from appearing. If the return value resolves to false, then Exago will show the rename text box as
usual.

OnExecuteReport v2016.3+
Description

Fires when a report is executed from within the folders tree.
Note
This action event can return a Promise.

Remarks
Passes the webReportsCtrl object, i.e. the application DOM, including the main UI window, folders
tree, main menu, etc. If the return value resolves to true, then Exago will not execute the selected
report. If the return value resolves to false, then Exago will execute the selected report as usual.

OnDoubleClickReport v2016.3+
Description

Fires when a report item in the folders tree is double-clicked.
Note
This action event can return a Promise.

Remarks
Passes the webReportsCtrl object, i.e. the application DOM, including the main UI window, folders
tree, main menu, etc. If the return value resolves to true, then Exago will not launch the report editor. If
the return value resolves to false, then Exago will launch the report editor as usual.

OnRightClickReport v2016.3+
Description

Fires when a report item in the folders tree is right-clicked.
Note
This action event can return a Promise.

Remarks

Passes the webReportsCtrl object, i.e. the application DOM, including the main UI window, folders
tree, main menu, etc. If the return value resolves to true and the selected node is a “custom” node
created by the client integration, then Exago will hide certain built-in menu items. If the return value
resolves to false, then Exago will show the normal context menu.

OnAfterAddDataObject
Description Fires after a data object is added to a
report.

OnBeforeRemoveDataObject
Description

Fires before a data object is removed from a
report.

OnChangeParameterValue
Description
Remarks

Fires when the value of a parameter in a prompt is changed
This is commonly used in conjunction with parameter drop-downs in order to selectively enable,
disable, and populate fields.

OnDashboardResize
Description
Remarks

Fires when a running dashboard has its container size changed, by either the web page or the browser
window
This is commonly used to enable dashboards to re-format their contents in response to changing
screen size.

OnBeforeCloseApiWindow
Description
Remarks

Fires when the user clicks the cancel button in an iFrame or modal window containing a report wizard.
This can be used to provide a JavaScript callback to close the window automatically, rather than
returning to a blank page.

OnSaveReportSuccess v2017.1+

Description

Fires after an existing report is successfully saved from a Wizard, Designer, or Viewer. Works for all
report types. Also fires when an Advanced Report is created from an ExpressView, Express Report or
a Dashboard Visualization.
Does not fire when a report is duplicated, or when a User Report is saved as a new Advanced Report
from the Report Viewer. Use OnDuplicateReport for these cases.
This can be useful for implementing handlers to update the host application after reports are saved.
This does not interfere with the default report saving behavior.

Remarks
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Report name (path and filename) is available to the action event handler through the reportName
property of the ClientInfo object.

OnClassifyUserInputURL v2018.2.6+
Description

Fires when a URL is loaded (e.g., when a URL is added to a URL tile in the Dashboard Designer or
when a URL is loaded upon dashboard execution) or clicked (e.g., when an end-user clicks a URL in
an executed report or report description).
Only fires on loading in the Dashboard designer or on an executed Dashboard.
This event is used for determining whether a URL is internal or external to the host domain, and can be
utilized to prompt users for verification when attempting to access external URLs.

Remarks

The urltoclassify property is an available property of the ClientInfo object allowing for the specification
of the URL
Please see Action Event: External URL Confirmation for more information.

Actionable UI Elements
Advanced Reports
The following Report Designer toolbar items can be attached to a Click Action Event.
ID
Description

Icon pre-v2019.2

Icon v2019.2–v2021.1

Icon v2021.1+

ReportOptionsBtn
Report Settings menu
SaveReportBtn
Save Report
DesignNewReportBtn
Create New Report

not available v2021.1+

UndoBtn
Undo
RedoBtn
Redo
FormatCellsBtn
Cell Format dialog
FormatPaintbrushBtn
Format Paintbrush
BoldBtn
Bold
ItalicBtn
Italic
UnderlineBtn
Underline
UnderlineSelect
Underline type select
MergeCellsBtn
Merge Cells
not available v2021.1+,
use MergeCellsBtn
always

SplitCellsBtn
Split Cells
AlignLeftBtn
Horizontal alignment - left

not available v2019.2+

WrapTextBtn
Wrap Text
AutoSumBtn
AutoSum
EditFormulaBtn
Formula Editor
SuppressDuplicatesBtn
Suppress Duplicates
CrossTabWizardBtn
CrossTab Report Wizard

not available v2021.1+

LinkedReportBtn
Linked Report/Drilldown
LinkedActionBtn
Linked Action Event
GoogleMapBtn
Google Maps Wizard

not available v2021.1+

MapBtn
GeoCharts Wizard

not available v2021.1+

ExpressView v2019.1.12+
Beginning with v2019.1.12+, the following ExpressView toolbar items can be attached to a Click Action Event.
ID
ExpressViewLiveDataButton

Icon

Description
Start/Stop using live data

Example
The return value of the embedded JavaScript determines whether the result of clicking the button should take place.
If the Action Event returns True, then toolbar item action is cancelled
If the Action Event returns False, then the toolbar item action is carried out
ExpressViewLiveData only: If the Action Event implementation returns a Promise, then the toolbar item action continues if and
when that Promise resolves False (for v2019.1.12+).
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string JsCode = @"(function() {
return !confirm('Continue?');
}())";
sessionInfo.JavascriptAction.SetJsCode(JsCode);
return sessionInfo.JavascriptAction;

ClientInfo
This article describes the properties and methods in the clientInfo object and what they are commonly used for.
Note
If an element is not listed here, it is likely intended for internal use and should not be accessed.

Properties
showHourglass
Description

Set to False to disable the progress icon that appears when data is being saved or
loaded.

includeReportData
Description

Set to False to prevent the client from passing the sessionInfo object to the server
whenever a server callback is done.

Remarks

It may be useful to disable this to limit overhead if access to sessionInfo is not needed
for a specific callback.

includeReportSaveData
Description

Set to False to prevent the client from passing the report save data to the server
whenever a server callback is done.

Remarks

The SaveData is an additional set of data passed whenever a report is saved. This
information is only passed by an onSaveReport global event. It may be useful to
disable this to limit overhead if the save data is not needed for a specific callback.

refreshDataOnReturn
Description

Set to False to prevent the client Viewer from refreshing the report whenever a server
callback alters report data.

Remarks

If a SaveReport callback does not alter the appearance of the report, it may be useful
to disable this to limit overhead.

Utilities
Description

Access to a large variety of utilities and controls.

Remarks

Likely unnecessary in most cases. A pre-written action event provided to you by a
support analyst may make use of this.

webReportsCtrl
Description

Access to the Exago Web Application user interface elements.

Remarks

Often used in order to add or remove items from the report tree sidebar. Useful for
allowing Exago to handle third-party report objects.

contextObject
Description

A generic class for the object which the action event call was attached.

Remarks

The more specific context items below provide a superset of this class.

dashboard, dashboardItem, report, chartData, chartSeriesDataPoint, chartItemDataPoint,
reportWidgets, categoriesCtrl, parameterListCtrl
Description

Specific classes which are set depending on the context of the call. Contain
information about the object for which the action event call was attached.

Remarks

These are set contextually depending on the object of the call. For example, chartData
will only be set if the action event was attached to a chart or gauge.

uiElement
Description

Provides information about the UI element called by a "click" local action event. For a
list of supported elements, see Actionable UI Elements.

isSandboxMode
Description

True if an action event is running in a non-interactive environment, i.e. any non-html
environment, where javascript interactivity is not permitted. Includes all export types:
PDF, Excel, RTF, CSV.

urlToClassify
Description

String value of a URL. To be classified as "external" or "internal". Requires user
confirmation if classified as external.

Remark

This property corresponds specifically with the OnClassifyUserInputURL Global
Action Event. For an example of a use case, please see Action Event: External
URL Confirmation.
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Methods
ServerCallback(args[])
Description

Call back to the server with any given arguments.

GetLanguageData(id)
Description

Returns the text and tooltip info from the language file for the specified UI item.

ExecuteParentFunction(func, args), GetParentFunction(func),
GetParentByFunctionName(func)
Description

If the Exago Web Application is running in an iframe these are helper functions to call
JavaScript functions in the parent frame.

Remarks

These functions are for convenience and safety. They are generally the same as
calling Parent.FunctionName.

LoadHtmlDialog(html, options)
Description

Creates and loads an HTML dialog box. Accepts an HTML string or an html element.
Accepts several options.

SetDialogValue(elementId, value)
Description

Populates the given element of a dialog with a given value.

GetDialogElementById(elementID)
Description

Finds and returns the element given by its ID.

Alert(alertText)
Description

Creates and loads an HTML alert dialog with the given text.

UpdateChart(chartWidget, chartData)
Description

Updates the given chart with the given data and re-renders it in the report.

GetDashboardReports(options)
Description

Returns all the reports on the dashboard as report objects.

GetDashboardWidgets()
Description

Returns all the widgets on the dashboard (i.e. all dashboard elements besides
embedded reports).

EditReport(reportName, options)
Description

Opens the Report Designer for the given report with options. See .NET API.

ExecuteReport(reportName, exportType, options)
Description

Executes the given report with options. See .NET API.

StartNewReportWizard(reportType)
Description

Starts the Designer for the given report type.

GetClientReportObject(reportName)
Description

Returns the given report object by name.

LoadUrlToNewTab(string url)
Description

Opens a new tab with the provided URL as the contents.

Introduction to the .NET API
Note
This version of the .NET API documentation is deprecated. A new version can be found at https://www.exagoaccess.com/api-docs/.
The Exago interface consists of two primary elements:
the User Interface, and
the API
The User Interface is built directly onto the .NET API. This means that .NET applications can interface directly with Exago. Non-.NET
applications use the REST Web Service API.
This guide will walk through the process of integrating Exago into a .NET-based web application.
This example will demonstrate:
referencing the API in the project
loading an existing report
modifying that report's run time filters
executing the report in a browser window
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Referencing the API
First reference the Web Reports API library. This is usually located in the <WebApp>\bin folder, where <WebApp> represents the install
directory of the Exago Web Application. The file is named WebReportsApi.dll .
Include the following namespaces for now:
WebReports.Api: Contains the Api class which is the main interaction class between Exago and your application.
WebReports.Api.Reports: Contains the Report class, for creating and managing reports.
WebReports.Api.Roles: Contains classes for managing role security settings.

Create an Api Object
An Api Object is the main class you need to create in order to interact with Exago. It contains the first and last points of entry for each
instance of your application.
Create an Api Object using the following overloaded constructor:
Api myApi = new Api(AppPath, ConfigFile);

AppPath is the physical or virtual location of your Exago installation.
ConfigFile is an optional configuration file name. If left out, it will default to WebReports.xml.
Caution
Always call the constructor with a minimum of the AppPath argument. Only one Api object should ever be opened per thread.

Load a Report
Now let's load the report we want to modify.
The ReportObjectFactory is the collection class for report management methods—creating, loading, copying, saving, renaming, and
deleting report files. It can be used to work within a repository or a temporary browser session, or both if necessary. In this example we're
simply loading an existing report into the Api object.
Reports called from the ReportObjectFactory are ReportObject objects, which is a general class representing the various report types.
WebReports.Api.Reports.Report objects — Advanced, CrossTab and Express Reports
WebReports.Api.ExpressView.ExpressView objects— ExpressViews
WebReports.Api.Composite.Chained.ChainedReport objects — Chained Reports
WebReports.Api.Composite.Dashboard.DashboardReport objects — Dashboards
We are casting the ReportObject called from the factory to a Report, because we know it is an Advanced Report. Report objects inherit
several methods from ReportObject, but greatly expands the management capabilities. If we loaded a Dashboard or a Chained Report, we
would cast it to DashboardReport or ChainedReport respectively.
Report myReport = (Report)myApi.ReportObjectFactory.LoadFromRepository(@"TestReport");

Note
Several methods reference an Active report by default. This is usually the last report accessed, but can be specified by the
ReportObjectFactory.Active property.
See Loading Reports in the .NET API for more information.

Retrieve the Role Security
Let's see if the current user has access to the database object we want to filter for.
if (myApi.Roles.ActiveRole.Security.DataObjects.GetDataObject("Customers") != null)
{ Permission Granted!; }
else Permission Denied!;

The Roles object allows for accessing and modifying the elements found within the Admin Console. Changing or adding Role settings will
only persist for the current session, and will not modify the config file.
We can also set some additional security and restrict the user from seeing specific data object rows:
DataObjectRow dataObjectRow = myApi.Roles.ActiveRole.Security.DataObjectRows.NewDataObjectRow();
dataObjectRow.ObjectName = "SSN";
dataObjectRow.FilterString = "false";

Modifying the Report
Now that we have loaded and declared our Report object, we can begin to modify its contents. Let's clear out the pre-existing runtime
filters, and add one of our own:
foreach (Filter oldFilter in myReport.Filters)
{ myReport.Filters.Remove(oldFilter); }
Filter myFilter = myReport.Filters.NewFilter();
myFilter.DbName = "Customers.CompanyName";
myFilter.Operator = wrFilterOperator.NotEqualTo;
myFilter.Value = "Exago Inc.";
myFilter.AndOrWithNext = wrFilterAndOrWithNext.And;

Note that all these modifications will take place within the current session, and will not modify the report definition itself unless you
specifically overwrite it.

Closing the Session and Executing
Let's execute the altered report. First, some administrative action is required.
Set the report execute type to HTML, so it runs in the browser:
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myReport.ExportType = wrExportType.Html;

And hide the application tabs to avoid clutter:
myApi.ShowTabs = false;

Now save the changes we've made to the Api. This will load the report into a temporary space in the Api to prepare for execution.
myApi.ReportObjectFactory.SaveToApi(myReport);

And we're all set! Calling the following method will end the session, perform the specified action, and return the session URL. The session
URL is an alphanumeric single-use identifier for the session. Append it to your Exago application URL.
Since we loaded a report into the Api, the action defaults to Execute.
string url = @"//MyDomainServer/Exago/" + myApi.GetUrlParamString(ExagoHome);

Note
The ExagoHome parameter can be used to specify the Web Application's home page. It will default to ExagoHome.aspx.
Now redirect your browser to the generated URL and see the results!

Load Reports in the .NET API
Note
This version of the .NET API documentation is deprecated. A new version can be found at https://www.exagoaccess.com/api-docs/.

The ReportObject Class
All Report type objects inherit from ReportObject. The class includes basic functions such as loading and saving the objects. Report
type objects consist of simple report types such as ExpressView and Advanced, and composite types such as Dashboard and Chained.

Accessing Reports via the API
A Report is normally loaded via API in order to launch directly into the execution or editing of the report. In most cases, report loading is
handling by the Exago runtime via the LoadFromRepository call. LoadFromRepository returns an object of type ReportObject.
In order for the load to complete, a corresponding SaveToApi is done. SaveToApi will save the ReportObject, including any
modifications back to the API for loading (for execution or editing). Both LoadFromRepository and SaveToApi can be accessed via
the Api.ReportObjectFactory property.
Both LoadFromRepository and SaveToApi return and store a ReportObject respectively. Most modifications made to a report
loaded at runtime (such as changing filter values) are performed on properties defined within the child types (such as Report or
DashboardReport). Such modifications would require a cast of the ReportObject to the appropriate child type.
If no modifications are required, the sequence is simple:
//Load the report -- Refers to the full folder path
//Followed by the report name
ReportObject ro = api.ReportObjectFactory.LoadFromRepository();
//Save the report back to the API
api.ReportObjectFactory.SaveToApi(ro);

If modifications are desired, it is necessary to cast the value returned by LoadFromRepository to the appropriate base type. Supported
base types include:
WebReports.Api.Reports.Report for Advanced, CrossTab and Express Reports.
WebReports.Api.Composite.Dashboard.DashboardReport for Dashboards.
WebReports.Api.Composite.Chained.ChainedReport for Chained Reports.
For example, you can modify Filters on a report to be executed as follows:
//Load the report -- Refers to the full folder path
//Followed by the report name
Report report = api.ReportObjectFactory.LoadFromRepository() as Report;
report.Filters[0].Value = ;
//Save the report back to the API
api.ReportObjectFactory.SaveToApi(report);

Note
The filter change will only apply to this execution of the report. The report design itself will not be modified.

.NET API General Reference
Note
This version of the .NET API documentation is deprecated. A new version can be found at https://www.exagoaccess.com/api-docs/.
This article contains a list of examples for using the .NET API's various features. The .NET API can be used for many purposes, and the
most common is to create secured access points for end-users via browser sessions. However, you can also use the API to create and
manage schedules, generate config files and reports programmatically, edit existing reports, and more.
Note
This guide is kept up to date for the most current version available. For a list of changes in the API, see the Updating Guide.

Getting Started

121 of 201

Load Reports in the .NET API

Technical Guide

Exago BI .NET applications must include a reference to the file WebReportsApi.dll , found in the bin folder of the application
installation directory. This contains all the classes and method groups necessary for the examples in this article.
Optional: If you are connecting to a .NET Assembly Data Source, you will need to include a reference to WebReportsAsmi.dll. A
reference to WebReports.dll is unnecessary, except in some rare cases that are not discussed in this guide.
The following Exago BI namespaces are used in the examples in this guide:
WebReports.Api
WebReports.Api.Reports
WebReports.Api.Common
WebReports.Api.Data
WebReports.Api.Roles
WebReports.Api.Programmability
WebReports.Api.Scheduler
WebReports.Api.ReportMgmt
WebReports.Api.Theme
As well as the following system namespaces:
System.Collections.Generic
System.Linq
System.Xml

Contents
API Object
Sorts and Filters
Settings
Role Permissions
Advanced Configuration
Scheduling
Managing Files and Folders

API Object
An API object must be instantiated at the start of an API application since it is the access point for all API activity. API objects also
encompass sessions which are used to encapsulate user-specific changes, such as security and permissions settings.
Note
Variable names, such as "api" and "report", are declared in their respective sections in this guide, then referenced throughout the
remainder.

Constructors
Basic constructor: appPath is the file path or virtual path to Exago base install.
Api api = new Api("appPath");

Specify a config file (other than the default WebReports.xml)
Api api = new Api("appPath", "configFn");

Custom config file and its location in Azure storage (must match web.config)
Api api = new Api("appPath", "configFn", "azurePath");

Let the host application configure log4net
Api api = new Api("appPath", bool isLogCustomConfig, "configFn");

Write to the default log file ([Temp]\WebReportsApiLog.txt)
Logger logger = Log.GetLogger();
logger.Info("message"); // Writes at info level

API Action
The location to direct the Exago interface when first loaded. Edit or Execute actions work on an "active" report.
api.Action = wrApiAction.Home;

Hide tabbed UI
api.ShowTabs = false;

Active Report
Load a report from repository. Makes it the active report. "reportName" is the fully qualified path relative to the base report directory without
the file extension. ReportObject is a generic class encompassing all report types.
ReportObject reportObject = api.ReportObjectFactory.LoadFromRepository("reportName");

Report is validated (checked for errors) unless overridden
ReportObject reportObject = api.ReportObjectFactory.LoadFromRepository("reportName", bool validate);

Manually validate
reportObject.Validate();

Check the errors list. See list of error types.
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foreach (ReportValidationError error in report.ValidationErrors)
{
string.Format("Error: {0}\n\t{1}\n\t{2}\n",
error.ReportErrorType.ToString(),
error.Data1,
error.Data2);
}

Get the report type
string reportType = reportObject.ReportType.ToString();

Cast the report object to higher level class
Report report = (Report)reportObject;

Validate the export type
bool IsReportAllowPdfExport = report.IsExportTypeAllowed(wrExportType.Pdf);
bool IsConfigAllowPdfExport = api.General.AllowPdfOutput;

Set the export type
report.ExportType = wrExportType.Pdf;

Launch Exago and Execute Report
To launch in a browser frame with specified Action, get the App URL to redirect the browser. Redirecting to the App URL closes the API to
further changes. It should be the last thing done.
Get the App URL, with the default home page "ExagoHome.aspx"
string appUrl = api.GetUrlParamString();

Specify a custom Exago home page, "homePage" is the file name without the file extension
string appUrl = api.GetUrlParamString("homePage");

Set ShowErrorDetail to true, for more detailed user error messages
string appUrl = api.GetUrlParamString(null, true);
// This is equivalent to:
string appUrl = api.GetUrlParamString() + "?ShowErrorDetail=true";

Redirect the browser to the App URL (this will close the API to any further changes)
Frame.Src = baseUrl + appUrl;

GetExecute() Methods
As an alternative to API Action, some reports can be executed and the data returned directly to the host application. Since this does not
launch Exago, this will not close the API, but report interactivity is not supported. Only bare HTML, JSON, and so on are returned. Acts on
the specified report, not the active report.
Review the Executing Reports with the API article for full details and supported report types.
string reportHtml = report.GetExecuteHtml();
string reportJson = report.GetExecuteJson();
byte[] reportData = report.GetExecuteData();
string[] reportSql = report.GetExecuteSql();

Calling the GetExecute() methods triggers the following Server Events, if applicable:
OnReportExecuteStart
OnReportExecuteEnd
OnAfterReportExportSuccess

Sorts and Filters
You can add sorts and filters to reports at runtime. After making changes, save back to the API for execution in the session.
api.ReportObjectFactory.SaveToApi(report);

Changes could be saved back to the report file on disk
api.ReportObjectFactory.SaveToRepository(report);

Save edited report as a new report
api.ReportObjectFactory.Copy(report, "newName", null);

Sorts
See the existing sorts in a report
foreach (Sort sort in report.Sorts)
{
string.Format("{0}, {1}\n", sort.SortText, sort.Direction);
}

Add a new sort to a report
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report.Sorts.Add(new Sort(api.PageInfo)
{
// Use object Alias name, as well as the field Alias name if set
SortText = objectName + '.' + fieldName,
Direction = wrSortDirection.Ascending
});

Formula sort
SortText = string.Format("=Formula({{{0}.{1}}})", objectName, fieldName);

Sorts is an ordered list. Reorder the list to change the precedence of the sorts.
// Move a sort from position 3 to position 1
for (int i = 3; i > 1; i--)
{
Sort temp = report.Sorts[i - 1];
report.Sorts[i - 1] = report.Sorts[i];
report.Sorts[i] = temp;
}

Filters
See the existing filters in a report
string filterString = ""; // Build a filter summary string for display
foreach (Filter f in report.Filters)
{
filterString += string.Format("{0}{1} {2} {3}{4}",
new string('(', f.GroupStartCnt),
f.FilterText,
f.DisplayOperatorText,
f.DisplayValue,
f.GroupEndCnt > 0 ? new string(')', f.GroupEndCnt) : ' ' + f.AndOrValue + ' ');
}

Add a new filter
// Get the data field info (should first check that the report contains the entity)
EntityColumn field = report.Entities.GetEntity("objectName").GetColumn("fieldName");
report.Filters.Add(new Filter(api.PageInfo)
{
FilterText = field.FullName, // Object and field Alias names
DataType = field.DataType,
Operator = wrFilterOperator.OneOf, // This filter type takes multiple values
DataValues = new DataValueCollection()
{
new DataValue(api.PageInfo, field) { Value = "value1" },
new DataValue(api.PageInfo, field) { Value = "value2" }
}
});

Group Min/Max filters
string groupFilterString = ""; // Build a filter summary string for display
int i = 0;
foreach (GroupFilter filter in report.GroupFilters)
{
groupFilterString += string.Format("{0} {1} for each {2} {3}{4}",
filter.DisplayOperatorText,
filter.FilterText,
filter.GroupName,
filter.IgnoreOtherGroups ? "ignoring other groupings" : "",
(i < report.GroupFilters.Count()) ? ", " : "" );
i++;
}

Add a new group filter
// Should check that the entity and sorts exist on the report
EntityColumn field = report.Entities.GetEntity("objectName").GetColumn("fieldName");
Sort sort = report.Sorts.GetSort("sortName");
report.GroupFilters.Add(new GroupFilter(api.PageInfo)
{
FilterText = field.FullName, // Object and field Alias names
Operator = wrGroupFilterOperator.Maximum,
GroupName = sort.SortText // Or sort.Entities[0].Name, or "EntireDataSet"
});

See Top N filter
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// Build a filter summary string for display
// Reports limited to one Top N filter, max one foreach group per filter
string topNFilterString = "";
if (report.TopNItems.Count() > 0)
{
if (report.TopNItems[0].UseTopNItem)
{
TopNItem filter = report.TopNItems[0];
topNFilterString = string.Format("{0} {1} {2}{3}",
filter.Action == TopNAction.top ? "Top" : "Bottom",
filter.Number,
report.Cells.GetCellById(filter.CellId).DisplayText,
(filter.ForEachGroup.Count() > 0) ? " for each " + filter.ForEachGroup[0] : "");
}
}

Add Top N filter
// Check that the cell exists
int cellId = report.Cells.GetCell(int row, int col).Id;
TopNItem topN = new TopNItem(api.PageInfo)
{
Action
= TopNAction.top,
Number
= int N, // the N in "Top N"
CellId
= cellId,
ForEachGroup = new List<string> { },
UseTopNItem = true
};
// Must be at zero-index position
if (report.TopNItems.Count() == 0)
report.TopNItems.Add(topN);
else
report.TopNItems[0] = topN;

Settings
Change the values of config settings and parameters dynamically, which often depend on user access rights. A dynamic config can be
thought of as an extension of a Role, although Roles aren't necessarily required.

Configuration Settings
api.General.anySetting = newValue;

See Config File and API Setting Reference for the full list of config settings.

Set General Storage Management Properties
The names of the available properties can be found in the Storage Management section of the Config File XML Reference article. Refer to
the specific sections of this article for setting Storage Management identity keys or options. In general, the properties are accessed via
SetupData.StorageMgmtConfig. For example:
//Enable report list and report XML caching
api.SetupData.StorageMgmtConfig.ReportXmlCacheEnabled = true;
api.SetupData.StorageMgmtConfig.ReportListCacheEnabled = true;
//Set the timeout for both caches to 30 seconds
api.SetupData.StorageMgmtConfig.ReportXmlCacheTimeout = 30;
api.SetupData.StorageMgmtConfig.ReportListCacheTimeout = 30;

Utilize the Storage Management Options Collection
There is a dictionary of options passed around the Storage Management system that stores pertinent information for the database, but
additional key-value pairs can be added.
Configure the Database Connection
api.SetupData.StorageMgmtConfig.SetOption("DbType", "SQLite");
api.SetupData.StorageMgmtConfig.SetOption("DbProvider", "Sqlite");
api.SetupData.StorageMgmtConfig.SetOption("ConnectionString", "Data Source=C:\\Program Files\\ExagoWeb\\Config\\Storage.sqlite");

Set a Custom Option
//add a custom option named user_Profile and set support_Administrator as its value
api.SetupData.StorageMgmtConfig.SetOption("user_Profile", "support_Administrator");

Reading Options Data
Use StorageMgmtConfig.Option("key_name"); to read the values from the configuration.
Example 1:
textBox1.Text = api.SetupData.StorageMgmtConfig.Option("ConnectionString");

will fill textbox1 with the connection string to the Storage Management database.
Example 2:
api.SetupData.StorageMgmtConfig.Option("user_Profile");

will return support_Administrator

Parameters
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Parameters are variables that persist throughout a session, and are reachable by extensions. They can be used to set custom
environment variables. userId and companyId are two such built-in parameters for storing user information.
Caution
The .NET namespace System.Web.UI.WebControls also contains a class called Parameter. You may wish to alias one or both
classes to resolve name conflicts.

using wrParameter = WebReports.Api.Common.Parameter;

List config parameters
foreach (Parameter parameter in api.Parameters)
{
string.Format("Name: {0}, Value: {1}\n", parameter.Id, parameter.Value);
}

Get a specific parameter by Id
Parameter parameter = api.Parameters.GetParameter("parameterId");

Add a new parameter
api.Parameters.Add(new Parameter(api.PageInfo)
{
Id
= "foo", // No spaces
DataType = (int)DataType.String,
Value
= "bar"
});

Non-hidden parameters are usable on reports
parameter.IsHidden = false;

Prompting parameters will ask the user for a value when running a containing report
parameter.PromptText = "Enter a value";

Prompting parameters can display a selection list based on a data field or custom SQL
Entity entity = api.Entities.GetEntity("entityName");
parameter.DropdownDataSourceId
parameter.DropdownObjectType
parameter.DropdownDbName
parameter.DropdownValueField
parameter.DropdownDisplayValueField

=
=
=
=
=

entity.DataSourceId;
entity.ObjectType;
entity.DbName;
entity.GetColumn("colName").Name;
entity.GetColumn("colName").Name;

Save to Disk
public void SaveConfigToFile(string fileName, bool forceAllValues)

The configuration data will be written to the current configuration file, or to the file name provided in the fileName argument. Pass null to
overwrite the current configuration file.
If forceAllValues is true, all of the General settings will be written to the file. Otherwise, only those settings which are different from
the defaults are written to the file. Default value is false.

Role Permissions
Roles are a neat way to encapsulate a collection of permissions. Roles also allow for some more fine grained control over data and folder
access than the base config settings. Only one role can be active at a time.

Get a specific role
Role role = api.Roles.GetRole("roleId");

Create new role
api.Roles.Add(new Role(api.PageInfo) { Id = "roleId", IsActive = true });

Edit role settings
role.General.AnySetting = "value";

Folder/Object/Row Security
role.Security.Folders.IncludeAll = true;
role.Security.Folders.Add(new Folder() { Name = "folderPath", ReadOnly = true });
role.Security.DataObjects.Add(new DataObject() { Name = "objectName" });
role.Security.DataObjectRows.Add(new DataObjectRow()
{
ObjectName = "objectName",
FilterString = "filterString"
});

Activate a role
role.Activate();

Advanced Configuration
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You can dynamically change data sources, objects, joins, etc., in the API, or simply use these settings to programmatically generate a
config file.

Data Sources
View data source
api.DataSources.GetDataSource("dataSourceName").DataConnStr;

Create a new data source
api.DataSources.Add(new DataSource(api.PageInfo)
{
Name
= "dataSourceName",
DbType
= Constants.DatabaseType.SqlServer,
DataConnStr = "connectionString"
});

Data Objects
View data objects
foreach (Entity entity in api.Entities)
{
// three ways to identify an entity
string.Format("Alias: {0}, Id: {1}, Database Name: {2}\n",
entity.Name, // Alias
entity.Id,
// Id
entity.DbName // Database Name
);
}

Get a specific data object
Note
This is the recommended way to get an entity by name, but there are other methods provided as well.

Entity entity = api.Entities.GetEntity("entityAlias");
// Returns null if it does not exist
// Best to retrieve entities by Alias name, because Aliases are unique and required
// Ids are unique, but not required; Db names are required, but not unique (across sources)

View object fields
foreach (EntityColumn column in entity.Columns)
{
string.Format("Alias: {0}, Database name: {1}\n",
column.Name,
// Alias (or actual if no alias)
column.ActualName // Database name
);
}

Create new data object
Tip
Set the Id property before the DbName.

Entity entity = api.Entities.NewEntity(entityName);
entity.DataSourceId = api.DataSources.GetDataSource("dataSourceName").Id;
entity.ObjectType = DataObjectType.Table;
entity.Id
= "idName";
// Unique
entity.DbName
= "databaseName"; // Required
entity.Name
= "aliasName";
// Required, unique
// Add key column
entity.KeyColumns.Add(new KeyColumn(entity.GetColumn("colName").ActualFullName));

SQL Object
entity.SqlStmt = "SELECT * FROM Employees";

Add tenanting to object
entity.Tenants.Add(new EntityTenant(api.PageInfo,
entity.Name,
entity.GetColumn("colName").ActualFullName, // Get col by Alias but supply ActualFullName
"parameterId" // Tenant parameter
));

Filter dropdowns
entity.FilterObjectType = DataObjectType.Table; // Table, View, Function, Procedure, etc.
entity.FilterDbName = "FilterObjectName";
// or custom SQL:
entity.FilterObjectType = DataObjectType.SqlStmt;
entity.FilterSqlStmt = "SELECT etc...";

Joins
See all config joins
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// Build the join string for display
string joinString = "";
// All config joins; for report joins, use report.Joins
foreach (Join join in api.Joins.OrderByDescending(x => x.Weight)) // Order by weight
{
foreach (JoinColumn col in join.JoinColumns)
{
joinString += string.Format("{0} {1} {2}{3}\n",
col.FromColumn.FullKeyName,
join.JoinText,
col.ToColumn.FullKeyName,
join.RelationType == 1 ? "(s)" : "" // 1-to-Many
);
}
if (join.Weight > 0) joinString += ("Weight: " + join.Weight + "\n");
}

Get specific join
Join join = api.Joins.GetItem("fromEntity", "toEntity", false);

Create a new join
Note
For creation of Advanced Joins, see Advanced Joins.

Entity fromEntity = api.Entities.GetEntity("fromName");
Entity toEntity = api.Entities.GetEntity("toName");
Join newJoin = new
{
EntityFromName =
EntityToName =
Type
=
RelationType =
Weight
=
};

Join(api.PageInfo)
fromEntity.Name,
toEntity.Name,
(int)JoinType.Inner,
0, // 0: One-to-One, 1: One-to-Many
0

// Add key columns
newJoin.JoinColumns.Add(new JoinColumn(
new KeyColumn(fromEntity.Name, fromEntity.GetColumn("fromColName").ActualFullName),
new KeyColumn(toEntity.Name, toEntity.GetColumn("toColName").ActualFullName)
));
// Add to the config; for reports, use report.Joins.Add()
api.Joins.Add(newJoin);
// If there is an active report, recreate the joins
report.CreateJoins();

Custom Functions
Get a specific function
UdfFunction function = api.CustomFunctions.GetItem("functionName");

Create a new function
UdfFunction newFunction = new UdfFunction(api.PageInfo)
{
Name
= "functionName",
AvailableIn = UdfFunctionAvailableType.Formula, // Custom or filter function
ArgumentsJson = "[{'Name':'argName','Required':true,'Description':'desc'}]",
Language
= CodeLanguage.CSharp.ToString(),
ProgramCode = "Code();"
};
// Add any references and namespaces
newFunction.Namespaces.Add("Program.Namespace");
newFunction.References.Add("Reference.dll");
// Add to the config
api.CustomFunctions.Add(newFunction);

Custom Aggregate Functions
Get a specific function
UdfFunction function = api.CustomFunctions.GetItem("functionName");

Create a new function
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var newCustomAgg = new UdfFunction();
newCustomAgg.AvailableIn = UdfFunctionAvailableType.CustomAggregate;
newCustomAgg.Language = "VB";
newCustomAgg.Name = "APICustomAgg";
newCustomAgg.Namespaces.Add("WebReports.Api.Common");
newCustomAgg.Category = "CustomAggs";
newCustomAgg.ProgramCode = @"
Public Class MyCustomAggregator
Inherits ICustomAggregator
Private count
Public Sub AddValue(ByVal sessionInfo As SessionInfo, ByVal value As Object, ParamArray args As Object())
count = count + 1
End Sub
Public Function Result(ByVal sessionInfo As SessionInfo, ParamArray args As Object()) As Object
Return count
End Function
End Class";
newCustomAgg.ArgumentsJson = "[{\"Name\":\"dataToAggregate\",\"Required\":true,\"Description\":\"\"},{\"Name\":\"recordLevel\",\"Required\":false,\"Description\":\"\"}]";
Common.Api.SetupData.Functions.Add(newCustomAgg);

Server Events
Get a specific server event
ServerEvent serverEvent = api.ServerEvents.GetByName("eventName");

Create a new server event
ServerEvent newEvent = new ServerEvent(api.PageInfo)
{
Name
= "eventName",
EventType = ServerEventType.OnReportExecuteStart, // Global event, or "None"
};
// Custom code
newEvent.ServerCode.CustomCode.Language
= CodeLanguage.CSharp;
newEvent.ServerCode.CustomCode.ProgramCode = "Code();";
//Add a namespace
newEvent.ServerCode.CustomCode.Namespaces.Add("System.IO");
// Code from data source
newEvent.ServerCode.DataSourceId = api.DataSources.GetDataSource("eventsAssembly").Id;
newEvent.ServerCode.FunctionName = "functionName";
// Add to config
api.ServerEvents.Add(newEvent);
// Add to a report (must be in config)
report.ServerEvents.Add(new ReportServerEvent(api.PageInfo)
{
EventType = ServerEventType.OnDataCombined,
EventId = api.ServerEvents.GetByName("eventName").Id
});

Storage Management Schema
Update reports to the current Storage Management schema when changing versions. This is the same as clicking the Update Reports
button in the Admin Console.
Api api = new Api();
String updateResults = (new WebReports.Api.ReportMgmt.UpdateReportsUtility(api.PageInfo)).RewriteAllReports();

Scheduling
Note
Use of the NodaTime library is required beginning with v2019.1. More information is available in the Time Zone Calculation
Enhancements in v2019.1 article.

View schedule list
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List<Exception> exceptions;
// Build the job list string
string jobList = "";
foreach (List<JobInfo> schedule in api.ReportScheduler.GetJobList(out exceptions))
{
foreach (JobInfo job in schedule.OrderBy(x => x.NextExecuteDate).ThenBy(x => x.Name))
{
jobList += string.Format("Job '{0}' for report '{1}' ",
job.Name,
api.ReportScheduler.GetReportScheduleInfoByJobId(job.JobId.ToString()).ReportBaseName
);
switch (job.Status)
{
case JobStatus.Completed:
jobList += string.Format("ran on {0}, at host {1}.\n",
job.LastExecuteDate.ToString("MMM d hh:mm tt"),
api.ReportScheduler.GetHost(api.ReportScheduler.GetHostIdxForJob(job.JobId))
);
break;
case JobStatus.Ready:
jobList += string.Format("ready to run on {0}.\n",
job.NextExecuteDate.ToString("MMM d hh:mm tt")
);
break;
case JobStatus.Deleted:
case JobStatus.Removed:
case JobStatus.Abended:
case JobStatus.UserAbort:
jobList += string.Format("ended. Last run on {0}, at host {1}.\n",
job.LastExecuteDate.ToString("MMM d hh:mm tt"),
api.ReportScheduler.GetHost(api.ReportScheduler.GetHostIdxForJob(job.JobId))
);
break;
default:
jobList += string.Format("status unknown.\n");
break;
}
}
}

Create an immediate schedule (basic options)
Note
Set the Api object's Active Report before creating the schedule. The active report is the report that is scheduled.

using NodaTime;
...
// Run-once, immediately save to disk
string jobId;
// Use to retrieve schedule info later for editing
int hostIdx;
// Assigned execution host id
ReportScheduleInfo newSchedule = new ReportScheduleInfoOnce()
{
ScheduleName
= "Immediate Schedule",
// Schedule name
ReportType
= wrReportType.Advanced,
// Report type
RangeStartDate = new LocalDate(DateTime.Now.Year, DateTime.Now.Month, DateTime.Now.Day),
ScheduleTime = new LocalTime(DateTime.Now.Hour, DateTime.Now.Minute), // Start time
SendReportInEmail = false
// Email or save
};

// Start date

// Send to the scheduler; wrap in try/catch to handle exceptions
try {
api.ReportScheduler.AddReport(
new ReportSchedule(api.PageInfo) { ScheduleInfo = newSchedule }, out jobId, out hostIdx);
}
catch (Exception) { }

Recurring schedules (additional options)
Daily
Note
Set the Api object's Active Report before creating the schedule. The active report is the report that is scheduled.
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using NodaTime;
...
ReportScheduleInfo newSchedule = new ReportScheduleInfoDaily()
{
... // Include basic options
// Range of recurrence, every N days, or every weekday
DailyPattern = ReportScheduleInfo.DailyPatternType.EveryNDays,
EveryNDays = 2, // N days
// End date (optional):
RangeEndDate
= new LocalDate(2017, 12, 25), // End on a specific date
RangeNOccurences = 10,
// Or end after N occurrences
// intraday recurrence (optional):
RepeatEvery
= true, // Enable intraday recurrence
RepeatEveryHours = 4,
// Repeat every N hours
RepeatEveryMinutes = 0,
// And N minutes
RepeatEveryEndTime = new TimeSpan(DateTime.Parse("12:00 PM").Ticks) // Optional end time
}

Weekly
Note
Set the Api object's Active Report before creating the schedule. The active report is the report that is scheduled.

ReportScheduleInfo newSchedule = new ReportScheduleInfoWeekly()
{
... // Include basic options
... // Optional end date, optional intraday recurrence
EveryNWeeks = 1, // Every N weeks
// On these days:
Sun
Mon Tues Wed
Thu Fri
Sat
IsDayOfWeek = new bool[] { false, true, false, false, true, false, false }
}

Monthly
ReportScheduleInfo newSchedule = new ReportScheduleInfoMonthly()
{
... // Include basic options
... // Optional end date, optional intraday recurrence
// Specific or relative day pattern
MonthlyPattern = ReportScheduleInfo.MonthlyPatternType.SpecificDayOfMonth,
// Specific: day X of every N months
SpecificDayOfMonth = 7, // Day of the month
SpecificEveryNMonths = 2, // Every N months
// Relative: the Xth
RelativeWeekOfMonth
RelativeDayOfWeek
RelativeEveryNMonths

day-of-week of every N months
= ReportScheduleInfo.WeekOfMonthType.First, // Week of month
= ReportScheduleInfo.DayOfWeekType.Weekday, // Day of week
= 2
// Every N months

}

Note
Set the Api object's Active Report before creating the schedule. The active report is the report that is scheduled.

Yearly
ReportScheduleInfo newSchedule = new ReportScheduleInfoYearly()
{
... // Include basic options
... // Optional end date, optional intraday recurrence
// Specific or relative day pattern
YearlyPattern = ReportScheduleInfo.YearlyPatternType.SpecificDayOfYear,
// Specific: Month/Day of every year
SpecificMonthOfYear = 3, // Month of the year
SpecificDayOfMonth = 15, // Day of the month
// Relative: the Xth day-of-week for month N
RelativeWeekOfMonth = ReportScheduleInfo.WeekOfMonthType.Last, // Week of month
RelativeDayOfWeek = ReportScheduleInfo.DayOfWeekType.Friday, // Day of week
RelativeMonthOfYear = 3
// Month N
}

Email job
newSchedule.SendReportInEmail = true;
newSchedule.EmailSubject
= "Subject Text";
newSchedule.EmailBody
= "Hello World!";
newSchedule.EmailToList.Add("email@company.com");
// newSchedule.EmailCCList.Add();
// newSchedule.EmailBccList.Add();

//
//
//
//
//
//

Enable email
Email subject
Email body
To addresses
CC addresses
BCC addresses

Batch email
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// Batch addresses entity (must be in the batch report)
Entity batchAddresses = report.Entities.GetEntity("entityName");
newSchedule.IsBatchReport = true;
newSchedule.BatchEmailToList.Add("supervisor@example.com");
// newSchedule.BatchEmailCcList.Add();
newSchedule.BatchEntity = batchAddresses.Name;
newSchedule.BatchField = batchAddresses.GetColumn("Email").Name;
newSchedule.IncludeReportAttachment = true;

//
//
//
//
//
//

Enable batch
Summary recipients
Summary cc recipients
Email address object
Email address field
Include the report

Access existing schedule by jobId
ReportScheduleInfo schedule = api.ReportScheduler.GetReportScheduleInfoByJobId("jobId");

Update an existing schedule
api.ReportScheduler.UpdateExistingSchedule(newSchedule, "jobIdToUpdate");

Delete an existing schedule
api.ReportScheduler.DeleteSchedulerJob("jobIdToDelete");

Managing Files and Folders
Initialize the manager class for the type of folder or storage management in use
// Storage Management - use for all versions v2020.1+
ReportMgmtBase manager = api.ReportManagement;
// File System - legacy use only
ReportMgmtFileSystem manager = new ReportMgmtFileSystem(api.PageInfo);
// Database - legacy use only
ReportMgmtMethod manager = new ReportMgmtMethod(api.PageInfo);
// Cloud drive - legacy use only
ReportMgmtCloud manager = new ReportMgmtCloud(api.PageInfo);

View the full reports tree
XmlDocument tree = new XmlDocument() { InnerXml = manager.GetReportListXml() };

View themes list by type
List<string> evThemes = manager.GetThemeList(ReportTheme.ReportThemeType.ExpressView.ToString());

Get a specific theme (class depends on theme type)
ExpressViewTheme evTheme = (ExpressViewTheme)ReportTheme.GetTheme(
api.PageInfo, ReportTheme.ReportThemeType.ExpressView, "themeName");

View list of templates
List<string> templates = manager.GetTemplateList();

Add a new folder
manager.AddFolder("parentFolder", "newFolderName");

Move or rename a folder
manager.RenameFolder("oldPath", "newPath");

Move or rename a report
manager.RenameReport("oldPath", "newPath");

Duplicate an existing report
api.ReportObjectFactory.Copy("reportName", "newName");

Save a new report to disk
api.ReportObjectFactory.Copy(report, "reportName", null);

REST — Introduction
The Exago API provides programmatic access to create session configurations based on user credentials. The REST API is an alternative
to the .NET API for applications not built in .NET environments. REST web services provide access to API functions for any client capable
of passing HTTP requests over a network.

Installing REST
Install the REST Web Service API following the steps in REST — Getting Started.

The API
This is the documentation for the Exago REST API. This information will always reflect the latest available Exago version. Changes are
made periodically to the API. For details, please refer to REST Updates.
The API is a JSON API. For more information, see Using JSON.
Endpoints are documented with the HTTP request type and a URI sub-path:
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POST /rest/sessions

Prepend the URL path to your web service to get the full endpoint URL:
http://{myapp}/{exago web service}/rest/sessions

Curly braces, {}, are values that you must supply:
GET /rest/roles/{Id}

Usually the value to supply is found in JSON given by a request to the base endpoint. For example, to retrieve a particular Role by its "Id",
first run GET /rest/roles to see the roles available to you:
[
{
"Id": "Admin"
},
{
"Id": "User"
}
]

Then to see detailed data on a Role, run GET /rest/roles/{Id} where {Id} is the value of its "Id" property (case sensitive):
GET /rest/roles/Admin

Some methods may accept optional URL parameters. Append any url parameters to the end of the endpoint URL using the following
format:
/rest/{endpoint}?{param1}={value1}&{param2}={value2}&{param3}={value3}

For all endpoints except /rest/sessions, you must append the session Id as a url parameter to the end of the URL:
VERB /rest/{endpoint}?sid={sid}

For more information, see Starting a REST Session.
Some examples in this documentation use cURL ("curl"), which is a command-line tool for transferring data using various protocols. Curl is
compatible with Windows or Linux, and can be downloaded from https://curl.haxx.se/. If curl is installed on your machine, you can copyand-paste the examples into a command line, replacing any item in {braces} with your local variables, in order to test them out for yourself.
Long examples may be broken into multiple lines in order to improve readability. The caret symbol (^) tells the command line to ignore the
following linebreak. On Linux, replace the caret with a backslash (\).
curl http://{webservice}/rest/settings?sid={sid} ^
-H "Accept: application/json" ^
-H "Content-Type: application/json" ^
-H "Authorization: Basic Og==" ^
-X PATCH ^
-d "{'ShowExpressReports':false}"

For testing, we recommend a graphical application such as Advanced Rest Client or Postman.

Authentication
The REST API requires authorization to be accessed. To make an authorized request, the authorization header must be supplied. There
are two different authorization methods depending on your needs. Both rely on the Admin Console > General > Other Settings > User
ID and Admin Console > General > Other Settings > REST Key.

Basic Authorization
When using basic authorization, the authorization header is constructed as follows:
1. The User ID and REST Key are combined into a string User ID:REST Key.
2. The resulting string literal is encoded using Base64.
3. "Basic" and a space are placed before the encoded string.
For example, if the User ID is "Brian" and the REST Key is "open sesame" then the authorization header would be constructed as follows:
1. Combine User ID and REST Key into a string
Brian:open sesame

2. Encode the string using Base 64
QWxhZGRpbjpvcGVuIHN1c2FtZQ==

3. Append "Basic " to the front
Basic QWxhZGRpbjpvcGVuIHN1c2FtZQ==

The auth key is sent in clear text with each request. If this is a concern, the REST API should be deployed in an SSL environment or the
more secure ExagoKey authorization should be used.
A configuration with a blank User ID and REST Key can be accessed using the following authorization header:
Authorization: Basic Og==

ExagoKey Authorization
ExagoKey authorization uses the HMAC-SHA256 algorithm for authorization. When using ExagoKey authorization, the authorization
header is constructed as follows:
1.
2.
3.
4.

The string to sign is UTF-8 encoded, then signed with the UTF-8 encoded REST key using the HMAC-SHA256 algorithm.
The resulting signature is then encoded using Base64.
The User ID and a colon is put before the encoded signature.
"ExagoKey" and a space are placed before the encoded string literal.
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For example, if the User ID is "Brian" and the REST Key is "open sesame" then depending on the request the authorization header might
be something like:
Authorization: ExagoKey Brian:6HZE5tCWjsjbJY+VXQg3UzXlK/jeoGhbm25YDXiHWdE=

Using ExagoKey does not send the password with each request, making it more secure than Basic Authorization. To ensure greater
security the REST API should be deployed in an SSL environment.

ExagoKey String
The ExagoKey string that is to be signed is constructed using the following information from the request, in the following order, with "\n"
after each item (including the last one).
1. The HTTP Method, must be in uppercase.
2. The absolute request path, up to but not including the query string if one should exist. For example, if the request is to
"http://myserver.com/exago/rest/sessions?config=myconfig" the absolute request path would be "/exago/rest/sessions".
3. The contents of the Content-Length header.
4. The contents of the Content-Type header, or a string of zero length if no header exists.
5. The contents of the Content-MD5 header, or a string of zero length if no header exists.
6. The session ID, or a string of zero length if no session ID exists.
7. The contents of the X-Exago-Date header, or the contents of the Date header if the X-Exago-Date header does not exist, or a string
of zero length if neither header exists.
Note
If a date is supplied, the REST API will reject any request that is older than 15 minutes from the supplied date. The date supplied is in
GMT (UTC).

Request Format
The REST API uses JSON. It will not accept data in any other format. In the case of an error, it may return plain text, but this is not
session data. You must set the following headers on all requests:
"Content-Type: application/json"
"Accept: application/json"
"Authorization: {type} {authstring}"
Most of the examples in this documentation omit the headers in order to improve readability; however they are required for all requests.

Response Format
Successful requests return HTTP status codes in the 200 range. When you create a resource with POST, the API returns the resource in
the response body:
Status: 201 Created
Location: /{webservice}/rest/Entities/Employees
{
"Id":
"Name":
"Schema":
"CategoryName":
"DataName":
"DataSourceId":
"DataType":
...

"Employees",
"Employees",
"dbo",
"",
"Employees",
"0",
"Table",

}

You may get a plain text response in the case of errors or bad requests. The content will not contain any session data.
Responses have one of the following status codes:
200
The request was completed successfully. The document in the body, if any, is a representation of some resource. This code is usually
returned for a successful GET request.
201
The request was completed successfully. A new resource has been created at the URL specified in the Location header of the response.
The document in the body, if any, is a representation of the resource created. This code is usually returned for a successful POST request.
204
The request was completed successfully. There is no content in the body. This code is usually returned for successful PATCH, PUT, and
DELETE requests.
400
The request was bad on the client side. The document in the body, if any, is error data describing the problem. This is usually the result of
using an invalid method type.
401
The request wasn’t authorized to access the resource. The document in the body, if any, is error data describing the problem.
404
The requested resource was not found. The document in the body, if any, is error data describing the problem. Often this is the result of a
malformed URL request string.
409
The request caused a conflict between two resources. The document in the body, if any, is error data describing the problem.
500
There was a problem on the server side. The document in the body, if any, is error data describing the problem. Often this is the result of a
malformed JSON request package.
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Request Data
The API returns and accepts JSON values, which can be strings, numbers, objects, arrays, true, false, or null. See Using JSON for more
information.
Each endpoint uses a unique JSON object for input and output of variables. The JSON is documented with each resource in a table:
Name

Type

Writeable

Description

Each row represents a property. The Name field is the name of the property. The Type field indicates what type of data it accepts.
The Writeable field indicates whether this property can be written:
no - this property is read-only
yes - this property can be written
yes ("value") - this property can be written; its default value is in parentheses
required - this property must be written; it cannot be null
required-create - this property must be written for all POST calls; it is read-only for all other calls
The Description field is any relevant information about the property.

Id Values
Most resources are identified by an "Id" property, which is an integer or string. The Id must be unique among the set of resources. If you
are permitted write-access to the Id, avoid conflicting names.

Constant or Enum Values
Some properties can only accept one of a set of string or integer values (or sometimes null).
Properties which accept enumerated values are indicated as having an "enum" type. The description field in its JSON representation links
to the list of possible values, which can usually be represented by their string or equivalent integer value. For example:
Name

Type

Writeable

Description

DataType

enum

yes

Parameter Type

Properties which accept constant string values are indicated as having an "const" type. The description field in its JSON representation
links to the list of possible values. For example:
Name

Type

Writeable

Description

JoinType

const

yes

Join Type

This Documentation
This documentation is broken down by section according to the use cases for different API elements. Each section represents a single
endpoint or set of related endpoints and use cases. To find out how to do something using the REST API, first browse to the relevant
section for the element you want to use. Then check the table of contents for what actions you want to take; Or read from top to bottom to
gain a fuller understanding of the resource.
Check out Getting Started with REST to get started!
See List of REST Endpoints for the available endpoints and their usages.

Additional Resources
Admin Support Lab — REST Web Service API Setup & Security
Admin Support Lab - Batch REST API
Admin Support Lab - .NET and REST APIs

Using JSON
The Exago REST API is JSON-based. ;Data sent to the API methods is formatted in JSON, and the methods return JSON formatted
response objects. In order to use the REST API you need to convert your data to, and from JSON.

What is JSON?
JSON is a data-interchange format that is designed to be text-based, and easy to read and parse. JSON objects are formatted using the
following rules:
1. Objects contain a collection of properties in "key": "value" format. Braces {} enclose objects.
2. Keys are strings, which are enclosed by single- (' ') or double-quotes (" "). Each key has a value, indicated by a colon (:). Properties
are separated by commas (,).
3. Properties can accept sets of values using arrays, enclosed by brackets [ ]. Values are separated by commas (,).
4. Values can be strings, numbers, arrays, other JSON objects, true, false, or null.
5. The order of properties within an object doesn't matter.

Example
{
"users": [
{
"id": "358",
"username": "alex224",
"admin": true,
...
},
...
]
}

Note
Ellipses ... indicate that one or more properties or objects have been omitted for clarity.

Using JSON with Code

135 of 201

Using JSON

Technical Guide

JSON data usually has to be converted into a format that your code can understand. Most modern programming languages have JSON
compatible libraries, if they are not built into the language.
To convert JSON strings into objects:
JavaScript (see JSON.parse() at MDN)
var json_obj = JSON.parse('{"user":{"id":"358"}}');

Python 3 (see json at Pydoc)
json_obj = json.loads('{"user":{"id":"358"}}')

JSON Object Documentation
Although JSON objects can be formatted in a variety of ways, each endpoint requires an object with a specific set of properties. The
required format can be viewed in the documentation for each endpoint. Some properties are mandatory; some are read-only; some are
create-only, which means that they are required for POST calls, but read-only for other call types; and some are optional. Accessing
certain resources in an un-authorized state may only return a subset of data; in general we recommend that all REST calls be authorized.
For example, the documentation for the JSON object above might read like the following:
Name

Type

Writeable

Description

users

array of
User

yes

List of users belonging to the session

Name

Type

Writeable

Description

id

integer

no

This user's unique Id

username

string

required

This user's login key

admin

boolean

yes (false)

Whether this user has admin privileges

User JSON

Note
Read (-only) permissions indicate that the property cannot be edited with PATCH or PUT. This does not indicate whether a DELETE call
can be used on the object.

Using the API with cURL
Throughout the REST documentation there are examples which use cURL, a free command-line tool for using various protocols. Download
cURL at: https://curl.haxx.se/download.html. If you're using Google Chrome, the Advanced REST Client browser extension is an
excellent alternative. We recommend using either program to experiment with the API and test your method calls.
Disclaimer
We cannot provide support for any third-party tools such as cURL or Advanced REST Client.
API calls using cURL require the following at a bare minimum: Three headers, Accept: application/json, Content-Type:
application/json, and your authorization header; The JSON data, which should be empty if the endpoint expects no data; And the
"verb" e.g. POST, GET, etc.
All cURL calls are formatted like the following:
curl http://{webservice}/rest/{endpoint}?sid={sid}&{param1}={value1}&{param2}={value2} ^
-d "{json}" ^
-H "Accept: application/json" ^
-H "Content-Type: application/json" ^
-H "Authorization: {type} {authstring}" ^
-X {verb}

Note
Replace text in {braces} with the applicable data for your environment, method, and JSON. End-of-line carets (^) terminate each line to
improve readability, but are not necessary.
For example, a new session call is formatted like the following:
curl http://{webservice}/rest/sessions ^
-d "" ^
-H "Accept: application/json" ^
-H "Content-Type: application/json" ^
-H "Authorization: Basic Og==" ^
-X POST

For an un-authenticated installation, you could copy and paste this example into a command line, replacing {webservice path} with the
path to your web service, in order to test whether REST is working.
If it succeeds, it should return data similar to the following:

{"AppUrl":"ExagoHome.aspx?d={appUrl}","Id":"{sid}","Page":"ExagoHome","ApiAction":"Default","ExportType":null,"ShowTabs":true,"ShowErrorDetail":true,"ReportSettings":{"Id":null,"Repo

Note that all the data was returned on a single line. For improved readability, copy and paste this into a "pretty-printer" (there are many free
online solutions).
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{
"AppUrl": "ExagoHome.aspx?d={appUrl}",
"Id": "{sid}",
"Page": "ExagoHome",
"ApiAction": "Default",
"ExportType": null,
"ShowTabs": true,
"ShowErrorDetail": true,
"ReportSettings": {
"Id": null,
"ReportPath": null,
"SortsResource": null,
"FilterItems": null
}
}

To pass JSON with cURL, either insert it inline:
curl http://{webservice}/rest/sessions ^
-d "{'ReportSettings':{'ReportPath':'Test\\TestReport'}}" ^
-H "Accept: application/json" ^
-H "Content-Type: application/json" ^
-H "Authorization: Basic Og==" ^
-X POST

Or reference a text file containing the JSON object:
curl http://{webservice}/rest/sessions ^
-d @json.txt ^
-H "Accept: application/json" ^
-H "Content-Type: application/json" ^
-H "Authorization: Basic Og==" ^
-X POST

json.txt
"{'ReportSettings':{'ReportPath':'Test\\TestReport'}}"

List of REST Endpoints
The following REST Web Service API endpoint paths are available. All calls require the following headers:
Content-Type: application/json
Accept: application/json
Authorization: {type} {authstring}

/rest/Batch v2018.1.1+
POST
/rest/Sessions
POST
GET
/rest/Sessions/{sid}
GET
PATCH
DELETE
All of the following calls require the Session ID URL parameter: sid={sid}

Example
GET /rest/Settings?sid={sid}

/rest/DataSources
GET
/rest/DataSources/{Id}
POST
GET
PATCH
/rest/Entities
POST
GET
/rest/Entities/{Id}
GET
PATCH
DELETE
/rest/Entities/{Id}/Fields
GET
/rest/Entities/{Id}/Fields/{Field Id}
GET
PATCH
POST v2019.1.13+
/rest/Folders/{Name}
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POST
DELETE
/rest/Folders/Rename
POST
/rest/Functions
POST
GET
/rest/Functions/{Id}
GET
PATCH
DELETE
/rest/Joins
POST
GET
/rest/Joins/{Id}
GET
PATCH
DELETE
/rest/Parameters
POST
GET
/rest/Parameters/{Id}
GET
PATCH
DELETE
/rest/Reports/List
GET
/rest/Reports/Execute/{Type}
POST
/rest/Roles
POST
GET
/rest/Roles/{Id}
GET
PATCH
/rest/Roles/{Id}/DataObjectRows
GET
PATCH
/rest/Roles/{Id}/Entities
GET
PATCH
/rest/Roles/{Id}/Folders
GET
PATCH
/rest/Roles/{Id}/Settings
GET
PATCH
/rest/Schedulesv2v2019.2.29+v2020.1.3+v2021.1.1+
GET
POST
/rest/Schedulesv2/{ScheduleID}v2019.2.29+v2020.1.3+v2021.1.1+
GET
PATCH
DELETE
/rest/Schedulesv2/Flushv2019.2.29+v2020.1.3+v2021.1.1+
POST
/rest/Schedulesv2/{ScheduleID}/Filtersv2019.2.29+v2020.1.3+v2021.1.1+
GET
PATCH
/rest/Schedulesv2/{ScheduleID}/Parametersv2019.2.29+v2020.1.3+v2021.1.1+
GET
PATCH
/rest/ServerEvents
GET
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/rest/ServerEvents/{Id}
GET
DELETE
/rest/Settings
GET
PATCH

REST — Batch
Use the Batch REST endpoint to group together multiple sequential calls into a single network request. For environments which make a
number of programmatic alterations to the session configuration, Batch can significantly reduce the network load and time to create the
session.
The session ID can be passed as a URL parameter just as it is for the other REST endpoints.
When supplied as part of a Batch call, the individual requests are evaluated sequentially in the order they are supplied.
Note
The GET|PATCH|DELETE /Sessions/{sid} endpoints are not supported by Batch REST.

Batch JSON
The body of a Batch call is formatted as an array of Batch objects, each of which has the following JSON format:
Name

Type

Writable

Description
REST endpoint URL (e.g. the part following /rest/).
Important
Unlike standalone calls, the service names are case-sensitive in
the Batch endpoint. Reference the service names from this list:
DataSources
Entities
Fields
Folders
Functions
Joins
Parameters
Reports
Roles
SchedulesV2
ServerEvents
Sessions
Settings
StorageMgmt

Url

string

required

Method

constant

required

Request method, one of: POST, PATCH, GET, DELETE

Payload

Payload

yes

Optional payload for POST and PATCH calls.

Example
[
{
"Url": "Sessions",
"Method": "POST"
},
{
"Url": "Roles/MyRole",
"Method": "PATCH",
"Payload": { ... }
}
]

Payload JSON
The format of the Payload property depends on the Url, and mirrors the payload supplied for the non-batch versions of the specified
endpoint. For example, when the Url is "Parameters", the payload has the following format (as detailed in REST — Parameters):
{
"Id":
"DataType":
"Value":
"PromptText":
"IsHidden":

"MyParameter",
"String",
"",
"Input a value",
true

}

Making Batch Calls
POST /rest/batch

All Batch calls are made using the POST method. Otherwise, calls to the Batch endpoint require the same Headers as all other REST
calls. Each request object is supplied in order of evaluation. The response object contains the responses from each request in the same
order that they were sent.
Important
Adding additional Data Source column metadata or performing a GET for the Data Source Fields will result in fixing the current column
metadata list as the only defined columns. The column metadata can be further altered, but will not be reflected in the Entity Columns
collection until the session is launched in a browser.

Available parameters
Name

Type

Description
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Specify which config file to create the session with.
Format: CustomConfigFile

config

string

Caution
All config files must use the same Temp path. Otherwise, you may experience
errors when loading sessions.

Response JSON
Name
ReturnCode

string

Type

ResponseContent

object

Description
Response code indicating whether the call was successful
If the response code is 200 or 201, this is the content of the response. Otherwise
this indicates whether an error occurred and the error type.

ResponseContent JSON
ReturnCode: 204
Name
StatusCode

Type
int

Description
Status code

StatusDescription string

Status description

ReturnCode: 400-500
Name
reason

Type
string

stacktrace string

Description
Error message
Stack trace, if available

Using curl
curl http://{webservice}/rest/batch -X POST ^
-d "[{'Url':'Sessions','Method':'POST'}, ^
{'Url':'Roles/Example','Method':'PATCH','Payload':{'IsActive':true}}]"

Example response
[
{
"ReturnCode": "201",
"ResponseContent": {
"AppUrl": "ExagoHome.aspx?...",
"ApiKey": "...",
"Id": "...",
"Page": "ExagoHome",
"ApiAction": "Default",
"ExportType": null,
"ShowTabs": true,
"ShowErrorDetail": true,
"ReportSettings": {
"Id": null,
"ReportPath": null,
"SortsResource": null,
"FilterItems": null,
"IsError": false,
"ErrorList": null
}
}
},
{
"ReturnCode": "204",
"ResponseContent": {
"StatusCode": 204,
"StatusDescription": null
}
}
]

REST — Sessions
Sessions are the means by which REST persists changes through multiple API calls. A REST session allows for you to easily
encapsulate a group of user-specific changes. Most REST changes will only affect the current session, with folder changes being the
exception. However, once an API session is committed and Exago is launched, a user will be able to make such changes as their role
permits.
Note
All requests require a Session ID URL parameter and basic request headers. In the following document, headers are omitted in the
interest of brevity.

Entering the API
A POST /Sessions call should always be the first made when entering the API. This creates a session, which contains a Session Id and
an AppUrl.

Session Id
The Session Id is a GUID which uniquely identifies the instance of Exago you're working in.
Example:
3c04c155-3317-4dab-a2ee-09572e3a8e44
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This Id is passed as a URL parameter to all other method calls.

AppUrl
The AppUrl is a string which encodes the session information in a format readable by the host application.
Example:
ExagoHome.aspx?d=fk7hInneiNI7yUR1n8fCjjbTuIdTWgQrj8AaUlzO8l7K5JMaf7DhbZxzaSAXthP3bWLA%2fzG4AtXApO6pGoBpzQ%3d%3d&showerrordetail=true

The AppUrl consists of three components: the Home Page, an alphanumeric string, and the ShowErrorDetail URL parameter.
Once you have committed your API changes and want to launch Exago, append the AppUrl to the end of your Exago base URL and
launch the full URL string in a browser:
http://yoursite.com/exago/ExagoHome.aspx?d=fk7hInneiNI7yUR1n8fCjjbTuIdTWgQrj8AaUlzO8l7K5JMaf7DhbZxzaSAXthP3bWLA%2fzG4AtXApO6pGoBpzQ%3d%3d&showerrordetail=true

An AppUrl can only be used once. Launching an API session will permanently close it, and apply your custom variables into a new user
session in the host application.
Tip
Retrieving the AppUrl via GET /Sessions/{Id} should always be the last call made when finishing in the API if you didn't store it after the
initial POST /Sessions call.

Session JSON
The Sessions endpoint allows for creation and deletion of sessions and access to some general settings. It also allows you to specify and
configure the action that the session will take when launched. To launch a report in the full user interface, it needs to be set in Sessions as
the output report.
Sessions are represented as JSON objects with the following properties:
Name

Type

Writable

Description
The unique Id of this session ("sid")

Id

string

no

AppUrl

string

no

Page

string

yes
("ExagoHome") The Exago home page

ApiAction

enum

yes ("Default") Api Action, to take when this session is launched

ExportType

enum

yes

Export Type, if ApiAction is 'ExecuteReport'

ShowTabs

boolean

yes (true)

Whether the tab bar should be shown

ShowErrorDetail

boolean

yes (true)

Whether detailed error messages should be shown

ReportSettings

Report

yes

A report with optional sorts & filters if ApiAction is 'ExecuteReport'
or 'EditReport'

ApiKey

string

no

Used when instantiating the JavaScript Api, if applicable.

The AppUrl of this session; changes to reflect any modifications
made to this session in the API

Example:
{
"AppUrl": "ExagoHome.aspx?d={alphanumeric}&showerrordetail=true",
"Id":
"{sid}"
"Page":
"ExagoHome",
"ApiAction":
"ExecuteReport",
"ExportType":
"Html",
"ShowTabs":
true,
"ShowErrorDetail": true,
...
}

Report JSON
If you want to edit or launch a report, specify a report in the ReportSettings property. Reports are represented as JSON objects with the
following properties:

Id

Name
string

Type

Writable
no (prev2021.1)

The unique ID of the this report

Description

ReportPath

string

yes

Full path from root folder to this report

SortsResource

Sorts

yes

Any sorts to apply to this report

FilterItems

array of Filter

yes

Any filters to apply to this report

IsError

boolean

no

Whether there were any validation errors when loading this report

ErrorList

array of
no
ReportValidationErrorType

If IsError == true, a list of errors encountered when loading this
report. Possible Errors

Example:
"ReportSettings": {
"Id": "ad0f442e-275b-48a0-893f-0b1255ee7880",
"ReportPath": "Reports\\Product Sales Report",
"SortsResource": null,
"FilterItems": [],
"IsError": false,
"ErrorList": null
}

Note
Windows file paths are delineated by double-backslashes: \\
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Sorts
Sorts can be added to the report, either in addition to, or replacing its existing sorts. This only affects the current session, and does not
edit the base report. The collection of sorts to be added is represented as a JSON object with the following properties:
Name
ReplaceFlag

string

Type

Writable
Description
yes (false) Whether to replace all existing report sorts

SortItems

array of Sort

yes

List of sorts to apply to this report

Example:
{
"ReplaceFlag": false,
"SortItems": [
{
"Id": "Products.ProductName",
"Asc": false
},
{
"Id": "Categories.CategoryName",
"Asc": false
}
...
]
}

Sort
Each sort in the SortItems property is represented as a JSON object with the following properties:
Name

Type

Writable

Description
Data field to sort on;
format: "EntityName.ColumnName"

Id

string

required

Asc

boolean

yes (false) Whether sort direction is ascending

Example:
{
"Id": "Products.ProductName",
"Asc": false
}

Filter
Filters can be added to the report in addition to its existing filters. This only affects the current session, and does not edit the base report.
Each filter to be added is represented as a JSON object with the following properties:
Name

Type

Writable

Description
Data field to filter on;
format: "EntityName.ColumnName"

Name

string

required

EntityName

string

yes

Entity name to filter on (deprecated)

ColumnName

string

yes

Column name to filter on (deprecated)

DataType

enum

yes
("string")

Data Field Type

Operator

enum

yes
Filter Operator Type
("EqualTo")

Values

array of strings

yes

Values to filter with

AndFlag

boolean

yes (true)

Whether this filter should be AND-ed with the next (versus OR-ed)

Prompt

boolean

yes (false)

Whether this filter should prompt the user for a value (Advanced or
Express Reports)

GroupWithNext

boolean

yes (false)

Whether this filter should be grouped with the next (Advanced or
Express Reports)

Note
Filter values that are DateTime strings must be able to be parsed by the .NET method DateTime.Parse using the current thread culture.
Example:
{
"Name": "Categories.CategoryName",
"DataType": "string",
"Operator": "OneOf",
"Values": [
"Beverages", "Seafood", "Produce"
],
"AndFlag": true,
"Prompt": false,
"GroupWithNext": false
}

Create a Session
POST /rest/sessions

Available parameters
Name
config

Type

Description
Specify which config file to create the session with.

string
Format: CustomConfigFile

Using curl
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curl http://{webservice}/rest/sessions -X POST ^
-d "{'Page':'Reporting','ApiAction':'Home','ShowTabs':false}"

Example response
Status: 201 Created
Location: /{webservice}/rest/Sessions/{sid}
{
"AppUrl": "Reporting.aspx?d={alphanumeric}",
"Id":
"{sid}",
"Page":
"Reporting",
"ApiAction":
"Home",
"ExportType":
null,
"ShowTabs":
false,
"ShowErrorDetail": true,
"ReportSettings": {
"ReportPath": null,
"SortsResource": null,
"FilterItems": null
}
}

Caution
Currently, if a new XML configuration file and temp path are passed via a POST session, the API session .enc file will first be written to
the original temp path of the default config file rather than the newly assigned path. This limitation prevents this action from being properly
completed. However, a new XML configuration file may still be passed with the default temp path, allowing this limitation to be bypassed.

Show a Session
GET /rest/sessions/{sid}

If the session is launched, the session object is deleted and can no longer be viewed.
Note
Unlike other resources, the {sid} is passed as part of the endpoint string, not as a URL parameter.

Using curl
curl http://{webservice}/rest/sessions/{sid} -X GET

Example response
Status: 200 OK
{
"AppUrl": "Reporting.aspx?d={alphanumeric}",
"Id": "{sid}",
"Page": "Reporting",
...
}

Edit a Session
PATCH /rest/sessions/{sid}

Only supply the properties to be edited. If the session is launched, the session object is deleted and it can no longer be edited.
Note
Unlike other resources, the {sid} is passed as part of the endpoint string, not as a URL parameter.

Using curl
curl http://{webservice}/rest/sessions/{sid} -X PATCH ^
-d "{'Page':'CompanyHome'}"

Example response
Status: 200 OK
{
"AppUrl": "Reporting.aspx?d={alphanumeric}",
"Id": "{sid}",
"Page": "CompanyHome",
...
}

Delete a Session
DELETE /rest/sessions/{sid}

If a session is deleted, the AppUrl can no longer be used. If the session is launched, the session object is deleted and it can no longer be
edited.
Note
Unlike other resources, the {sid} is passed as part of the endpoint string, not as a URL parameter.

Using curl
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curl http://{webservice}/rest/sessions/{sid} -X DELETE

Example response
Status: 204 No Content

Launch a Report with Sorts and Filters
POST /rest/sessions

Set the ApiAction to ExecuteReport, and specify a report, with any optional sorts and filters, in the ReportSettings property. If you want
to save the report to a file, set the ExportType to the desired file type.

Using curl
curl http://{webservice}/rest/sessions -X POST ^
-d @sessionSettings.txt

sessionSettings.txt

"{'ApiAction':'ExecuteReport','ExportType':'html','ReportSettings':{'ReportPath':'Sales\\Products','FilterItems':[{'Name':'Categories.CategoryID','DataType':'Integer','Values':["123"

Response
Status: 201 Created
Location: /{webservice}/rest/Sessions/{sid}
{
...
"ApiAction":
"ExecuteReport",
"ExportType":
"Html",
...
"ReportSettings": {
...
"ReportPath": "Sales\\Products",
"SortsResource": {
"ReplaceFlag": true,
"SortItems": [
{
"Id": "Categories.CategoryID",
"Asc": true
}
]
},
"FilterItems": [
{
"Name": "Categories.CategoryID",
"DataType": "Integer",
"Values": ["123"]
}
]
}
}

To launch the report in Exago, take the AppUrl, and append it to the URL to your Exago installation to create the full URI path:
http://{website}/{exago}/{AppUrl}

Example
http://yoursite.com/reporting/homepage?d={alphanumeric}&showerrordetail=true

REST — Data Sources
A Data Source is a resource which contains or accesses the information which is reported on. Often this is a database, but a variety of
types are supported. Data Sources are accessed using a connection string, which passes the location of the resource and authentication
params. This endpoint allows for session-based read/write access to all data sources for the current config.
Important
All requests require a Session ID URL parameter and basic request headers. In the following document, headers are omitted for clarity.

Data Source JSON
Data Sources are represented as JSON objects with the following properties:
Id

Name
string

Type

Writable
no

Description
The unique Id of this data source

Name

string

yes

The name of this data source

DbType

enum

yes
("MsSql")

Data Source Type

Connection

string

yes

The connection string of this data source

Schema

string

yes

The data source schema name (blank for default)

Example
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{
"Id":
"Name":
"DbType":
"Connection":
"Schema":

"1",
"My Data Server",
"MsSql",
"Server=DataServer;Database=Northwind;uid=username;pwd=password;",
"dbo"

}

List Data Sources
GET /rest/datasources

List all the data sources in the current configuration. Output is an array of JSON objects, each representing an individual data source.
GET /rest/datasources?config=myconfig.xml

List all of the data objects only in the user's session specific configuration. Replace myconfig.xml with the file name of the corresponding
config file name. Output is an array of JSON objects, each representing an individual data source.
Name

Type

Id

string

Name

string

Description
The unique Id of this data
source
The name of this data source

Using curl
curl http://{webservice}/rest/datasources?sid={sid} -X GET

Example response
Status: 200
[
{
"Id":
"Name":
},
{
"Id":
"Name":
}
]

OK

"0",
"Northwind"

"1",
"AdventureWorks"

Show Data Source
GET /rest/datasources/{Id}

Show the properties of the data source specified by its Id.

Using curl
curl http://{webservice}/rest/datasources/{Id}?sid={sid} -X GET

Example response
Status: 200 OK
{
"Id":
"Name":
"DbType":
"Connection":
"Schema":

"0",
"Northwind",
"MsSql",
"Server=DataServer;Database=Northwind;uid=username;pwd=password;",
"dbo"

}

Create Data Source
POST /rest/datasources

May be useful if you don't want your connection strings in the config file.

Using curl
curl http://{webservice}/rest/datasources?sid={sid} -X POST ^
-d "{'Name':'NW','DbType':'MsSql','Connection':'Server=SRV;Database=NW;uid=ID;pwd=PW;'}"

Example response
Status: 201 Created
Location: /{webservice}/rest/DataSources/2
{
"Id":
"Name":
"DbType":
"Connection":
"Schema":

"2",
"NW",
"MsSql",
"Server=SRV;Database=NW;uid=ID;pwd=PW;",
""

}

Edit Data Source
PATCH /rest/datasources/{Id}

Only supply the properties to be edited.
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Using curl
curl http://{webservice}/rest/datasources/{Id}?sid={sid} -X PATCH ^
-d "{'Connection':'Server=SRV;Database=NW;uid=Admin;pwd=Password;'}"

Example response
Status: 204 No Content

Delete Data Source
DELETE /rest/datasources/{Id}

Using curl
curl http://{webservice}/rest/datasources/{Id}?sid={sid} -X DELETE

Example response
Status: 204 No Content

REST — Data Objects
Data Objects (also known as "Entities") are the manner by which Exago views and accesses the tables, views, procedures, etc... from
the Data Sources. Data objects represent the structure of the data, but the actual data is only accessed at report run-time.
Note
All requests require a Session ID URL parameter and basic request headers. In the following document, headers are omitted in the
interest of brevity.

Data Object JSON
Data Objects are represented as JSON objects with the following properties:
Name

Type

Writable
requiredcreate

Description

Id

string

The unique Id of this data object

Name

string

required

The display name ("alias") of this data object

Schema

string

yes

The schema of this data object
How Exago should retrieve the schema for the data object. There
are three possibilities:

SchemaAccessType

string

yes

CategoryName

string

yes

Default — Follow the global Schema Access Type setting
in Other Settings.
Datasource — Queries the data source for the schema.
Metadata — Reads the schema from the stored metadata.
The Category/Folder group this object will appear in
The name of this data object in its data source
Important
The name of data objects may not contain the following
characters:
{ } [ ] , . %

DataName

string

required

To create a data object for a database table (or other backing
model) with one of these characters in its name, create a Custom
SQL Object with a simple SELECT clause. For example for a
table named sales.figures.2020:
SELECT * FROM [sales.figures.2020]

Note that the identifier delimiters (the [ ]) around the table name
will vary with the database type.
DataSourceId

integer

required

The Id of the data source of this data object (see Data Sources)

DataType

enum

yes
("Table")

Data Object Type

SqlStatement

string

yes

The custom SQL of this data object if it's DataType is SqlStmt

canreexecuteindb

Boolean

yes

See Interactive Filtering in Database in the Data Object
Properties section of the Data Objects article for more information

Parameters

array of strings

yes

Any parameters for stored procedure, .NET Assembly or Web
Service API calls

KeyColumns

array of strings

yes

The unique key fields of this data object

TenantColumns

array of Tenant Column yes

The tenant fields of this data object

FilterDropdownObject

Filter Dropdown

The filter dropdown object of this data object

yes

Example
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{
"Id":
"Employees_0",
"Name":
"Employees",
"Schema":
"dbo",
"CategoryName": "",
"DataName":
"Employees",
"DataSourceId": "0",
"DataType":
"Table",
"SqlStatement": "",
"canreexecuteindb": true,
"Parameters":
[],
"KeyColumns":
["EmployeeID"],
"TenantColumns": [
{
"Column":
"EmployeeID",
"Parameter": "UserId"
}
],
"FilterDropdownObject": {
"FilterDbName":
"Employee_List",
"FilterDataSourceId": -1,
"FilterObjectType": "view",
"FilterSchema":
"",
"FilterSqlStmt":
""
}
}

Tenant Column JSON
Tenant Columns are represented as JSON objects with the following properties:
Name
Column

string

Type

Writable
Description
required The tenant data field

Parameter

string

required The tenant parameter

Example
"TenantColumns": [
{
"Column":
"EmployeeID",
"Parameter": "UserId"
}
]

Filter Dropdown JSON
A Data Object's Filter Dropdown is represented as a JSON object with the following properties:
Name
FilterDbName

string

Type

Writable
Description
required The name of this data object in its data source

FilterObjectType

enum

yes

Data Object Type

FilterSchema

string

yes

The schema for this data object

FilterSqlStmt

string

yes

The custom SQL for this data object if it is of type SqlStmt

Example
"FilterDropdownObject":
"FilterDbName":
"FilterObjectType":
"FilterSchema":
"FilterSqlStmt":
}

{
"Employee_List",
"view",
"",
""

List Data Objects
GET /rest/entities

List all the data objects in the current configuration. Output is an array of objects, each representing an individual data object.
Name

Type

Description

Id

string

The unique Id of this data object

Name

string

The display name ("alias") of this data object

Using curl
curl http://{webservice}/rest/entities?sid={sid} -X GET

Example response
Status: 200 OK
[
{
"Id":
"Name":
},
{
"Id":
"Name":
},
...

"Customers_0",
"Customers"

"Employees_0",
"Employees"

]
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Show Data Object
GET /rest/entities/{Id}

Show the properties of the data object specified by its Id.

Using curl
curl http://{webservice}/rest/entities/{Id}?sid={sid} -X GET

Example response
Status: 200 OK
{
"Id":"system_departments_0",
"Name":"Departments",
"Schema":"",
"CategoryName":"Roster",
"DataName":"system_departments",
"DataSourceId":"4",
"DataType":"Table",
"SqlStatement":"",
"Parameters":[],
"KeyColumns":["id"],
"TenantColumns":[],
"FilterDropdownObject":null
}

Create Data Object
POST /rest/entities

Requires a DataName or a custom SqlStatement. One or more KeyColumns are required for most data types.

Using curl
curl http://{webservice}/rest/entities?sid={sid} -X POST ^
-d @newDataObject.txt

newDataObject.txt
"{'Id':'Employees_1','Name':'Employees','Schema':'dbo','DataName':'Employees','DataSourceId':0,'KeyColumns':['EmployeeID']}"

Example response
Status: 201 Created
Location: /{webservice}/rest/Entities/Employees_1
{
"Id":
"Employees_1",
"Name":
"Employees",
"Schema":
"dbo",
"CategoryName": "",
"DataName":
"Employees",
"DataSourceId": "0",
"DataType":
"Table",
"SqlStatement": "",
"Parameters":
[],
"KeyColumns":
["EmployeeID"],
"TenantColumns": [],
"FilterDropdownObject": null
}

Edit Data Object
PATCH /rest/entities/{Id}

Only supply the properties to be edited.

Using curl
curl http://{webservice}/rest/entities/{Id}?sid={sid} -X PATCH ^
-d "{'Name':'Staff List'}"

Example response
Status: 204 No Content

Delete Data Object
DELETE /rest/entities/{Id}

Using curl
curl http://{webservice}/rest/entities/{Id}?sid={sid} -X DELETE

Example response
Status: 204 No Content

Data Field JSON
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Data fields for each object are represented as JSON objects with the following properties. The actual data in the fields is not accessible via
REST. Data fields cannot be created or deleted. However, some metadata for existing fields can be edited.
Important
The IsFilterable property name changed to Filterable in v2019.1.13.

Id

Name
string

Type

Writable
no

Description
The unique name for this data field

Name

string

yes

The display name for this data field

Type

enum

yes

Data Field Type

IsFilterable (pre2019.1.13)
Filterable (v2019.1.13+)
IsVisible

bool
(pre-v2017.2)
const
(v2017.2+)
boolean

Whether this field is filterable
yes
Filterable Type
yes

Whether this field is visible to end users. Set to false to hide it or
true to show it.
The content of the data field. Enclose other Exago data fields in
curly braces { }. There are three possibilities:

Value

string

yes

Description

string

yes

An Exago formula — A custom function used to define the
field value. Can use other fields from the same data object.
(e.g. “Concatenate({Orders.ShipCountry},'+ ',
{Orders.ShipCity})”)
A SQL formula — SQL statement used to define the the field
value. (e.g. “Concat(ShipCountry, ' + ',
ShipCity)”)
A static value — Static content (e.g. "12345")
A text description of the data field what will be shown to the end
user
Describes the content of the Value property. Either:

ColumnSource

string

yes

Data — use for either a static value, or when Value contains
a single column name
ExagoFormula — use when the Value is an Exago formula
SqlFormula — use when the Value is a SQL formula

SortAndGroupBy

string

yes

Either an Exago formula or another data field name that will be used
to sort/group the values in this column. Enclose column names in
curly braces { }. If null, sorting/grouping on a field is not enabled.

List Data Fields of a Data Object
GET /rest/entities/{Id}/fields

List all the data fields in the data object specified by its Id. Output is an array of objects, each representing an individual data field.
Id

Name

Type
string

Description
The unique Id of this data field

Name

string

The display name of this data field

Using curl
curl http://{webservice}/rest/entities/{Id}/fields?sid={sid} -X GET

Example response
Status: 200 OK
[
{
"Id":
"Name":
},
{
"Id":
"Name":
},
{
"Id":
"Name":
},
{
"Id":
"Name":
},
{
"Id":
"Name":
},
...

"Address",
"Address"

"BirthDate",
"Date of Birth"

"EmployeeID",
"ID Number"

"FirstName",
"First Name"

"LastName",
"Last Name"

]

Show Data Field
Important
Performing a GET for the data fields will result in fixing the current column metadata list as the only defined columns. The column
metadata can be further altered, but will not be reflected in the Entity Columns collection until the session is launched in a browser.

GET /rest/entities/{Id}/fields/{Field Id}

Show the properties of the data field specified by its Id, of the data object specified by its Id.

Using curl
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curl http://{webservice}/rest/entities/{Id}/fields/{Field Id}?sid={sid} -X GET

Example response
Status: 200 OK
{
"Id":
"Name":
"Type":
"IsFilterable":
"IsVisible":

"LastName",
"Last Name",
"String",
true,
true

}

Edit Metadata for Data Field
PATCH /rest/entities/{Id}/fields/{Field Id}

Only supply the properties to be edited.

Using curl
curl http://{webservice}/rest/entities/{Id}/fields/{Field Id}?sid={sid} -X PATCH ^
-d "{'Name':'Surname'}"

Example response
Status: 204 No Content

Add New Metadata to Data Field
Add new metadata that doesn't already exist to a data field.
POST /rest/entitites/{Id}/Fields/{Field Id}

Caution
Setting the Type property to a data type that does not match the actual type in the data source will cause errors when reports are run or
designed.
Important
Adding additional column metadata will result in fixing the current column metadata list as the only defined columns. The column
metadata can be further altered, but will not be reflected in the Entity Columns collection until the session is launched in a browser.

REST — Folders
Management of the folder and report tree is available with the REST Web Service API. Unlike other resources, managing the tree affects
the base configuration, and is not temporary to a session. Therefore it also affects concurrent users.
Note
All requests require a Session ID URL parameter and basic request headers. In the following document, headers are omitted in the
interest of brevity.

Node JSON
The Report Tree is represented as an output-only (ie. non-writeable) resource. Each object in the tree is a Node. Nodes are represented as
JSON objects with the following properties:
Note
The top-level node has only an Entity property.
Name
name

string

Type

Description
The name of this folder or report

leaf_flag

boolean

Whether this node is a report.
true if the item is a report, false if it is not

readonly_flag

boolean

Whether this node is read-only for the active role

type

enum

Report Type (null if this is a folder)

user

string

The active role

entity

array of Node

If this is a folder, an array of the nodes contained
within

Example
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{
"Entity": [
{
"name":
"Asset Reports",
"leaf_flag":
false,
"readonly_flag": false,
"type":
null,
"user":
"Admin",
"Entity": [
{
"name":
"Sales Report",
"leaf_flag":
true,
"readonly_flag": false,
"type":
"advanced",
"user":
"Admin",
"Entity":
null
},
{
"name":
"Financial Holdings",
"leaf_flag":
false,
"readonly_flag": false,
"type":
null,
"user":
"Admin",
"Entity": [
{
"name":
"Liquidity Report",
"leaf_flag":
true,
"readonly_flag": false,
"type":
"expressview",
"user":
"Admin",
"Entity":
null
},
{
"name":
"Regional Holdings",
"leaf_flag":
true,
"readonly_flag": false,
"type":
"dashboard",
"user":
"Admin",
"Entity":
null
}
]
}
]
}
]
}

Show Folders Tree
Show the full Report Tree for the current configuration.
GET /rest/reports/list

Using curl
curl http://{webservice}/rest/reports/list?sid={sid} -X GET

Example response
Status: 200 OK
{
"Entity": [
{
"name": "Asset Reports",
...
"Entity": [
{
"name": "Sales Report",
...
"Entity": null
},
{
"name": "Financial Holdings",
...
"Entity": [
{
"name": "Liquidity Report",
...
"Entity": null
}
]
}
]
}
]
}

Folder JSON
The /rest/folders endpoint represents each folder as an output-only (ie. non-writeable) resource. Folders are represented as JSON objects
with the following properties:
Name

Type

Name

string

Status

const

Description
Full path from root folder to this
folder
Folder Status
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Create a Folder
Name is the full path from the root folder to the name of the folder to be created. Spaces and unusual characters must be URL-encoded.
Folder names are case sensitive.
POST /rest/folders/{Name}

Using curl
curl http://{webservice}/rest/folders/Asset%20Reports/Overseas%Holdings?sid={sid} -X POST

Example response
Status: 200 OK
{
"Id":
null,
"Name": "Asset Reports/Overseas Holdings",
"Status": "Created"
}

Note
The Id property is not used.

Move or Rename a Folder
POST /rest/folders/rename

Folders are moved or renamed by supplying the following JSON resource:
Name
OldName

string

Type

Writable
Description
required Full path from the root to the folder to be moved or renamed

NewName

string

required

Full path from the root to the new folder location and name

Using curl
curl http://{webservice}/rest/folders/rename?sid={sid} -X POST ^
-d "{'OldName':'Asset Reports\\Overseas Holdings', ^
'NewName':'Asset Reports\\Regional Holdings'}"

Note
Windows file paths are delineated by double-backslashes: \\

Example response
Status: 200 OK
{
"Id":
null,
"Name": "Asset Reports/Regional Holdings",
"Status": "Renamed"
}

Delete a Folder
Name is the full path from the root to the name of the folder to be created. Spaces and special characters must be URL-encoded. Folder
names are case sensitive. The folder must be empty to be deleted.
DELETE /rest/folders/{Name}

Using curl
curl http://{webservice}/rest/folders/Asset%20Reports/Overseas%Holdings?sid={sid} -X DELETE

Example response
Status: 200 OK
{
"Id":
null,
"Name": "Asset Reports/Overseas Holdings",
"Status": "Deleted"
}

REST — Functions
Functions are custom formulas that can be used in reports to manipulate data. Only custom functions can be edited, not the built-in
functions.
Note
All requests require a Session ID URL parameter and basic request headers. In the following document, headers are omitted in the
interest of brevity.

Function JSON
Functions are represented as JSON objects with the following properties:
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Name
Id

Type
string

Writeable
required-create

Description
The unique Id of this function

Description

string

yes

The description of this function

Language

enum

yes

Code Language

Namespaces

array of
strings

yes

Namespaces for this function

References

array of
strings

yes

References for this function

ProgramCode

string

yes

Function code

IsCustom

boolean

no

Whether this is a custom function

Example
{
"Id":
"Description":
"MinArgs":
"MaxArgs":
"Language":
"Namespaces":
"References":
"ProgramCode":
"IsCustom":

"DayOfWeek",
"Returns the day of the week as a string given a date value",
null,
null,
"cs",
[],
["System.dll"],
"return System.Convert.ToDateTime(args[0].ToString());",
true

}

List Functions
GET /rest/functions

List all the functions in the current configuration. Output is an array of objects, each representing an individual function.
Name

Type

Description

Id

string

The unique Id of this function

Available parameters
Name

Type

Description

filter

string

Possible values: custom - Return only custom
functions.

Using curl
curl http://{webservice}/rest/functions?sid={sid} -X GET

Example response
Status: 200 OK
[
{
"Id": "Today"
},
{
"Id": "Tomorrow"
},
...
]

Show Function
GET /rest/functions/{Id}

Show the properties of the function specified by its Id.

Using curl
curl http://{webservice}/rest/functions/{Id}?sid={sid} -X GET

Example response
Status: 200 OK
{
"Id":
"Description":
"MinArgs":
"MaxArgs":
"Language":
"Namespaces":
"References":
"ProgramCode":
"IsCustom":

"Today",
"",
null,
null,
"cs",
[],
[],
"return sessionInfo.Today;",
true

}

Create Function
POST /rest/functions

Using curl
curl http://{webservice}/rest/functions?sid={sid} -X POST ^
-d @customFunction.txt
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customFunction.txt

"{'Id':'DayOfWeek','Description':'Returns the day of the week as a string given a date value','References':['System.dll'],'ProgramCode':'return System.Convert.ToDateTime(args[0].ToSt

Example response
Status: 201 Created
Location: /{webservice}/rest/Functions/DayOfWeek
{
"Id":
"Description":
"MinArgs":
"MaxArgs":
"Language":
"Namespaces":
"References":
"ProgramCode":
"IsCustom":

"DayOfWeek",
"Returns the day of the week as a string given a date value",
null,
null,
"cs",
[],
["System.dll"],
"return System.Convert.ToDateTime(args[0].ToString());",
true

}

Edit Function
PATCH /rest/functions/{Id}

Only supply the properties to be edited. Only custom functions can be edited.

Using curl
curl http://{webservice}/rest/functions/{Id}?sid={sid} -X PATCH ^
-d "{'Namespaces':['WebReports.Api']}"

Example response
Status: 204 No Content

Delete Function
DELETE /rest/functions/{Id}

Only custom functions can be deleted.

Using curl
curl http://{webservice}/rest/functions/{Id}?sid={sid} -X DELETE

Example response
Status: 204 No Content

REST — Data Joins
Joins are the relationship data objects have to each other. Join information is accessible and editable via REST.
Important
All requests require a Session ID URL parameter and basic request headers. In the following document, headers are omitted for clarity.

Join JSON
Joins are represented as JSON objects with the following properties:
Name

Type

Writeable

Description

Id

string

no

The unique Id of this join

EntityFrom

string

required-create

The "from" (or "left") data object of this
join

EntityTo

string

required-create

The "to" (or "right") data object of this
join

JoinType

const

yes ("Inner")

Join Type

RelationshipType

const

yes ("OneToOne")

Join Relation Type

Weight

integer

yes (0)

The weight of this join

JoinColumns

array of
JoinColumn

required

The data fields which are joined

Example
{
"Id":
"Shippers.Orders",
"EntityFrom":
"Shippers",
"EntityTo":
"Orders",
"JoinType":
"Inner",
"RelationshipType": "OneToMany",
"Weight":
0,
"JoinColumns": [
{
"ColumnFrom": "ShipperID",
"ColumnTo": "ShipVia"
}
]
}
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JoinColumn JSON
The JoinColumn objects of a join indicate which columns are used to join the data objects. Objects can be joined on multiple join columns
(which are AND-ed). Each join requires one or more sets of join columns. JoinColumn objects have the following properties:
Name

Type

Writeable

Description

ColumnFrom

string

required

The join data field for the "from" (or "left")
data object

ColumnTo

string

required

The join data field for the "to" (or "right")
data object

Example
"JoinColumns": [
{
"ColumnFrom": "ShipperID",
"ColumnTo": "ShipVia"
}
]

List Joins
GET /rest/joins

List all the joins in the current configuration. Output is an array of objects, each representing an individual join.
Name

Type

Description

Id

string

The unique Id of this join

Available parameters
Name

Type

Description

entity

string

Show only joins that join this data object

Using curl
curl http://{webservice}/rest/joins?sid={sid} -X GET

Example response
Status: 200 OK
[
{
"Id": "Employees.Orders"
},
{
"Id": "Employees.EmployeeTerritories"
},
...
]

Show Join
GET /rest/joins/{Id}

Show the properties of the join specified by its Id.

Using curl
curl http://{webservice}/rest/joins/{Id}?sid={sid} -X GET

Example response
Status: 200 OK
{
"Id":
"Orders.OrderDetails",
"EntityFrom":
"Orders",
"EntityTo":
"OrderDetails",
"JoinType":
"Inner",
"RelationshipType": "OneToOne",
"Weight":
0,
"JoinColumns": [
{
"ColumnFrom": "OrderID",
"ColumnTo": "OrderID"
}
]
}

Create Join
POST /rest/joins

Using curl
curl http://{webservice}/rest/joins?sid={sid} -X POST ^
-d @newJoin.txt

newJoin.txt
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"{'EntityFrom':'Shippers','EntityTo':'Orders','RelationshipType':'OneToMany','JoinColumns':[{'ColumnFrom':'ShipperID','ColumnTo':'ShipVia'}]}"

Example response
Status: 201 Created
Location: /{webservice}/rest/Joins/Shippers.Orders
{
"Id":
"Shippers.Orders",
"EntityFrom":
"Shippers",
"EntityTo":
"Orders",
"JoinType":
"Inner",
"RelationshipType": "OneToMany",
"Weight":
0,
"JoinColumns": [
{
"ColumnFrom": "ShipperID",
"ColumnTo": "ShipVia"
}
]
}

Edit Join
PATCH /rest/joins/{Id}

Only supply the properties to be edited.

Using curl
curl http://{webservice}/rest/joins/{Id}?sid={sid} -X PATCH ^
-d "{'JoinType':'LeftOuter'}"

Example response
Status: 204 No Content

Delete Join
DELETE /rest/joins/{Id}

Using curl
curl http://{webservice}/rest/joins/{Id}?sid={sid} -X DELETE

Example response
Status: 204 No Content

REST — Parameters
Parameters are used throughout the application to store values. The userId and companyId parameters are used for identifying the
current user. Non-hidden parameters can be accessed in reports.
Important
All requests require a Session ID URL parameter and basic request headers. In the following document, headers are omitted for clarity.

Parameter JSON
Parameters are represented as JSON objects with the following properties:
Name

Type

Writeable

Description

Id

string

required-create

The unique Id of this parameter

DataType

enum

yes ("String")

Parameter Type

Value

string

yes

The value of this parameter

PromptText

string

yes

If set, text to prompt the user for a value

IsHidden

boolean

yes (true)

Whether the parameter is accessible in reports

Example
{
"Id":
"DataType":
"Value":
"PromptText":
"IsHidden":

"MyParameter",
"String",
"",
"Input a value",
true

}

List Parameters
GET /rest/parameters

List all the parameters in the current configuration. Output is an array of objects, each representing an individual parameter.
Name

Type

Description

Id

string

The unique Id of this parameter

Using curl
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curl http://{webservice}/rest/parameters?sid={sid} -X GET

Example response
Status: 200 OK
[
{
"Id": "MyParameter"
},
{
"Id": "HelloWorld"
}
]

Show Parameter
GET /rest/parameters/{Id}

Show the properties of the parameter specified by its Id.

Using curl
curl http://{webservice}/rest/parameters/{Id}?sid={sid} -X GET

Example response
Status: 200 OK
{
"Id":
"DataType":
"Value":
"PromptText":
"IsHidden":

"MyParameter",
"String",
"",
"Input a value",
true

}

Create Parameter
POST /rest/parameters

Parameters are designed to be set in the API. If they do not already exist in config, create them programmatically.

Using curl
curl http://{webservice}/rest/parameters?sid={sid} -X POST ^
-d "{'Id':'Hello','DataType':'String','Value':'World','IsHidden':false}"

Example response
Status: 201 Created
Location: /{webservice}/rest/Parameters/Hello
{
"Id":
"DataType":
"Value":
"PromptText":
"IsHidden":

"Hello",
"String",
"World",
"",
false

}

Edit Parameter
PATCH /rest/parameters/{Id}

Only supply the properties to be edited.

Using curl
curl http://{webservice}/rest/parameters/{Id}?sid={sid} -X PATCH ^
-d "{'IsHidden':true}"

Example response
Status: 204 No Content

Delete Parameter
DELETE /rest/parameters/{Id}

Using curl
curl http://{webservice}/rest/parameters/{Id}?sid={sid} -X DELETE

Example response
Status: 204 No Content

REST — Role Security
Roles are collections of security settings for users of the application. They are used to distinguish classes of users by access rights.
Setting an active role will cause it to take effect for the application session, once the AppUrl is launched in the browser. Once in an
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application session, the active role cannot be changed. Only one role can be active at a time.
Roles do not affect your access to the API.
Note
All requests require a Session ID URL parameter and basic request headers. In the following document, headers are omitted in the
interest of brevity.

Role JSON
A role's base status is represented as a JSON object with the following properties:
Name

Type

Id

string

IsActive

boolean

Writable
requiredcreate
yes (true)

Description
The unique Id of this role
Whether this role is active

Example
{
"Id":
"Client",
"IsActive": false
}

List Roles
GET /rest/roles

List all the roles in the current configuration. Output is an array of objects, each representing an individual role.
Name
Id

Type
string

Description
The unique Id of this role

Using curl
curl http://{webservice}/rest/roles?sid={sid} -X GET

Example response
Status: 200 OK
[
{
"Id":
},
{
"Id":
},
...

"Admin"

"Client"

]

Create a Role
POST /rest/roles

Creating a new role activates it by default.

Using curl
curl http://{webservice}/rest/roles?sid={sid} -X POST ^
-d "{'Id':'User'}"

Example response
Status: 201 Created
Location: /{webservice}/rest/Roles/User
{
"Id":
"User",
"IsActive": true
}

Show Role Status
GET /rest/roles/{Id}

Using curl
curl http://{webservice}/rest/roles/{Id}?sid={sid} -X GET

Example response
Status: 200 OK
{
"Id":
"User",
"IsActive": true
}

Activate or Deactivate a Role
PATCH /rest/roles/{Id}
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Only supply the properties to be edited.

Using curl
curl http://{webservice}/rest/roles/{Id}?sid={sid} -X PATCH ^
-d "{'IsActive':false}"

Example response
Status: 204 No Content

Delete a Role
DELETE /rest/roles/{Id}

Using curl
curl http://{webservice}/rest/roles/{Id}?sid={sid} -X DELETE

Example response
Status: 204 No Content

Role Settings JSON
Each role has a group of settings that may be used to override the base config. Each key corresponds with a setting in the Admin
Console, which is noted in the Description field. If a setting is blank or null, then the value from the base config is not overridden for this
role. The settings are represented as a JSON object with the following properties:
Note
All properties are read/write. No properties are required. Default values are inherited from the base config.
Name

Type

Description

ReportPath

string

Report Path

LanguageFile

string

Language File

ServerTimeZoneOffset

integer

Server Time Zone Offset

ReadFilterValues

boolean

Read Database for Filter Values

DbTimeout

integer

Database Timeout

ScheduleManagerViewLevel

enum

Scheduler Manager User View Level

DateFormat

string

Date Format

TimeFormat

string

Time Format

DateTimeFormat

string

DateTime Format

SeparatorSymbol

string

Numeric Separator Symbol

CurrencySymbol

string

Numeric Currency Symbol

ShowGrid

boolean

Show Grid Lines in Report Viewer

ShowCrossTabReports

boolean

Allow Creation/Editing of CrossTab Reports

ShowExpressReports

boolean

Allow Creation/Editing of Express Reports

ShowExpressReportsGrouping

boolean

Show Grouping in the Express Report Designer

ShowExpressReportsFormulas

boolean

Show Formula Button in the Express Report Designer

AllowReportCustomSQLObjects
v2018.1+

boolean

Allow Creation of Custom SQL Objects in Advanced Reports

ShowExpressReportsStyling

boolean

Show Styling Toolbar in the Express Report Designer

ShowExpressReportsThemes

boolean

Show Themes in the Express Report Designer

ShowScheduleReports

boolean

Show report scheduling options

ShowScheduleReportsManager

boolean

Show Schedule Manager in the main menu

ShowScheduleReportsEmail

boolean

Show Email Report Options

DecimalSymbol

string

Numeric Decimal Symbol

The following settings have been added to versions v2018.1.27+, v2018.2.16+, 2019.1.2+ of Exago:
Name
ShowAdvancedReports

boolean

Type

Description
Allow Creation/Editing of Advanced Reports

ShowDashboardReports

boolean

Allow Creation/Editing of Dashboard Reports

ShowDashboardNewVisualizationButton boolean

Allow Creation/Editing of Dashboard Visualizations

ShowExpressViews

boolean

Allow Creation/Editing of ExpressViews

AllowExpressViewLiveEdit

boolean

Allow Editing ExpressView with Live Data

ShowChainedReports

boolean

Allow Creation/Editing of Chained Reports

CacheVisibilityLevel

wrCacheVisibility

Cache Visibility Level

Example
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{
"ReportPath":
"C:\\Exago\\Reports",
"LanguageFile":
null,
"ServerTimeZoneOffset":
0,
"ReadFilterValues":
true,
"DbTimeout":
0,
"ScheduleManagerViewLevel": "All",
"DateFormat":
"MM/dd/yyyy",
"TimeFormat":
"hh:mm:ss a",
"DateTimeFormat":
"MM/dd/yyyy hh:mm:ss a",
"SeparatorSymbol":
",",
"CurrencySymbol":
"$",
"ShowGrid":
true,
"ShowCrossTabReports":
true,
"ShowExpressReports":
true,
"ShowExpressReportsGrouping": true,
"ShowExpressReportsFormulas": true,
"ShowExpressReportsStyling": true,
"ShowExpressReportsThemes": true,
"ShowAdvancedReports":
true,
"ShowDashboardReports":
true,
"ShowDashboardNewVisualizationButton": true,
"ShowExpressViews":
true,
"AllowExpressViewLiveEdit": true,
"ShowChainedReports":
true,
"CacheVisibilityLevel":
"Global",
"ShowScheduleReports":
true,
"ShowScheduleReportsManager": true,
"ShowScheduleReportsEmail": true,
"DecimalSymbol":
"."
}

Show Role Settings
GET /rest/roles/{Id}/settings

Show the settings for the role specified by its Id.

Using curl
curl http://{webservice}/rest/roles/{Id}/settings?sid={sid} -X GET

Example response
Status: 200 OK
{
"ReportPath":
"LanguageFile":
"ServerTimeZoneOffset":
"ReadFilterValues":
"DbTimeout":
"ScheduleManagerViewLevel":
"DateFormat":
"TimeFormat":
...

"C:\\Exago\\Reports",
null,
0,
true,
0,
"All",
"MM/dd/yyyy",
"hh:mm:ss a",

}

Edit Role Settings
PATCH /rest/roles/{Id}/settings

Only supply the properties to be edited.

Using curl
curl http://{webservice}/rest/roles/{Id}/settings?sid={sid} -X PATCH ^
-d "{'ShowAdvancedReports':false}"

Example response
Status: 204 No Content

Folder Permissions JSON
Each role has a set of folder permissions which allow or disallow access to folders for the current session. The permissions are
represented as a JSON object with the following properties:
Note
All properties are read/write. No properties are required.
Caution
The Report Tree should contain no more than 1,000 items in it for best user experience.
Name

Type

IncludeAll

boolean

ReadOnly

boolean

AllowManagement

boolean

Description
If True, all folders are visible to this role except the ones specified in
Folders. If False, only the folders specified in Folders are visible to
this role.
If True, all folders are read-only except the folders marked
ReadOnly = 'true'. If false, only the folders marked ReadOnly = 'true'
are read-only.
If True, users will be able create, rename and delete folders via the
user interface. If False, users cannot take action on folders and the
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CreateFolders

boolean

Add Folder buttons are hidden from the user interface.
If True, when adding Folders to the Role via the API, Exago will
check if the folder exists and add it if not. If False no check will be
performed. Once the session is launched, this property no longer
applies.

Folders

array of Folder

The folders with properties specific to this role

Folder JSON
Each folder in the Folders property is represented as a JSON object with the following properties:
Name

Name
string

Type

Description
Full path from the root folder to this folder

ReadOnly

boolean

Whether this folder is ReadOnly

Propagate

boolean

Whether this folder's subfolders share its ReadOnly property

Example
{
"IncludeAll":
false,
"ReadOnly":
false,
"AllowManagement": true,
"CreateFolders": false,
"Folders": [
{
"Name":
"Examples\Client",
"ReadOnly": true,
"Propagate": true
}
]
}

List Folder Permissions
GET /rest/roles/{Id}/folders

Show the folder permissions for the role specified by its Id.

Using curl
curl http://{webservice}/rest/roles/{Id}/folders?sid={sid} -X GET

Example response
Status: 200 OK
{
"IncludeAll":
false,
"ReadOnly":
false,
"AllowManagement": true,
"CreateFolders": false,
"Folders": [
{
"Name":
"Examples",
"ReadOnly": true,
"Propagate": true
}
]
}

Edit Folder Permissions
PATCH /rest/roles/{Id}/folders

Only supply the properties to be edited. Supplying a Folders property will overwrite the entire collection.

Using curl
curl http://{webservice}/rest/roles/{Id}/folders?sid={sid} -X PATCH ^
-d "{'ReadOnly':true}"

Example response
Status: 204 No Content

Data Object Permissions JSON
Each role has a set of data object permissions which allow or disallow access to data objects for the current session. The permissions are
represented as a JSON object with the following properties:
Note
All properties are read/write. No properties are required.
Name

Type

IncludeAll

boolean

Entities

array of Data Object

Description
If true, all data objects are available to this role except the ones
specified in Entities. If false, only the data objects specified in
Entities are visible to this role.
The data objects with properties specific to this role

Data Object JSON
Each Data Object in the Entities property is represented as a JSON object with the following properties:
Name

Type

Description
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The unique Id of this data object

Example
{
"IncludeAll": true,
"Entities": [
{
"Id": "EMP"
},
{
"Id": "ETE"
}
]
}

List Data Object Permissions
GET /rest/roles/{Id}/entities

Show the data object permissions for the role specified by its Id.

Using curl
curl http://{webservice}/rest/roles/{Id}/entities?sid={sid} -X GET

Example response
Status: 200 OK
{
"IncludeAll": false,
"Entities": [
{
"Id": "EMP"
}
]
}

Edit Data Object Permissions
PATCH /rest/roles/{Id}/entities

Only supply the properties to be edited. Supplying an Entities property will overwrite the entire collection.

Using curl
curl http://{webservice}/rest/roles/{Id}/entities?sid={sid} -X PATCH ^
-d "{'IncludeAll':false}"

Example response
Status: 204 No Content

Row Filters JSON
You can add security filters to data objects so that users can only view specific rows in the data object. The collection of row filters for this
role is represented as a JSON object with the following properties:
Name
DataObjectRows

Type
Description
array of Row Filter The row filters for this role

Row Filter JSON
Each row filter in the DataObjectRows property is represented as a JSON object with the following properties:
Name
Id

Type
string

Description
The Id of the data object to filter
The filter string.

Filter

string

The filter string should be valid, standard SQL to be added to the
'WHERE' clause sent to the Data Source. This filter string can
include Exago system parameters (e.g. @userId@) or custom SQL
including subqueries (e.g. IN (SELECT EmployeeID FROM
Employees WHERE EmployeeID <4)). The Filter String must
contain the actual name of objects in the Data Source (e.g. tables,
views, columns, etc...) rather than their Exago aliases.

Example
{
"DataObjectRows": [
{
"Id":
"EMP",
"Filter": "EmployeeID = 1"
},
{
"Id":
"ETE",
"Filter": "EmployeeID = 2"
}
]
}

List Row Filters
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GET /rest/roles/{Id}/dataobjectrows

Show the row filters for the role specified by its Id.

Using curl
curl http://{webservice}/rest/roles/{Id}/dataobjectrows?sid={sid} -X GET

Example response
Status: 200 OK
{
"DataObjectRows": [
{
"Id":
"EMP",
"Filter": "EmployeeID = 3"
},
...
]
}

Edit Row Filters
PATCH /rest/roles/{Id}/dataobjectrows

This will overwrite the entire filter collection.

Using curl
curl http://{webservice}/rest/roles/{Id}/dataobjectrows?sid={sid} -X PATCH ^
-d "{'DataObjectRows':[{'Id':'EMP','Filter':'Client'}]}"

Example response
Status: 204 No Content

REST — Schedulesv2
Viewing, creating, modifying, and deleting schedules via the REST Web Service API is available in Exago v2021.1.1+. This feature
requires the installation and proper configuration of the Scheduler Service.
Note
All requests require a Session ID URL parameter and basic request headers. In the following document, headers are omitted in the
interest of brevity.

Schedule JSON
A schedule is represented as a JSON object with the following properties:
Name

Type

Writable

Description
A GUID which uniquely identifies this schedule in the
application.

JobId

string

no

ScheduleName

string

requiredcreate

The descriptive name of the schedule.

ReportName

string

requiredcreate

The name of the report being scheduled including the relative
folder path.

Status

string from ScheduleJobStatus

no

ScheduleJobStatus
The read-only current status of the schedule.

ExportType

string from ScheduleExportType yes

ScheduleExportType
The file type of the created report when the schedule runs.

Password

string

yes

The PDF or Excel output file password in plain-text.

IsArchive

boolean (false)

no

true if this schedule object represents an execution that was
saved to disk as opposed to being e-mailed.
false if this schedule object represents an execution that
was e-mailed.

JobType

string from ScheduleJobType

no

ScheduleJobType
The read-only type of job this schedule will perform.

Recurrence

ScheduleRecurrence

yes

A JSON object representing the schedule's recurrence
pattern (e.g. time, day and range of running).

FilterValues

array of ScheduleCompositeFilter yes

An array of JSON objects representing the prompting filters
to apply to the component reports of a composite report
(Chained Report or Dashboard)

Filters

array of ScheduleFilterItem

yes

An array of JSON objects representing theprompting filters to
apply to the report in this schedule, if the ReportName
refers to a report that is not a Chained Report or Dashboard.

Parameters

array of ScheduleParameter

yes

An array of JSON objects representing the parameters for
this schedule.

Batch

ScheduleBatchInfo

yes

A JSON object representing the batch processing
information.

Recipients

ScheduleRecipientInfo

yes

A JSON object representing the e-mail recipients of this
schedule's report.

Schedule Example
This example represents a schedule named Report Totals which will run a report named Employee Orders from the My Reports folder.
When it runs, a PDF file with the password "abcd" will be generated an attached to an e-mail sent to myemail@me.com. This schedule
will run every hour starting at 9:00 AM until 5:00 PM every day of the week from March 1, 2021–June 1, 2021.
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{
"JobId": "4c835b79-56e3-4051-a0c3-6d21d9576bbc",
"JobType": "Report",
"ScheduleName": "Report Totals",
"ReportName": "My Reports\\Employee Orders",
"ReportId": "9b5d7d7f-53fe-4db3-8914-c5c3fad9fb70",
"Status": "Ready",
"ExportType": "Pdf",
"Password": "abcd",
"IsArchive": false,
"Recurrence": {
"IsImmediate": false,
"RecurrenceType": "Daily",
"RecurrenceRange": "EndByDate",
"ScheduleTime": "09:00",
"RepeatEvery": true,
"RepeatEveryHours": 1,
"RepeatEveryMinutes": 0,
"RepeatEveryEndTime": "17:00",
"RangeStartDate": "2021-03-01",
"RangeEndDate": "2021-06-01",
"OccurrencesToEnd": 1,
"RecurrencePattern": {
"Once": null,
"Daily": {
"IsEveryWeekday": true,
"DailyNumberOfDaysInterval": 0
},
"Weekly": null,
"Monthly": null,
"Yearly": null
}
},
"Filters": null,
"FilterValues": null,
"Parameters": [],
"Batch": null,
"Recipients": {
"EmailResults": true,
"AttachOutputToEmail": true,
"ToAddresses": [
"myemail@me.com"
],
"CcAddresses": [],
"BccAddresses": [],
"ReplyToAddresses": [],
"EmailSubject": "Hourly order update",
"EmailBody": "Please find the hourly order update attached to this e-mail."
}
}

List All Schedules
GET /schedulesv2

List all of the schedules in the current configuration. Returns an array of ScheduleListItem objects, each representing an individual
schedule.

Create New Schedule
POST /schedulesv2

Create a new schedule. The ScheduleName and ReportName are required. Returns HTTP 201 Created with a Schedule object
representing the new schedule.

Example
This example creates a new schedule named MyTestSchedule. This schedule will run a report named Products by Category from the
ExpressViews folder 10 times, starting on October 17, 2019. The report will run at 2:45 PM only on weekdays. The output will be saved as
a PDF file to a directory on the server's file system.
{
"ScheduleName": "MyTestSchedule",
"ReportName": "ExpressViews\\Products by Category",
"ExportType": "Pdf",
"Recurrence": {
"IsImmediate": false,
"RecurrenceType": "Daily",
"RecurrenceRange": "EndAfterNOccurences",
"ScheduleTime": "14:45",
"RepeatEvery": false,
"RangeStartDate": "2019-10-17",
"RangeEndDate": null,
"OccurrencesToEnd": 10,
"RecurrencePattern": {
"Daily": {
"IsEveryWeekday" : true,
"DailyNumberOfDaysInterval": 0
}
}
}
}

Show a Schedule
GET /schedulesv2/{scheduleID}
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Show the properties of the schedule specified by the scheduleID. Returns a Schedule object representing the schduleID requested.

Edit a Schedule
PATCH /schedulesv2/{scheduleID}

Edit the properties of the schedule specified by the scheduleID. Include only those properties to be updated. Returns no JSON objects but
will return HTTP status code 204 to indicate success.

Example
This example changes the ExportType of the schedule with ID aaaaaaaa-bbbb-cccc-dddd-eeeeeeeeeeee to be RTF.
PATCH /schedulesv2/aaaaaaaa-bbbb-cccc-dddd-eeeeeeeeeeee
{
"ExportType": "Rtf"
}

Delete a Schedule
DELETE /schedulesv2/{scheduleID}

If the specified schedule is active (that is, it is not Completed or Deleted) it will be set to Deleted status. If the specified schedule is
inactive, it will be flushed from the scheduler. Therefore, two calls must be made or a separate call to flush the scheduler must be made if
the schedule was active when it deleted and the intention is to flush it. Returns no JSON objects but will return HTTP status code 204 to
indicate success.

Example
This example marks schedule with ID aaaaaaaa-bbbb-cccc-dddd-eeeeeeeeeeee as Deleted.
DELETE /schedulesv2/aaaaaaaa-bbbb-cccc-dddd-eeeeeeeeeeee

Flush the Scheduler
POST /schedulesv2/flush

Flush the scheduler of all Completed and Deleted schedules. An array of ScheduleListItem will be returned with the resulting schedule
list after the flush has occurred.

ScheduleListItem JSON
A JSON object which represents an item in the schedule list. An array of ScheduleListItem is returned when calling GET
/schedulesV2

Id

Name
string

Type

Writable
no

Description
The GUID which uniquely identifies this schedule.

ScheduleName

string

no

The descriptive name of the schedule. The same as entering a
Schedule Name into the Scheduled Report Wizard in the user
interface

Type

string from
no
ScheduleRecurrenceType

ScheduleRecurrenceType
Indicates the type of recurrence this schedule has.

ReportName

string

no

The name of the report being scheduled

LastExecDate

string

no

The date and time of the most recent execution of this schedule, in
UTC time as YYYY-MM-DDThh:mm:ssz format. If the schedule has
never run, returns null.

NextExecDate

string

no

The date and time of the next execution of this schedule, in UTC
time as YYYY-MM-DDThh:mm:ssz format. If the schedule will not
run again, returns null.

Status

string from
ScheduleJobStatus

no

ScheduleJobStatus
The read-only current status of the schedule.

RunCount

integer

no

The number of times this schedule has been executed.

UserId

string

no

The value of the built-in @userId@ parameter when the schedule
was created.

CompanyId

string

no

The value of the built-in @companyId@ parameter when the
schedule was created.

JobType

string from
ScheduleJobType

no

ScheduleJobType
The type of job that this schedule represents

Example
This array contains one ScheduleListItem representing a daily recurring schedule that has already run once and will run again the
following hour.
{
"Id": "4c835b79-56e3-4051-a0c3-6d21d9576bbc",
"ScheduleName": "Report Totals",
"Type": "Daily",
"ReportName": "Employee Orders",
"LastExecDate": "2021-02-12T21:46:37Z",
"NextExecDate": "2021-02-12T22:00:00Z",
"Status": "Ready",
"RunCount": 1,
"UserId": "Fiona Light",
"CompanyId": "Tip O' The Nose Services, LLC",
"JobType": "Report"
}

ScheduleRecurrence JSON
A JSON object representing a schedule recurrence pattern.
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Name

Type

Writable
yes (false)

Description
Determines if the schedule
will run immediately or not. If
true the schedule runs immediately. Must be false in order
to use the other recurrence properties.

IsImmediate

boolean

RecurrenceType

string from RecurrenceType yes

RecurrenceType
The type of recurrence to use.

RecurrenceRange

string from
RecurrenceRange

yes

RecurrenceRange
Determines when the schedule's recurrence pattern will
end.

ScheduleTime

string

required

The time at which the schedule should run. Must be
formatted in hh:mm format utilizing a 24-hour clock. (e.g.
9:00 AM = 09:00, 1:37 PM = 13:37)

RepeatEvery

boolean

yes (false)

If true, the schedule will repeat every RepeatEveryHours
hours and RepeatEveryMinutes minutes until
RepeatEveryEndTime.

RepeatEveryHours

integer

yes

If RepeatEvery is true, the schedule will run every this
number of hours.

RepeatEveryMinutes

integer

yes

If RepeatEvery is true, the schedule will run every this
number of minutes.

RepeatEveryEndTime

string

yes

If RepeatEvery is true, the schedule will stop repeating at
this time.
Must be formatted in hh:mm format utilizing a 24-hour
clock. (e.g. 9:00 AM = 09:00, 1:37 PM = 13:37)
The date on which the schedule will start recurring, in yyyymm-dd format.

RangeStartDate

string

yes
Set to {null} to clear an existing value when editing a
schedule.

RangeEndDate

string

yes

If RecurrenceRange is EndByDate, the schedule will stop
recurring on this date, in yyyy-mm-dd format.

OccurrencesToEnd

integer

yes

If RecurrenceRange is EndAfterNOccurences, the
schedule will stop recurring after this many occurences
have run.

RecurrencePattern

ScheduleRecurrencePattern yes

A JSON object representing the pattern that the recurrence
should follow.

ScheduleRecurrencePattern JSON
A JSON object representing a schedule recurrence pattern. The pattern selected here should match the RecurrenceType set in
ScheduleRecurrence.
Important
Pick one and only one of the properties.
Name

Type

Writable

Description
A JSON object that represents a schedule that should run only
once.

Once

OncePattern

yes

Daily

DailyPattern

yes

A JSON object that represents a schedule which will run on a daily
basis.

Weekly

WeeklyPattern

yes

A JSON object that represents a schedule which will run on a
weekly basis.

Monthly

MonthlyPattern

yes

A JSON object that represents a schedule which will run on a
monthly basis.

Yearly

YearlyPattern

yes

A JSON object that represents a schedule which will run on a
yearly basis.

OncePattern JSON
A JSON object representing a schedule that does not recur, but runs only one time.
Name
OnceDate

Type
string

Writable
Description
required
The date on which the schedule shall run, in yyyy-mm-dd format.

DailyPattern JSON
A JSON object representing a schedule recurrence pattern which occurs on a day-to-day basis.
Name
IsEveryWeekday

Type
boolean

Writable
required

Description
If true, the schedule runs every weekday, Monday–
Friday.
If False, set DailyNumberOfDaysInterval.
If IsEveryWeekday is false, the schedule will skip
this number of days between exections.

DailyNumberOfDaysInterval

integer

yes

For example, setting this value to 2 will result in a
report executing on the 1st, 4th, 7th, etc... day of the
month as there are two days between those dates.

Example
This Daily recurrence pattern runs every weekday.
{
"IsEveryWeekday": true
}

WeeklyPattern JSON
A JSON object representing a schedule recurrence pattern which occurs on a weekly basis.
Name
WeeklyNumberOfWeeksInterval

Type
integer

Writable
required

Description
The schedule will execute this number of weeks.
The schedule will run only on the days contained in
the array, with the first element of the array
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array of boolean

required

representing Sunday, the second element
representing Monday, and so on. The array must
contain exactly seven boolean values. Set the value to
true to have the schedule run for that day, or false for
it to skip that day.

Example
In this example, the schedule will run every Sunday, Wednesday and Saturday of the week.
{
"WeeklyNumberOfWeeksInterval": "1",
"WeeklyDaysOfWeek": [
true,
false,
false,
true,
false,
false,
true
]
}

MonthlyPattern JSON
A JSON object representing a schedule recurrence pattern which occurs on a monthly basis.
Name

Type

Writable

Description
Determines whether a schedule will recur on a
specific day of the month, or on a relative position in
the month (e.g. third Monday of the month). Set to
true for a specific day, or false for a relative day.

IsOnSpecificDayOfMonth

boolean

yes

MonthlySpecificDayNumber

integer

yes

If IsOnSpecificDayOfMonth is true, this is the
calendar day of the month that the schedule will
recur. Otherwise, null.

MonthlySpecificEveryNMonths

integer

yes

If IsOnSpecificDayOfMonth is true, the monthly
schedule will run every this number of months.
Otherwise, null.

MonthlyDayPosition

string

yes

If IsOnpecificDayOfMonth is false, the monthly
recurrence will run on a relative position in the month.
One and only one of the following values are
accepted: first, second, third, fourth, last. Works in
combination with MonthlyDayOfWeek.

MonthlyDayOfWeek

string

yes

If IsOnSpecificDayOfMonth is false, the days on
which the relative monthly recurrence occurs. One
and only one of these values may be used: day,
weekday, weekendday, sun, mon, tue, wed, thu, fri,
sat.

MonthlyRelativeEveryNMonths

integer

yes

If IsOnSpecificDayOfMonth is false, the schedule
will recur every this number of months.

Example
In this example, the schedule will run on the second Monday of every other month.
{
"IsOnSpecificDayOfMonth" : false,
"MonthlyDayPosition" : "second",
"MonthlyDayOfWeek" : "mon",
"MonthlyRelativeEveryNMonths" : 2
}

YearlyPattern JSON
A JSON object which represents a yearly schedule recurrence pattern.
Name

Type

Writable

IsOnSpecificDayOfYear

boolean

required

YearlySpecificMonth

integer

yes

Description
If true, the yearly schedule will recur on a specific day of the
year. Use YearlySpecificMonth and
YearlySpecficDayNumber to set the date. If false, the
schedule will recur on a relative part of the year. Use
YearlyRelativeDayPosition, YearlyRelativeDayOfWeek,
YearlyRelativeMonth to select the relative day of
recurrence.
If IsOnSpecificDayOfYear is true, this is the month portion
of the date on which the schedule will recur.
Provide an integer representing the month of the calendar (1
= January, 2 = February ... 12 = December)

YearlySpecficDayNumber

integer (1)

yes

If IsOnSpecificDayOfYear is true, this is the day portion of
the date on which the schedule will recur. Any positive
integer 1–31 is accepted.

YearlyRelativeWeekPosition

string

yes

If IsOnSpecificDayOfYear is false, this is the relative week
in the month that this schedule will recur. One and only one
of the following values are accepted: first, second, third,
fourth, last. Works in combination with
YearlyRelativeDayOfWeek and YearlyRelativeMonth.

YearlyRelativeDayOfWeek

string

yes

If IsOnSpecificDayOfYear is false, this is the relative day of
the week in the month that the schedule will recur. One and
only one of these values may be used: day, weekday,
weekendday, sun, mon, tue, wed, thu, fri, sat.

YearlyRelativeMonth

string

yes

If IsOnSpecificDayOfYear is false, this is the number of the
month in the year that the schedule will recur. (e.g. (1 =
January, 2 = February ... 12 = December))

Examples
This example will run the schedule every year on the last Sunday in September.
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{
"IsOnSpecificDayOfYear": false,
"YearlyRelativeDayPosition": "last",
"YearlyRelativeDayOfWeek": "sun",
"YearlyRelativeMonth": 9
}

This example will run the schedule on April 15th of every year.
{
"IsOnSpecificDayOfYear": true,
"YearlySpecificMonth" : "April",
"YearlySpecficDayNumber" : 15
}

ScheduleFilterItem JSON
A JSON object representing a group of one or more ScheduleFilterElement objects, defining the grouping of the prompting filters on a noncomposite (ExpressView, Express, Advanced, CrossTab) report.
Name

Type

Writable

Description

Group

array of ScheduleFilterItem yes

The contents of a group of filters. If the filters are not
grouped together, this value is null.

Filter

array of
ScheduleFilterElement

The filter statements contained in the group.

yes

ScheduleFilterElement JSON
A JSON object representing an individual filter on a non-composite (ExpressView, Express, Advanced, CrossTab) report.
Name

Type

Writable

Description
The field to be filtered, which can include applied formulas. This field
must be one of the fields on the scheduled report.

FilterText

string

yes

Operator

string from
ScheduleFilterOperator

yes

ScheduleFilterOperator
The filter operator.

AndFlag

boolean

yes

If true, this filter will be logically ANDed with the next filter in the
array. If false, this filter will be logically ORed with the next filter in
the array.

Values

array of number, string or
yes
boolean

The values to filter by. When using Operator.Between or
Operator.NotBetween the array must contain exactly two values.
When using Operator.OneOf or Operator.NotOneOf the array
may contain any number of values. All other operators use only one
value, which must still be in an array. Date and DateTimes must be
represented as strings in yyyy-mm-dd format.

Example
This Filters array represents the following filter summary from the Advanced Report Designer: Work Order Tickets.Open Date >
'05/14/2017' And (Work Order Tickets.Description Contains 'lightning' And Work Order
Tickets.Description Contains 'RMA')
"Filters": [
{
"Group": null,
"Filter": {
"FilterText": "Work Order Tickets.Open Date",
"Operator": "GreaterThan",
"AndFlag": true,
"Values": [
"2017-05-14 23:59:59.997"
]
}
},
{
"Group": [
{
"Group": null,
"Filter": {
"FilterText": "Work Order Tickets.Description",
"Operator": "Contains",
"AndFlag": true,
"Values": [
"lightning"
]
}
},
{
"Group": null,
"Filter": {
"FilterText": "Work Order Tickets.Description",
"Operator": "Contains",
"AndFlag": true,
"Values": [
"RMA"
]
}
}
],
"Filter": null
}
]

ScheduleCompositeFilter JSON
A JSON object representing a prompting filter on a composite (Chained or Dashboard) report. ScheduleCompositeFilter objects appear in
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an array in the Schedule object's FilterValues property.
Name
Reports

Type
array of int

Writable

Description
An array of component report indices on a composite report (a
Chained Report or Dashboard) that this filter applies to.

yes
0 represents the first report, 1 represents the second report, and so
on.

FilterText

string

yes

The data field or formula that contains the data that will be filtered. It
must be on all of the reports indicated by the Reports array.

Operator

string from
ScheduleFilterOperator

yes

ScheduleFilterOperator
The filter operator.

AndFlag

boolean

yes

If true, this filter will be logically ANDed with the next filter in the
array. If false, this filter will be logically ORed with the next filter in
the array.

array of number, string or
yes
boolean

Values

The values to filter by. When using Operator.Between or
Operator.NotBetween the array must contain exactly two values.
When using Operator.OneOf or Operator.NotOneOf the array
may contain any number of values. All other operators use only one
value, which must still be in an array. Date and DateTimes must be
represented as strings in yyyy-mm-dd format.

Example
This Schedule JSON object excerpt is from a scheduled Chained Report with two reports in the chain. It's Filters property is null, but the
FilterValues property contains an array of ScheduleCompositeFilter JSON objects, one for each prompting filter. Note the
Employees.Eid applies to both reports in the chain.
"Filters": null,
"FilterValues": [
{
"Reports": [
0
],
"FilterText": "=Year({Employees.HireDate})",
"Operator": "EqualTo",
"AndFlag": true,
"Values": [
"2009"
]
},
{
"Reports": [
0,
1
],
"FilterText": "Employees.EID",
"Operator": "OneOf",
"AndFlag": true,
"Values": [
"4",
"5",
"6"
]
},
{
"Reports": [
1
],
"FilterText": "=Year({Orders.OrderDate})",
"Operator": "EqualTo",
"AndFlag": true,
"Values": [
"2016"
]
}
],

ScheduleParameter JSON
A JSON object representing a prompting parameter on the scheduled report.
Name

Type

Writable

Id

string

required

Value

integer, string or date

yes

DisplayValue

integer, string or date

yes

Reports

array of integer

yes

Description
The Id (name) of the parameter on the scheduled report. To update
the parameter's value, the parameter with this Id must appear on the
report being scheduled and must be prompting.
The value to set the parameter to, which is the same as setting the
value of a prompting parameter when running a report. It does not
change the underlying default parameter value.
For boolean parameters, use 0 for false or 1 for true.
The value that is displayed in the report, if different than the Value.
An array of component report indices on a composite report (a
Chained Report or Dashboard) that this parameter applies to.
0 represents the first report, 1 represents the second report, and so
on.

ScheduleBatchInfo JSON
A JSON object representing the information for processing individualized scheduled reports, also known as a batch report. The
individualized reports will be e-mailed to recipients based on a Data Object field contained within BatchEmailEntityCategory >
BatchEmailEntity > BatchEmailField. A summary of the batch report's execution will be sent by e-mail to ToAddresses and CC'ed to
CcAddresses.
More information about Batch E-Mailing can be found in the article on Scheduling Reports.
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Writable

Description
If true, the report output will be attached to the
individualized e-mail messages.

AttachReportToEmail

boolean (false)

yes

ToAddresses

array of string

yes

An array of e-mail addresses to send the batch
report results summary to.

CcAddresses

array of string

yes

An array of e-mail addresses to carbon copy email the batch report results summary to.

BatchEmailEntityCategory

string

yes

The Data Object that BatchEmailEntity belongs
to. The folder must exist in Exago.

BatchEmailEntity

string

yes

The Data Object containing the batch recipient
information.

BatchEmailField

string

yes

The field in BatchEmailEntity that contains the email address of each recipient of the individualized
batched report.

Example
This example sends a copy of the schedule's execution summary to theboss@mycompany.com, and sends the individualized executed
report to each entry with an EmailAddress in the Employees data object.
{
"AttachReportToEmail": true,
"ToAddresses": [
"theboss@mycompany.com"
],
"CcAddresses": [],
"BatchEmailEntityCategory": "",
"BatchEmailEntity": "Employees",
"BatchEmailField": "EmailAddress"
}

ScheduleRecipientInfo JSON
A JSON object representing an e-mail to send when the schedule has run and to optionally attach the report to the e-mail.
Name

EmailResults

Type

boolean

Writable

Description
If true, the report is attached to an e-mail message.
If false, the report is saved to disk instead.

yes

If this is a batch schedule, this is always true.
Has the same effect as checking or unchecking the
Email Results checkbox on the Recipients tab of
the Scheduled Report Wizard.

AttachOutputToEmail

boolean (true)

yes

If this is a batch schedule, if true, the completed
report is attached to the e-mail message for each
recipient. If false, the report is not attached to the email—the e-mails can be used for delivering personal
data-driven alerts or updates.
Has the same effect as checking or unchecking the
Attach Report Output to Email checkbox on the
Recipients tab of the Scheduled Report Wizard for
batch reports.

ToAddresses

array of string

required

An array of e-mail addresses to send the e-mail to.

CcAddresses

array of string

yes

An array of e-mail addresses to CC to.

BccAddresses

array of string

yes

An array of e-mail addresses to BCC to.

ReplyToAddresses

array of string

yes

An array of e-mail addresses that will appear as the
Reply-To: addresses in the e-mail.

EmailSubject

string

yes

The subject line of the e-mail message.

EmailBody

string

yes

The body text/content of the e-mail message.

Example
This example attaches the report output file to an e-mail and sends it to firstperson@mycompany.com and
secondperson@mycompany.com. The e-mail is CCed to supervisor@mycompany.com and manager@mycompany.com, and BCCed to
ceo@mycompany.com. All e-mail messages will have a subject line of "Here is the report you needed" and the message "Attached is the
report you had asked for!" will appear in the body of the e-mail.
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{
"EmailResults": true,
"AttachOutputToEmail": true,
"ToAddresses": [
"firstperson@mycompany.com",
"secondperson@mycompany.com"
],
"CcAddresses": [
"supervisor@mycompany.com",
"manager@mycompany.com"
],
"BccAddresses": [
"ceo@mycompany.com"
],
"ReplyToAddresses": [],
"EmailSubject": "Here is that report you needed",
"EmailBody": "Attached is the report you had asked for!"
}

REST — Server Events
Server events can be accessed for reference and disabled for the session. Server events cannot currently be created or edited using REST.
Important
All requests require a Session ID URL parameter and basic request headers. In the following document, headers are omitted for clarity.

Server Event JSON
Server events are represented as JSON objects with the following properties:
Name

Type

Writeable

Description

Id

string

no

The unique Id of this server event

Name

string

no

The name of this server event

Note
Access to other properties of server events via REST is not yet implemented.

Example
{
"Id": "0",
"Name": "RunAfterReportExecution"
}

List Server Events
GET /rest/serverevents

List all the server events in the current configuration. Output is an array of objects, each representing an individual server event.
Name

Type

Description

Id

string

The unique Id of this server event

Name

string

The name of this server event

Using curl
curl http://{webservice}/rest/serverevents?sid={sid} -X GET

Example response
Status: 200 OK
[
{
"Id":
"Name":
},
{
"Id":
"Name":
}

"0",
"RunAfterReportExecution"

"1",
"AddDisclaimerToOutput"

]

Show Server Event
GET /rest/serverevents/{Id}

Show the properties of the server event specified by its Id.

Using curl
curl http://{webservice}/rest/serverevents/{Id}?sid={sid} -X GET

Example response
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Status: 200 OK
{
"Id": "0",
"Name": "RunAfterReportExecution"
}

Delete Server Event
DELETE /rest/serverevents/{Id}

Using curl
curl http://{webservice}/rest/serverevents/{Id}?sid={sid} -X DELETE

Example response
Status: 204 No Content

REST — Config Settings
The Settings endpoint allows you to access many relevant settings for the current configuration.

Settings JSON
Settings are represented as JSON objects with the following properties. Each corresponds with a setting in the Admin Console and/or
Config file.
Some settings appear both in the Settings JSON (Table A) and in General Settings JSON (Table B). When this happens, the setting
contained in Table B should be used in lieu of the one in Table A.

General

Table A — Settings JSON
Type
General Settings

yes

DateFormat
Deperecated. Use General/DateFormat instead.

string

yes

TimeFormat
Deprecated. Use General/TimeFormat instead.

string

yes

DateTimeFormat
Deprecated. Use General/DateTimeFormat instead.

string

yes

SeparatorSymbol
Deprecated. Use General/SeperatorSumbol instead.

string

yes

CurrencySymbol
Deprecated. Use General/CurrencySymbol instead.

string

yes

DecimalSymbol
Deprecated. Use General/DecimalSymbol insread.

string

yes

ShowGrid
Deprecated. Use General/IsShowGrid instead.

boolean

yes

ShowCrossTabReports
Deperecared. Use General/IsShowCrossTabReports
instead.

boolean

yes

ShowExpressReports
Deprecated. Use General/IsShowExpressReports
instead.

boolean

yes

ShowExpressReportsGrouping
Deprested. Use
General/IsShowExpressReportsGrouping instead.

boolean

yes

ShowExpressReportsFormulas
Deprecated. Use
General/IsShowExpressReportsFormulaButton
instead.

boolean

yes

ShowExpressReportsStyling
Deperecated. Use
General/IsShowExpressReportsStylingToolbar
instead.

boolean

yes

ShowExpressReportsThemes
Deprecated. Use
General/IsShowExpressReportsThemes instead.

boolean

yes

ShowAdvancedReports
Deprecated. Use General/IsShowAdvancedReports
instead.

boolean

yes

ShowScheduleReports
Deperecated. Use General/IsShowScheduleReports
instead.

boolean

yes

ShowScheduleReportsManager
Deperecated. Use
General/IsShowScheduleReportsManager instead.

boolean

yes

ShowScheduleReportsEmail
Deperecated. Use
General/IsShowScheduleReportsEmail instead.

boolean

yes

ReadFilterValues
Deprecated. Use General/IsReadFilterValues instead. boolean

yes

ShowTabs

boolean

yes

WebReportsBaseUrl

string

yes

DefaultFolderName

string

yes

DefaultReportName

string

yes

Name

Writable

General Settings JSON
Some settings appear both in the Settings JSON (Table A) and in General Settings JSON (Table B). When this happens, the setting
contained in Table B should be used in lieu of the one in Table A.
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Table B — General Settings JSON
Type
string

Writable
yes

AllowHomeDirect

boolean

yes

AllowHtmlOutput

boolean

yes

AllowExcelOutput

boolean

yes

AllowPdfOutput

boolean

yes

AllowRtfOutput

boolean

yes

AllowCsvOutput

boolean

yes

DefaultOutputType

wrExportType

yes

IsWriteLog

boolean

yes

CustomCode

string

yes

LicenseKey

string

yes

DateFormat

string

yes

TimeFormat

string

yes

DateTimeFormat

string

yes

integer
DateTimeTreatedAs

0. Date
1. Time
2. DateTime

yes

IsReadFilterValues

boolean

yes

DbTimeout

integer

yes

DbRowLimit

integer

yes

DbRowLimitStepSize

integer

yes

VisualizationDbRowLimit

integer

yes

CallTypeParamName

string

yes

ColumnParamName

string

yes

FilterParamName

string

yes

FullFilterParamName

string

yes

SortParamName

string

yes

DataCategoryParamName

string

yes

ObjectIdParamName

string

yes

IsShowGrid

boolean

yes

ActiveRoleId

string

yes

IsDebugging

boolean

yes

IsShowPdfTemplate

boolean

yes

IsDashboardPromptAtExecution

boolean

yes

IsDashboardShowUrlItemButton

boolean

yes

IsVisualizationShowKeyword

boolean

yes

IsShowChartWizard

boolean

yes

IsShowMapWizard

boolean

yes

IsShowGoogleMapWizard

boolean

yes

IsShowGaugeWizard

boolean

yes

IsSaveOnExecute

boolean

yes

IsSaveOnFinish

boolean

yes

IsEnableRightClickMenus

boolean

yes

IsEnableReportsTreeDragAndDrop

boolean

yes

IsShowLinkReportFields

boolean

yes

IsShowLinkReportFormula

boolean

yes

IsShowLinkAction

boolean

yes

IsShowInsertImage

boolean

yes

ExpirationDateStr

string

yes

IsHtmlPaging

boolean

yes

WindowHeight

integer

yes

WindowWidth

integer

yes

SeparatorSymbol

string

yes

CurrencySymbol

string

yes

DecimalSymbol

string

yes

IsDataMapping

boolean

yes

IsShowJoinFields

boolean

yes

IsDetectJoinedObjects

boolean

yes

IsEnableSpecialCartesianProcessing

boolean

yes

IsIncludeNotFilterNullValues

boolean

yes

TempPath

string

no

TempCloudService

string

yes

DataCloudService

string

yes

IsShowScheduleReports

boolean

yes

IsShowScheduleReportsManager

boolean

yes

ScheduleManagerViewLevel

Schedule Manager View Level

yes

IsShowScheduleReportsEmail

boolean

yes

ScheduleRemotingHost

string

yes
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SynchronousRemotingHost

string

yes

SchedulerQueueService

string

yes

ReportScheduleEmailSubject

string

yes

ReportScheduleEmailBody

string

yes

IsRenewSession

boolean

yes

PasswordRequirement

string

yes

IsExecuteRemotely

boolean

yes

IsAccessDataSourcesRemotely

boolean

yes

MaxTempFileAge

integer

yes

AllowExecuteNewFilters

boolean

yes

ExternalInterface

string

yes

DecimalPlaces

integer

yes

CurrencyDecimalPlaces

integer

yes

ApplyGeneralFormatDecimalPlaces

boolean

yes

ApplyGeneralCurrencyRightAlignment

boolean

yes

ChartColors

string

yes

GeochartMapKey

string

yes

MapColors

string

yes

GoogleMapJSAPIKey v2018.1+

string

yes

GoogleMapGeocodeAPIKey v2018.1+

string

yes

GoogleMapColors

string

yes

GaugeColors

string

yes

IsShowGroupFilters

boolean

yes

IsShowJoinsWindow

boolean

yes

IsShowAdvancedJoins

boolean

yes

IsShowEventsWindow

boolean

yes

IsShowReportParametersWindow

boolean

yes

IsShowCrosstabReports

boolean

yes

IsShowDashboardReports

boolean

yes

IsShowChainedReports

boolean

yes

IsAllowExpressViewLiveEdit

boolean

yes

IsShowExpressViews

boolean

yes

IsShowDashboardNewVisualizationButton

boolean

yes

IsShowDashboardDataFieldsSearch

boolean

yes

IsShowExpressViewDataFieldsSearch

boolean

yes

IsUseSampleDataForDashboardVisualizationDesign

boolean

yes

IsDashboardPromptKeywordByDefault

boolean

yes

IsShowExpressReports

boolean

yes

IsShowExpressReportsGrouping

boolean

yes

IsShowExpressReportsFormulaButton

boolean

yes

IsShowExpressReportsStylingToolbar

boolean

yes

IsShowExpressReportsThemes

boolean

yes

IsShowAdvancedReports

boolean

yes

IsShowGroupHeadersFormulaButton

boolean

yes

IsOneCategoryLimit

boolean

yes

IsCacheServices

boolean

yes

SchedulerRecipientWindow

string

yes

FilterExecutionWindow

string

yes

IsShowIeDownloadButton

boolean

yes

IsDeleteSchedulesUponReportDeletion

boolean

yes

AllowMultipleSessions

boolean

yes

AllowMD5OnFIPS

boolean

yes

WriteBOMToCSV v2019.1.1+

boolean

yes

IsShowScheduleNoEndDate

boolean

yes

IsShowScheduleIntradayRecurrence

boolean

yes

TempUrl

string

yes

UserPreferenceStorage

integer

yes

UserStartupReportOverwriteGettingStarted

boolean

yes

UserStartupReportMaxNum

integer

yes

integer
ExcelExportTarget

0.
1.
2.
3.
4.

2003
2007
2010
2013
2016

yes

AllowDependantFilters

boolean

yes

LinkedReportsInNewTab

boolean

yes

LoadImageFuncParamPrefix

string

yes

LanguageFile

string

yes

IsShowHelp

boolean

yes

CustomHelpSource

string

yes
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IsEmailScheduledReports
IsEnableBatchReports

boolean
boolean

yes
yes

IsShowScheduleDeliveryTypeOptions

boolean

yes

IsUseSecureRemotingChannel

boolean

yes

IsShowTemplateUploadButton

boolean

yes

UseSVGForAppIcons

boolean

yes

CrossTabMaximumFields

boolean

yes

IsShowExportsInTab

boolean

yes

integer
IsShowHtmlToolbar

1. auto
2. show always
3. hide always

yes

IsEnableScheduling

boolean

yes

IsShowFilterDescription

boolean

yes

integer
DefaultFilterExecutionWindow

0.
1.
2.
3.

standard
operator
simple
custom

yes

IsChangeableFilterExecutionWindow

boolean

yes

IgnoreInaccessibleReportFolders

boolean

yes

integer
SchemaAccessType

1. datasource
2. metadata

yes

decimal
Note
ServerTimeZoneOffset

Set to 0 to use the ClientTimeZoneName. If null,
Exago will use the External Interface (a deprecated
extensibility feature) to calculate the time zone
change.

yes

ClientTimeZoneName

string

yes

IsShowEnhancedTooltips

boolean

yes

IsShowReportUploadDownloadOptions

boolean

yes

AllowInteractiveHtml

boolean

yes

AllowHtmlInScheduledEmails

boolean

yes

DefaultIsDockOpen

boolean

yes

integer
DockPlacement

0. left
1. right

yes

CssTheme

string

yes

AllowExecuteSaveToDesign

boolean

yes

UserAllowUserReports

boolean

yes

MaxNumberOfChartPoints

integer

yes

DefaultFont

string

yes

DefaultFontSize

integer

yes

DefaultChartFont

string

yes

IsWebFarmSupport

boolean

yes

IsSilentDashboardRefresh

boolean

yes

MaxJobExecutionMinutes

integer

yes

IsAggregateAndGroupInDatabase

boolean

yes

IsEvaluateFormulasInDatabase

boolean

yes

IsShowBrowserOutOfDateWarning

boolean

yes

AreDateFunctionsLoaded

boolean

yes

VersionNumber

string

no

DbRowLimitParamName v2018.1

string

yes

DbRowRangeStartParamNamev2018.1+

string

yes

DbRowRangeEndParamName v2018.1+

string

yes

string
ExpressviewJoinAlgorithm v2018.1+

yes
"Standard" or "Legacy"

ExcludeDataSourcesReportCustomSQL v2018.1+

boolean

yes

LoadAssemblyInExternalDomain v2018.1+

boolean

yes

ShowTipsExpressView v2018.2+)

boolean

yes

ShowTutorialExpressView v2018.2+

boolean

yes

IsShowSQLWindow v2019.1+

boolean

yes

Example:
{
"General": {
"ReportPath": "C:\\Exago\\Reports",
"AllowHomeDirect": true,
"AllowHtmlOutput": true,
"AllowExcelOutput": true,
"AllowPdfOutput": true,
"AllowRtfOutput": true,
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"AllowRtfOutput": true,
"AllowCsvOutput": true,
"DefaultOutputType": 2,
"IsWriteLog": true,
"CustomCode": "",
"LicenseKey": "",
"DateFormat": "",
"TimeFormat": "",
"DateTimeFormat": "",
"DateTimeTreatedAs": 0,
"IsReadFilterValues": true,
"DbTimeout": 600,
"DbRowLimit": 0,
"DbRowLimitStepSize": 1000,
"VisualizationDbRowLimit": 0,
"CallTypeParamName": "",
"ColumnParamName": "",
"FilterParamName": "",
"FullFilterParamName": "",
"SortParamName": "",
"DataCategoryParamName": "",
"ObjectIdParamName": "",
"IsShowGrid": true,
"ActiveRoleId": "",
"IsDebugging": false,
"IsShowPdfTemplate": true,
"IsDashboardPromptAtExecution": false,
"IsDashboardShowUrlItemButton": false,
"IsVisualizationShowKeyword": false,
"IsShowChartWizard": true,
"IsShowMapWizard": false,
"IsShowGoogleMapWizard": false,
"IsShowGaugeWizard": true,
"IsSaveOnExecute": true,
"IsSaveOnFinish": true,
"IsEnableRightClickMenus": true,
"IsEnableReportsTreeDragAndDrop": true,
"IsShowLinkReport": true,
"IsShowLinkReportFields": true,
"IsShowLinkReportFormula": false,
"IsShowLinkAction": false,
"IsShowInsertImage": true,
"ExpirationDateStr": "",
"IsHtmlPaging": true,
"WindowHeight": 0,
"WindowWidth": 0,
"SeparatorSymbol": ",",
"CurrencySymbol": "$",
"DecimalSymbol": ".",
"IsDataMapping": false,
"IsShowJoinFields": true,
"IsDetectJoinedObjects": true,
"IsEnableSpecialCartesianProcessing": true,
"IsIncludeNotFilterNullValues": false,
"TempPath": "",
"TempCloudService": "",
"DataCloudService": "",
"IsShowScheduleReports": false,
"IsShowScheduleReportsManager": false,
"ScheduleManagerViewLevel": 0,
"IsShowScheduleReportsEmail": false,
"ScheduleRemotingHost": "",
"SynchronousRemotingHost": "",
"SchedulerQueueService": "",
"ReportScheduleEmailSubject": "",
"ReportScheduleEmailBody": "",
"IsRenewSession": true,
"PasswordRequirement": "",
"IsExecuteRemotely": false,
"IsAccessDataSourcesRemotely": false,
"MaxTempFileAge": 1440,
"AllowExecuteNewFilters": true,
"ExternalInterface": "",
"DecimalPlaces": -1,
"CurrencyDecimalPlaces": -1,
"ApplyGeneralFormatDecimalPlaces": false,
"ApplyGeneralCurrencyRightAlignment": true,
"ChartColors": "#e85d61, #e5d08f, #00d995",
"GeochartMapKey": "",
"MapColors": "Lightblue,Navy",
"GoogleMapKey": "",
"GoogleMapColors": "Lightblue,Navy",
"GaugeColors": "#e85d61, #e5d08f, #00d995",
"IsShowGroupFilters": true,
"IsShowJoinsWindow": true,
"IsShowAdvancedJoins": true,
"IsShowEventsWindow": false,
"IsShowReportParametersWindow": true,
"IsShowCrosstabReports": true,
"IsShowDashboardReports": true,
"IsShowChainedReports": true,
"IsAllowExpressViewLiveEdit": false,
"IsShowExpressViews": true,
"IsShowDashboardNewVisualizationButton": true,
"IsShowDashboardDataFieldsSearch": false,
"IsShowExpressViewDataFieldsSearch": true,
"IsUseSampleDataForDashboardVisualizationDesign": true,
"IsShowDashboardExistingVisualizationReportButton": false,
"IsDashboardPromptKeywordByDefault": false,
"IsShowExpressReports": true,
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"IsShowExpressReports": true,
"IsShowExpressReportsGrouping": true,
"IsShowExpressReportsFormulaButton": true,
"IsShowExpressReportsStylingToolbar": true,
"IsShowExpressReportsThemes": true,
"IsShowAdvancedReports": true,
"IsShowGroupHeadersFormulaButton": false,
"IsOneCategoryLimit": false,
"IsCacheServices": true,
"SchedulerRecipientWindow": "",
"FilterExecutionWindow": "",
"IsShowIeDownloadButton": false,
"IsDeleteSchedulesUponReportDeletion": false,
"AllowMultipleSessions": true,
"AllowMD5OnFIPS": false,
"WriteBOMToCSV": false,
"IsShowScheduleNoEndDate": true,
"IsShowScheduleIntradayRecurrence": true,
"TempUrl": "",
"UserPreferenceStorage": 0,
"UserStartupReportOverwriteGettingStarted": false,
"UserStartupReportMaxNum": 1,
"ExcelExportTarget": 1,
"AllowDependantFilters": false,
"LinkedReportsInNewTab": false,
"LoadImageFuncParamPrefix": "",
"LanguageFile": "en-us,en-us-getting-started,en-us-tooltips",
"IsShowHelp": true,
"CustomHelpSource": "",
"IsEmailScheduledReports": true,
"IsEnableBatchReports": false,
"IsShowScheduleDeliveryTypeOptions": false,
"IsUseSecureRemotingChannel": false,
"IsShowTemplateUploadButton": false,
"UseSVGForAppIcons": true,
"CrossTabMaximumFields": 5,
"IsShowExportsInTab": true,
"IsShowHtmlToolbar": 0,
"IsEnableScheduling": true,
"IsShowFilterDescription": false,
"DefaultFilterExecutionWindow": 0,
"IsChangeableFilterExecutionWindow": true,
"IgnoreInaccessibleReportFolders": false,
"SchemaAccessType": 1,
"ServerTimeZoneOffset": 0,
"ClientTimeZoneName": "America/New_York",
"IsShowEnhancedTooltips": true,
"IsShowReportUploadDownloadOptions": false,
"AllowInteractiveHtml": true,
"AllowHtmlInScheduledEmails": false,
"DefaultIsDockOpen": false,
"DockPlacement": 0,
"CssTheme": "Basic",
"AllowExecuteSaveToDesign": true,
"UserAllowUserReports": true,
"MaxNumberOfChartPoints": 300,
"DefaultFont": "Arial",
"DefaultFontSize": 8,
"DefaultChartFont": "Arial",
"IsWebFarmSupport": false,
"IsSilentDashboardRefresh": false,
"MaxJobExecutionMinutes": 240,
"IsAggregateAndGroupInDatabase": false,
"IsEvaluateFormulasInDatabase": true,
"IsShowBrowserOutOfDateWarning": true,
"AreDateFunctionsLoaded": true,
"VersionNumber": "2016.3.4.100"
},
"DateFormat": "",
"TimeFormat": "",
"DateTimeFormat": "",
"SeparatorSymbol": ",",
"CurrencySymbol": "$",
"DecimalSymbol": ".",
"ShowGrid": true,
"ShowCrossTabReports": true,
"ShowExpressReports": true,
"ShowExpressReportsGrouping": true,
"ShowExpressReportsFormulas": true,
"ShowExpressReportsStyling": true,
"ShowExpressReportsThemes": true,
"ShowAdvancedReports": true,
"ShowScheduleReports": false,
"ShowScheduleReportsManager": false,
"ShowScheduleReportsEmail": false,
"ReadFilterValues": true,
"ShowTabs": true,
"WebReportsBaseUrl": null,
"DefaultFolderName": "",
"DefaultReportName": ""
}

Note
All requests require a Session ID URL parameter and basic request headers. In the following document, headers are omitted in the
interest of brevity.

177 of 201

Constants and Enumerators

Technical Guide

Show Settings
GET /rest/settings

Show the available settings for the current configuration.

Using curl
curl http://{webservice}/rest/settings?sid={sid} -X GET

Example response
Status: 200 OK
{
"General": {
"ReportPath": "C:\\Exago\\Reports",
...
}
"DateFormat":
"MM/dd/yyyy",
"TimeFormat":
"hh:mm:ss a",
"DateTimeFormat":
"MM/dd/yyyy hh:mm:ss a",
"SeparatorSymbol":
",",
"CurrencySymbol":
"$",
"ShowGrid":
true,
"ShowCrossTabReports":
true,
"ShowExpressReports":
true,
...
}

Edit Settings
PATCH /rest/settings

Only supply the properties to be edited.

Using curl
curl http://{webservice}/rest/settings?sid={sid} -X PATCH ^
-d "{
'General':
{
'ReportPath':'C:\\Exago\\Reports',
'IsShowLinkReportFormula':false,
...
}
'ShowScheduleReports':false,
'ShowExpressReports':false,
...
}"

Example response
Status: 204 No Content

Constants and Enumerators
There are many variables in the APIs that require a specific type of value from a set of values. These sets of values are called enumerated
types, and each value in a type is called an enumerator, or enum. Enumerated types are no more than a set of named values, which act as
Constants in the API.
When an API variable requires an enum, it must be set to one of the constants that are defined in the specified enumerated type. For
example, if a variable requires a Report Type enum, it accepts the values Advanced, Express, Dashboard, Chained or ExpressView. Other
values will cause an invalid type error.
Some API variables are not enumerated types, but may require a set of constants regardless. These constants have no numeric
equivalent.
The following article is a reference guide that lists the most important enumerated types and lists of constants that are used throughout the
API.
Caution
Numeric values should not be used as enum types as these values are not constants.

wrApiAction
Enum Name

Numeric Value

Description
If a report is loaded, this is equivalent to ExecuteReport. Otherwise,
this is equivalent to Home.

Default

0

Home

1

Open the home page.

ExecuteReport

2

Execute the loaded report (specify format with wrExportType).

EditReport

3

Open the loaded report in the appropriate editor.

NewAdvancedReport

4

Open the New Advanced Report Wizard.

NewReport

4

Deprecated: Use NewAdvancedReport instead.

NewCrossTabReport

5

Open the New CrossTab Report Wizard.

NewExpressReport

6

Open the New Express Report Wizard.

NewDashboardReport

7

Open the Dashboard Designer for a new dashboard.

NewExpressView

8

Open the ExpressView Designer for a new ExpressView.

ScheduleReport

9

Open the Schedule Report Wizard for the loaded report.

ScheduledReportsManager

10

Open the Scheduled Report Manager.
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Cache Visibility Level
User

Enum Name
1

Numeric Value

Description
Cache visibility set at the UserId parameter level

Company

2

Cache visibility set at the CompanyId parameter level

Global

3

Global cache visibility

Code Language
Note
Each value has multiple names.
Enum Name
c#
cs
csharp

Numeric Value

Description

0

C Sharp

js
javascript

1

JavaScript

vb
visualbasic

2

Visual Basic

Data Source Type
Enum Name Numeric Value
Description
MsSql
0
Microsoft SQL Server
MySql

1

MySQL

ODBC

2

ODBC

Postgres

3

PostreSQL

Oracle

4

Oracle

DB2

5

IBM DB2

Informix

6

IBM Informix

Assembly

7

.NET Assembly

WebService

8

Web Service

File

9

Excel file

MsOlap

10

OLAP

DataType
The DataType enumeration is used in the REST Web Service API when processing data object column metadata and when getting the
the value of the EntityColumn.DataTypeEnum property in the .NET API.
Enum Name

Numeric Value

Description

String

0

String

Date

1

Date, i.e. day, month, year

DateTime

2

Date & time

Time

3

Time, i.e. hour, minute, second (am/pm)

Integer

4

Integer number

Decimal

5

Decimal number

Float

6

Floating-point number

Bit

7

Bit

Guid

8

Globally (universally) unique identifier, aka. UUID

Image

9

Image

Currency

10

Currency

DataType
The DataType constants are used throughout the application including when defining the return type (the <return_data_type>) of
Quick Functions.
Constant Name
StringDataType

0

Integer Value
A string

Description

DateDataType

1

A date

IntegerDataType

2

An integer

OldBitDataType

3

Deprecated — a single bit. Users should use BitDataType (13)
instead

NumericDataType

4

A number

FloatDataType

5

A floating point number

DecimalDataType

6

A decimal number

GuidDataType

7

Globally (universally) unique identifier, aka. UUID

DateTimeDataType

8

A DateTime

TimeDataType

9

Time — this data type is currently not in use in the application

ImageDataType

10

An binary image

CurrencyDataType

11

A currency value

AmbiguousFormulaDataType

12

A formula returns a different data type based on its outcome (e.g.
=if(temperature > 98.6, temperature, false)

BooleanDataType

13

A boolean (true/false) value

BitDataType

13

A single bit

DataObjectType
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Assembly

.NET Assembly

File

Excel file

Function

User-defined function

Procedure

Stored procedure

SqlStmt

Custom SQL statement

Table

Data table

View

SQL view

WebSvc

Web Service method

MdxStmt

OLAP MDX query

Technical Guide
Description

DashboardLayoutFit
Enum Name

Description
All tiles are resized horizontally and vertically to fit on the
canvas
Same as selecting Scale to Screen in the Dashboard
Designer Canvas Format menu

All

Width

Tiles are resized horizontally to fit within a specified
canvas width
Same as selecting Specify Height in the Dashboard
Designer Canvas Format menu

None

The tiles are not resized. The canvas has a specified
height and width
Same as selecting Specify Height and Width in the
Dashboard Designer Canvas Format menu

wrDockLocation
Used to set the location of the interactive dock in the Report Viewer with the .NET API's SetupData.General.DockPlacement
setting.
Enum Name Numeric Value
Description
Left
0
The pane is docked on the left.
Right

1

The pane is docked on the right.

wrExportType
Enum Name

Numeric Value

Description

Html

0

Run in the browser, using the appropriate viewer.

Excel

1

Export as an Excel file.

Pdf

2

Export as a PDF file.

Rtf

3

Export as an RTF file.

Csv

4

Export as a comma-separated value text file.

Word

5

Export as a Word file.

Default

6

Default type specified by the loaded report; if not specified,
default type specified by the current config.

Filterable Type
Enum Name

Description

All

Field supports all filter types

True

Field supports all filter types

None

Field cannot be filtered

False

Field cannot be filtered

Dynamic

Field supports only dynamic (interactive) filters

Static

Field supports only static (report) filters

Filter Operator Type
Enum Name
EqualTo

0

Numeric Value

Description
Data value is equal to the filter value

NotEqualTo

1

Data value is less than the filter value (number, date)

LessThan

2

Data value is less than or equal to the filter value
(number, date)

LessThanOrEqualTo

3

Data value is greater than the filter value (number, date)

GreaterThan

4

Data value is greater than or equal to the filter value
(number, date)

GreaterThanOrEqualTo

5

Data value is not equal to the filter value

StartsWith

6

Data value starts with the filter value (string, number)

NotStartsWith

7

Data value does not start with the filter value (string,
number)

EndsWith

8

Data value ends with the filter value (string, number)

NotEndsWith

9

Data value does not end with the filter value (string,
number)

Contains

10

Data value contains the filter value (string, number)

NotContains

11

Data value does not contain the filter value (string,
number)

Between

12

Data value is between the two filter values

NotBetween

13

Data value is not between the two filter values

OneOf

14

Data value is equal to one of the filter values
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Data value is not equal to any of the filter values

FolderStatus
Enum Name
Exists

This folder exists

Description

DoesNotExist

This folder does not exist

Created

This folder was successfully created

Deleted

This folder was successfully deleted

Renamed

This folder was successfully renamed

JobStatus v2019.2+
A read-only property showing the current status of a schedule. Used in REST - Schedules.
Ready

Enum Name
0

Numeric Value

Description
The schedule will run at its next scheduled run time.

Running

1

The schedule is currently running and the reports are executing.

Completed

2

The schedule has completed its final event, and will not run again. It
will be removed from the list when the scheduler is flushed.

Suspended

3

The schedule has been suspended and will not be run again.

Deleted

4

The schedule has been deleted, and will be removed from the list
when the cache is flushed.

Abended

5

The last run failed due to an error. The schedule will not run again.

UserAbort

6

Schedule is running, but user has requested to delete it.

Transmitting

7

Schedule is finished and waiting for data to be transmitted to client
for synchronous execution.

Removed

8

Schedule should be removed if it hasn't already.

Immediate

9

As soon as resources are available, the schedule will be run.

Join Type
Enum Name

Description

Inner

Inner join

LeftOuter

Left outer join

RightOuter

Right outer join

FullOuter

Full outer join (left outer join + right outer join)

Join Relation Type
Enum Name
OneToOne

One-to-one relationship

Description

OneToMany

One-to-many relationship

Parameter Type
Enum Name

Numeric Value

Description

String

0

String

Date

1

Date, i.e. day, month, year

Integer

2

Integer number

Decimal

3

Decimal number

wrRowRangeSqlMethod
Used in the dbconfigs.json file. See Managing the dbconfigs.json File.
Enum Name
LimitOffset

Description
Disable range limiting SQL.
SELECT ... LIMIT rangeSize OFFSET offsetRow

OffsetFetch

SELECT ... OFFSET offsetRow ROWS FETCH NEXT rangeSize ROWS ONLY

RowNumberWithTop

SELECT TOP endingRow ROW_NUMBER() Over(Order By (...)) as wrRowNum ... as
wrRowNumbered WHERE wrRowNumbered.wrRowNum BETWEEN startingRow AND
endingRowField

RowNumber

SELECT ROW_NUMBER() Over(Order By (...)) as wrRowNum ... as wrRowNumbered
WHERE wrRowNumbered.wrRowNum BETWEEN startingRow AND endingRowField

RowNumberNoAlias

SELECT ROW_NUMBER() Over(Order By (...)) as wrRowNum ... WHERE wrRowNum
BETWEEN startingRow AND endingRowField

None

RecurrenceRange v2019.2+
Determines the ending of a scheduled report recurrence. Used in REST - Schedules.
Enum Name
NoEndDate

Description
This schedule has no end date and will recur indefinitely.

This schedule shall run only for a specified number of instances.
EndAfterNOccurences The number of instances is specified in the OccurencesToEnd
property.
EndByDate

This schedule shall run until a specified date is reached.
The date is specified in the RangeEndDate property.

RecurrenceType v2019.2+
Determines the frequency of scheduled report recurrence. Used in REST - Schedules.
Enum Value
Description
Once
This schedule will only run one time.
Daily

The schedule will repeat every day, every weekday, or every number of days.
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Weekly

The schedule will repeat every week, or every number of weeks, on one or more days

Monthly

The schedule will repeat every month, or every number of months, on a certain day.

Yearly

The schedule will repeat every year on a certain day.

wrReportType
Advanced

Enum Name
0

Numeric Value

Description
Advanced Report (CrossTab Reports are also considered
Advanced Reports)

Standard

0

Deprecated: Use Advanced instead.

Express

1

Express Report

Dashboard

2

Dashboard

Chained

3

Chained Report

ExpressView

5

ExpressView

Folder

6

Report Folder

ReportValidationErrorType
The types of report validation errors that can happen. Not all validation error types are applicable to all report objects.
Enum Name
SortFormulaSyntaxError
FilterFormulaSyntaxError
DataObjectNotFound
SortDataFieldNotFound
FilterDataFieldNotFound
LinkedDataFieldNotFound
MinMaxFilterDataFieldNotFound
JoinDataObjectNotFound
JoinNotFound
JoinDataFieldNotFound
ChartDataFieldNotFound
MapDataFieldNotFound
CellDataFieldNotFound
RowGroupNameNotFound
RowGroupFormulaNameNotFound
ChartCellIdNotFound
MapCellIdNotFound
MergedCellsAcrossSections
CrossTabIdNotFound
CrossTabCellIdNotFound
ColumnSortByFieldNotFound
ChildReportNotFound
ExpressViewColumnMissingEntity
ExpressViewColumnMissingField
ExpressViewGroupMissingField
ExpressViewFilterMissingField
ExpressViewChartMissingField
EtlReportDesignerModeNotEtl
EtlReportTypeNotAdvanced
EtlDataTypeNotSet
EtlDataTypeNotFound
EtlReportFormatInvalid
EtlCellBlank
EtlHeaderCellValueDuplicate
EtlPossibleDataTypeError
EtlCellSpan
None
ReportParameterNameUsed

ScheduleExportType v2019.2+
The export type for a report run on a schedule. Used in REST - Schedules.
Enum Name
Pdf

Description
Export as a PDF file.

Rtf

Export as an RTF file.

Excel

Export as a Microsoft Excel workbook file.

Csv

Export as a CSV text file.

ScheduleFilterOperator v2019.2+
Utilized when adding filters to scheduled reports via the REST Web Service API. Used in REST - Schedules.
Enum Name
EqualTo

Description
Evaluates as true when FilterText is equal to Values, otherwise false.

NotEqualTo

Evaluates as true when FilterText is not equal to Values, otherwise false.
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LessThan
LessThanOrEqualTo

Evaluates as true when FilterText is less than Values, otherwise false.
Evaluates as true when FilterText is less than or equal to Values, othwerwise false.

GreaterThan

Evaluates as true when FilterText is greater than Values, otherwise false.

GreaterThanOrEqualTo Evaluates as true when FilterText is greater than or equal too Values, otherwise false.
StartsWith

Evaluates as true when FilterText starts with Values, otherwise false.

NotStartsWith

Evaluates as true when FilterText does not start with Values, otherwise false.

EndsWith

Evaluates as true when FilterText ends with Values, otherwise false.

NotEndsWith

Evaluates as true when FilterText does not end with Values, otherwise false.

Contains

Evaluates as true when Values is contained within FilterText, otherwise false.

NotContains

Evaluates as true when Values is not contained within FilterText, otherwise false.

Between

Evaluates as true when FilterText is between two values contained in Values, otherwise false.

NotBetween

Evaluates as true when FilterText is not between two values contained in Values, otherwiese false.

OneOf

Evaluates as true when FilterText matches at least one of Values, othwerwise false.

NotOneOf

Evaluates as true when FilterText does not match any of Values, otherwise false.

ScheduleJobType v2019.2+
A read-only property that shows the type of job assigned to a schedule. Used in REST - Schedules.
Enum Name
Report
This job runs a report.

Description

Batch

This job runs a batch report.

Email

This job handles the disposition of a Report or Batch job by sending the output as an e-mail.

Disk

This job handles the disposition of a Report or Batch job by saving the output to disk.

ScheduleRecurrenceType v2019.2+
A read-only property that shows the type of job recurrence assigned to a schedule. Used in REST - Schedules.
Enum Name
Description
Once
This schedule only runs once.
Daily

This schedule recurs daily.

Weekly

This schedule recurs weekly.

Monthly

This schedule recurs monthly.

Yearly

This schedule recurs yearly.

ScheduleManagerViewLevel
User

Enum Name
1

Numeric Value

Description
Filter schedules by current UserId parameter

Company

2

Filter schedules by current CompanyId parameter

All

3

Show all schedules

TreeShortcut
Used in the Storage Management System.

Default

Enum Name
0

Numeric Value

Description
The report will take the default action defined in the system's
configuration.

Run

1

The report will run in the Report Viewer

Export

2

The report will be exported

wrUserMessageType
Used when Displaying User Messages.
Enum Name

Numeric Value

Id

0

Text

1

Description
The user message will display the string associated with the Id in
the Language Files.
The user message will display the string message

wrUserPreferenceStorage
Used when setting the User Preference Storage Method setting programatically.
Enum Name

Numeric Value

Description
User preferences are stored in the user's local browser storage.

Cookie

0

ExternalInterface

1

This refers to a deprecated extensibility feature that is no longer
supported. It should not be used in new installations.

ServerEvent

2

User Preferences are stored and retrieved via Server Events.

None

3

Users cannot modify User Preference features, and the user
interface icon is hidden.

User Preferences are stored and retrieved via an External Interface.

Executing Reports with the API
Note
This version of the .NET API documentation is deprecated. A new version can be found at https://www.exagoaccess.com/api-docs/.
There are two different ways to use the Exago APIs to perform report execution. This guide discusses the main differences and provides
examples for both types in each API.
API Action is the most comprehensive way to run executions, and supports all types of reports. This is the only way to run
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composite reports such as Dashboards and Chained Reports. This method launches an Exago session into the browser via URL,
and thus usually requires the use of an Iframe. This also means that all interactive Report Viewer or ExpressView (v2016.3+)
features are supported.
GetExecute() executes reports on the back-end and returns bare HTML, JSON, CSV, or binary data. GetExecute supports noncomposite (Advanced, Express and CrossTab) reports and ExpressView (as of v20191.31+, 2019.2.19+ and v2020.1.5+). Using this
method you do not have to launch any visible instance of Exago for the user, and can simply use it as a calculation engine.

Overview
Launch Method

Supported Report Types

.NET Supported Output
Types

All types

Interactive Report Viewer, Dashboard Viewer,
ExpressView designer, or PDF, RTF, Excel, CSV

API Action

Redirect browser
frame to Exago
session URL

GetExecute

Data returned directly Advanced, Express,
to calling method
CrossTab, ExpressView*

REST Supported
Output Types

HTML, CSV, PDF, RTF, HTML, CSV, PDF, RTF,
Excel, JSON
Excel, JSON

* GetExecute() for ExpressView is supported in v20191.31+, 2019.2.19+ and v2020.1.5+ only.

API Action
API sessions in Exago have a property called action type, which determines what part of Exago should be launched when the session is
opened. Action types include executing a report, loading a report into the editor, loading a report into the scheduler, opening a section of
the UI, etc.
Note
API Action is also referred to as GetUrlParamString, because this is the general term for the methods which return the session redirect
URL.
To tell the session to execute a report, set the action type to ExecuteReport.
Actions which load reports, such as Execute or Edit, work on the active report object. This is another property that must be set. This is
done differently for each API: details are in the included examples.
Important
For security reasons, always set the action type and the active report explicitly. Although setting an active report defaults to execute,
if a report fails to load and an action has not been specified, Exago will launch into the full Web Application user interface. This could
cause users to have unintended levels of access.
Once you've finished setting the session variables, call GetUrlParamString(). This finalizes the session and creates a single-use URL
string. This is done differently for each API; details are in the included examples. The URL is used to direct a browser window or iFrame to
an Exago instance where the specified action takes place. The user can then interact with the report like normal.
See the following sections for examples. Variable names and arguments are placeholders.

.NET API
1. First create an API session and load a report object.
// a .net api object is a specific session; methods act on that session
WebReports.Api.Api netApi = new WebReports.Api.Api(appPath);
Report myReport = (Report)netApi.ReportObjectFactory.LoadFromRepository(reportPath);

2. Set the desired output type.
myReport.ExportType = wrExportType.Html;

3. Then save the report object back to the API.
netApi.ReportObjectFactory.SaveToApi(myReport);

4. Set the API action to execute.
netApi.Action = wrApiAction.ExecuteReport;

5. Finally, call GetUrlParamString to get the session URL.
// note: this terminates the session
string url = netApi.GetUrlParamString(homePage);

REST Web Service API
When using the REST Web Service API, the initialization call creates a session ID string, a required URL parameter in all subsequent
method calls. Note that the session URL is generated immediately, and altered dynamically as modifications are made to the session.
To use REST, create the session and pass the session variables. Take note of the sessionId and UrlParamString.
POST /sessions
Payload:
{
"Page": homePage,
"ApiAction": "ExecuteReport",
"ExportType": "Html",
"ReportSettings":
{
"ReportPath": reportPath
}
}

Response (some params omitted):
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{
"sid": sessionId,
"AppUrl": urlParamString
}

GetExecute
There are four provided GetExecute methods. Each return a different data representation of the report. Not every API supports every data
type; see the Overview for details.
GetExecuteHtml: Typically used for web viewing
GetExecuteCsv: Plain-text format readable by spreadsheet applications
GetExecuteData: Byte array of binary data
GetExecuteJson (v2016.3+): Typically used for asynchronous client-server communication
Since GetExecute does not require loading the Exago UI, calling GetUrlParamString is not required. Report interactivity is also not
supported when executing reports via the GetExecute functions. However, the following Server Events are triggered by GetExecute in order
to ensure that the data returned accurately reflects the report design:
OnReportExecuteStart
OnReportExecuteEnd
OnAfterReportExportSuccess
See the following sections for examples. Variable names and arguments are placeholders.

.NET
1. First create an API session and load a report object.
// a .net api object is a specific session; methods act on that session
WebReports.Api.Api netApi = new WebReports.Api.Api(appPath);
Report myReport = (Report)netApi.ReportObjectFactory.LoadFromRepository(reportPath);

2. Then call the appropriate GetExecute method for the desired data type.
string reportHtml = myReport.GetExecuteHtml();

REST Web Service API
When using the REST Web Service API, the initialization call creates a session ID string, which is a required URL parameter in all
subsequent method calls. Note that the session URL is generated immediately, and altered dynamically as modifications are made to the
session.
1. First create an API session. Take note of the session ID.
POST /sessions
Response (some params omitted):
{
"Id": sessionId
}

2. Then execute the selected report. Supported types are HTML, CSV, PDF, RTF, Excel, JSON.
POST /reports/execute/{type}?sid="sid"
Payload:
{
"ReportPath": "Inventory\Categories"
}

Sample Response:
Status: 200 OK
{
"ReportPath":
"ExportType":
"DataType":
"ExecuteData":
"IsError":
"ErrorList":

"Inventory\Categories",
"csv",
"Data",
"\"Categories\"\r\n\"Seafood\"\r\n\"Produce\"\r\n\"Beverages\"\r\n",
false,
null

}

For more information, see REST — GetExecute.

JavaScript API
The Exago JavaScript (JS) API allows Exago functionality to be embedded directly into HTML <div> containers.
<div>s can inherit code and styles from the host application. Since CSS cascades down to Exago as well as up to the parent app, a
single base of styles can be used, rather than separate ones for the host app and for Exago. The Exago DOM is accessible from the host
application, so custom scripting is possible without being limited to Action Events.

Background
The JS API implements asynchronous calls to Exago BI in the client browser. Besides the advantages of embedding in <div>s and
interacting programmatically, the API allows for multiple calls without needing to generate a new session for each one. As sessions are
created once per page load, this can increase the feeling of responsiveness in the host application.
As the JS API runs on the client-side, it is not standalone. Session objects are still required to be generated, either with the .NET or REST
Web Service API. Session objects must include any relevant user permissions and configuration settings.
A parameter called the ApiKey encodes the session object in a string, which is passed from the server-side API to the JS API. The JS
API then initializes a JS API object, which is analogous to an Exago user session.
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Note
JS API objects are static and single-use. They cannot persist between page loads, and multiple JS API objects cannot be active on the
same page.
The JS API object provides a set of functions that are used to implement elements of Exago BI functionality.
Note
API Actions and active reports should not be set when using the JS API as doing so may produce errors within the API session. Any
desired actions, such as executing a report or editing a report on the page, should be done using the appropriate JavaScript API
functions instead.

Setup and Configuration
These steps describe how to configure the environment to use the JS API, as well as how to implement it in an application.
1. Create the Session
2. Instantiate the JS API object

1. Create the Session
1. Use the .NET API or REST Web Service API to set up the session. Make all configuration changes there, as these settings cannot
be changed once the JS API object is loaded.

.NET
Instantiate an API object with one of the available constructors.
Example:
Api api = new Api("appPath");

REST
The Id is the session ID (sid) that will be needed for subsequent REST Web Service API calls. Save the value of the ApiKey
property, as it will be needed to instantiate the JS API object in step 2.
POST http://server/webservice_virtual_path/rest/sessions Payload:
{
"AppUrl": "UrlParamString",
...
"Id": "1234-5678-9012-3456",
...
}

2. Set the WebAppBaseUrl property to the virtual directory where Exago BI is installed:

.NET
api.SetupData.WebAppBaseUrl = "http://server/Exago/";

REST
Do either one of the following:
PATCH /Rest/Settings?sid={sid}. This method requires the session be established first in step 1. Payload:
{ "WebReportsBaseUrl" : "http://server/Exago" }

Add to the web service config file ({WebService}/Config/WebReportsApi.xml):
<webreportsbaseurl>http://server/Exago/</webreportsbaseurl>

In contrast to the .NET and REST Web Service APIs, the JavaScript API has no concept of an Active Report or an API Action.
Instead, the action and report are specified by calling the individual JS function calls.
Note
A side-effect of this is that per-session report changes cannot be made in memory, since the JS API function can only act on
saved reports. Changes will need to be saved to storage before execution.
3. Once the session is ready, get the ApiKey if not saved in step 1.1 (skip this step if you already have the ApiKey). This encodes the
session settings to pass to the JS API. This API key will need to be passed to the page as it will be used in client side JavaScript
calls.

.NET
return api.GetApiKey();

REST
GET Rest/Sessions/{sid}, then get the ApiKey property from the response object:
{
...
"ApiKey": "encodedAlphanumericApiKey"
}

2. JS API Object
1. Load the JS API library into the host web application via a <script> tag:
<script src="http://server/Exago/WrScriptResource.axd?s=ExagoApi"></script>
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Note
WrScriptResource.axd is not a file on the file system, it is a virtual file that contains the necessary scripts to load the API.
"http://server/Exago" is the URL to the virtual path of your Exago web application.
2. Using the ApiKey, instantiate an ExagoApi JavaScript API object. There are two constructors available:

Constructor 1
var api = new ExagoApi(ExagoBaseURL, ApiKey, onLoadCallback, [showErrorDetail]);

ExagoBaseURL — URL to the installation of Exago BI
ApiKey — key generated when the session was created
onLoadCallback — function to execute once the JS API has been fully loaded and is ready for use
Optional: showErrorDetail — set to true to see more detailed application error messages. (Default: False).
Example
new ExagoApi("https://exago.example.com", "tCq0n6dMl6kQEbgofptKsdinMINJpqsClF5kVnzz2wcgcEfGjYE8eEeKjR3NBkjayZY%2fbs7RLTcpH9EtDyhRBA%3d%3d", () => {
console.log("Exago is ready for further API calls!");
}, true);

Constructor 2 v2019.1.22+ v2019.2.8+
This constructor contains an additional OnError() callback function. The definitions below are written using TypeScript syntax.
var api = new ExagoApi(options: wrExagoApiOptions);

This constructor takes one argument, an object of type wrExagoApiOptions. wrExagoApiOptions objects are defined by the
following interface:
interface wrExagoApiOptions {
WebEndpoint: string;
ApiKey: string;
OnLoad: () => void;
OnError?: (err: wrJsApiError) => void;
OnDisposeContainer?: (container: HTMLElement) => void;
ShowErrorDetail?: boolean;
IncludeCredentials?: boolean;
}

WebEndPoint — URL to the installation of Exago BI
ApiKey — key generated when the session was created
OnLoad() — function to execute once the JS API has been fully loaded and is ready for use
OnError() — optional: function to execute if the loading of the JS API fails. Takes one argument, an object of type
wrJsApiError which simply represents an error message if loading of the API fails. A wrJsApiError object is defined by the
following interface:
interface wrJsApiError {
Message: string;
}

OnDisposeContainer — optional: function to execute when the <div> containing Exago is no longer needed and can be
disposed. Takes one argument of type HTMLElement object, the ID of the containing <div>. This is the recommended way
of passing this function to the ExagoApi object. For more information, see Disposing Containers below.
ShowErrorDetail — optional: true if full error messages should be displayed to the end user in the browser, false if they
should be saved to the log only
IncludeCredentials v2019.2.29+ v2020.1.13+ v2021.1.1+ — optional: determines the credentials mode to use for any XHR
or fetch request.
Request Type
IncludeCredentials Value
Result
fetch
omitted or true
credentials property of the Request object is set to include
fetch

false

credentials property of the Request object is set to sameorigin

XHR

true

withCredentials property of the XMLHttpRequest object is
set to true

XHR

false

withCredentials property of the XMLHttpRequest object is
set to false

OnError()
The OnError() callback function will be called under the following conditions:
Any HTTP 4xx or 5xx status code is returned from any XHR or fetch request involved with initialization
There are several use cases for the OnError() callback function, such as (but not limited to):
An expired ApiKey is passed
An incorrect WebEndPoint is passed
In a cross-origin environment, cookieless sessions are not enabled
The Exago application server is down
Example
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new ExagoApi({
WebEndpoint: "https://exago.example.com",
ApiKey: "tCq0n6dMl6kQEbgofptKsdinMINJpqsClF5kVnzz2wcgcEfGjYE8eEeKjR3NBkjayZY%2fbs7RLTcpH9EtDyhRBA%3d%3d",
ShowErrorDetail: true,
OnLoad: () => {
console.log("Exago is ready for further API calls!");
},
OnError: () => {
console.log("There was an error loading Exago");
},
});

Note
ApiKeys are single-use. Multiple instances are not supported nor necessary. Functions can be called against the object for the duration
of the session.

Functions
The following functions are available for loading and managing Exago functionality.
Note
Functions can only be used once the JS API is fully loaded. Wait for onLoadCallback() or OnLoad() to indicate that the API is
ready.
Caution
Due to a known issue, the callbacks mentioned in the following JavaScript API functions only work as described as of v2018.1.12+ or
v2018.2+.

LoadFullUI(container)
Load the full web application user interface in to a <div> container.
Argument
container

Description
<div> container to place the user interface
into

Note
The Full UI being loaded will block almost all other actions, so while the Full UI is displayed on screen, the host application cannot
perform any other Exago functions such as executing reports or creating new reports.

ExecuteReport(container, exportType, reportPath, [udfOrOptions],
[updateCallback], [errorCallback])
Execute a report or dashboard to a specific output type in a defined container.
container

Argument

Description
Div container to place the executed report into

exportType

html|pdf|csv|excel|rtf

reportPath

Relative path to report to execute
Example: "MyFolder\\MyReport"
Optional: Report UDF information for use within folder management or a Report Options object for
modifying reports before execution
Note

udfOrOptions v2019.1+

If the wrJsApiExecuteReportOptions object is passed to this parameter, the updateCallback and
errorCallback parameters will be ignored and ExecuteReport will change its behavior based upon
the contents of the object being passed. For more information, please see the Interfaces section
below and the JavaScript API: Filters and Parameters article.
Optional: Callback to execute when the execution status changes, called when the report execution is
starting and again when it is ready to be viewed
Parameter ‘container’: The same container HTMLElement that was passed in to the call
Parameter ‘updateType’: The type of update as a string, either

updateCallback (container,
updateType)

The parameter 'updateType' will assume one of these string values:
“executionstart”: The report has been loaded and is starting execution, or
“initialcontentload”: The execution viewer has been loaded and populated with at least the first
page of the report, if executing an Advanced Report or ExpressView to HTML)
Note: This callback will occur once for each status change unless errors occur.
Optional: Callback to execute in the event an execution blocking error occurs

errorCallback (container,
errorMessage) => string

Parameter ‘container’: The same container HTMLElement that was passed in to the call
Parameter ‘errorMessage’: The error text
Return value: See errorCallback return values below.

ExecuteStaticReport(exportType, reportPath, udfOrOptions , successCallback,
[errorCallback])
Execute a report, and return its output to the successCallback function. Report is not interactive.
Note
This function is only compatible with Advanced Reports.
Argument

Description

exportType

html|pdf|csv|excel|rtf|json

reportPath

Relative path to report to execute
Example: "MyFolder\\MyReport"
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Report UDF information for use within folder management or a Report Options object for modifying
reports before execution
Note

udfOrOptions v2019.1+

If the wrJsApiExecuteStaticReportOptions object is passed to this parameter, the
sucessCallback and errorCallback parameters will be ignored and ExecuteReport will change its
behavior based upon the contents of the object being passed. For more information, please see the
Interfaces section below and the JavaScript API: Filters and Parameters article.
Callback to execute when execution request returns
Parameter 'executionData': a string containing the executed report’s data is passed as a
parameter, whose formatting depends on the specified exportType. If the export type is “html”,
“csv”, or “json”, the returned string will contain all of the data in the corresponding format. If the
export type is “pdf”, “excel”, or “rtf”, the returned string will be partial URL to the file, e.g.
“ExecuteExport.aspx?eid=…”. See the below example for prefixing the returned partial URL with
the base address.

successCallback
(executionData)

Optional: Callback to execute in the event an error occurs.
errorCallback (errorMessage)

Parameter 'errorMessage': The error text.
Return value: See errorCallback return values below.

const container = ...
const exportType = ...
const reportPath = ...
api.ExecuteStaticReport(exportType, reportPath, null,
(executionData) =>
{
if (exportType == "excel" || exportType == "rtf" || exportType == "pdf")
container.innerHTML = "<iframe src="' + api.GetBaseAddress() + executionData + '"></ iframe>";
else
container.innerHTML = executionData;
},
(errorMessage) =>
{
container.innerHTML = errorMessage;
});

ScheduleReportWizard(container, reportPath, [udf], [errorCallback])
Open the schedule report wizard for a report.
Argument
container

Description
Div container to place the scheduled report wizard into

reportPath

Relative path to report to schedule
Example: "MyFolder\\MyReport"

udf

Optional: Report UDF information for use with folder management
Optional: Callback to execute in the event an error occurs, such as the
scheduler being disabled

errorCallback
(container,
errorMessage) => string

Parameter ‘container’: The same container HTMLElement that was
passed in to the call
Parameter ‘errorMessage’: The error text
Return value: see errorCallback return values below.

ScheduleReportManager(container, [errorCallback])
Open the schedule report manager.
Argument
container

Description
Div container to place the scheduled report manager into
Optional: Callback to execute in the event an error occurs, such as the scheduler being disabled

errorCallback (container,
errorMessage) => string

Parameter ‘container’: The same container HTMLElement that was passed in to the call
Parameter ‘errorMessage’: The error text
Return value: see errorCallback return values below.

LoadReportTree(successCallback, [errorCallback])
Load the report tree as JSON, returned to the successCallback method.
Argument

Description
Callback to execute once the report tree has been loaded.

successCallback (reportTree)

Parameter 'reportTree': A JSON object representing the report tree.
Optional: Callback to execute in the event an error occurs

errorCallback (errorMessage)

Parameter ‘errorMessage’: The error text

EditReport(container, reportPath, [udf], [errorCallback])
Load the report designer for a report.
container

Argument

Description
Div container to place the report designer into

reportPath

Relative path to report to edit
Example: "MyFolder\\MyReport"

udf

Optional: Report UDF information for use with folder management
Optional: Callback to execute if the report fails to load

errorCallback (container,
errorMessage) => string

Parameter ‘container’: The same container HTMLElement that was passed in to the
call
Parameter ‘errorMessage’: The error text
Return value: see errorCallback return values below.
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NewReport(container, reportType)
Load the report designer for a new report.
Argument
container

Description
Div container to place the report designer into

reportType

advanced|express|dashboard|chained|expressview

DisposeContainerContent(container)
Disposes the contents of a container and resets the system state to be aware of what containers are open.
Argument
Description
container Div container to dispose

DisposePage()
Disposes the contents of a page, removing any event listeners added to the page and performing other cleanup necessary for complete
removal of the ExagoAPI instance. After calling DisposePage(), the ExagoAPI instance should be considered "closed." Any new Exago
JavaScript API calls must be performed on a new ExagoAPI instance.

IsAllowedReportType(reportType)
Returns whether or not a specified report type is allowed for the session.
Tip
CrossTab Reports are a type of Advanced Report.
Argument
reportType

Description
advanced|express|dashboard|chained|expressview

GetAllowedReportTypes()
Returns an array of the report types allowed for this session.

Example:
function RunReportJS() {
var container = document.getElementById("ExagoDiv");
api.ExecuteReport(container, "html", "Examples\\ClientReport");
}

Note
Container divs must be empty or disposed before loading. Additionally, you should specify size and position constraints for each div.

div#ExagoDiv {
width: 1200px;
height: 600px;
position: relative;
}

Disposing Containers
It is important to properly dispose of containers when they are finished being used by explicitly calling the
DisposeContainerContent(container) method.
Optionally, an OnDisposeContainer callback can be defined that will execute when a container has been disposed either implicitly or
explicitly. This allows the host application to safely reset the container to whatever state necessary, or remove the container from the page
entirely. When a user encounters an error that prevents the requested action, e.g., ExecuteReport(...), the container will auto-dispose and
execute the OnDisposeContainer callback if one is defined.
Example:
api.OnDisposeContainer = function(container) {
container.parentElement.removeChild(container);
};

Disposing Pages v2018.2+
Once an ExagoAPI instance has been instantiated, DisposePage() must be called before instantiating subsequent ExagoAPI instances.
DisposePage() will dispose the contents of an entire page, thereby disposing each instantiated container. Furthermore, it will remove any
event listeners added to the page by the ExagoApi instance and perform other cleanup necessary for complete removal of the ExagoAPI
instance.
After calling DisposePage(), the ExagoAPI instance should be considered "closed." Any new Exago JavaScript API calls must be
performed on a new ExagoAPI instance.

errorCallback return value
Whenever an error occurs that prevents the JS API action from updating a container (such as an undefined report name in a call of
ExecuteReport), the following will happen:
If errorCallback is not defined, an alert dialog will appear with the error message (or a placeholder error message, if the URL
parameter 'showerrordetail' is set to false).
If errorCallback is defined, it will first be called. If errorCallback returns a string (either the original error message or a custom
message), an alert dialog will appear with the given string, or a placeholder error message if the URL parameter 'showerrordetail' is
set to false.
If errorCallback does not return a string, or the string is empty, no alert dialog will be shown and the DisposeContainerContent()
method will run immediately.
Clicking on the error dialog’s dismiss button will close the dialog and call DisposeContainerContent(). The container’s content will be
closed, the inner HTML will be cleared, and the OnDisposeContainer callback will be called.

Interfaces v2019.1+
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The following interfaces are available for managing and modifying report settings at runtime.

wrJsApiExecuteReportOptions
Allows information for the modification of filters and parameters of a report to be passed to the udfOrOptions parameter of the
ExecuteReport function. If this interface is passed to ExecuteReport the updateCallback and errorCallback parameters of this function
will be ignored; however, they may be specified within this interface if necessary.
Note
All properties in the wrJsApiExecuteReportOptions object are optional.
Property

Description

Udf

The UDF information used to load the report if required

UpdateCallback
(container, updateType)
=> void

Callback to execute when there has been an update in the status of the
report execution

ErrorCallback (container, Callback to execute in the event an error occurs
errorMessage) => string
NewFilters

An array of wrJsApiExecuteReportFilter objects defining the new filters
to add to the report before execution begins
An array of prompting filter values to modify before execution begins

PromptingFilterValues

When executing an Advanced Report, an array of
wrJsApiPromptingFilterValue objects should be passed
When executing a Dashboard or Chained Report, an array of
wrJsApiCompositePromptingFilterValue objects should be
passed
Note: It is assumed that the value provided by the given item will be the
final value for the filter before the report executes. As such, any filter with a
value modified by an item in this array will not prompt the user upon
execution.

Parameters

A list of wrJsApiExecuteReportParameter objects defining the nonhidden parameters to add or modify before execution begins

wrJsApiExecuteStaticReportOptions
Allows information for the modification of filters and parameters of a non-interactive report to be passed to the udfOrOptions parameter of
the ExecuteStaticReport function. If this interface is passed to ExecuteStaticReport the successCallback and errorCallback
parameters of this function will be ignored; however, they may be specified within this interface if necessary.
Note
All parameters in the wrJsApiExecuteStaticReportOptions object are optional.
Parameter

Description

Udf

The UDF information used to load the report if required

SuccessCallback
(execution) => void

Callback to execute when the report execution succeeds

ErrorCallback
(errorMessage) => string Callback to execute in the event an error occurs
NewFilters

An array of wrJsApiExecuteReportFilter objects defining the new filters
to add to the report before execution begins
An array of prompting filter values to modify before execution begins

PromptingFilterValues

When executing an Advanced Report, an array of
wrJsApiPromptingFilterValue objects should be passed
When executing a Dashboard or Chained Report, an array of
wrJsApiCompositePromptingFilterValue objects should be
passed
Note: It is assumed that the value provided by the given item will be the
final value for the filter before the report executes. As such, any filter with a
value modified by an item in this array will not prompt the user upon
execution.

Parameters

A list of wrJsApiExecuteReportParameter objects defining the nonhidden parameters to modify before execution begins

wrJsApiExecuteReportFilter
Defines the necessary information for a new filter. To be passed to wrJsApiExecuteReportOptions in order to add new filters to a report
prior to execution.
Property

Description

FilterText

The filter string (e.g., "Employees.FirstName" or
"=MonthName({Employees.BirthDate})")
Note: This must take the form of a data field, formula, or parameter.
The condition used to match the data values to the specified filter value or
values
type wrJsApiFilterOperator =

Operator

"EqualTo" (Default)
"NotEqualTo"
"LessThan"
"LessThanOrEqualTo"
"GreaterThan"
"GreaterThanOrEqualTo"
"StartsWith"
"NotStartsWith"
"EndsWith"
"NotEndsWith"
"Contains"
"NotContains"
"Between"
"NotBetwen"
"OneOf"
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"NotOneOf"
Select whether or not to prompt the user for a value upon report execution

PromptFlag

AndFlag

Defaults to False
Set to True to insert an AND condition after this filter, set to False to insert
an OR condition after this filter
Defaults to True
Select whether or not to group this filter with the filter following it

GroupWithNextFlag

Defaults to False
The values to add to the filter

Values

Note: Can be a string, number, or date, or an array of any of these types if
multiple values are required (e.g., for "Between" and "OneOf" filters).
Note: All date values must be passed as JavaScript Date objects (e.g., var
date = new Date('December 17, 1995 03:24:00');.
The name of the filter

Title

Defaults to an empty string ("")

wrJsApiPromptingFilterValue
Defines the necessary information to pass a value to a prompting filter for Advanced Reports. To be passed to
wrJsApiExecuteReportOptions in order to set prompting filter values of a report prior to execution.
Property

Description

FilterText

The filter text used to identify which filter to modify

Index

Optional: In the case of multiple filters having the same FilterText, the
index into the matching group of filters
Defaults to 0 (zero)
Optional: Reassign the condition used to match the data values to the
specified filter value or values
type wrJsApiFilterOperator =

Operator

"EqualTo"
"NotEqualTo"
"LessThan"
"LessThanOrEqualTo"
"GreaterThan"
"GreaterThanOrEqualTo"
"StartsWith"
"NotStartsWith"
"EndsWith"
"NotEndsWith"
"Contains"
"NotContains"
"Between"
"NotBetwen"
"OneOf"
"NotOneOf"
The values to add to the filter

Values

Note: Can be a string, number, or date, or an array of any of these types if
multiple values are required (e.g., for "Between" and "OneOf" filters).
Note: All date values must be passed as JavaScript Date objects (e.g., var
date = new Date('December 17, 1995 03:24:00');.

wrJsApiCompositePromptingFilterValue
Defines the necessary information to pass a value to a prompting filter for Dashboards and Chained Reports, also known as "composite
reports". To be passed to wrJsApiExecuteReportOptions in order to set prompting filter values of a report prior to execution.
Property

Description

Index

The index of the filter as it appears in the prompting UI, beginning at 0
(zero) and increasing by 1 for each following filter
Optional: Reassign the condition used to match the data values to the
specified filter value or values
type wrJsApiFilterOperator =

Operator

"EqualTo"
"NotEqualTo"
"LessThan"
"LessThanOrEqualTo"
"GreaterThan"
"GreaterThanOrEqualTo"
"StartsWith"
"NotStartsWith"
"EndsWith"
"NotEndsWith"
"Contains"
"NotContains"
"Between"
"NotBetwen"
"OneOf"
"NotOneOf"
The values to add to the filter

Values

Note: Can be a string, number, or date, or an array of any of these types if
multiple values are required (e.g., for "Between" and "OneOf" filters).
Note: All date values must be passed as JavaScript Date objects (e.g., var
date = new Date('December 17, 1995 03:24:00');.
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wrJsApiExecuteReportParameter
Defines the necessary information to add or modify non-hidden parameters. To be passed to wrJsApiExecuteReportOptions in order to
add or set parameter values of a report prior to execution.
Property

Description
The name of the non-hidden parameter to modify

Name
Note: This value must not contain the '@' symbol.
The value to give to the parameter
Value

Note: Can be a string, number, or date depending on the parameter's
datatype.
The text that will display when prompting the user for a value

PromptText

Note: If this field is set to a null value, the parameter will be considered
non-prompting.

JavaScript API: Filters and Parameters
As of v2019.1, runtime filters and parameters can now be modified via the JavaScript API prior to a report's execution. New behaviors have
been defined for the for ExecuteReport function in order to allow the addition of new filters, the modification of existing filters, and the
addition or modification of parameters. These modifications only apply at runtime and do not alter report definitions.
Important
Review the JavaScript API article for in depth descriptions of the Functions and Interfaces utilized by these features.
For the code snippets in the following sections, please assume the following framework:
function executeReport() {
var reportPath = document.getElementById('exagoReport').value;
var exportSelector = document.getElementById('execSelection');
var exportType = exportSelector.value;
var containerId = document.getElementById('containerSelection').value;
var container = document.getElementById('container' + containerId);
/**

Adding a New Filter
Modifying an Existing Prompting Filter
Adding Parameters and Modifying Parameter Values
**/
var reportOptions =
{
Udf: null,
UpdateCallback: updateCallback,
ErrorCallback: errorCallback,
//For adding new filters to a report
NewFilters: filters,
//For modifying prompting filters in Advanced Reports
PromptingFilterValues: promptingFilters,
//For modifying prompting filters Dashboards and Chained Reports
//PromptingFilterValues: promptingCompositeFilters,
//For adding or modifying the non-hidden parameters of a report
Parameters: parameters
};
api.ExecuteReport(container, exportType, reportPath, reportOptions);
}

Adding a New Filter
To add runtime filters to a report via the JavaScript API:
1.
2.
3.
4.

Define the report filter objects by specifying their FilterText, Operator, Values, and other necessary information.
Add these definitions to an array of report filters.
Reference this array in the NewFilters property of the report options interface.
Call ExecuteReport referencing the report options parameter.

For a full list of properties and a description of this feature, please see the wrJsApiExecuteReportFilter section of the JavaScript API
article.
Please consider the following when adding a new filter via the JavaScript API:
FilterText may not be null
FilterText must take one of the following forms:
a data field (Employees.LastName)
a function (=Month({Employee.BirthDate}))
a parameter (@parameterName@)
If the Operator type is OneOf or NotOneOf, then Values must be an array. If the type is Between or NotBetween, then the
array may only be a length of two.
Filter functions, like DayAfterTomorrow(), may not be used as a value.
Note
Currently, runtime filters may not be added to Dashboards or Chained Reports via the JavaScript API.

Example
The following code sample creates two runtime filters on the Employees data category.
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var filters = [];
var filter =
{
FilterText: "Employees.EmployeeID",
Operator: "Between",
PromptFlag: true,
AndFlag: true,
GroupWithNextFlag: false,
Values: [2, 5],
Title: "Employee Id"
};
filters.push(filter);
filter =
{
FilterText: "=Year({Employee.HireDate})",
Operator: "GreaterThanEqualTo",
PromptFlag: false,
AndFlag: true,
GroupWithNextFlag: false,
Values: 2010,
Title: "Employee Hire Date"
};
filters.push(filter);

Modifying an Existing Prompting Filter
To modify and set the values for existing prompting filters on a report via the JavaScript API:
1.
2.
3.
4.

Define the prompting filter objects by specifying their FilterText, Index, and Values.
Add these definitions to a designated array of prompting filters.
Reference this array in the PromptingFilterValues property of the report options interface.
Call ExecuteReport referencing the report options parameter.

Note
Only prompting filters may be modified prior to report execution. Non-prompting filters cannot currently be modified via the JavaScript API.
For a full list of properties and a description of this feature, please see the wrJsApiPromptingFilterValue and
wrJsApiCompositePromptingFilterValue sections of the JavaScript API article.
Note
Any prompting filter with a value set via the JavaScript API will be treated as non-prompting and will not appear in the prompting Filters
menu upon report execution.

Examples
The following sections detail how to modify prompting filters on Advanced Reports and non-interactive filters on Dashboards and
Chained Reports:

Modifying Prompting Filters on an Advanced Report
For the following example, assume that the following existing prompting filters on an Advanced Report:
Employees.LastName Starts With 'D' AND
Employees.ID Is Between '2' And '5' AND
Employees.LastName Is Not Equal To 'Dodsworth'

These filters are ordered as they appear in the Filters menu in the Advanced Report designer. FilterText values are treated as the
primary identifier of each filter. The Index value serves as a secondary identifier, increasing its value at each instance of identical
FilterText. The following list details filter indexing for Advanced Reports:
Employees.LastName [Index: 0]
Employees.ID
[Index: 0]
Employees.LastName [Index: 1]
/** Continuing the example: ************************/
=MonthName({Employees.BirthDate}) [Index: 0]
Employees.ID
[Index: 1]
Employees.BirthDate [Index: 0]
Employees.LastName [Index: 2]

Note
If the Index value is left null, the value of 0 (zero) will be passed by default.
The following code modifies and sets the values for two existing prompting parameters on a report prior to its execution. It sets the value of
"Davolio" to the second instance of the Employees.LastName filter and modifies the Operator of the first instance of the
Employees.EmployeeID filter.
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var promptingFilters = [];
var promptingFilter =
{
FilterText: "Employees.LastName",
Index: 1,
Values: "Davolio"
};
promptingFilters.push(promptingFilter);
promptingFilter =
{
FilterText: "Employees.EmployeeID",
Index: 0,
Values: [2, 5],
Operator: "NotBetween"
};
promptingFilters.push(promptingFilter);

Modifying Prompting Filters on a Dashboard or Chained Report
For the following example, assume the following existing prompting filters on the Dashboard or Chained Report:
=Year({Employees.HireDate}) = '1996' AND
Employees.FirstName Is Not Equal To 'Janet' AND
Employees.Title = 'Sales Representative'

These filters are ordered as they appear in the Filters menu on the composite report. However, within composite reports, Index values are
the primary identifiers of each filter and are set on a global scale. The Index value increases for each new filter on a composite report. The
following list details filter indexing for composite reports:
=Year({Employees.HireDate}) [Index: 0]
Employees.FirstName
[Index: 1]
Employees.Title
[Index: 2]
/** Continuing the example
Employees.ID
Employees.BirthDate
Employees.FirstName

************************/
[Index: 3]
[Index: 4]
[Index: 5]

Note
Index values for composite reports do not default to 0 (zero) and are a required field for each prompting filter.
The following code modifies and sets the values for three existing prompting parameters on a composite report prior to its execution.
var promptingCompositeFilters = [];
var promptingCompositeFilter =
{
Index: 0,
Values: [1996, 2005],
Operator: "Between"
};
promptingCompositeFilters.push(promptingCompositeFilter);
promptingCompositeFilter =
{
Index: 1,
Values: ["Nancy"],
};
promptingCompositeFilters.push(promptingCompositeFilter);
promptingCompositeFilter =
{
Index: 2,
Values: "Sales Manager"
};
promptingCompositeFilters.push(promptingCompositeFilter);

Adding Parameters and Modifying Parameter Values
New parameters may be added to a report and existing non-hidden parameter values may be modified prior to report execution via the
JavaScript API. For a full list of properties and a description of this feature, please see the wrJsApiExecuteReportParameter section of
the JavaScript API article.
To add a new parameter to a report:
The Name value must be unique and cannot be identical to the names assigned to existing non-hidden parameters or to reserved
parameters. If the Name value is identical to an already existing non-hidden parameter, then this parameter's value will be
overwritten.
The Value being assigned to the new parameter must be a number, string, or date. It may not be an array of multiple values.
The PromptText value set represents the text that will display when prompting the user for a value. If PromptText is set to a null
or empty string value, the parameter will be set to non-prompting. Otherwise, the parameter will prompt the user for input upon
report execution.
Note
For more information on parameters and a list of reserved parameters please see the Parameters article.
To modify the value of an existing non-hidden parameter:
The Name value must be identical to an existing non-hidden parameter on the report.
The Value being assigned to the parameter must be a number, string, or date, and must match the existing parameter's datatype.
It may not be an array of multiple values.
The PrompText value set represents the text that will display when prompting the user for a value. If PromptText is set to a null
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or empty string value, the parameter will be set to non-prompting. Otherwise, the parameter will prompt the user for input upon
report execution.
Note
Modifying parameters via the JavaScript API will overwrite existing parameters at the application/system level for that specific report
execution. For example, if an existing prompting parameter is modified to be non-prompting, it is equivalent to setting this parameter to
be non-prompting within the Admin Console.

Example
The following code will add two parameters. In this example, the first parameter, @FirstName@, will prompt the user with the specified
prompting text, while the second parameter, @Id@, will be non-prompting.
var parameters = [];
var parameter =
{
Name: "FirstName",
Value: "Anne",
PromptText: "Enter your first name"
};
parameters.push(parameter);
parameter =
{
Name: "Id",
Value: 9,
PromptText: ""
};
parameters.push(parameter);

JavaScript API: Report and Dashboard Execution Timing
As of v2019.1.3+, Exago BI exposes a JavaScript API that may be invoked in the browser to execute reports and dashboards and retrieve
information about how long they take to run. This makes it easier to do benchmarking, especially for dashboard executions where a test
would need to wait until the last tile is finished loading.
Note
All report types and execution formats are supported in this API.
wrWebReportsCtrl.ExecuteReport now returns a Promise that resolves with the class that controls the given execution (one of
wrChainedExecuteClass, wrDashboardDesignCtrl, wrExecuteClass, wrExpressViewDesignCtrl). Each of these classes
exposes the Timing property, which is a Promise that resolves when execution timing information has finished being collected for the
given execution.
const executor = await wrWebReportsCtrl.ExecuteReport("Reports\\Report", "html");
await executor.Timing; // Evaluates to { load: 5243 }

The Timing property resolves with an object describing timing information about the report or dashboard execution:
{
load: 5243
}

Returns the time (in milliseconds) it took for the report or last dashboard tile to finish loading.

Cross-Origin Embedding of Exago
When a user enters Exago BI, the application creates a session in order to preserve the user's working state and environment while they
engage with it. The session information is stored on the web application server or state server (depending on the network configuration).
Whenever requests are made the user's browser sends a unique, randomly generated ID to the web server in order to authenticate the user
and preserve the connection between user and session.
By default, this session ID is stored as a browser cookie. However, when embedding Exago BI in a cross-origin environment (where the
Exago server and host application are referred to by different protocols, domains or ports) cookies are considered a potential attack vector
for cross-site scripting. Most modern web browsers prevent embedded content from separate origins from using cookies without additional
configuration to explicitly allow this behavior safely.
Consider these three scenarios for embedding Exago in a host application:
Exago and Host Application are referenced by the same origin (not covered by this article)
Exago and Host Application are referenced by different origins, using Cross-Origin Resource Sharing with cookies (recommended)
Exago and Host Application are referenced by different origins, using cookieless sessions (not recommended)

Cross-Origin Resource Sharing (CORS) with Cookies
Important
When using cookies, Exago must be accessed via HTTPS in a CORS environment.
If the Exago BI application is being accessed over a network, the Exago web server must be configured to allow cross-origin requests
from the embedding host application.
By default, a web application making a request for content that originates from a remote server sends a cross-origin HTTP request. For
security reasons, browsers restrict these types of requests when they originate from scripts.
Important
When using the JavaScript API with versions prior to v2019.1.23, v2019.2.9 in a CORS environment, cookieless sessions must be used.
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To permit content to be accessed by whitelisted resources, you can configure the Exago web server to send a Access-Control-Allow-Origin
and Access-Control-Allow-Credentials headers to the calling server.

v2019.2.29+, v2020.1.13+, v2021.1.1+
As of the version numbers listed above, two new Application Settings elements, AccessControlAllowCredentials and
CorsAllowedOrigins have been added to the Web Application's appSettings.config file. These new nodes are the only supported
way of adding Access-Control-Allow-Origin and Access-Control-Allow-Credentials for new installations.
Setting the headers in the web server's configuration is no longer recommended. However, that method will continue to function for existing
clients upgrading from previous versions.
Review the Web Application appSettings.config section of the Application Settings article for full details on setting these headers.

pre-v2019.2.29, v2020.1.13, v2021.1.1
Access-Control-Allow-Origin should be set to a single domain that matches the domain of the page in which Exago is embedded. For
example:
Access-Control-Allow-Origin: hostapp.server.com
Access-Control-Allow-Credentials: true

In IIS, this is either set in the HTTP Response Headers or added manually to the web.config file.
In Apache, the following lines should be added to all relevant .conf files:
Header set Access-Control-Allow-Origin "hostapp.server.com"
Header set Access-Control-Allow-Credentials: "true"

In NGINX, the following line should be added inside the location /Exago/ {...} section of the "exago" NGINX site configuration file:
add_header 'Access-Control-Allow-Origin' 'hostapp.server.com';
add_header 'Access-Control-Allow-Credentials' 'true'

Cookieless Sessions
Important
As of Exago v2019.1.23+, v2019.2.9+ the use of cookieless sessions is not recommended when Exago is hosted over a secure
connection (HTTPS). Use Cross-Origin Resource Sharing (CORS) with Cookies instead.

Enable Cookieless Sessions
Note
This article references <WebApp>\as a placeholder for the application's install location. The default install locations are /opt/Exago/
on Linux and C:\Program Files\Exago\ExagoWeb\ on Windows; however, these directories may be changed during installation.
To enable cookieless sessions, locate the following line in the <WebApp>\web.config file and set the cookieless attribute to true:
<sessionState mode="InProc" cookieless="true" timeout="20" />

Cookieless sessions work to preserve state by appending the session ID to the URL string itself, which is used to connect to the web
server. For example, a standard application URL generated by the server API after creating a session looks similar to the following:
//ExagoBI/ExagoHome.aspx?sn=0

With cookieless sessions enabled, the session ID is added to the URL, for example:
//ExagoBI/(S(rim43x0e3cz2hf4sjw24ezdk))/ExagoHome.aspx?sn=0

This has no direct implications for the embedding process into the host application.
Important
In Linux environments, a patched System.Web.dll Mono library is necessary when using cookieless sessions. This patched DLL is
installed when the Exago Linux Installer is executed, or it can be installed using our patch script. Exago only supports specific versions
of Mono, review Installing Exago on Linux for details.

Secured Authentication
When the web application server is exposed to the internet or any insecure public network or intranet, you need to enable secured
authentication to prevent unauthorized access.
Because the session ID is passed as a part of the URL, it can be used by malicious third parties to send unauthorized requests to the web
server. Secured authentication causes the web server to require a secondary security token in order to authenticate the session. This does
not require any additional effort on the part of the end-user.
To enable secured authentication, edit the <WebApp>\appSettings.config file and add the following line:
<add key="useSecurityToken" value="True" />

The server API generates a security token with the session and embeds it into the page markup. It is sent with every client request as a
part of the payload. When using a secured connection, the payload is encrypted, thus making it nearly impossible for a malicious party to
derive the token.
Caution
Unsecured connections will compromise any security intended by the use of secured authentication. If the payload is unencrypted, the
token can be easily intercepted by a third party. The web server must enforce HTTPS in order for secured authentication to function
properly.

Additional Resources
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Review these third-party resources for additional background information on the topics presented in this article.
Mozilla Developer Network: Cross-Origin Resource Sharing (CORS)
IBM: Prevent a cross-site scripting attack

Application and Performance Logging
An administrator can configure how Exago handles logging in order to change or extend functionality.

Logging Defaults
By default Exago saves a log file WebReportsLog.txt to the application’s Temp path. The logger maintains a lock on the file for the
lifespan of the application. The log file cannot be edited or deleted without restarting the application or releasing the lock.
Note
As of version 2018.1, the .NET API logs to the file <Temp>\WebReportsApiLog.txt
There are five configurable verbosity levels for the logger. By default, Exago logs at the Info level. Set the level by changing the Admin
Console > General > Other Settings > Write Log File setting.
None — Turns logging off.
Error — Logs application errors.
Warn — Logs application warnings, which may be indicative of problems in the configuration, as well as all Error messages.
Info — Logs SQL statements, number of rows returned from each statement, and report execution information, as well as all Warn
and Error messages. Report execution information includes the following:
Execution start — Start time, @userId@ and @companyId@ parameter values, full report name and filter summary.
Execution end — End time, runtime, @userId@ and @companyId@ parameter values amd full report name.
Debug — Logs a variety of debugging information that can be used to time specific parts of the application as well as all Info,
Warn, and Error messages.
Important
Setting the log level to DEBUG in a production environment can have unintended performance consequences. Only use DEBUG
level logging in production temporarily and under advisement from the Exago Support, Services or Development teams.

log4net
The logger can load its configuration from a file and continually watch the file for changes. A config file can be used to lock or unlock the
log file, change the log file name and path, as well as customize and extend logging capability.
A custom log configuration file overrides the application's configuration settings.
Notice
Enabling or disabling logging with log4net will require restarting the web server.
To use a custom log configuration:
Note
This article references <WebApp>/ and <Sched>/as a placeholder for the Web Application and Scheduler Service's install location
respectively. The default install location is C:\Program Files\Exago\ExagoWeb\ (/opt/Exago/ on Linux), or C:\Program
Files\Exago\ExagoScheduler\ (/opt/Exago/Scheduler/ on Linux); however, these directories can be changed during
installation.
1. Create a file named log4net.config in the <WebApp>\Config directory of the Exago Web Application, or open the
<Sched>/eWebReportsScheduler.exe.config for the Scheduler Service. The following shows a sample config file:
Note
For versions pre-v2019.2.32, pre-v2020.1.15, or pre-v2021.1.3, replace #%-3property{ThreadId} with #%-3thread in the
conversionPattern nodes.
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<log4net>
<appender name="RollingFile" type="log4net.Appender.RollingFileAppender" >
<file value="WebReportsLog.txt" />
<layout type="log4net.Layout.PatternLayout">
<conversionPattern value="%date #%-3property{ThreadId} %-5level [%-8.8property{ReportId}][%-8.8property{SessionId}] - %message%newline" />
</layout>
<maxSizeRollBackups value="10" />
<maximumFileSize value="1MB" />
<rollingStyle value="Size" />
</appender>
<appender name="PerfRollingFile" type="log4net.Appender.RollingFileAppender" >
<file value="WebReportsPerfLog.txt" />
<layout type="log4net.Layout.PatternLayout">
<conversionPattern value="%date #%-3property{ThreadId} %-5level %logger [%-8.8property{ReportId}][%-8.8property{SessionId}] - %message%newline" />
</layout>
<maxSizeRollBackups value="10" />
<maximumFileSize value="1MB" />
<rollingStyle value="Size" />
</appender>
<root>
<level value="DEBUG" />
<appender-ref ref="RollingFile" />
</root>
<!-- Set logging level to DEBUG and use logger define at the ROOT level -->
<logger name="Exago Logger">
<level value="DEBUG" />
</logger>

<!-- Disable Performance Logging
<logger name="Perf Logger">
<level value="OFF" />
</logger>
-->
<!-- Enable Perf Logging in general log file -->
<logger name="Perf Logger">
<level value="INFO" />
</logger>
<!-- Perf logging in its own file
<logger name="Perf Logger" additivity="False">
<level value="INFO" />
<appender-ref ref="PerfRollingFile" />
</logger>
-->
</log4net>

2. Determine the type of logging needed: either Application, Performance or both.
3. Edit the log4net.config file as follows:

Anatomy of the log4net.config file
For full details about the log4net.config file, refer to Apache's official log4net documentation. Below are some common changes
that can be made that apply to Exago.

Appenders
The appender sections control the log output. There can be seperate log files output for both the standard Exago application log and for
performance logging. In the example two appenders are defined, one named RollingFile and the other PerfRollingFile which can be used for
application and performance logging, respectively.
Change Log File Location
This node determines the location of the log file. This should be a fully qualified file path.
<file value="Path\To\Log.txt" />

Changing the Logging Pattern
<conversionPattern value="%date %-5level [%property{SessionId}] %message%newline" />

Configures which information is logged and the format of how it is written.
See Apache log4Net SDK Documentation - PatternLayout Class for details on how to format the conversionPattern.
Unlock the Log File
<lockingModel type="log4net.Appender.FileAppender+ExclusiveLock" />

Configures the locking model in use for the log file. To temporarily disable the write lock, you can use:
log4net.Appender.FileAppender+MinimalLock
Note
This will result in a performance reduction until it is reset.

Loggers
The root and logger nodes establish loggers that receive information from Exago and then send it to the appenders that actually write
the files.
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The Exago Logger is used by the main application. The Perf Logger records application performance. By default, logs will then be passed
to the the root logger unless their corresponding additivity attribute is False.
In the example file, both Application logging (via the <logger name="Exago Logger"> node) and Performance logging (via the
<logger name="Perf Logger"> node) are enabled. They will capture the data then will use the <root> logger since the additivity
attribute is not specified. The <root> logger uses the RollingFile appender, so both the Application and Performance log data will be
written to the same file.
To write the application and performance logs to different files, comment out the <logger name="Perf Logger"> node and
uncomment the <logger name="Perf Logger" additivity="False"> node. The log level and destination appender are then
further defined:
Change Logging Level of a Logger
Specifies the Exago logging level: OFF, ERROR, INFO, or DEBUG.
Important
Setting the log level to DEBUG in a production environment can have unintended performance consequences. Only use DEBUG level
logging in production temporarily and under advisement from the Exago Support, Services or Development teams.

<level value="INFO" />

Change Appender a Logger Uses
Specify the name of an appender in the ref attribute of this node.
<appender-ref ref="PerfRollingFile"

Resolving log4net.dll version conflicts
Exago uses a specific version of the log4net.dll file that is shipped with the application. When a .NET embedding application implements a
different version of log4net, there can be conflicts. The solution is to add a runtime assembly binding redirect to the Exago web.config.
Example
<dependentAssembly>
<assemblyIdentity name="log4net" publicKeyToken="669e0ddf0bb1aa2a" culture="neutral"/>
<bindingRedirect oldVersion="1.2.11.0" newVersion="1.2.15.0" />
</dependentAssembly>

See Redirecting Assembly Versions (MSDN) for more information.

Logging to a SQL Database
The following will describe the necessary steps to store Exago logging information in a database. The sample referenced here is configured
for MS SQL Server, but log4net provides examples for other database types.
1. Create a new database table to store the log transactions
CREATE TABLE [dbo].[exagoweb] (
[id] [int] IDENTITY (1, 1) NOT NULL,
[timestamp] [datetime] NOT NULL,
[logger] [varchar] (255) NOT NULL,
[thread] [varchar] (255) NOT NULL,
[level] [varchar] (50) NOT NULL,
[reportId] [varchar] (255) NOT NULL,
[sessionId] [varchar] (255) NOT NULL,
[message] [varchar] (4000) NOT NULL
)

2. Use the following example log4net configuration file as a reference to configure log4net logging to the database:
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<?xml version="1.0" encoding="UTF-8"?>
<log4net>
<appender name="AdoNetAppender" type="log4net.Appender.AdoNetAppender">
<bufferSize value="100" />
<connectionType value="System.Data.SqlClient.SqlConnection, System.Data, Version=4.0.0.0, Culture=neutral, PublicKeyToken=b77a5c561934e089" />
<connectionString value="database connection string" />
<commandText value="INSERT INTO exagoweblog ([timestamp],[logger],[thread],[level],[reportId],[sessionId],[message]) VALUES (@timestamp, @logger, @thread, @level, @report
<parameter>
<parameterName value="@timestamp" />
<dbType value="DateTime" />
<layout type="log4net.Layout.RawTimeStampLayout" />
</parameter>
<parameter>
<parameterName value="@logger" />
<dbType value="String" />
<size value="255" />
<layout type="log4net.Layout.PatternLayout">
<conversionPattern value="%logger" />
</layout>
</parameter>
<parameter>
<parameterName value="@thread" />
<dbType value="String" />
<size value="255" />
<layout type="log4net.Layout.PatternLayout">
<conversionPattern value="%-3thread" />
</layout>
</parameter>
<parameter>
<parameterName value="@level" />
<dbType value="String" />
<size value="50" />
<layout type="log4net.Layout.PatternLayout">
<conversionPattern value="%-5level" />
</layout>
</parameter>
<parameter>
<parameterName value="@reportId" />
<dbType value="String" />
<size value="255" />
<layout type="log4net.Layout.PatternLayout">
<conversionPattern value="%-8.8property{ReportId}" />
</layout>
</parameter>
<parameter>
<parameterName value="@sessionId" />
<dbType value="String" />
<size value="255" />
<layout type="log4net.Layout.PatternLayout">
<conversionPattern value="%-8.8property{SessionId}" />
</layout>
</parameter>
<parameter>
<parameterName value="@message" />
<dbType value="String" />
<size value="4000" />
<layout type="log4net.Layout.PatternLayout">
<conversionPattern value="%message" />
</layout>
</parameter>
</appender>
<root>
<level value="INFO" />
<appender-ref ref="AdoNetAppender" />
</root>
</log4net>

3. Restart the web server and relaunch Exago.
You should no longer see information being saved to disk, and should see entries being populated in the database table instead.

Troubleshooting log4net
log4net does provide the ability to troubleshoot logging. Should you need to troubleshoot, add the following to Exago’s web.config file below
appSettings:
<system.diagnostics>
<trace autoflush="true">
<listeners>
<add
name="textWriterTraceListener"
type="System.Diagnostics.TextWriterTraceListener"
initializeData="C:\tmp\log4net.txt" />
</listeners>
</trace>
</system.diagnostics>

In addition to the above, add the following entry to the appSettings collection:
<add key="log4net.Internal.Debug" value="true"/>
Save the file, refresh IIS and give IIS_IUSRS full permission to the folder where logging logs are set to be stored. In the example above, that
would be “C:\tmp”. Then, attempt to execute Exago reports and check the logging log file to see why Exago logging is failing.
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